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A. These show precautions based on the Ordinance on Industrial Safety and Health (Articles 36, 
104, 150, 151). 
 
  

For the sake of safety, teaching work should only be performed by workers who have 
undergone special training. 
(The same is true for any maintenance work done with the power source not cut off.) 
->Implementation of safety education 

  
For teaching work, prepare work regulations concerning robot operation methods 
and procedures, measures for when there is an abnormality and when restarting, etc. 
Perform teaching work according to these regulations. 
(The same is true for any maintenance work done with the power source not cut off.) 
->Prepare work regulations. 

  
For teaching work, set up a device that can stop operation immediately. 
(The same is true for any maintenance work done with the power source not cut off.) 
->Emergency stop switch setting 

  
During teaching work, label the start switch etc. to indicate that teaching work is 
underway. 
(The same is true for any maintenance work done with the power source not cut off.) 
->Display that teaching work is underway 

  
During operation, prevent contact between workers and robots by preparing a fence 
and a barrier. 
-> Setting up a safety fence 

 
  

Determine a uniform signal to relevant staff for the start of operation and use that 
signal. 
-> Signal for the start of operation 

  
For maintenance work, in principle, cut off the power and label the start switch etc. to 
indicate that maintenance work is underway. 
->Display that maintenance work is underway 

  
Before starting work, check the robot, emergency stop switches, related devices, etc. 
and make sure there are no abnormalities. 
-> Check before the start of work 

 

 

 

 

 

 

 

 

 

Before using the robot, always carefully read the 
precautions below as well as the separate "Safety 
Manual" and take all necessary safety measures. 
 

Safety Precautions 
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B. This shows precaution points given in the separate "Safety Manual". 
For details, please read the text of the "Safety Manual". 
 
  

Use the robot in an environment that is within the range of its specifications. Failure 
to do this can cause a drop in reliability and breakdown. 
(Temperature, humidity, atmosphere, noise, etc.) 

 
When transporting the robot, put it into its specified transport posture. 
Failure to do this can cause a drop in reliability and breakdown. 

  
Install the robot on a solid platform. 
If the robot is in an unstable posture, this can cause positional deviation and 
vibration. 

  
Wire cables away from noise sources as possible. 
If cables are brought too close to noise sources, this can cause positional deviation 
and malfunction. 

  
Do not apply excess force to connectors or bend cables excessively. 
Doing so can cause a contact defect or cut line. 

  
Set work masses, including hands, so as not to exceed the rated load or permitted 
torque. 
Exceeding either of these can cause an alarm or breakdown. 

  
Install hands and tools and hold work securely. 
Failure to do this can cause objects to fly loose during operation and cause personal 
injury or damage. 

  
Ground the robot and controller reliably. 
Failure to do this can cause malfunction due to noise or in an extreme case, electrical 
shock. 

  
Display the operating state while the robot is operating. 
Lack of such a display can result in someone coming too close to the robot by mistake 
or mistaken operation. 

  
Always secure the priority rights for control of the robot before doing any teaching 
work within the robot's operating range. Failure to do this can allow the robot to start 
due to an external command, causing personal injury or damage. 

  
Make the jog speed as slow as possible and do not take your eyes off the robot. 
Failure to do this may cause a collision between the workpiece and peripheral 
devices. 

  
After completing program editing, but before starting automatic operation, always 
check operations in a step run. Failure to do this may cause a collision with a 
peripheral device due to a programming error or the like. 

  
Set up the safety fence in such a way that, while the equipment is running on 
automatic, either the safety fence door is locked or if anyone tries to open the door, 
the robot is stopped. Failure to take these protective measures can cause an accident 
resulting in injury. 
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Never make alterations on your own judgment or use maintenance parts other than 
those designated. Doing so can cause breakdown and malfunctions. 
  
When moving the robot arm from the outside, never stick a hand or finger into an 
opening. Depending on the posture, the hand or finger could get caught in the 
equipment. 

  
Do not stop the robot or perform an emergency stop by switching the robot controller's 
main power supply OFF. 
If the robot controller's main power supply is switched OFF during automatic operation, 
this can reduce the robot's precision. It could result in collisions with peripheral device 
or the like due to arm drop or inertia. 

  
When rewriting a program, parameters, or other internal information within the robot's 
controller, do not switch the robot controller's main power supply OFF. 
If the robot controller's main power supply is switched OFF during automatic operation, 
or while a program or parameter is being written, there is a danger of the internal 
information in the robot controller being corrupted. 

  
For using RH-5AH/10AH/15AH series or RH-6SH/12SH/18SH series. 
While pressing the brake release switch on the robot arm, be aware of the arm 
dropping under its own weight. 
Dropping lead to a collision of the hand with the peripheral equipment or catching of 
hands or fingers. 

 
 
 

 
 

 

 

 

 

 

At shipment, the robot controller is set to English (ENG). 
To use it in Japanese, change "LNG" parameter to "JPN". 
For the setting method, please refer to "14.1Editing from parameter 
list" 
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- Added function to set breakpoints during online editing 
- Added function that batch editing of structure flags on XYZ position 

variables / work position variables batch editing screen. 
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will be valid from next start. 

- Add [Change] button to program monitor. 
[Tool] 
- Add menu button and jog button to user definition screen. 
[Operation panel] 
- Corresponding to arch motion with position jump. 
- Add [P.jump] button to operation panel. 
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- Added function that restore the object setting contents of the layout and 

the robot arrangement position. 
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1.50C 2019/04 [Tool] 
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1.62Q 2020/01 
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1.80J 2020/07 [OS] 
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2.00A 2022/07 - Supports visual program function 
- Supports iQ Care MELFA Support function 

 



 

PREFACE 

Thank you for purchasing this MELFA Mitsubishi Electric industrial robot. 
This document is the user's manual for the MELSOFT "RT ToolBox3", "RT ToolBox3 mini" and "RT ToolBox3 
Pro". 
This document will help you to maximize the functions of this software over a wide range of stages, from 
initial robot startup to program writing, editing, and management. 
In order to operate the robot safely, carefully read this document and the safety manual that comes with the 
robot main unit before operating the robot. Also, store this manual carefully so that you can take it out and 
read it whenever needed. 

Target versions for this document 
This document is for the "RT ToolBox3", "RT ToolBox3 mini" and "RT ToolBox3 Pro", and supports the 
following robot controllers. 

・ CR800-R/ CR800-Q/CR750-Q/CRnQ-700 series controllers 
・ CR800-D/CR750-D/CRnD-700 series controllers 
・ CRn-500 series controllers 

In this manual, these components may also be written as “CR800/750/700/500 series”. 

Target readers for this document 
This document assumes that the reader understands basic Microsoft Windows operation methods and the 
robot controller. 
Those who have not mastered basic computer operation methods should read the user's manual for their 
computer. 

Notation method in this document 

 

This indicates an item for which incorrect handling could present imminent 
danger of death or serious injury. 

 
This indicates an item for which incorrect handling could present a danger of 
death or serious injury. 

 
This indicates an item for which incorrect handling could present a danger of 
injury. It could also present a danger of just physical damage. 

 
This document uses the following general terms and abbreviations 

General Term/Abbreviation Contents 
RCPU General term for Mitsubishi PLC CPU modules of R04CPU, R04ENCPU, 

R08CPU, R08ENCPU, R16CPU, R16ENCPU, R32CPU, R32ENCPU, 
R120CPU, R120ENCPU, R08PCPU, R16PCPU, R32PCPU, R120PCPU, 
R08SFCPU, R16SFCPU, R32SFCPU and R120SFCPU. 

Universal model QCPU General term for Mitsubishi PLC CPU modules of Q02U, Q03UD, Q03UDE, 
Q04UDH, Q04UDEH, Q06UDH, Q06UDEH, Q13UDH, Q13UDEH, Q26UDH 
and Q26UDEH. 

Built-in Ethernet port QCPU General term for Mitsubishi PLC CPU modules of Q03UDE, Q04UDEH, 
Q06UDEH, Q13UDEH and Q26UDEH. 

GX Works 2 / 3 Abbreviation of SW1DNC-GXW2-E / SW1DND-GXW3-E type of Mitsubishi 
PLC programming software package. 

 
The Microsoft® Windows® operating system is a registered trademark of the Microsoft Corp. of the United States in the United States 
and other countries. 
Adobe® and Acrobat® are registered trademarks of Adobe Systems Incorporated. AutoCAD is a registered trademark or trademark of 
Autodesk Inc., its subsidiaries, and associated corporations in the United States and other countries. 
 
The system names, product names, etc. in this manual are generally trademarks and registered trademarks of their respective 
companies. In the main text, the ©, ®, and TM marks are omitted. 
 
Transfer of all or part of the contents of this document without permission is prohibited. 
The contents of this document are subject to change without notice. 
Every effort has been made to ensure the accuracy of the contents of this document, but if you should notice any unclear point, mistake, 
or omission, please notify Mitsubishi Electric. 
 
© 2017 MITSUBISHI ELECTRIC CORPORATION 
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1. Usage 
 
This explains precautions you need to know before using this software.  

 
 
1.1. How to Use this Document 
The manual is in the DVD-ROM as the Adobe PDF file.  

D:/Doc/RT3Manual.pdf   (Example for the DVD drive is “D :”.)  
 
For reading the manual in the DVD-ROM, Adobe Reader is required. 
If Adobe Reader isn’t installed, please download from the following Adobe Systems Incorporated URL (As of 
November, 2019) 

URL: http://www.adobe.com/ 
 

 
 
1.2. Checking the Product 

1.2.1. Checking the package 

Please check if all items shown below are included in the package.  
- DVD-ROM "RT ToolBox3" 
- Setup Guide 
- END-USER SOFTWARE LICENSE AGREEMENT 
- License Certification  

(Please make sure Product ID is printed on it.) 
* Please contact the branch office or the agency if there is some shortage in the package.  
 
 
1.2.2. Checking the DVD-ROM contents 

The DVD-ROM has the following configuration.  

 
 
 
1.2.3. About the "MelfaRXM.ocx" communications middleware 

MelfaRXM.ocx is the ActiveX control that communicates with the robot-controller. You can create the Windows 
Application of "MELFA ROBOT" by using this control. 
You can use "MelfaRXM.ocx" in the standard version of this software only. 
For information on how to set up "MelfaRXM.ocx", refer to "28 MelfaRXM.ocx Communications Middleware 
Setup". 
If using only the function of “RT ToolBox3”, you don't need to install this software. 
 

Doc 

/: 

The files for installation of this software 

This manual (pdf) ・・・・・・・ 

Utility The folder for setup of the communication middleware "MelfaRXM.ocx" ・・・・・・・ 

: 
: 

Sample The sample data (Layout, Hand model)  ・・・・・ 
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1.3. Items to be prepared by the customer 
This explains what the customer needs to prepare in order to use this software 
 
 
1.3.1. Computer system 

Use a computer that meets the specifications given in: "1.4 Operating Environment". 
 
 
1.3.2. Computer cable 

Prepare the cable for connecting the controller and the computer. The cable required depends on the connection 
specifications and controller used, as shown below.  
For the RS-232 cable refer to the "Standard Specifications" for your robot.  
 

Table 1-1 CR800-D/CR750-D/CRnD-700/CRn500 Series Communication Cables 
Method Description Cable confirmed to work by us 

Model name Manufacturer 
USB USB A type, USB mini B type - - 
Ethernet 10BASE-T, 100BASE-TX - - 

RS-232 For controller front panel 

CRnD-700 
series 2D-232CBL03M Mitsubishi Electric 

CRn-500 
series 

RS-MAXY-CBL 
RS-AT-RCBL 
(for expansion serial 
interface (option)) 

Mitsubishi Electric 

For expansion option box (CR1-EB3) RS-AT-RCBL Mitsubishi Electric 
 

Table 1-2 CR800-R/CR800-Q/CR750-Q/CRnQ-700 Series Communication Cables 

Method Description Cable confirmed to work by us 
Model name Manufacturer 

USB USB A type to mini B type 

ZUM-430 Loas Co., Ltd. 
USB-M53 Elecom Co., Ltd. 

GT09-C20USB-5P Mitsubishi Electric System 
Service 

MR-J3USBCBL3M Mitsubishi Electric 
Ethernet 10BASE-T, 100BASE-TX - - 

RS-232 

For connecting by personal computer - 
PLC CPU 
(when Personal computer connector is 
D-sub, 9-pin) 

QC30R2 Mitsubishi Electric 

 

 

Normal operation not guaranteed with USB to RS-232 cable 
 

Normal operation is not guaranteed when using the USB to RS-232 cable. When using the RS-232 
as a communication port, use of a computer with a serial port is recommended. 

Caution 
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1.4. Operating Environment 
This explains the operating environment.  
 
 
1.4.1. Connectable robot controllers 

This software can connect to the robot controllers shown below 
 

Table 1-3 Connectable Robot Controllers and Communications Types 
Robot controller Communications (*1) Remark 

CR800-D/CR750-D/ 
CRnD-700 series 

 
(The photo is the robot 
 controller for CR800-D.) 

USB (*2) 

Commercial items such as computers and 
cables might be incompatible with our equipment 
or the FA environment such as temperature and 
the noise, etc. 
When using, please confirm the operation 
enough, because you might have to take 
measures against noise such as EMI measure or 
addition of ferrite core. 

Ethernet (TCP/IP)  
RS-232 Only CRnD-700 series 

GOT communications 

Communicate with CR800-D/CR750-D/ 
CRnD-700 series controller connected with the 
GOT via Ethernet by USB / RS-232. 
GOT 2000/1000 series and the Ethernet 
communication unit (GT25-J71E71-100/ 
GT15-J1E71-100) are needed. 

CR800-R/CR800-Q/ 
CR750-Q/CRnQ-700 series 

 
(The photo is the robot 
 controller for CR800-R.) 

CRnQ_R 
communications 

USB (*2)  

Ethernet 
(TCP/IP) 

The PLC RCPU, Ethernet interface module or 
Built-in Ethernet port QCPU is required. 

RS-232 

 

Ethernet (TCP/IP) 

Only can be used for CR800-R/CR800-Q 

CRn-500 series  

 

Ethernet (TCP/IP) The robot controller must have the "Ethernet 
interface" option. 

RS-232  

(*1) The computer must have the respective communication ports. 
(*2) When using a USB connection, 1 computer can connect to only 1 robot controller. 

 
This software can be connected to a maximum of 32 controllers at the same time. These controllers may be different 
models. 
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1.4.2. Computer system 

This software operates on PC/AT compatible computers that meet the following specifications.  
 

Item Recommended environment 

CPU 

Mini/standard edition: 
Intel® Core™2 Duo processor 2 GHz or faster recommended 

Standard edition: When multiple simulators are started up 
Intel ® Core™i7 series or faster recommended, 
VRAM 1 GB or more video card recommended 

Pro edition: 
Environment in which SolidWorks can run (64-bit OS only supported) 

Main memory 

Mini/standard edition: 
1 GB or more for a 32-bit OS and 2 GB or more for a 64-bit OS 

recommended 
Pro edition: 

Environment in which SolidWorks can run 
Hard disk Free space when RT ToolBox3 is installed: 5 GB or more 
Virtual memory Free space when RT ToolBox3 is running: 512 MB or more 
Display XGA (1024x768) or higher 

SXGA (1280 x 1024) or higher recommended 
*When the screen layout crashes, set the display to 100% before use 

Optical device DVD-ROM drive 
Keyboard PC/AT compatible keyboard 
Pointing device Must operate on Windows 

Communications 
functions 
Communications port 

- USB2.0  
(Note: This cannot be used for connection with the CRn-500 series as 
there is no USB) 

- LAN: 100Base-TX/10Base-T 
- RS-232 communication port that operates on Windows (Minimum 

9600bps: 1 port) 
Must have one of the above interfaces 

OSs for which 
operation is warranted 

Windows 7 Starter (32-bit version)  
Windows 7 Home Premium (32/64-bit version) 
Windows 7 Professional(32/64-bit version) 
Windows 7 Enterprise (32/64-bit version) 
Windows 7 Ultimate (32/64-bit version) 
Windows 8 (32/64-bit version) (*1) 
Windows 8 Pro (32/64-bit version) (*1) 
Windows 8 Enterprise (32/64-bit version) (*1) 
Windows 8.1 (32/64-bit version) (*1) 
Windows 8.1 Pro (32/64-bit version) (*1) 
Windows 8.1 Enterprise (32/64-bit version) (*1) 
Windows 10 Home (32/64-bit version) (*1) 
Windows 10 Pro (32/64-bit version) (*1) 
Windows 10 Education (32/64-bit version) (*1) 
Windows 10 Enterprise (32/64-bit version) (*1) 
Windows 10 IoT Enterprise 2016 LTSB 

*1: When you install this software, [.NET Framework 3.5 (includes .NET 2.0 and 3.0)] feature should be 
turned on. Refer to Chapter 1.5.1.1 for the method of current status confirmation and enabling. 
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1.5. Installation, Uninstallation 
This section explains the method for installing the software and the method for uninstalling it.  
 

 
 
 
1.5.1. Installation 

 
 
Install this software with the procedure below.  
 

When you insert this product into the computer's DVD-ROM drive, the setup screen is displayed 
automatically. 

 
If the setup screen is not displayed when you insert this product into the computer's DVD-ROM drive, display 
the setup screen with the following method. 

 
1) Display the [Run] dialog. 

 

Press  on the keyboard. 

When installing, log in as a user with administrator rights.  
 

When installing, log in as a user with administrator rights. The system will not let you install if you 
log in as a user who does not have administrator rights.  

Please input the product ID attached to RT ToolBox3 again when you install 
the standard version of RT ToolBox3 in the personal computer in which “iQ 
Works (MELSOFT Navigator)" is installed. 

When RT ToolBox3 is installed in a personal computer in which “iQ Works (MELSOFT 
Navigator)" is installed, the product ID for “iQ Works (MELSOFT Navigator)” is displayed on 
"Input Product ID" screen. RT ToolBox3 is installed in the personal computer as mini version 
when this software is installed with this Product ID. Please input the product ID attached to RT 
ToolBox3 product again when you install a standard version of RT ToolBox3. 

Caution 

Caution 

Uninstall RT ToolBox3 before installing.  
 

If "RT ToolBox3" has already been installed in the personal computer, it is necessary to uninstall 
it before "RT ToolBox3" is installed. 

Caution 
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2) Check the DVD-ROM drive name, then input "drive name":\Setup.exe.  

(If the DVD-ROM drive is "D:” input "D:\Setup.exe".) 
 

 
Figure 1-1 Specify the File Name and Execute 

 

 
* The Product ID is printed on the License Certificate 
* After the installation is completed, the computer may need to be rebooted.  

 

 Start 

(f) Input Product ID 

 

(i) Start the program, and confirm whether 
the product was installed correctly 

(h) Installation Wizard Complete 

 Finish 

(a) Set the DVD-ROM in PC's DVD-ROM drive. 

(b) Open "Setup.exe" in DVD-ROM. 
(If it does not start automatically) 

(c) Starting installation Wizard 

(d) License Agreement 

(g) Choose Destination Location 
(e) Input "Customer Information" 
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1.5.1.1. Installation on Windows 8 / 8.1 / 10 
When you install this software on Windows 8 / 8.1 / 10, you will need to turn on the ".NET Framework Version 3.5 
(includes .NET 2.0 and 3.0)” feature of the PC you want to install. If you install this software with this feature turned 
off, the installation will stop and show the following dialog. 
 

 
 
 
If the dialog is shown, install this software again after you turn on ".NET Framework Version 3.5 (includes .NET 2.0 
and 3.0)” feature as follows. 
 
(1) Be ready to connect the PC to the Internet. 
 
(2) Select [Programs] – [Turn Windows features on or off] from the Control Panel. 
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(3) Check the [.NET Framework 3.5 (includes .NET 2.0 and 3.0)] check box on the Turn Windows features on or off 

screen and click [OK]. 

 
 
(4) Select [Download files from Windows Update] when the following screen is shown. 
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(5) This process is complete when the following screen is shown. 
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1.5.2. Uninstall 

Uninstall by the following method.  
 
- Windows 7 

Execute [Start] – [Program Functions] or [Uninstall Program], 
select the application name, then execute the uninstallation. 

 
- Windows 8 / 8.1 / 10 

Press the [Windows] + [X] key, and select the [Program 
Functions] from the displayed menu. 
 
With [Program Functions], select the application name, then 
execute the uninstallation. 
 

 
 

Start uninstallation. 

From [Start] – [Control Panel], display the 
control panel and select "Add/Remove 
Programs". 

Select the product to delete, then click the 
"Change or Remove Programs". 

 
Completion 

 
 

 
Figure 1-2 Uninstalling Applications (Windows7) 

 
 
 
 

RT ToolBox3 
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1.5.3. USB driver (CR800-D/CR750-D/CRnD-700 series robot controller) installation  

 
Connecting the CR800-D/CR750-D/CRnD-700 series robot controller by USB requires installation of the robot USB 
driver. 
 
When you connect the CR800-D/CR750-D/CRnD-700 robot controller and the computer with a USB cable, 
installation starts and completes automatically.  
 

 

 

When the communication becomes unstable  
 

If you connect the computer and CR800-D/CR750-D/CRnD-700 series robot controller with a USB cable, 
the communication may become unstable due to noise. 
In this case, we recommend changing to LAN communication. 
 

If you cannot communicate with the CR800-D series robot 
controller with USB in Windows 7 (64-bit version)  

 

Please perform Windows Update and update Windows to the latest state. 
* When communicating with the robot controller of the CR800-D series with USB in Windows 

7 (64-bit version), Application of "Security Update for Windows 7 for x64-based Systems 
(KB3033929)" is mandatory. 

Caution 
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1.5.4. CRnQ_R communication USB driver installation  

 
Connecting the CR800-R/CR800-Q/CR750-Q/CRnQ-700 series robot controller by USB requires installation of the 
robot USB driver. Install by the following procedure. 

 
 

 
↓ 

1) When "Control panel" is selected 
from the start menu with the USB 
cable connected, the following 
screens are displayed.  
The screen on the left is displayed. 
Click the part circled in red in this 
screen. 

 
↓ 

2) The screen on the left is displayed. 
Click the part circled in red in this 
screen. 
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↓ 

3) The screen on the left is displayed. 
Click the part circled in red in this 
screen. 

 
↓ 

4) The screen on the left is displayed. 
Right-click on the “MELSEC” 
displayed on this screen. 
Select "Update Driver Software" in 
the menu displayed upon 
right-clicking this item. 
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↓ 

5) The screen on the left is displayed. 
Click "Browse my computer for 
driver software" on the bottom. 

 
↓ 

6) The screen on the left is displayed, 
set to "C:\Melsec\Easysocket 
\USBdrivers". 
If multiple MELSOFT products have 
been installed, browse the 
installation destination 
"EasySocket\USBDrivers" of the 
first installed product. 
After setting, click the "Next" button.  

 
↓ 

7) The screen on the left is displayed. 
Click "install". 
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↓ 

(Completed) 

8) The screen on the left appears, 
indicating completion of installation. 
Click the [Finish] button. 

 
 
1.5.5. CRnQ_R Communication USB driver for GOT transparent function / GOT 

communication installation  

 
Connecting the CR800-R/CR800-Q/CR750-Q/CRnQ-700 series robot controller by USB via the GOT transparent 
mode (Bus, Direct coupled or Ethernet) and connecting the CR800-D/CR750-D/CRnD-700 series robot controller by 
USB via GOT communication requires installation of the USB driver for the GOT transparent function. 
  
When you connect the GOT and the computer by the USB cable, installation starts and completes automatically.  
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1.6. When Starting at the Same Time as Another Product 
When starting this software and another one of our products at the same time, follow the following precautions. 
Correct communications and screen display are sometimes not possible.  
 

Table 1-4 Precautions for Starting at the Same Time with another Product 
Product name Explanation Precaution 

RT VisualBox MELFA  ASSISTA  
software 

Cannot be used at the same time as 
this software 

RT ToolBox  
computer support software 

Older version of this 
software 

Cannot be used at the same time as 
this software 

RT ToolBox 2 Older version of this 
software 

Cannot be used at the same time as 
this software 

MELFA-Works 3D robot simulator Cannot be used at the same time as 
this software 

MELFA-Vision Network vision sensor 
software Start this software first. 

E/EN series computer support 
software for Windows E/EN series software Cannot be used at the same time as 

this software 

P/P-2 R-250R/R-300R series 
software  

Can be used at the same time as this 
software 

 
 
1.7. Upgrade of software 
It is possible to download the latest version from the MITSUBISHI ELECTRIC FA site where information on 
MITSUBISHI ELECTRIC Corporation FA equipment products is offered. 
 

https://www.mitsubishielectric.com/fa/ 
 
It is necessary to register as FA members to download software. 
 

https://www.mitsubishielectric.com/fa/
https://www.mitsubishielectric.com/fa/
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2. Changes from RT ToolBox2 
In RT ToolBox3, the following content has been changed from RT ToolBox2. 

 
 
2.1. Changes to Save Format in Workspaces and Compatibility 
The save format for the layout settings for workspaces differ in RT ToolBox2 and RT ToolBox3. 
When a workspace saved in RT ToolBox2 is opened in RT ToolBox3, the layout that was last opened in the 3D 

monitor of the entire workspace, the robot layout, etc. are automatically converted to the saving format of RT 
ToolBox 3, and a layout file is created. In addition, if you want to display the layout created by RT Toolbox 2, you 
need to convert it to the saving format of RT ToolBox 3 using the layout conversion function. 
Workspaces created in RT ToolBox3 can also be opened in RT ToolBox2. However, note that layouts set in RT 

ToolBox3 cannot be displayed. 
 
 
2.2. Operations Using the Ribbon 
Instead of the tool bar and menus that were used in RT ToolBox2, in RT ToolBox3, a ribbon interface is made 

available that allows the user to quickly find the required commands. 
 For an explanation on the ribbon, refer to "6 Ribbon". 
 
 
2.3. Linking Between the Offline and Simulation Environments. 
In RT ToolBox2, the environments for offline editing and simulator tasks were independent from each other. For this 

reason, program transfer or parameter restore operation was needed to reflect new programs and parameters made 
by offline editing in the simulator. 
 
In RT ToolBox3, common data is used offline and on the simulator. For this reason, operations for reflecting new 

programs and parameters made by offline editing in the simulator are no longer needed. 
As a result, in RT ToolBox3, programs and parameters can be edited without having to be aware of any differences 

in the offline and simulator environments. 
 

 

Simulator execution using 
offline data 

Simulator 

Offline data 
*Program 
* Parameters 
* Spline 

....and others New settings made by editing on the 
simulator are set to the offline data 
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In addition, a backup / restore function for projects in the personal computer has been added, enabling the 

environment within the robot controller (online) and the environment in the personal computer (offline / simulation) to 
cooperate as described below. 

(1) Build environment of robot controller in personal computer. 
(2) Reflect the contents set in the personal computer to the robot controller. 

 

 
Figure 2-1 Cooperation between robot controller environment and simulation 

 
For each backup / restore method (a) - (d) above, please refer to the following chapters respectively. 

Symbol Operation contents References 
(a) Robot controller back up 18.1 Backup(Robot -> PC) 
(b) Restore to robot controller 18.2 Restore (PC -> Robot) 
(c) Offline project back up 18.6 Deleting Backup Data 
(d) Restore to offline project 18.7 Open Backup program 

 
 
2.4. Support of Program Language MELFA-BASIC VI 
In RT ToolBox3, the program language "MELFA-BASIC VI" that has been added on CR800 series controllers is now 
supported. For details, refer to "10 Robot Programming Language Setting". 
 
 
2.5. Discontinuation of Robot Individual Display in 3D Monitor 
In the RT ToolBox2 3D monitor, displays for individual robots by each project and all robots in workspaces were 
displayed. However, in RT ToolBox3, to avoid confusion among users due to the two different available displays, 
only all robots in workspaces are displayed. 
 
 
2.6. Memory of screen display position and size 
In RT ToolBox3, remembers the display position and size of each screen. Next time, the same screen is displayed 
with the same position and size as the previous time. 

 

Environment inside the 
robot controller(Online) 

Inside personal 
computer environment 

(Offline/Simulator) 

Robot 
Controller 
Backup 

Offline 
Project 
Backup 

(a) Backup 

(c) Backup 

(d) Restore 

(b) Restore 

(1) Build environment of robot 
controller in personal computer 

(2) Reflect the contents set in 
the personal computer to the 
robot controller 

Offline data 
*Program 
*Parameters 
*Spline 
… Etc 
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Figure 2-2 Memory of screen display position and size 

 
In RT ToolBox3, remembers the display position and size of each screen. Next time, the same screen is displayed 
with the same position and size as the previous time. 

 
 

 
 

 
Please be careful, if initialized by this method, display position and size of all screens are 
initialized. 

Caution 

Remember ｓ  the display 
position and size of each 
screen. 
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3. RT ToolBox3 Usage  
 
This explains the usage of this software simply.  
 
 
3.1. Starting RT ToolBox3 
When you install this software, a shortcut is prepared on the desktop.  Start RT ToolBox3 by double clicking this 
short cut.  

 
Figure 3-1 RT ToolBox3 Shortcut 

 
From [Start] button -> [All Programs] -> [MELSOFT], select [RT ToolBox3] and start it.  
 

 
Figure 3-2 RT ToolBox3 Initial Screen  

 
When you start RT ToolBox3, "Communication Server 2" is started up as an icon.   
This Communication Server 2 has functions for connecting with a robot controller or, during a simulation, a virtual 
controller. Do not close Communication Server 2.  
 

 
Figure 3‑3 Communication Server 2 
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3.2. Explanation of RT ToolBox3 Screens 
The composition of the main RT ToolBox3 screen is as follows. 
 

 
 

Figure 3-4 Explanation of Main Screen 
 

(1) Title bar (2) Ribbon 

(3) Project tree 

(4) Property window 

The screen currently active 
is displayed on top. 

(6) Screens 

(6) Screens 

(8) Status bar 

(7) Output window 

(5) Individual function tree 
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(1) Title bar  

Displays the name of the workspace currently being edited.  
 

 
 
(2) Ribbon  

Command groups available in RT ToolBox3 are displayed. 
For details, refer to "6 Ribbon". 

 
 

After the size is changed, you can close RT ToolBox3. 

Displays the name of the workspace currently being edited. 

Minimize RT ToolBox3. 

Maximize/Minimize RT ToolBox3. 

The status of the connection with the robot is displayed. 
The connection statuses are online, offline, and simulation. 

Click to close RT ToolBox3. 

Operations assigned to each icon can be performed. 
(Save, Print, Change RT ToolBox3 Mode, and others) 
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(3) Project tree 

This displays a list of all the projects registered in the workspace and by functions. 
From this tree, the program edit screen, monitor screen, etc. can be started.  

 
The project tree is a docking window. By dragging the title section with the mouse, you can dock the project tree 
at the top, bottom, left, or right edge of the main screen. For details on the docking window,  
refer to "7 Docking Window". 

 
When the project tree is closed, it can be redisplayed by checking [Workspace] in the [View] tab -> [View] group 
on the ribbon. 

 
(4) Property window 

You can reference various attributes of the workspace being edited.   
If you click an item on the project tree, its attributes are displayed.  

 
 

The property window is a docking window. For details on the docking window, refer to "7 Docking Window". 
 

When the property window is closed, it can be redisplayed by checking [Properties] in the [View] tab -> [View] 
group on the ribbon. 

The attributes are being displayed. 
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(5) Individual function tree 

When a specific screen (e.g. 3D monitor) is displayed, this exclusive tree is displayed. When multiple trees are 
displayed, the displayed tree can be switched by selecting the desired tab. 

 
 

The window of the individual function tree is a docking window. For details on the docking window, refer to "7 
Docking Window". 
 
When the individual function tree is closed, it can be redisplayed by clicking the [Reset the window layout.] 
button in the [View] tab -> [View] group on the ribbon. 
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(6) Screens 

This displays the screens that can be started from the project tree, including the program edit screen and 
monitor screen. The currently active screen is displayed on top. 

 

 
 

To close a screen, click the [ ] button in the upper-right corner of the screen.   
You can also change the screen size with the button in the upper-right of the screen.  

 
 
(7) Output window  

RT ToolBox3 event logs and search results, for example, are displayed in this window. 
There are two types of output window, "Output" and "Search". 
 
In the "Output" window, event logs such as the content of syntax check errors in program editing are output. 

 
 
In the "Search" window, search results in program editing, for example, are output. 

 

Minimize the screen. Close the screen. 

Maximize/Minimize the screen. 
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The exclusive context menu is displayed by right-clicking on the output window. The following operations can be 
performed from this menu. 

Menu item Description of operation 
Copy The text string within the selected range can be copied. 

Save As The content displayed in the output window can be saved as 
a .txt format file. 

Clear All This clears the content displayed in the output window. 
 
 
The output window is a docking window. For details on the docking window, refer to "7 Docking Window". 

 
When an output window is closed, the respective output window can be redisplayed by checking [Output] or 
[Search] in the [View] tab -> [View] group on the ribbon. 

 
(8) Status bar  

Displays RT ToolBox3 status information.  
 

 
 
(9) Context menu display 

The context menu can be displayed by clicking the mouse right button. This is a handy menu depending on 
work contents and it improves work efficiency. 
For example, [Copy], [Cut] and [Paste] operations can be executed when performing program editing. 

 

During program editing, displays the cursor position. 

RT ToolBox3 mode is displayed. 
The online mode, offline mode or simulation mode is displayed. 
 

Each of the Caps Lock, 
Num Lock or Scroll Lock 
state is displayed. 
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3.3. Changes in RT ToolBox3 Display Format 
The display language and display style of RT ToolBox3 can be changed. 
 
 
3.3.1. Changing the display language 

The screen for changing the RT ToolBox3 display language can be changed by clicking the [Select Display 
Language] button in the [View] tab -> [View Settings] group on the ribbon. 
 

 
Figure 3-5 Display language switching 

 
When the display language has been changed, the display will be in the newly set language when RT ToolBox3 is 
next started up. 
 
A list of languages that can be selected as follows. 

Languages 
English(英語) 
Japanese(日本語) 
Chinese Simplified(简体中文) 
Chinese traditional(繁體中文) 

 
Version 1.01B or later, when non-Japan has been selected, regardless of the "LNG" parameter setting, the controller 
turns on the language of communication in English. Sets the Japan and switch to Japan. 
This function can be used with Version 1.01B or later of the CR800/750/700 series controller. 
 
 
3.3.2. Changing the display style 

The screen for changing the RT ToolBox3 display style can be changed by clicking the [Select Display Language] 
button in the [View] tab -> [View Settings] group on the ribbon. 
 

 
Figure 3-6 Display Style Switching 

 
When the display style has been changed, the display will be in the newly set style when RT ToolBox3 is next started 
up. 
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3.4. Help Display 
Explanations and information about RT ToolBox3 operation can be displayed in the Help display. 
 
 
3.4.1. Displaying language help 

Help for each individual program language can be displayed by selecting from the [Help] tab -> [Language Help] 
drop-down menu on the ribbon. 
For details on program languages, refer to "10 Robot Programming Language Setting". 
 
 
3.4.2. Displaying the instruction manual 

The instruction manuals for the robot controller and RT ToolBox3 can be displayed by selecting from the [Help] tab 
-> [Instruction Manual] drop-down menu on the ribbon. 
 
Also, when the screen or tab is open, clicking the [ ] button (display and jump to the manual page of this screen) on 
the title bar will display the items of the manual for the currently selected screen. 
 

 
Figure 3-7 Display Manual from Title Bar 

 

With the screen displayed, 
click the  button. 
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3.4.2.1. Detailed explanations of functions and operations 
By clicking the series name of the robot controller from the [Help] -> [Manual] -> [Detailed explanations of functions 
and operations] dropdown menu, you can display detailed explanation of functions and operations corresponding to 
the series of controllers. 
 

 
 

Figure 3-8  Detailed explanations of functions and operations  
 

- The [ ] button (display and jump to the manual page of this screen) on the title bar does not 
become effective on screens where tabs are not displayed. 

- Depending on the software installation status of the personal computer, items related to the 
manual may not be displayed. The relationship between the software installation status of the 
personal computer and the display status of the manual is as follows. 

 
Table 3-1 Display status when displaying the manual from the [ ] button 

software installation status Display state of manual 
Internet Explorer and Adobe Reader are installed. The corresponding item is displayed. 

AcroRd32.exe is associated with the PDF file. The top of the page containing the 
corresponding item is displayed. 

Acrobat.exe is associated with the PDF file. The top of the page containing the 
corresponding item is displayed. 

PDF files other than AcroRd32.exe and 
Acrobat.exe are associated. 

The first page of the manual is 
displayed. 

 

Caution 
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3.4.2.2. Troubleshooting 

By clicking the series name of the robot controller from the [Help] -> [Manual] -> [Troubleshooting] dropdown menu, 
you can display troubleshooting corresponding to the series of controllers. 
 

 
 

Figure 3-9  Troubleshooting  
 
 
3.4.3. Connecting to the Mitsubishi Electric FA site 

You can connect to the Mitsubishi Electric FA site by clicking the [Help] tab -> [Connect to FA Site] button on the 
ribbon. To be able to connect to the Mitsubishi Electric FA site, your personal computer environment must be able to 
support an Internet connection. 
 
 
3.4.4. Displaying version information 

The screen for checking the version and product ID of RT ToolBox3 is displayed by clicking the [Help] tab -> [About] 
button on the ribbon. 
 

 
Figure 3-10 Checking Version Information 
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3.5. Communication Server 2 
When you start RT ToolBox3, "Communication Server 2" is started up as an icon.   
This Communication Server 2 has functions for connecting with a robot controller or, during a simulation, a virtual 
controller.  

 
Figure 3-11 Communications Server 2 as Icon 

 

 
When you return Communication Server 2 from an icon to its original size, you can check the status of the 
connection with the robot. 

 
 

Figure 3-12  Communication Server2 
 
(1) Title bar 

(AA/BB)  AA: shows the number of robot controllers with which connections are established and BB: shows the 
number of projects switched online.  

 
(2) Line State 

The connection status of the communication line with the robot is displayed. The status color indicates the 
status of the robot controller that is currently being selected.  

 
Table 3-2 Line State 

Status Content Color 

Connecting Indicates that the connection with the robot has been established. 
Light blue 

or 
Blue 

Connection wait 

Indicates that a communication to verify connection is being made in the 
case of RS-232 connection. 
Indicates the wait status for communication port connection in the case of 
TCP/IP and USB connection. 

Green 

Connection 
error 

Displayed when the data reception enable signal cannot be detected 
because a cable has been disconnected or the robot has not been started 
in the case of RS-232 connection. 
Displayed when the communication port cannot be opened in the case of 
TCP/IP and USB connection. 
In the case of USB connection, if the USB driver has not been installed, it 
is also displayed in red. 

Red 

Do not close Communication Server 2 manually.  
 

Communication Server 2 has functions for connecting to a robot controller or during simulation, a virtual 
controller.  Do not close Communication Server 2.  Communication Server 2 closes automatically 
when RT ToolBox3 is closed.  
 

Turn Communication Server 2 into an icon.  
Turn Communication Server 2 into an icon with the  button.  

Caution 

(1) Title bar 

(2) Line State 

(3) Communication 
State 

(4) Robot 
controller 

(5) Robot 
Information 
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Status Content Color 

Communication 
Setting error 

Displayed when the communication port cannot be opened in the case of 
RS-232 connection. This is not displayed in the case of TCP/IP 
connection 

Red 

Waiting Indicates the idling status displayed at the start of remote maintenance. Yellow 
 
(3) Communication State 

The contents of communication with the robot controller are displayed.  
 
(4) Robot 

This changes the robot controller for which the "Line status" and "Communication status" are displayed.  
This is only displayed for robot controllers that are online or have been switched to simulation status.  

 
(5) Robot Information 

Information on the currently connected robot can be referenced.  

 
Figure 3-13 Connected Robot Information 

  

 
 
This software can communicate with robot controller by higher reliability communication. In this case, line state color 
(connecting) of communication server 2 is “Blue”. 
 

Table 3-3 Combination of higher reliability communication 
 Robot controller software version 

CR800-D/R/Q CR750-D/CRnD-700 CR750-Q/CRnQ-700 CRn-500 

All versions Ver.P8  
or later 

Ver.P7a  
or earlier 

Ver.N8  
or later 

Ver.N7 
or earlier All versions 

Combination with  
this software ◎ ◎ ○ ◎ ○ ○ 

○ : Conventional communication (line state color (connecting): light blue) 
◎ : Higher reliability communication (line state color (connecting) : blue) 

Points to note when using the USB connection in CRnQ_R 
Communication  

 

After connection success using a USB connection in CRnQ_R communication, when 
communication is disconnected due to external factors such as the following, the line state may 
remain "connected". In such a case, please return offline once and remove the factors then 
return online again.  
・ When the power of the robot controller is turned off 
・ When the communication cable is disconnected 

Caution 
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3.6. Closing RT ToolBox3 

To exit RT ToolBox3, click the [Workspace] tab -> [Exit] menu on the ribbon. You can also close with the [ ] button in 
the upper-right of the screen. 
When you close RT ToolBox3, Communication Server 2 also closes automatically. 

Cautions on higher reliability communication by TCP/IP 
When connected higher reliability TCP/IP communication, connect only one line per port number. 
If two or more lines are connected to the same port number, a communication error may occur. 

Caution 
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4. Notes of when RT ToolBox3 is used with iQ Works 
(MELSOFT Navigator) 

There are some limitations when robot controller's workspace is made by using iQ Works (MELSOFT Navigator) 
or RT ToolBox3 is started from iQ Works (MELSOFT Navigator). Please refer to the following notes when you use iQ 
Works (MELSOFT Navigator).  
 
 
4.1. Notes of when RT ToolBox3 is installed 

Notes 1-1： Please input product ID attached to the product again when you install a 
standard version of RT ToolBox3 in the personal computer in which “iQ Works 
(MELSOFT Navigator" is installed. 

 
When RT ToolBox3 is installed in the personal computer in which “iQ Works (MELSOFT Navigator)" is 

installed, product ID for “iQ Works (MELSOFT Navigator)” is displayed on "Input Product ID" screen. RT 
ToolBox3 is installed in the personal computer as mini version when this software is installed with this Product 
ID. Please input product ID attached to RT ToolBox3 product again when you install a standard version of RT 
ToolBox3. 

 
 
4.2. Notes concerning workspace operation 

Notes 2-1： The workspace name and the workspace title cannot be changed. 
 

When RT ToolBox3 is started from iQ Works (MELSOFT Navigator), the workspace name and the 
workspace title cannot be changed. "Edit workspace" in the dropdown menu of the workspace name is 
displayed in the gray and cannot be selected. (Refer to “Figure 4-1 Menu of [Workspace] and 
Dropdown-menu of the Workspace”) 

 
 
Notes 2-2： Please close RT ToolBox3 once when you edit another workspace.  

 
Another workspace cannot be opened after closing the editing workspace when RT ToolBox3 is started 

from iQ Works (MELSOFT Navigator). [New] of the [Workspace] menu and [Open] are displayed in the gray, 
and cannot be selected. (Refer to “Figure 4-1 Menu of [Workspace] and Dropdown-menu of the 
Workspace”) When you edit another workspace, please exit RT ToolBox3 once and start RT ToolBox3 
specifying another workspace from iQ Works (MELSOFT Navigator).  

 
 
Notes 2-3： It is not possible to save as another name when the workspace is edited. 

 
The editing workspace cannot be saved as another name when RT ToolBox3 is started from iQ Works 

(MELSOFT Navigator). [Save As] in [Workspace] menu is displayed in the gray and cannot be selected.  
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Figure 4-1 Menu of [Workspace] and Dropdown-menu of the Workspace 

 
4.3. Notes concerning Project operation 

Notes 3-1： It is not possible to delete, or and import a project. 
 

When RT ToolBox3 is started from iQ Works (MELSOFT Navigator), it is not possible to add a new project, 
import a project, or delete an existing project. [Add project] and [Import project] (in the dropdown menu by 
selecting a workspace name) and [Delete project] (in the dropdown menu by selecting a project name) are 
display in the gray and cannot be selected.  

 
Figure 4-2 Menu of [Workspace] and Dropdown-menu of the Workspace 

 
 
Notes 3-2： It is not possible to change a project name. 

 
When RT ToolBox3 is started from iQ Works (MELSOFT Navigator), it is not possible to change the project 

in the editing workspace. "Project name" in "Edit project" screen is displayed in the gray, and cannot be 
selected. 

Dropdown-menu of the 
Workspace 

(Online) 

Menu of [Workspace] 

Dropdown-menu of Project 

Dropdown-menu of  
the Workspace 

(Online) 

Menu of [Workspace] 
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Figure 4-3 Edit project 

 
 
4.4. Notes to edit the workspace created by iQ Works(MELSOFT Navigator)  

Notes 4-1： Do not change the composition of the workspace created by iQ Works 
(MELSOFT Navigator). 

 
The composition (changing a workspace name, changing a title, adding a project, deleting a project or 

changing a project name) of the workspace made with iQ Works (MELSOFT Navigator) cannot be changed 
with RT ToolBox3 started from iQ Works (MELSOFT Navigator). These information can be edited with RT 
ToolBox3 started directly by the start menu etc. However, it becomes impossible to take the correspondence 
in iQ Works (MELSOFT Navigator) when these information is changed. Please do not change the 
composition (changing a workspace name, changing a title, adding a project, deleting a project or changing a 
project name) of workspace when editing them with RT ToolBox3 started directly.  

 
Prohibited matter in RT ToolBox3 started directly 

Workspace ・ Change the workspace name. 
・ Change the title. 

Project ・ Add a project 
・ Import a project 
・ Delete a project 
・ Change the project name 

 
The workspace name made with iQ Works (MELSOFT Navigator) is set as follows. Please note the 

handling of this workspace. 
 

Workspace name RT Workspace This is fixation. 
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5.  Basic Functions 
 
The basic functions of this software are shown below.  
 

Table 5-1 RT ToolBox3 Basic Functions 
 

Function Explanation 
Offline Targets files on the computer. 
 Robot model Displays the model of the robot used. 

Program Displays the names of the robot programs written on the computer. 
SQ Direct Displays the SQ Direct files written on the computer. 
Spline Displays the numbers of the spline files written on the computer. 
Parameter It is possible to set the parameters offline and save them to the files. 

The saved files can be sent to the robot controllers. 
Online These are used with the robot controller connected. 
 Robot model Displays the model of the robot connected to the robot controller. 

Program Displays the names of the programs stored on the robot controller. 
SQ Direct It is possible to edit SQ Direct variables in the robot controllers. 
Spline Displays the numbers of the spline files stored on the robot controller. 
Parameters It is possible to set the parameters and save them to the file without 

connecting the robot controller. 
The saved parameter file can be forwarded to the robot controller. 

 Parameter list The parameters can be set individually. 
 Parameter 

settings by 
function 
 

The parameters can be set individually per robot function. 
The functions are as follows. 
・ Operating range 
・ Jog 
・ Hand  
・ Weight and size 
・ Tool 
・ Slot table 
・ Output signal reset pattern 
・ Dedicated input/output signal 

allocation 
・ RS-232 settings 
・ User-defined area 
・ Free plane limit 
・ Evacuation point 
・ Robot language 
・ Added axes 
・ Collision detection 
・ Heater operation 

・ Operation parameters 
・ Program parameters 
・ User error 
・ RS-232 setting 
・ Ethernet setting 
・ CC-Link setting 
・ CC-Link IE Field setting 
・ CC-Link IE Field Basic setting 
・ PROFIBUS setting 
・ PROFINET setting 
・ DeviceNet setting 
・ Ethernet IP setting 
・ EtherCAT setting 
・ IO unit 
・ Work coordinate 
・ Force control 
・ Collision avoidance 
・ Safety 

Monitors 
 Operation 

monitor 
You can reference the slot status, program, monitor, program external 
variables, operation status, history of operation events, and current errors. 

Signal monitor You can check the statuses of signals input to the robot and signals output 
from the robot. 

Work monitor You can check the robot work time and production information for each 
robot program. 

Servo monitor Monitors servo system information. 
Maintenance 
 Home position 

data 
This sets the robot home position. 

Initialization This sets the robot controller's internal time, deletes all the programs in the 
controller, initializes the remaining battery time, and sets the serial number 
for the connected robot. 

Maintenance 
forecast 

Forecasts the time for maintenance. 
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Function Explanation 
Position repair Supports recovery from home position deviation 
Password Setup Registers, changes, or deletes the password to limit controller access 

rights. 
Option card You can check information on option cards mounted in the robot controller. 

Tool 
 Oscillograph The various robot controller data are displayed in a graph. 

DXF File Import Imports DXF files for conversion into robot program / spline files. 
User definition screen It is possible to edit the user definition screen which can be operated by 

the high-functionality T/B. 
File Manager You can copy, delete and rename the files in the robot controller. 
2D Vision Calibration Run the 2D vision calibration. 
Force sensor 
calibration 

This Function calculates the weight and center of gravity position of robot 
hand attached to the force sensor to be used for the gravity offset cancel in 
Force sensor. 

Force control log 
viewer 

This function can display force control log data graph in the PC and robot 
controllers. 

Tool automatic 
calculation 

The tool length is calculated automatically and the value of a tool 
parameter is set up.  

Simulation This can be used in connection with a virtual robot. 
*This can only be used in the standard edition. 

 Same functions as 
online 

The same functions can be used with a virtual robot controller as with an 
online one. 

Tact time calculation The tact time for the robot program with the specified contents can be 
calculated in the simulation. 

MELFA-Works You can be used the function of MELFA-Works (as 3D robot simulator). 
*This can only be used with the Pro edition. 

Backup, restore You can back up the information in the robot controller and restore 
backed-up information to the controller. 

MELFA 3D-Vision You can do a setup of MELFA-3D Vision. 
I/O Simulator Simulates the signal communication between robots. 
Document out You can output the each information in robot controller and offline setting 

to the HTML document. 
Robot firmware update You can update the firmware of the robot controller. 

Since this function is a function for maintenance, not open to the public. 
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6. Ribbon  
 
The ribbon is displayed at the top of the RT ToolBox3 screen. 
The various operations of RT ToolBox3 can be performed by selecting the commands provided on the ribbon. 
 

 
Figure 6-1 RT ToolBox3 Ribbon 

 
 
6.1. Selecting the Tab  
The ribbon is divided into tabs which each correspond to a specific command. Clicking the desired tab displays a list 
of commands registered to that tab. 
The following tabs are provided on the ribbon. 
 

Table 6-1 Operations Available on Each Tab on the Ribbon 
Tab Name Description 

Workspace This differs from other tabs in that a drop-down menu appears when it is clicked. 
Various operations can be performed by selecting the desired item from the drop-down 
menu. 

Home Editing operations can be performed on workspaces and projects and the RT ToolBox3 
mode can be changed. 
When a screen that supports printing functions is active, the print command can be 
used. 

Online The RT ToolBox3 mode can be changed, and operation commands in the online and 
simulator modes are available. 

View RT ToolBox3 view related settings can be performed. 
Settings for displaying docking windows such as the project tree and window layout 
commands for the currently displayed screen are available. 
Select this tab also when changing the RT ToolBox3 display language. 

3D View Commands for performing settings and operations relating to 3D monitor functions are 
available. 
For an explanation of 3D monitor functions, refer to "22 3D Monitor". 

File This is used for file reading, saving and performing other operations in program editing 
and in the spline editing functions. 
This tab is displayed only when the screen for a related function is active. 

Edit Operation commands for editing file contents are available in program editing and in the 
spline editing functions. 
This tab is displayed only when the screen for a related function is active. 

Tool Commands for displaying simple tool screens used in program editing and in the spline 
editing functions are available. 
This tab is displayed only when the screen for a related function is active. 

Parameter This tab is displayed only when the parameter list screen given in "14.1 Editing from 
parameter list" is active. 
Commands for searching the text strings of parameter names in the parameter list 
screen are available. 

Monitor This tab is displayed only when the one of the monitor screens given in "15 Status 
Monitoring" is active. 
Commands for selecting monitoring "Start/Stop" are available. 

Oscillograph This tab is displayed only when the oscillograph screen given in “19.1 Oscillograph” is 
active. 
Commands for operations such as recording and data playback are available. 

MELFA-Works Only when the screen related to the MELFA-Works is in the active state, this tab is 
displayed. 
In this tab, there are the commands for using each function for the MELFA-Works are 
prepared. 
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Help Commands for displaying language help for robot programs and the RT ToolBox3 
Instruction Manual are available. 

 



 

6-60  6-60 

 
6.2. Tool Tip Display of Ribbon Commands  
An explanation for a command is displayed by moving the cursor over the command on the ribbon. 
 

 
Figure 6-2 Tool Tip Display of Ribbon Commands 

 
 
6.3. Minimizing the Ribbon 
Minimizing refers to collapsing the command display area of the ribbon so that only the tab name is displayed. By 
minimizing the ribbon, the area for displaying the editing screen, for example, can be increased. 
Even with the ribbon minimized, ribbon commands can be operated by clicking the tab. 
 

 
Figure 6-3 Ribbon in Minimized State 

 
The ribbon can be minimized by either of the following operations: 
・Select and check "Minimize the Ribbon" from the menu that is displayed by clicking ▼ at the ribbon top. 
・Double-click one of the tabs. 
 
To return a minimized ribbon to its original size, perform either of the following operations: 
・Select and uncheck "Minimize the Ribbon" from the menu that is displayed by clicking ▼ at the ribbon top. 
・Double-click one of the tabs. 
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7. Docking Window  
Some of the windows displayed in RT ToolBox3 can be turned into a docking window and their display position can 
be customized as desired. The docking window can be placed at any position to the left, right, top or bottom of the 
main screen. 
In the RT ToolBox3 default state, each of the docking windows is placed at any of the left, right, top or bottom 
positions. 
 
 
7.1. Moving and Placing Docking Windows 
A docking window becomes separated from the main screen by dragging the title area of the docking window. 
Docking windows in a separated state can be moved as desired inside and outside RT ToolBox3. 
Docking windows can also be used as they are in a separated state. 

 

 
Figure 7-1 Docking Window in Separated State 

 
While a separated docking window is being dragged and moved, marks with left, right, top or bottom arrows are 
displayed in the main screen. 
 

 
Figure 7-2 State During Movement of a Docking Window 
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The docking window is docked to the position indicated by the arrow by dropping the window over one of the marks. 
 

 
Figure 7-3 When a Docking Window Is Docked to the Bottom of the Main Screen 
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7.2. Aligning Side-by-side and Overlaying Docking Windows 
When a window is moved to a position where another window is already docked, the left, right, top or bottom arrow 
marks appear on the already docked window. 
 

 
Figure 7-4 When a Window Is Moved Over a Docked Window 

 
The docking window can be docked with it aligned side-by-side with the left, right, top or bottom of the docked 
window by dropping the window over one of the marks in this state. 
 

 
Figure 7-5 When a Window Is Aligned With the Left Side of the Docked Window 

 

Also, the window can be placed overlaying a docked window when it is dropped on top of the  mark. 
When multiple windows are displayed overlaying each other, the currently displayed window contents can be 
switched by changing the selected tab. The currently selected window can be detached and moved by clicking and 
dragging the title area of the window. 
 

 
Figure 7-6 When Docking Windows Are Overlaid 
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7.3. Minimizing Docking Windows 

A docking window can be collapsed (minimized) by clicking the pin  displayed at the top right of the respective 
docking window. By minimizing a docking window, the area for displaying the editing screen, for example, can be 
increased. 
 
When a docking window is minimized, only the window name is displayed at the docking position. Window contents 
can be temporarily displayed by moving the mouse cursor to the position of the window name in this state. A 
minimized docking window is displayed by a side-facing pin . 
 

 
Figure 7-7 Minimizing Docking Windows 

 
To return a minimized docking window to its original size, click the side-facing pin . 
 
 
7.4. Resetting a Docking Window to Its Default Layout 
A docking window can be reset to its default layout by clicking the [Reset the window layout.] button in the [View] tab 
-> [View] group on the ribbon. 
 

 
Figure 7-8 Resetting the Layout of a Docking Window 

 

Not minimized Minimized Minimize 
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7.5. Screen Layout Mode of the Docking Window 
In the [Screen Layout Mode] on [Option] on the [General] screen, you can set whether to keep the layout of the 
docking window for each workspace or always open it in the same layout. 
Since the initial value is "Workspace", you need to select "Account" to always open in the same layout. 
Option screen is displayed by clicking the [Option] button in the [Workspace] drop-down menu on the ribbon 
 

 
Figure 7-9 Setting of Screen Layout Mode 
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8. Workspaces and Projects 
 
This describes workspaces and projects.  
 
 
8.1. Workspaces and Projects 
This software has workspaces and projects.  
The information for one controller is managed as one project. A workspace can manage up to 32 projects. If 
Ethernet is used for communication, you can simultaneously reference information on multiple projects (robot 
controllers) registered in the workspace.  
When using multiple robot controllers, it is convenient to manage with separate workspaces for each manufacturing 
line and installation location.  
 
(1) Using multiple robot controllers (up to 32) 
 

 
Figure 8-1 Using Multiple Robot Controllers 

 
(2) Using 1 robot controller 

 
Figure 8-2 Using One Robot Controller 

 

Workspace 

Project 
1 

Communication 

RT ToolBox3 

Workspace 

Project 
1 ・・・ 

Project 
2 

Project 
32 

RT ToolBox3 

... 

You can connect multiple 
controllers at the same time. Communication 

 
Communication 

 
Communication 

 

You can reference 
the information for 
multiple controllers 
at the same time. 
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Workspace editing and storage and project addition etc., are explained from the next section onward. 
 

 
 

Update workspaces and projects offline.  
 

You cannot perform the following operations in the online status or while a simulation is running. 
Switch offline, then perform the operations.  
・ Opening an existing workspace 
・ Saving the workspace with a different name 
・ Adding a project 
・ Changing a project name 
・ Deleting a project 

 
For details on switching offline, see "8.18 Offline/Online/Simulation". 

Caution 

You cannot edit multiple workspaces at the same time.  
With this software, you cannot edit multiple workspaces at the same time. Register to a single 
workspace all the projects (controllers) you want to reference at the same time.  
 

Simultaneous connection with 32 units 
The maximum of 32 robot connections is a theoretical value.  It does not guarantee that if you 
actually connect 32 robots, you will achieve the same performance as when only 1 robot is 
connected. For example, if you monitor all the robots when 32 are connected, status updating is 
slower than for when 1 robot is connected.  

Caution 
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8.2. Creating a New Workspace 
Click the [Workspace] tab -> [New] button or click the [Home] tab -> [Workspace] group -> [New] button on the 
ribbon. The New Workspace screen is displayed. Input the workspace name and title, and then click the [OK] button. 
The Edit Project screen is displayed, so set the project name (as desired), the communication method, and the robot 
model for offline (both are the information of the robot that you want to connect.), then click the [OK] button.  
You can change the robot model of 3D monitor to a simple model. Please refer to "22.13 Types of Robot Model" 
for the content of the simple model. 

 
Figure 8-3 Creating a New Workspace 

 
The project tree is displayed in the workspace and the "RC1" project is created as the default value.  
This project name can be changed later. For details, see "8.12 Editing Projects". 
If you want to display a simple model for the robot model in the 3D monitor, check the checkbox of the same label. 

 
 

Workspace names 
 

Workspace names are used as folder names in Windows, so you cannot use characters that 
cannot be used in Windows folder names (\ /: *? “ < > | ).  

Caution 
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8.3. Opening an Existing Workspace 
To open an already created workspace, click the [Home] tab -> [Workspace] group -> [Open] button on the ribbon. 

Select the workspace to edit and click the [OK] button. 
 

 
Figure 8-4 Opening a Workspace 

 
The name of the last used workspace is added to the [Workspace] tab on the ribbon. You can open one of these 

workspaces by clicking its name here. 

 
Figure 8-5 Recently Used Workspace Names 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The recently used workspaces are 
added. 
When you click one of these 
workspace names, the workspace is 
opened. 
When the mouse cursor is placed 
over the workspace name, the path 
of the folder containing the 
workspace is displayed. 

When you click the [Remove Recent] 
button, all workspace names 
displayed in "Recent workspace" are 
deleted. 
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8.4. Open the RT ToolBox2 Workspace 
As with the “8.3Opening an Existing Workspace”,you can open the workspace of RT ToolBox2. 
When RT ToolBox 2 workspace is opened with RT Toolbox 3, a dialog is displayed to confirm whether to use RT 
Toolbox 2 parameters for the first time only. 
Check the parameters to be used in RT Toolbox 3 and click the [OK] button. 
 
RT ToolBox3 displays the following RT ToolBox2 parameter information. 
 Simulator parameters ⇒ Offline parameters 
 Offline parameters ⇒ Backup parameter information 
 

 
Figure 8-6 Open the RT ToolBox2 Workspace 

 

 
 
 
8.5. Closing a Workspace 
To close a workspace currently being edited, click the [Home] tab -> [Workspace] group -> [Close] button on the 
ribbon. Note that to delete a workspace, you must close it first.  
 

[Open the RT ToolBox2 Workspace] is displayed only once 
 

Displayed only when RT ToolBox2's workspace is opened for the first time in RT ToolBox3. The 
unchecked parameter information in the checkbox will not be available in RT ToolBox3. 

Caution 
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8.6. Deleting a Workspace 
Click the [Home] tab -> [Workspace] group -> [Delete] button on the ribbon. The "Delete Workspace" screen is 

displayed. Check the name of the workspace to delete, and then click the [OK] button.  
 

 
Figure 8-7 Deleting a Workspace 

 

 
 
 
8.7. Saving a Workspace 
The information added to the workspace is saved automatically.  

 
You can also save a workspace under a different name. Click the [Home] tab -> [Workspace] group ->  

[Save As] button on the ribbon, enter the new workspace name and title, and then click the [OK] button. 
 

 
Figure 8-8 Save As 

Deleting a workspace 
 

When deleting a workspace, close that workspace. You can not delete a workspace that is being 
edited.  

Caution 



 

8-72  8-72 

 
8.8. Changing a Workspace 
Workspace names and workspace titles can be changed directly. 

 
 

Click the name of the workspace with the right button on the mouse, then click "Edit workspace" on the right 
button menu. The “Change Workspace” screen is displayed. Input the new workspace name and new workspace 
title, then click the [OK] button. 

 
 Figure 8-9 Changing the name of the workspace and workspace title 

 
To change the workspace title, click the name of the workspace with the right mouse button, then click "Edit 

workspace title" on the right button menu. The workspace title screen is displayed. Input the new workspace title, 
and then click the [OK] button. 

 

Don’t change workspace names and workspace titles  
made with iQ Works (MELSOFT Navigator).  

 

Don’t change workspace names and workspace titles made with iQ Works (MELSOFT Navigator). 
Changing the structural informationof a workspace will break its conformance with iQ Works (MELSOFT 
Navigator). 

Caution 
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8.9. Adding a Project 
You can create up to 32 projects in one workspace. 
Click the [Home] tab -> [Project] group -> [Add] button on the ribbon. 
 

 
Figure 8-10 Adding a Project 

 
A screen in Wizard format for setting protect details is displayed. 
Set the project name, information of the robot to connect to and communication method in each of the pages of the 
Add Project screen, and then click the [Finish] button. 
The project is added to the workspace. 
 
Projects can also be added from a project tree. 
After selecting the workspace, use the right mouse button to select [Add project], or double-click the workspace 
name on the project tree. 
 

 
Figure 8-11 Adding a Project from a Project Tree 

 

 

Adding a new project offline.  
 

It is possible to add a new project offline. A new project cannot be added, when the status of either of 
project is "Online" or "Simulation". 

 
Don’t add a project to a workspace made with iQ Works (MELSOFT Navigator). 

Don’t add a project to a workspace made with iQ Works (MELSOFT Navigator). Changing the structural 
information of a workspace will break its conformance with iQ Works (MELSOFT Navigator). 

Caution 
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The following describes the details that are set in each of the pages of the Add Project screen. 
 
8.9.1. Step 1. Outline 

Set the project name. Any optional comments can be set to projects. 
 

 
Figure 8-12 Add Project Screen (Step 1. Outline) 

 
 
8.9.2. Step 2. Robot model 

Select the robot model and series of robot controller to be used in the project. 
You can narrow down candidate models by selecting "Type" and "Maximum load". 
 

 
Figure 8-13 Add Project Screen (Step 2. Robot model) 
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8.9.3. Step 3. Communication 

Set up communication with the robot controller to connect to the robot. 
The network setup set on the personal computer can be copied to this screen by clicking the [Copy This PC Setting] 
button. 
For details on how to set the communication method, refer to "9.2 Connection Settings". 
 

 
Figure 8-14 Add Project Screen (Step 3. Communication) 

 
 
8.9.4. Step 4. Language 

Select the program language that is used for programming the robot program. For details, refer to "10 Robot 
Programming Language Setting". 
Also, at "Regional language", set the language in which comment text in the robot program and messages set by the 
user errors are handled. As the default setting, it is set so as to match "Language of the OS". 
 

 
Figure 8-15 Add Project Screen (Step 4. Language) 
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8.9.5. Step 5. Travel axis 

Set the travel base to be displayed in the 3D monitor. For details, refer to "9.2.6 Travel base setting for display". 
 

 
Figure 8-16 Add Project Screen (Step 5. Travel axis) 

 
8.9.6. Step 6. Robot Additional Axis 

Sets how to use the additional axis. For details, refer to "14.3.9 Robot additional axis parameter". 
 

 
Figure 8-17 Add Project Screen (Step 6. Robot Additional Axis) 
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8.9.7. Step 7. Tool 

Set the parameters of the tool of Robot 1. For details, refer to "14.3.5 Tool parameter". 
 

 
Figure 8-18 Add Project Screen (Step 7. Tool) 

 
8.9.8. Step 8. Weight and Size 

Set the parameters of the “Work” and “Hand and Weight” of Robot 1. For details, refer to "14.3.4 Weight and size 
parameters". 
 

 
Figure 8-19 Add Project Screen (Step 8. Weight and Size) 

 
The setting information here is registered in the offline parameter. 
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8.10. Transfer offline parameters to robot controller 
The information setting on edit project screen is registered in the offline parameter. The offline parameters can be 
transferred to the robot controller by the following two methods. 
 
Method(1) 
1) Back up the project in offline mode. 
2) After changing the online mode, restore the backed up project. 
3) Select the parameters on the restore screen and execute the restore. 
 

 
Figure 8-20 Parameter transfer procedure 

 
Method(2) 
1) Move to online mode, select the offline parameter item of the project and click the right mouse button. Select 

and click [Write to controller] in the displayed context menu. 
2) After the parameter selection screen is activated, select the parameters to be transferred and click the [OK] 

button. 
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Figure 8-21 Parameter transfer procedure 
 

1 

2 

2 



 

8-80  8-80 

 
8.11. Change of the operation mode after adding the project 
After completed adding the project, a message of confirm about change the operation mode is displayed. 
By click the [Online] button or [Simulation] button, you can change the operation mode in the RT ToolBox3. 
If you don't want to change the operation mode, please click the [Cancel] button. 
 

 
Figure 8-22 message of confirm about change the operation mode 

 
If you don't want to display the message, you can set in the option screen below. To display the option screen, you 
will select the [Option] in [Workspace] tab from the ribbon. 
When [General] category -> [Project Editing] -> [Switch the Operation Mode] is unchecked, the message of confirm 
will not be displayed after adding projects. 
 

 
Figure 8-23 Display setting about the confirm change of operation mode 
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8.12. Editing Projects  
You can edit the details of a project once it has been created. 
Click the project name with the mouse right button, and click [Edit Project] in the right button menu. The Edit Project 
screen in the same screen configuration as the Add Project screen is displayed. In this screen, edit the project 
settings, and then click the [Finish] button. 

 

 
Figure 8-24 Editing Projects 

 

 
 

Don’t change a project name in a workspace  
made with iQ Works (MELSOFT Navigator). 

Don’t change a project name in a workspace made with iQ Works (MELSOFT Navigator). Changing the 
structural information of a workspace will break its conformance with iQ Works (MELSOFT Navigator). 

Caution 
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8.13. Deleting a Project 
A project cannot be deleted when it is running a simulation or has a robot connected online. 
Click on the project you want to delete and press the Ctrl key while in batch delete and select it. 
Click "Delete Project" on the right button menu.  
The deletion confirmation message is displayed. Check that you have clicked the correct project name, then click 
the [OK] button. 
 

  
Figure 8-25 Deleting a Project 

 

 
 

Don’t delete a project in a workspace  
made with iQ Works (MELSOFT Navigator). 

Don’t delete a project in a workspace made with iQ Works (MELSOFT Navigator). Changing the 
structural information of a workspace will break its conformance with iQ Works (MELSOFT Navigator). 

Caution 
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8.14. Contents of Project Tree 
A project tree shows the current workspace's project configuration in a hierarchical manner.  
 
You can start all functions from the project tree, including program editing, monitoring, etc. 
The contents of the project tree depend on the state of connection with the robot controller.  

 
Figure 8-26 Structure of Project Tree in Workspace 

  
(1) Offline/Simulation 

Displays the information stored in computer. In the simulation mode, "Simulation" is displayed. 
The name of the currently set robot model, name of the robot program/SQ direct file/spline file, and parameter 
items that can be referenced are displayed. 

 
(2) Online 

The "Online" area is displayed when the online mode is switched to after connecting to the controller. 
The name of the currently connected robot model and information items that can be referenced in the controller 
are displayed. 

 
(3) Backup 

Controls the information backed up from the controller.  
 
(4) Tool 

Other functions are displayed. 
 

Items are displayed for 
each project. (1) Offline 

(3) Backup 

(2) Online 
Project 1 
 <Project name: RC1> 
Connected with the controller. 

Project 2 
 <Project name: RC2> 
Not connected with the controller. 

(4) Tool 
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8.15. Copying Programs Between Projects  
Use program management to copy or move a created robot program to another project. For details on the operation 
method, see "11.13 Program Management", "11.13.2 Copy", or "11.13.3 Move". 
 
It is possible to copy by drag and drop the project name in the project tree. 
Please refer to "11.13 Program Management" in this manual for details. 
 
 

It is possible to change the display order  
 of the projects in the tree.  

It is possible to change the display order of the projects in the tree. 
Drag the project with the mouse, and drop it at the transportation destination. The project will 
move to the top of the dropped project.  
 

                      

Memo 

Drag and drop 
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8.16. Importing projects 
It is possible to import projects in other workspaces to the current workspace. 
The project can be imported only offline. Please operate after changing to offline when current mode is online or 
simulation. 

 
 
Select the [Home] tab -> [Project] group -> [Import] button on the ribbon. After the "Select Workspace" window is 
displayed, select the workspace including the project that you want to import, and click [OK] button. The list of the 
projects in the selected workspace is displayed in the "Select the projects" window. Check the project, and click the 
[OK] button.  

 
 

Figure 8-27 Import of project 
 
Up to 32 projects can be registered to one workspace. 

Don’t import a project to a workspace  
made with iQ Works (MELSOFT Navigator). 

Don’t import a project to a workspace made with iQ Works (MELSOFT Navigator). Changing the 
structural information of a workspace will break its conformance with iQ Works (MELSOFT Navigator). 

Caution 

Check the 
project. 
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8.17. Option Setting 
RT ToolBox 3 has options that allow you to customize the type of operation panel and the background color of 
program editing, etc. The options that can be set are as follows. 
 

Table 8-1 What you can set with options 
Category Option Item Contents Reference 

General Project Editing Sets whether to display the operation mode 
switching confirmation message after project 
edit. 

8.11 

Screen Layout Sets the position memory mode of each 
docking window. 7.5 

Operation Panel Operation Panel Set the type of the operation panel. 20.3.1 
20.4.2 

3D Monitor Object Sets how to move the object using the 
mouse. 22.3.6 

3D monitor display 
method 

Set whether or not to always display the 3D 
monitor on the front. 22.2 

Program 
Editing 

Display Display Option Make settings related to display, such as 
whether to display input candidates. 

11.6.1 
11.6.2 
11.6.3 
11.6.4 
11.6.5 
11.6.6 
11.6.7 
11.6.8 

Fonts and 
Colors 

Design Option Set font color and font. 11.6.10 

Background 
Color 

Each robot language Set the background color for each program 
language. 11.6.11 

General Syntax Check Before 
Save 

Set whether to check syntax and display 
results. 11.6.12 

Get Current Position Whether to acquire the current position of the 
robot automatically or not. 11.6.13 

Save and Load of the 
Program 

Sets the status of the check box when saving 
/ loading the program. 11.6.14 

 
Clicking the [Option] button in the [Workspace] tab on the ribbon, the option screen is displayed. When you click on 
an option item, the explanation of that item is displayed at the bottom of the screen. 

 
Figure 8-28 Item Description Screen 

 

Click 

A description of the item you clicked is displayed. 
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8.18. Offline/Online/Simulation 
The project statuses are offline, online, and simulation. The meaning of each status and the contents displayed in 
the project tree are shown below.  
 

Table 8-2 RT ToolBox3 Status 
Status Explanation Project tree display 

Offline Targets files stored on the computer. 
In the offline mode, the icon displayed at left of the project 
name in the project tree is green, and Offline, Backup and 
Tool are displayed in the project tree. 

 
Online The robot is connected to the robot controller and you can 

check and change the information in the controller  
In the online mode, the icon displayed at left of the project 
name in the project tree is blue, and Online, Offline, 
Backup and Tool are displayed in the project tree.  

Simulation 
* This is available 
on the standard 
and Pro editions. 

This targets a virtual robot controller running on the 
computer and you can check and change the information 
in the virtual controller  
In the simulation mode, the icon displayed at left of the 
project name in the project tree is blue, and Offline (*1), 
Simulation, Backup and Tool are displayed in the project 
tree. 

 

Pseudo input Signals is input from the personal computer to the robot 
controller, not from external equipment. During pseudo 
input mode, the robot controller does not accept signal 
input from external equipment. 
Please refer to “15.3.1.2Pseudo-input”.  

 
(*1)  This is displayed only when the virtual robot controller of the CR800-R/CR800-Q/CR750-Q/CRnQ-700 

series is displayed. With the above series, offline SQ direct files can be edited even during a simulation. 
 
When this software starts, it goes to "Offline" status.  
You can change a workspace or a project only in the "Offline" status.  
 

 
 
You can switch between the offline, online and simulation modes by either the icons on the title bar or by the "Home" 
or "Online" tabs on the ribbon. With the tool bar, you can switch as follows. 

 

 
Figure 8-29 Explanation of Tool Bar

Switch to "Offline". 
 
Switch to "Online". 
 
Switch to "Simulation". 

Simulation functions are supported only on the RT ToolBox3 standard and pro editions. It cannot be 
used in the mini edition.  
Also, note that simulation functions cannot be used when Movemaster commands are selected on the 
standard or pro editions. 

Caution 
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The current status and the statuses into which the current status can be switched are as follows:  
 

Table 8-3 Current Status and Switchable Status 
Current status Switchable statuses Title Bar Display Ribbon [Home] Tab Display 
Offline Can be switched to online or 

simulation. 
 

 
Online Can only be switched to 

offline. 
 

 
Simulation Can only be switched to 

offline. 
 

 
 
Display the current status by checking [Online] in the menu bar.  
 
When switching to online or simulation, if multiple projects are registered in the workspace being edited, the project 
selection screen is displayed as in "Figure 8-30 Screen for Selecting Project to Switch Online". Check only the 
project to be switched to online or simulation, then click [OK]. Note, however, that up to eight projects can be 
switched to the simulation mode. 
This screen is not displayed if the online mode is switched to when there is just one project in the workspace. 
 

 
Figure 8-30 Screen for Selecting Project to Switch Online  

 

In the project unconnected the robot controller, please do not switch 
to online.  

 

If you switch to online in the project unconnected the robot controller, the execution speed 
decreases because the retry process is performed frequently. In the project unconnected the robot 
controller (or power is not turned on at the controller), please switch to offline. 
 

Do not connect from many of projects to one robot controller.  
 

Do not connect from many of projects to one robot controller. When many projects referring to the 
same data at the same time, some data may not be read correctly. 
 

Do not connect with USB from one personal computer to many robot 
controllers.  

 

In USB connection, can only connect from one personal computer to one robot controller. Even if 
you use a USB hub, can not connect to many robot controllers.  

 

Caution 
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9. Connecting to the Robot 
This explains the method for connecting the robot controller and the computer. 
With this software, you must make the communication settings for each project. 

 
 
 

9.1. Robots Connected and Types of Communication 
Connecting the robot controller and computer can be done by the following methods. Be aware that the available 
connection method is restricted according to the connected robot controller.  
 

Table 9-1 Robot Controllers That Can Be Connected and Types of Communication 
Robot Controller Communication Type Remarks 

CR800-D/CR750-D/ 
CRnD-700 series 

 
(The photo is the robot 
 controller for CR800-D.) 

USB (*4) 

Commercial items such as computers and cables 
might be incompatible with our equipment or 
unsuitable for the FA environment such as 
temperature, noise, etc. 
When using, please fully confirm operation as 
measures against noise such as EMI measure or 
addition of ferrite core may be needed. 

Ethernet(TCP/IP) (*1)  
RS-232 CRnD-700 only 

GOT communications 

Connect via a CR800-D/CR750-D/CRnD-700 
series controller connected with the GOT via 
Ethernet by USB / RS-232. 
A GOT 1000 series and the Ethernet 
communication unit (GT15-J1E71-100) are needed. 

CR800-R/CR800-Q/ 
CR750-Q/CRnQ-700 
series 

 
(Pictured is a CR800-R 
robot controller.) 

CRnQ_
R 
commu
nication 
(*2) 

USB (*4)  

Ethernet 
(TCP/IP) 

The PLC RCPU, Ethernet interface module or 
Built-in Ethernet port QCPU is required. 

RS-232  

Ethernet(TCP/IP) Only can be used for CR800-R/CR800-Q 

CRn-500 series 

 

Ethernet(TCP/IP) (*3) The robot controller must have an "Ethernet 
interface" option. 

RS-232  

(*1)  For details on the communication settings on the robot controller side for CR800-D/CR750-D/CRnD-700 series 
controllers, see "Detailed explanations of functions and operations" and "Standard Specifications" in the user's 
manual for the robot controller. 

Do not pull out the cable during communication.  
 

Please never pull out the cable during communication with the robot controller. If the 
communication cable is removed during communication, the status of the robot controller or the 
computer might become abnormal. Please remove the cable when the status is not “Online” or this 
software has been exited.  

 

Also when communicating by USB, do not pull out the USB cable until 
communication is completed. 

Caution 
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(*2)  For details on the communication settings on the robot controller side for CR800-R/CR800-Q/CR750-Q/CRnQ-700 
series controllers, see "Detailed explanations of functions and operations" and "Standard Specifications" in the 
user's manual for the robot controller. 
Moreover, use the “GX Developer” to set the PLC communication settings. 

(*3)  For details on the Ethernet connections on the robot controller side for CRn-500 series controllers, see the "Ethernet 
Interface Option User's Manual". 

(*4)  When using a USB connection, 1 computer can connect to only 1 robot controller. 
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9.2. Connection Settings 
Click the name of the project to display the project tree for with the right button of the mouse, then from the right 
button menu, click [Edit Project]. The project edit screen is displayed. Set connection settings in the "Step 3. 
Communication" page of the Edit Project screen. 
 

 
Figure 9-1 Connection Settings 

 
Select the communication method, and set the details for each communication method in the [Communication] field. 
After setting the details, click the [Finish] button. 
 
The content of the detailed settings for each communication method is explained from the following section 
onwards. 
 

 
 

Do not connect from multiple projects to 1 controller at the same 
time. 

 

Do not connect from multiple projects to 1 controller at the same time. 
The same data may be referred to, and the data not read correctly. 
 

Do not connect USB to multiple controllers from 1 computer. 
 

When using USB connection, 1 computer can connect to only 1 robot controller. It is also not 
possible to connect to multiple controllers using the USB hub. 

Caution 
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9.2.1. USB Communication Settings 

 
Figure 9-2 USB Communication Settings  

 
Table 9-2 USB Communication Setting Items and Default values 

Item Explanation Default value 
Send timeout Timeout time for sending 

Settable range 
 Minimum value :  1000 msec 
 Maximum value : 30000 msec 

5000 msec 

Receive timeout Timeout time for receiving 
Settable range 
 Minimum value :  5000 msec 
 Maximum value :120000 msec 

5000 msec 

Retries Number of communication retries 
Settable range 
 Minimum value :  0 
 Maximum value : 10 

3 

 
When the USB cable is connected to the computer, the screen for installing the USB driver may be displayed. 
For details on USB driver installation, see "1.5.3 USB driver (CR800-D/CR750-D/CRnD-700 series robot 
controller) installation ". 
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9.2.2. TCP/IP (Ethernet) Communication Settings 

Input the IP address assigned to the robot controller connected to, then click the [OK] button. 
 

 
Figure 9-3 TCP/IP Communication Settings 

 
Table 9-3 TCP/IP Communication Setting Items and Default Values 

Item Explanation Default value 
IP address Sets the IP address of the connected robot controller. Blank 
Port used Number of the port used for communication 10001 
Send timeout Timeout time for sending 

Settable range 
 Minimum value :  1000 msec 
 Maximum value : 30000 msec 

5000 msec 

Receive timeout Timeout time for receiving 
Settable range 
 Minimum value :  5000 msec 
 Maximum value :120000 msec 

30000 msec 

Retries Number of communication retries 
Settable range 
 Minimum value :  0 
 Maximum value : 10 

0 

 
Ask the network administrator for help with the computer side network settings (IP address, subnet mask, default 
gateway, etc.). 
Moreover, for details on the communication settings on the robot controller side, please refer as follow. 

CR800/CR750/700 : See "Detailed explanations of functions and operations" and "Standard 
Specifications" in the user's manual for the robot controller. 

CRn-500  : See "Ethernet Interface Option User's Manual". 
 

 
 

When connecting to 10 or more robot controllers at the same time. 
 

When connecting to 10 or more robot controllers at the same time, set the reception timeout 
time to at least 10000 msec as the connection processing takes time. 

Caution 
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When the following screen is displayed when connecting by 
Ethernet. 
 

When the following screen is displayed when connecting by Ethernet, click the [Allow access] 
button by checking all the checkboxes in the screen. 

 

 

Caution 

Cautions when connecting to a CRn-500 robot controller by 
Ethernet 
 

In the program edit function, change “Receive timeout” and “Retries” in the TCP/IP 
communication settings when all of the following use conditions apply, and the program is written 
to the robot controller. 

 

<< Use conditions >> 
1. Ethernet communication. 

(*Ethernet is an option in the CRn-500.) 
2. Write “command line only” in program writing. 

(Uncheck the position variables write items and check “Command line only”) 
3. The number of command lines of the robot program is 1600 or more. 
4. In the TCP/IP Communication Settings, the values of both “Receive timeout” and 

“Retries” are other than 0. 
 
 
 

item Value 
Receive timeout (msec) 30000 or more 

Retries 0 
 
When using it on the condition of not changing the communication settings, errors might occur 

during robot program writing, or the robot program might not be correctly written. Therefore, it is 
necessary to check all content of the robot program. So be sure to change the communication 
settings. 

Caution 
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9.2.3. RS-232 Communication Settings  

 
Change the RS-232 communication settings to match the robot controller side communications settings. 
RS-232 communication can be used when connecting to a CR700 or CR500 series controller. 
 

 
Figure 9-4 RS-232 Communication Settings 

 
Table 9-4 RS-232 Communication Setting Items and Default Values 

Item Explanation Default value 
Port used COM1 – COM10 can be selected. COM1 
Communication 
speed 

Select from 4800, 9600, and 19200. 
+ It is possible to select Baud rate 38400 only when 
connecting this software with the CRnD-700 controller.  

9600 

Character size 7 or 8 can be selected, but select 8. 8 
Parity None, Odd, or Even can be selected. EVEN 
Stop bit Select from 1, 1.5, and 2. 2 
Send timeout Timeout time for sending 

Settable range 
 Minimum value :  1000 msec 
 Maximum value : 30000 msec 

5000 msec 

Receive timeout Timeout time for receiving 
Settable range 
 Minimum value :  5000 msec 
 Maximum value : 120000 msec 

30000 msec 

Retries Number of communication retries 
Settable range 
 Minimum value :  0 
 Maximum value : 10 

3 

Usage protocol Non-Procedural or Procedural can be selected. Procedural 
 
Set the following to perform a high-speed, stable communication. 

Baud rate : 19200 bps 
Protocol used : Procedural 

It is also necessary to change the communication settings to the same value of the robot controllers at this 
time. 

 

 

Normal operation not guaranteed with USB to RS-232 cables. 
 

Normal operation is not guaranteed when using the USB to RS-232 cable. When using the RS-232 
as a communication port, use of a computer with a serial port is recommended. 

Caution 
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9.2.4. GOT Communication Settings 

GOT communication is a communication method that uses the RS-232 and USB interfaces on GOT to establish a 
connection when a CR800-D/CR750-D/CRnD-700 series controller or GOT2000/1000 series is connected by 
Ethernet. 
 

 
Figure 9-5 GOT Communications Settings 

 
Table 9-5 GOT Communication Setting Items and Default Values 

Item Explanation Default value 
COM (*1) COM1 - COM10 can be selected. COM1 
Baud (*1) Select from 9.6Kbps、19.2Kbps、38.4Kbps、57.6Kbps、

115.2Kbps. 19.2Kbps 

Network No. (*2) 1 - 239 can be set. Match to Network No. of the GOT. 1 
Station No. (PC side 
I/F setting) (*2) 

1 - 64 can be set. Match to Station No. of the GOT. Set a 
value different from the Station No. of Robot 
controller-side I/F setting. 

64 

Station No. (Robot 
controller side I/F 
setting) (*2) 

1 - 64 can be set. Match to Station No. set by GOT. 
1 

Timeout 1 - 9999 can be set. Set the timeout after transmission.  
Note: If too short a time is set, a timeout error occurs. 30 seconds 

(*1) COM and Baud are available only that RS-232 is selected. 
(*2) In case of CR800-D controller, it is not displayed because it is unnecessary. 
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9.2.5. CRnQ_R Communication Settings 

 
CRnQ_R communication is a method to connect with a CR800-R/CR800-Q/CR750-Q/CRnQ-700 series controller 

by using a RCPU, a PLC Universal model QCPU module or a PLC Ethernet Interface module. 
When using RS-232 or USB, connect to the connector of the PLC Universal model QCPU module. 
When using Ethernet, connect to the connector of the PLC RCPU, Ethernet Interface module or Built-in Ethernet 

port QCPU.  
 

 
Figure 9-6 CRnQ_R Communication Settings 

 
On the CRnQ_R communication setting screen, when you select the computer interface, the communication 

routes using the selected interface are displayed at the bottom of the screen. Select the communication route, then 
press the [Detailed Settings] button. The detailed settings screen corresponding to the selected communications 
route is displayed. These detailed settings will be explained from the next item. 
 
 

The communication routes are displayed here. 
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9.2.5.1. When RS-232 is selected 

When "RS-232" is selected as the computer interface, the communications routes that can be selected are as 
follows. 
 

Table 9-6 Communication Routes That Can Be Selected for "RS-232" 
No. Communications routes Special mention 

1 Serial communication CPU unit connection Note1 
2 Serial communication Serial communication other station access via CPU unit Note1 
3 Serial communication NET/-0(H) other station access via CPU unit Note1 
4 Serial communication CC-Link other station access via CPU unit Note1 
5 Serial communication Ethernet other station access via CPU unit Note1 
6 Serial communication Serial communication via CPU unit - NET/10(H), CC IE other 

station access 
Note1 

7 Serial communication Serial communication via CPU unit-Ethernet other station 
access 

Note1 

8 Serial communication NET/10(H), CC IE via CPU unit - serial communication other 
station access 

Note1 

9 Serial communication NET/10(H), CC IE via CPU unit - CCLink other station access Note1 
10 Serial communication Other station access CCLink - NET/10(H), CC IE via CPU unit Note1 
11 Serial communication CCLink via CPU unit - Ethernet other station access Note1 
12 Serial communication Ethernet via CPU unit - serial communication other station 

access 
Note1 

13 Serial communication Ethernet via CPU unit - CCLink other station access Note1 
14 Serial communication Serial communication connection Note2 
15 Serial communication Other station access serial communication via serial 

communication 
Note2 

16 Serial communication Other station access NET/10(H), CC IE via serial 
communication 

Note2 

17 Serial communication Other station access CC-Link via serial communication Note2 
18 Serial communication Other station access Ethernet communication via serial 

communication 
Note2 

19 Serial communication Serial communication via serial communication - NET/10(H), CC 
IE other station access 

Note2 

20 Serial communication Serial communication via serial communication - Ethernet other 
station access  

Note2 

21 Serial communication NET/10(H), CC IE via serial communication - serial 
communication other station access   

Note2 

22 Serial communication NET/10(H), CC IE via serial communication - CCLink other 
station access 

Note2 

23 Serial communication CCLink via serial communication - NET/10(H), CC IE other 
station access 

Note2 

24 Serial communication CCLink via serial communication - Ethernet other station access Note2 
25 Serial communication Ethernet via serial communication - serial communication other 

station access 
Note2 

26 Serial communication Ethernet via serial communication - CCLink other station access Note2 
27 Serial communication CC-Link other station access via G4 Note3 
28 Serial communication CCLink via G4 - NET/10(H), CC IE other station access Note3 
29 Serial communication CC-Link via G4 – Ethernet other station access Note3 
30 Serial communication Serial communication other station access via NET/10(H), CC IE 

remote 
Note3 

31 Serial communication NET/10(H), CC IE other station access via NET/10(H), CC IE 
remote 

Note3 

32 Serial communication CC-Link other station access via NET/10(H), CC IE remote Note3 
33 Serial communication Ethernet other station access via NET/10(H), CC IE remote Note3 
34 Serial communication Serial communication other station access via NET/10(H), CC IE 

remote 
Note3 

35 Serial communication Serial communication via NET/10(H), CC IE remote - Ethernet 
other station access 

Note3 

36 Serial communication NET/10(H), CC IE via NET/10(H), CC IE remote - Serial 
communication other station access 

Note3 



 

9-99  9-99 

No. Communications routes Special mention 
37 Serial communication NET/10(H), CC IE via NET/10(H), CC IE remote - CC-Link other 

station access 
Note3 

38 Serial communication CC-Link via NET/10(H), CC IE remote - NET/10(H), CC IE other 
station access 

Note3 

39 Serial communication CC-Link via NET/10(H), CC IE remote - Ethernet other station 
access 

Note3 

40 Serial communication Ethernet via NET/10(H), CC IE remote - Serial communication 
other station access 

Note3 

41 Serial communication Ethernet via NET/10(H), CC IE remote - CC-Link other station 
access 

Note3 

Note1: CR800-R only supports USB. 
Note2: CR800-R only supports RS-232. 
Note3: CR800-R does not support that route. 
 

 
Figure 9-7 RS-232 (Serial Communication 

NET/10(H), CC IE through CPU Unit – CCLink Other Station Access) Detailed Settings 
 

"(5) Network communication route setting of MNET/10" and "(6) Coexistence network route setting of C24" may not 
be settable depending on the network route selected. 
GOT (Ethernet) transparent mode, display the setup screen by clicking the “Setting” button, and set the 
communication items. 
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9.2.5.2. When USB is selected 

When "USB" is selected as the computer interface, the communications routes that you can select are the same as 
for RS-232. See "Table 9-6 Communication Routes That Can Be Selected for "RS-232"". 
 

 
Figure 9-8 USB (Serial Communication 

NET/10(H), CC IE through CPU Unit – Serial Communication Other Station Access) Detailed Settings 
 

"(5) Network communication route setting of MNET/10" and "(6) Coexistence network route setting of C24" may not 
be settable depending on the network route selected. 
GOT (Ethernet) transparent mode, display the setup screen by clicking the “Setting” button, and set the 
communication items.  
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9.2.5.3. When NET/10(H), CC IE is selected 

It is possible to communicate using the "CC-Link IE controller network port" or "CC-Link IE field network port" newly 
established in the QnCPU. 
 
When "NET/10, CC IE" is selected as the computer interface, the communications routes that you can select are as 
follows. 
 

Table 9-7 Communication Routes That Can Be Selected for "NET/10(H), CC IE" 
No. Communications Route Special mention 

1 NET/10(H), CC IE board communication   Other station access via 
NET/10(H), CC IE unit  

Note1 

2 NET/10(H), CC IE board communication      NET/10(H), CC IE via 
NET/10(H), CC IE unit – CC-Link other station access 

Note1 

3 NET/10(H), CC IE board communication   NET/10(H), CC IE via NET/10(H), 
CC IE unit - Serial communication other station access 

Note1 

Note1: CR800-R supports communication with the CC IE controller board. 
 

 
Figure 9-9 NET/10(H), CC IE (NET/10(H), CC IE Board Communication 

NET/10(H), CC IE through NET/10(H), CC IE Unit – CC-Link Other Station Access) Detailed Settings 
 
"(5) Network communication route setting of MNET/10" and "(6) Coexistence network route setting of C24" may not 
be settable depending on the network route selected. 
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9.2.5.4. When CC-Link is selected 

When "CC-Link" is selected as the computer interface, the communications routes that you can select are as 
follows. 
 

Table 9-8 Communication Routes That Can Be Selected for "CC-Link" 
No. Communications Route Special mention 

1 CC-Link board communication   Other station access via CC-link unit Note1 
2 CC-Link board communication   CC-Link via CC-link unit – NET/10(H), CC 

IE other station access 
Note1 

3 CC-Link board communication   CC-Link via CC-link unit – Ethernet other 
station access 

Note1 

Note1: CR800-R does not support that route. 
 

 
Figure 9-10 CC-Link (CC-Link Board Communication 

CC-Link through CC-Link Unit – NET/10(H), CC IE Other Station Access) Detailed Settings 
 

"(5) Network communication route setting of MNET/10" and "(6) Coexistence network route setting of C24" may not 
be settable depending on the network route selected. 
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9.2.5.5. When Ethernet is selected 

When "Ethernet" is selected as the computer interface, the communications routes that you can select are as 
follows. 

 
Table 9-9 Communication Routes That Can Be Selected for "Ethernet" 

No. Communications Route Special mention 
1 Ethernet board communication Access other station via Ethernet module  
2 Ethernet board communication Access Ethernet-serial communication other 

station via Ethernet module 
 

3 Ethernet board communication Access Ethernet-CC-Link other station via 
Ethernet module 

 

4 Ethernet port direct communication PLC module connection Note1 
5 Ethernet port direct communication Access serial communication other station 

via PLC module 
Note1 

6 Ethernet port direct communication Access CC-Link other station via PLC 
module 

Note1 

7 Ethernet port IP address designate communication PLC module connection  
8 Ethernet port IP address designate communication Access serial 

communication other station via PLC module 
 

9 Ethernet port IP address designate communication Access CC-Link other 
station via PLC module 

 

Note1: CR800-R does not support that route. 
 

 
Figure 9-11 Ethernet (Ethernet board communication Access Ethernet-serial communication other station via Ethernet 

module) Detailed Settings 
 
“(1)PC side I/F Ethernet board setting”, “(2)Network communication route setting Ethernet”, "(5)Network 
communication route setting of MNET/10", and "(6)Coexistence network route setting of C24" may not be settable 
depending on the network route selected. 
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Can not connect with two or more robot controllers in direct 
connection. 

 

When two or more robot controllers are connected on the network, it does not support from 
“4. Ethernet port direct communication PLC module connection” to “6. Ethernet port direct 
communication Access CC-Link other station via PLC module” in Table 9-9. Please use other 
route for communication. 

Caution 
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9.2.5.6. When Q series bus is selected 

When the "Q series bus" is selected as the computer interface, the communication route that can be selected is as 
follows. 

 
Table 9-10 Communication Route That Can Be Selected with the "Q Series Bus" 

No. Communications Route Special mention 
1 Q bus communication CPU unit connection Note1 

Note1: CR800-R does not support that route. 
 

 
Figure 9-12 Q Series Bus (Q Bus Communications CPU Unit Connection) Detailed Settings 
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9.2.6. Travel base setting for display 

Set the traveling axis for display. The travel axis is set in Step 5. of the "Add/Edit Project" screen. 

 
Figure 9-13 Travel base setting for display 

 

 
 

9.2.6.1. Travel base setting 
Set the travel base that is displayed in the [Travel axis] field of this screen. 
Up to two travel bases can be used simultaneously. 
 
When the [Use the travel axis] checkbox is selected, the travel axis, travel direction, motion limit, pitch, and travel 
base information can be set. 
You can set J7 and J8 axes to the travel axis. When two travel bases are used, specify different axes to each of the 
travel bases. 
The travel directions are as follows. When [Z +direction]/ [Z -direction] is set in the Travel direction, the travel base 
does not display. 
 

MELFA ASSISTA series does not set travel base. 
 

This screen cannot be used because MELFA ASSISTA does not support traveling axes. 

Caution 
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Figure 9-14 Travel direction (When setting the J8 axis to the traveling axis) 
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9.2.6.2. Robot additional axis parameter setting 

Click the [Set the parameters of the additional axis] button. The content set to [Travel axis] is applied to the robot 
additional axis parameters of the simulation. Note that parameters are not automatically set if the above button is not 
clicked. 
 
* The additional axis parameters include these parameters. 
AXMENO,AXJNO,AXUNT,AXGRTD,AXGRTN,AXACC,AXDEC,AXMREV,AXJMX,AXENCR,MEJAR 
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10. Robot Programming Language Setting 
 
Select the robot program language that is used. The languages you can select are as follows. 
 

Table 10-1 Robot Programming Languages for Each Controller 

Robot controller 
Robot program language 

MELFA-BASIC VI MELFA-BASIC V MELFA-BASIC IV Movemaster 
commands 

CR800-D/CR800-R/ 
CR800-Q ○ ○ × × 

CR750-D/CRnD-700 × ○ ○ ○ 

CR750-Q/CRnQ-700 × ○ ○ ○ 
CRn-500  × × ○ ○ 

 
The Movemaster commands are restricted by the robot models that can use them. Before trying to use Movemaster 
commands, check in the "Standard Specifications" that the model you are using supports Movemaster commands. 

 
On the project tree, click the desired project name with the right mouse button, then from the right button menu, 
select "Edit Project". The project edit screen is displayed. Set the language in the "Step 4. Language" page of the 
Edit Project screen. 

 

 
Figure 10-1 Setting the Language 

 
Select the program language to be used and click the [Finish] button. 
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11. Writing Programs 
 

This chapter explains robot program editing methods.  You can directly edit programs in the robot controller or edit 
programs stored on the computer. 

 
 

Program names that cannot be handled by the computer 
 

If a program name in the robot controller is the same as a "reserved term" in Windows, when you 
try to open that program for program editing, an error will result In this case, it is necessary to change 
the program name in the controller. 

"Reserved terms" are special character strings that the Windows system uses and therefore can 
not be used as file names. These "reserved terms" are character strings such as the following. 

 
AUX, COM1 to COM9, CON, LPT1 to 9, NUL, PRN 

 
 

Program names that cannot be handled by the robot controller. 
It is not possible to use the following program names: 

2. The program name is too long. (13 characters or more). 
3. The program name contains characters other than alphanumerics. 
4. The top of the program name is "0"(Zero). 

A warning is displayed when you input the program name including these conditions in the following 
operations. 

- Writing a New Program 
- Copying the program 
- Renaming the program name 
- Drag and drop operation 
 
 

When a password is registered in a program by the robot controller's 
security function, the program in the robot controllers cannot be read, 
saved, copied, renamed, or deleted. 

When the password is registered in a program by the robot controller's security function, the 
programs in the robot controller cannot be operated as follows. 

○ : Enable、 × : Disable 
  Item to which password of security function is registered. 

Program Parameter File 
Reading of programs. 

× ○ ○ Saving programs 
Copying programs 
Renaming programs 
 

Please delete the robot controller's security function password when you perform these. Refer 
to "16.5.3 Delete Password" for the method of deleting the password.  

For details on versions of robot controllers that support security functions, refer to "Table 16-12 
Compliant version of this function and controller". 

Caution 
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11.1. Writing a New Program 

11.1.1. Writing a new program on the computer 

For the new program you are going to write, select [Offline] -> [Program], then click the right mouse button.  The 
right button menu is displayed, so click [New]. 

 

 
 

Figure 11-1 Writing a New Program on the Computer 
 
Input the robot program name, then click the [OK] button. 
 

 
 

Program storage folder 
 

Programs on the computer are managed in units of workspace projects. The folder they are stored 
into is workspace writing folder\project name\Program. 

To store into any other folder, first store in this folder, then copy to the desired folder with the 
program management copy function. 

Caution 
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11.1.2. Writing a new program in the robot controller 

Select [Online] or [Simulation] -> [Program] for the new project to be created, and click the mouse right button. 
The right button menu is displayed, so click [New]. 
 

 
Figure 11-2 Writing a New Program in a Robot Controller 

 
Input the robot program name, then click the [OK] button.  The "Read Item" screen is displayed, so check the read 
items, then click the [OK] button.  For details on the read items, see "11.2.3 Read Items when opening program 
in robot controller". 
 

 
Figure 11-3 Editing a New Program 
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11.2. Opening an Existing Program 

11.2.1. Opening an existing program on the computer 

Open the target project in the project tree with [Offline] -> [Program].  The stored programs are displayed on the 
project tree, so double click the program you want to edit. 

 

 
Figure 11-4 Opening a Program on the Computer 

 
 

11.2.2. Opening a program in a robot controller 

Expand [Online] or [Simulation] -> [Program] for the target project in the project tree. The stored programs are 
displayed on the project tree, so double click the program you want to edit. 

 

 
Figure 11-5 Opening a Program in a Robot Controller 

 
Input the robot program name, then click the [OK] button.  The "Read Item" screen is displayed, so check the read 
items, then click the [OK] button.  For details on the read items, see "11.2.3 Read Items when opening program 
in robot controller". 
If you open a program which is set “Reading protection” (displayed  on the project tree), release it with reference 
to “11.12 Set / Release read protection” before you open the program. 
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11.2.3. Read Items when opening program in robot controller  

You can set the robot program read items divided into command lines, position variables, and program external 
position variables.  This function is displayed after H1 edition on CRn-500 series controller. 
 
The default values of read items are as follows. 
 

 
Figure 11-6 Read Items 

 
The program external position variable read operations are shown in "Table 11-1 Program External Position 
Variable Read Operations". (For details on program external position variables, see "Detailed explanations of 
functions and operations" in the robot controller's user's manual.) 
 

Table 11-1 Program External Position Variable Read Operations 
 Read Item 

Position variable, joint variable 
(P_01, J_02, etc.) 

(MOVEMASTER command : 
901-999) 

Position array variable, 
joint array variable 

(P_100( ), J_102( ), etc.) 

C
om

m
an

d 

Po
si

tio
n 

Ex
te

rn
al

 
po

si
tio

n 
va

ria
bl

e 

CR800/ 
CR750/700 
series robot 
controllers 

   Reads only the external position 
variables (position variables, joint 
variables) used in instruction 
statements. (*1) 

Reads all elements used in 
instruction statements. (*2) 
    

   Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables).    

C
R

n-
50

0 
se

rie
s 

ro
bo

t c
on

tro
lle

r 
so

ftw
ar

e 
ve

rs
io

n Ve
r.J

1 
or

 la
te

r    Reads only the external position 
variables (position variables, joint 
variables) used in instruction 
statements. (*1) 

Reads all elements used in 
instruction statements. (*2) 
    

   Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables).    

Ve
r.H

1 
to

 H
7    

Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables). 

   

   

   

Ve
r.G

9 
or

 
ea

rli
er

 

This screen is not displayed. 

*1: When Movemaster commands are used, all external position variables are read. 
*2: When only P_100 (1) is used in the command statement, P_100 (1) to P_100 (10) are all read.  However, the number of 

valid elements depends on the robot controller software version used. 
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11.2.4. Editing a program in the backup data 

Program data backed up on the personal computer by the backup function can be edited in the Edit Program screen. 
 
Open the target project in the project tree under [Backup]. Select the backup data (All files or Program) stored the 
program you want to edit. From the right mouse button menu, click [Open Backup program]. The stored programs 
are displayed on “Open Backup Program” window. Select the program you want to edit, and click [OK] button. 
The extension of program data file in the backup data is “*.MB6”, “*.MB5”, or “*.MB4”. 
 

 
Figure 11-7 Opening a program in the backup data 

 
If you open a program which is set with “Read protection”, the reading password input screen is displayed. You can 
open it by inputting the password set prior to backup.  

 

Cautions on opening backed-up programs. 
The cautions on opening backed-up programs are as follows, 
(1) Only programs made in the robot program language specified by the current project can be 

opened. 
(2) The program external position variables used in the program cannot be read. 
(3) If the program is opened from Program backup data, the values of the user definition 

external variables become 0. 
(4) If the program is opened from Program backup data or the data of an unsupported robot, 

the joint position variables, additional axis values, and direct-driven axis values used might 
be not converted correctly. 

Caution 
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11.3. Explanation of Program Edit screen 
This explains the program edit screen. 

 
Figure 11-8 Explanation of Program Edit screen 

 
The top part of the screen is the program command statement edit screen and the bottom part is the position 
variable edit screen. 

Position variable edit screen 

Command editing 
screen Move the border line 

up and down 

Drag title "position" or tab "XYZ"/"Joint”/”Work coordinate” 
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To change the position dividing the top and bottom screens, drag the border line with the mouse. Also, the display 
position of each editing screen can be changed by dragging the title "position" or tab "XYZ"/"Joint"/"Work coordinate". 
This is handy when you want to expand the command edit screen, for example because there are many lines of 
commands. For details, see "11.5 Customizing the Display Position". 

 
The background color for the command edit screen depends on the robot language used. The background color can 
be changed from option screen. For details, refer to "11.6.11Setting the background color of the program 
editor". 

 
Table 11-2 Command Edit Screen Background Color (Initial color) 

Robot language Background color 
Normal Debugging 

MELFA-BASIC VI White 

Light blue MELFA-BASIC V White 
MELFA-BASIC IV Light yellow 
Movemaster commands  Light green 

Debugging means when the program is opened in debugging status. 
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11.4. Ribbon During Program Editing 
During program editing the "File", "Edit", "Debug" and "Tool" tabs are displayed on the ribbon. 

 

 
Figure 11-9 Ribbon During Program Editing 

 
The button in each of these tabs are as follows. 

Tab Group Button Explanation Menu 
item 

Home  

 
 

 

Print Page Setup Pages in the program to print can be customized. 11.10.3 
Print 
preview 

You can preview how a printed page of the program 
will look. 

11.10.1 

Print This prints the program. 11.10.2 
File  

 
 

 

Save Save Saves the program being edited with its current 
name. 

11.9.1 

Save As -> 
PC... 

Saves the program being edited with its current 
name on the PC 

11.9.2 

Save As -> 
Robot... 

Saves the program being edited with its current 
name on Robot controller 

11.9.3 

Save As -> 
Template 

Save the editing program as a template to PC 11.9.4 

Program template Insert/Edit It is possible to insert template to editing program 
and edit template 

11.7.4.1
5 

Edit  

 
 

 

Command line Cut Cuts a character string from the command being 
edited. 

11.7.4.2 

Copy Copies a character string in the command being 
edited. 

11.7.4.1 

Paste Pastes the copied or cut character string to the 
specified location. 

11.7.4.3 

Undo Cancels the command edit and return to the 
previous state 

 

Redo Redo the command edit  
Syntax 
Check 

You can check whether or not the edited robot 
program is syntactically correct. 

11.7.4.13 

Template You can display a list of the commands and make 
insertions on the program command edit screen. 

11.7.4.14 

Jump Jumps to the specified step number or label. 11.7.4.9 
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Tab Group Button Explanation Menu 
item 

Separate Separates and displays the command editing 
screen. 

11.5 

Collapse all Collapses and displays all command blocks. 11.7.4.23 
Expand all Expands and displays all command blocks. 11.7.4.23 

Position variable Add Add a position variable. 11.7.3.1 

Edit Edit the selected position variable. 11.7.3.1 

Delete Delete the selected position variable. 11.7.3.2 

Robot Select the robot to be used in the "Get current Pos." 
and "Pos. Jump". 

11.6.13 
11.8 

Get current 
Pos. 

Get the current position of robot to selected position 
variable. 

11.6.13 

Pos. Jump Move the robot to the coordinates of selected 
position variable. 

11.8 

Copy Copies the position variable. 11.7.4.4 

Paste Pastes the copied position variable. 11.7.4.5 

Redo Redoes the editing operation on the position 
variable. 

 

Undo Undoes the edited location of the position variable.  
Find/Replace Find Searches for the specified character string. 11.7.4.6 

Replace Replaces the specified character string with another 
character string. 

11.7.4.8 

Find in 
Files 

Searches for the specified character string in the 
program files. 

11.7.4.7 

Bookmark Set Adds a bookmark to the selected program line. 11.7.4.22 
Delete Deletes a bookmark from the selected program line. 
Delete All Deletes all bookmarks from the program. 
Previous Jumps to the line set with a bookmark immediately 

before the cursor. 
Next Jumps to the line set with a bookmark immediately 

after the cursor. 
Transmission All Writes all lines of the program to the robot controller. 

This cannot be used when the program is opened in 
debugging status. 

11.7.4.1
2 

Partially Writes the selected program lines to the robot 
controller. 
This cannot be used when the program is opened in 
debugging status. 

11.7.4.11 

Comment Comment Batch exchanged selected lines are 
commented-out. 

11.7.4.19 

Uncommen
t 

The selected lines of the comment are batch 
released. 

11.7.4.19 

Remove all Removes all comments in the program. 11.7.4.20 
Arrange All Arrange all comment in the program. 11.7.4.21 

Debug edit Edit Edits the program command lines opened in 
debugging status. 

11.11.3 

Insert Inserts the command lines into a program opened in 
debugging status. 

Delete Deletes the command lines in a program opened in 
debugging status. 

Debug  
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Tab Group Button Explanation Menu 
item 

Start/Stop Debug start Reopens the program being edited in the debug 
mode. 

11.11.1 

Debug stop Reopens the program in the debug mode in an 
editable state. 

11.11.6 

Breakpoint Set... Sets a breakpoint in a program opened in 
debugging status. 

11.11.4 

Delete Deletes a breakpoint in a program opened in 
debugging status. 

Delete all Deletes all breakpoints in a program opened in 
debugging status 

Show Show the 
executed 
line always 

Sets display/non-display the executed line in the 
program opened in debugging status. 

11.11.1 

Tool 
* 

 

 
 
Command line Renumber The renumbering function can only be used with 

MELFA-BASIC IV and Movemaster commands. 
Batch-renumbers line numbers. 

11.7.4.17 

Sort The sorting function can only be used with 
MELFA-BASIC IV and Movemaster commands. 
Sorts edited programs in line number order. 

11.7.4.18 

Position variable 
Batch edit 

XYZ 
variable 

Changes the position variables in the program being 
edited in a batch and can sum up all the values 

11.7.4.16 

Joint 
variable 
Work 
coordinate 
variable 

Tact time 
Calculation 

Run 
calculation 

Tact time calculation can only be used in a 
simulation. 
You can calculate the tact time of the program. 

21.3 

Other Option You can customize the syntax check before saving 
for example. 

11.6 

 
* When the program is opened in the debug mode, the [Tool] tab is not displayed. 
 



 

11-121  11-121 

 
11.5. Customizing the Display Position 
The separation position of the screen can be customized by dragging the border line between the command editing 
screen and the position variable editing screen. 

 
 

Figure 11-10 Customizing the Screen Separation Position by the Border Line 
 

Move the border 
line up and down 

Move the border 
line up and down 
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The separation position of the command editing screen can be customized by clicking the [Edit] tab -> [Command 
line] group -> [Separate] button on the ribbon. 
The separation position of the command editing screen can also be customized by dragging the " " or border line 
on the scroll bar in the command editing screen. 

 
Figure 11-11 Customizing the Separation Position of the Command Editing Screen by the Border Line 

 

Move the border 
line left and right 

Move the border 
line up and down Drag 

Drag 
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You can customize the position editing screen itself and the display position of the XYZ data/joint data/work 
coordinate data of the position editing screen by dragging each of the "Position", "XYZ"/"Joint"/"Work coordinate" 
title and tabs in the position editing screen. 

 

 
Figure 11-12 Customizing the Screen Separation Position by Title and Tabs 

Drag 

Drag 

Drag 
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11.6. Customizing Other Than the Display Position 
The program editing screen can be customized in various ways such as the syntax check before saving and 
color-coding of reserved terms in the robot program that is displayed in the command edit area. 
With the program opened, click the [Tool] tab -> [Other] group -> [Option] button on the ribbon, and make the 
required setting in the Option screen that is displayed. 
Clicking the [Reset default values] button returns settings to their default state. 
 

 
Figure 11-13 Option Screen 

 
11.6.1. Displaying input candidates  

Input candidates can be selected and input from a list when some of the commands, system functions and system 
status variables in the robot program have been input in the command edit area. 

 

 
Figure 11-14 Setting Term Complementation 

 
  

Select “Automatically display 
input candidates while 
inputing a character string”. 

Select “When press Ctrl+Space 
key, the input candidate list 
displayed”. 

Input reserved 
terms up to 
midway 

Input reserved terms 
up to midway by the 
[Ctrl] + [Space] keys 
after input 
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11.6.2. White space display 

Space in the command edit area can be replaced with visible text and displayed. 

 
Figure 11-15 Setting White Space Display 

 
11.6.3. Auto indent 

The edit starting digit after the Enter key is pressed in the command edit area can be automatically aligned with the 
previous line. 

 
Figure 11-16 Setting Auto Indent 

 

Checked Unchecked 

Edit start digit is automatically 
aligned with previous line 
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11.6.3.1. Auto indent with specific commands 

Insert/align indent when there is a specific command line break in the command edit area. This function can be used 
only when "11.6.3Auto indent" is valid. 
 

 
 
 
 
 
 

Figure 11-1 Auto indent with specific commands 
 
The instructions for automatic indentation are as follows. 
 Combination of corresponding instructions 
Indent of insert If For Function Select While 
Indent of align 
*1 

ElseIf 
Else 
EndIf 

Next FEnd End Select WEnd 

*1The indentation is aligned with the start position of the commands. 
 

Insert indent Align indent 

Click Enter 
 

The beginning position of the 
For and Next statement are the 
same position 

Click Enter 

Insert indent for the number of characters 
specified in "11.6.3.2Number of indent 
characters" 
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11.6.3.2. Number of indent characters 

You can set the number of characters when indenting is inserted in a specific command statement between 1 and 8 
characters. 
 

 
Figure 11-2 Number of indent characters 

 
 

Indent number of characters is 4 

Click Enter 

Insert 4 characters of indentation 
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11.6.4. Command format hints 

You can use pop-up hint display to display the format for the robot program command, system functions, and system 
status variables displayed in the command edit area. 

 
Figure 11-17 Command Edit Area Command Format Hint Display Settings 

 
11.6.5. Pasting line numbers 

To paste a copied robot program to a robot program created with MELFA-BASIC V or MELFA-BASIC VI, either 
delete or past the line number, or select [Page with line number]. This is handy when pasting and using programs 
created with MELFA-BASIC IV or examples of robot programs in Instruction Manuals. 

 

 
Figure 11-18 Line Number Pasting Setting 

 

The format and description 
corresponding to the selected 
input candidate are displayed 

Checked Unchecked 

Copy source robot program 

Paste operation 
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11.6.6. Convert blank lines to comments 

Insert the comment (" ' ") for a blank line when saving the program or checking the syntax. Please use if you don't 
want to automatically delete blank lines . 
 

 
Figure 11-19 Convert blank lines to comments 

 
11.6.7. Save a program in the form of no line number 

Save the program in the format with no line number (MELFA-BASEC V / MELFA-BASEC VI  only) when saving 
offline program etc.There is no display change on the program edit editor. 
 

Save, syntax check 
operation, etc. 

Unchecked Checked 

Blank line is deleted Insert the comment 
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Figure 11-20 Save a progrma in the form of no line number 

 
The saved document format is as follows 
 

 
Figure 11-21  Save a progrma in the form of no line number 

 
Points to note are as follows 
1) It cannot be converted immediately after setting in the option, please save again. 
2) Regardless of whether or not it is saved, all programs are converted to a format without line numbers when 

shifting from simulator to offline. 

Save, copy, move, etc. 

Unchecked 
 

Checked 

Omit line number save 

Command line label 

Command line content 

Position variable label 
Content of the 
position variable 
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3) Only for MELFA-BASIC V / MELFA-BASIC VI. When a program saved without line numbers format is copied to 
a project other than the MELFA-BASIC V or MELFA-BASIC IV, the line number is automatically set. 

4) Do not erase the tag indicating the command line / position variable. The program can not be read normally. 
 
11.6.8. Line break after insertion 

Wrap at the end of the command line when inserting the command template. 
 

 
Figure 11-3 Wrap line when inserting the command template 

 

The cursor moves to the next line 
of the inserted command line 

Insert template 
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11.6.9. Character colors 

You can assign the colors for displaying robot program command, system functions, and system status variables 
displayed in the command edit area. 
Click the item of the color you want to change on the option screen, the [...] button is displayed at the right end. 
When you click the […] button, the color setting screen is displayed. After setting the color, click the [OK] button. 

 
Figure 11-22 Command Edit Area Character Color Settings 

 
11.6.10. Changing the font 

You can change the font displayed in the command edit area.   
Click the item of the font you want to change on the option screen, the [...] button is displayed at the right end. When 
you click the […] button, the font setting screen is displayed. After setting the font name, style, and size, click the 
[OK] button. 

 
Figure 11-23 Command Edit Area Font Setting 
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11.6.11. Setting the background color of the program editor 

It is possible to set the background color of the command area in the program editor. 
For details on how to set the color, refer to “11.6.9 Character colors”. 

  
Figure 11-24Setting the background color of the program editor. 

 

 
 
11.6.12. Setting the syntax check at program save 

You can set whether or not to have the syntax checked when you save a program and whether or not to display a 
message when there are no syntax errors. 
The default setting is automatic syntax checks with no message displayed if there is no syntax error. 

 
Figure 11-25 Settings for Syntax Check Before Saving 

 

Please note that it is easy to mistake off-line and online, etc., if the same color is used by the 
background color. 

Caution 
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11.6.13. Get current position 

When adding a position variable, the current position can be retrieved automatically if connected to the robot. At this 
time, a confirmation message will be displayed if "Display the Message when Get the Current Position" is checked. 

 
Figure 11-26 Setting the get current position. 

 
11.6.14. Program Save and Read 

You can start up the screen with "Position Variables" and "Program External Position Variables" checked in [Save 
item] when saving the program and [Read item] when reading. 

 
Figure 11-27 Initial setting of “Program external position variables” in the [Read Items] and the [Save Items]. 

 
 
 
 

[Read Items] - Reading the program 

[Save Items] - Saving the program 
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11.7. Program Editing 
This section explains how to edit programs created with MELFA-BASIC V or MELFA-BASIC VI. 
For RT ToolBox3 command statement edits can be input in the same way as with a general editor like Notebook. 
 
 
11.7.1. MELFA-BASIC V / MELFA-BASIC VI command statement editing 

When using MELFA-BASIC V or MELFA-BASIC VI to create a program, the program does not have line Nos. as in 
MELFA-BASIC IV or Movemaster commands and instead this is indicated by a step No. at the left edge of the 
Program screen. These step numbers are automatically displayed with the keyboard [Enter] key. 

 

 
Figure 11-28 MELFA-BASIC V and MELFA-BASIC VI Command Editing Screen 

 
Even if MELFA-BASIC V and MELFA-BASIC VI commands are entered using all lowercase characters, they are 
converted to the correct uppercase and lowercase characters when the program is written to the robot controller. 
 

 
Figure 11-29 Character Input in MELFA-BASIC V and MELFA-BASIC VI 

 

When the program is written to 
the controller, uppercase and 
lowercase characters are 
converted to MELFA-BASIC V 
and MELFA-BASIC VI format. 

Step number 
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11.7.2. MELFA-BASIC IV and Movemaster command command statement editing  

When writing a program using MELFA-BASIC IV or Movemaster commands, step numbers like those of 
MELFA-BASIC V / MELFA-BASIC VI are not displayed. Input the line number at the front of the command 
statement. 

 
Figure 11-30 MELFA-BASIC IV Command Edit screen 

 
 
A function is provided for sorting lines in line number order even if lines are not entered in this order. 

For details, see "11.7.4.18 Sort". 

 
Figure 11-31 Sort 

 
Even if the MELFA-BASIC IV, and Movemaster Command commands are all input in lower case, these shall be 
correctly converted to upper case in the robot controller when written to the robot controller. 

 
Figure 11-32 MELFA-BASIC IV Character Input 

 

When this is written to the 
controller, it is converted in the 
controller into all uppercase 
characters, which is correct 
MELFA-BASIC IV format. 

Syntax error 

Line numbers 
OK 

For MELFA-BASIC IV and Movemaster commands, input line numbers. 
Step numbers are not displayed on the MELFA-BASIC IV and Movemaster command edit screen. 

When using MELFA-BASIC IV and Movemaster commands, always input line numbers. 
If there are no line numbers, a syntax error will result. 

Caution 
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11.7.3. Position variable editing 

Position variables are edited on the position edit screen. Clicking the "XYZ" tab switches to the list of XYZ coordinate 
type variables, and clicking the "Joint" tab switches to the list of joint coordinate type variables and clicking the "Work 
coordinate" tab switches to the list of work coordinate type variables. 

 
Figure 11-33 Position Variable Edit Screen 

 
Array variables are displayed developed in their own lists. 
 

 
Figure 11-34 Array Variable Display 

XYZ position variables Joint position variables 

Work coordinate position variables 
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Kinds of position variable that can be used differ depending on the robot program language. The kinds that can be 
used in each robot program language are as follows. 

 
11-3 Kinds of position variable that can be used in each robot program language 

Robot program language 
Kinds of variable that can be used 

Position type 
variable Joint type variable Work coordinate 

type variable 
MELFA-BASIC VI ○ ○ ○ 

MELFA-BASIC V ○ ○ × 
MELFA-BASIC IV ○ ○ × 
Movemaster command  ○ × × 

 

 

About uppercase characters and lowercase characters 
 in position variable names 

In MELFA-BASIC V and MELFA-BASIC VI, lowercase characters can be used for variable names. 
This software does not differentiate between uppercase letters and lowercase letters in variable 

names. For example, the position variables PA and pa are recognized as the same position 
variables. 

The controller converts all later variables to match the first position variable name defined.  For 
example, if you write a program like that below, the position variable "pa" is used and "PA" is 
converted into "pa". 

         
 

When this is written to the controller, it is 
converted in the controller as on the right. 
 

Caution 
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11.7.3.1. Adding/changing position variables 

To add a position variable, select one of the list of XYZ/joint/work coordinate type variables, and click the [Add] 
button on the program edit screen or click the [Add] button in the [Edit] tab -> [Position Variable] group from the 
ribbon. A new line is added to the end of the currently selected list and the screen is ready for input of the variable 
name.(*1) 
At this time, if "Get Current Position Automatically" in the option screen is checked and there is a connection to the 
robot, the current position of the robot is displayed. 
If you add a position variable that has already been selected, the selected position variable is copied and displayed. 
When the variable name is entered, addition of the position variable is fixed. 
 
 

 
Figure 11-35 Add Position Variable 

Enter variable 
name 

Click 

Select 
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There are two ways of changing the position variable. 
[Method (1)] Directly change the list 
Select the cell you want to change on the list, and enter the value directly. 

 
Figure 11-36 Changing the Position Variable by Directly Editing the List 

 
[Method (2)] Change in the Edit Position data screen 
Select the target position variable to be changed from the list and click the [Edit] button on the program edit screen 
or click the [Edit] button in the [Edit] tab-[Position Variable] group from the ribbon. The selected position variable is 
displayed in the Edit Position data screen. Enter each of the element values of the position variable and the position 
variable name, and click the [OK] button. 
 

 
Figure 11-37 Changing the Position Variable in the Edit Position Data Screen 

 
Although the variable name can be changed by either of these methods, it cannot be changed in the case of an SQ 
Direct File or when a program is opened for debugging. 
When the program is being edited in the online or simulation mode, the current position of the robot can be read by 
the [Get current pos.] button. However, this function cannot be used for the work coordinate variable. 
A confirmation message will be displayed if the "Display the Message when Get the Current Position" on the option 
screen is checked. 
 

The valid elements are selected. 
For some robot models, the 
elements are not selected. 

Select cell and enter the 
value directly 
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Figure 11-38 Getting the Current Position 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.7.3.2. Deleting position variables 
Select the target position variable and then click the [Delete] button on the program edit screen or click the [Delete] 
button in the [Edit] tab-[Position Variable] group from the ribbon. The selected position variable is deleted. You can 
also delete multiple position variables at the same time. You can select multiple position variables by clicking 
position variables while holding down the [Ctrl] key or the [Shift] key on the keyboard. However, you cannot select 
XYZ position variables and joint position variables at the same time. However, it is not possible to delete two or more 
types of position variables, joint variables and work coordinate variables at the same time. 
 

To add a position array variable, specify the array name and element number in the variable name. 
Also, when writing to a robot, be sure to write the Dim declaration in the statement. If there is no Dim 
declaration, an error will occur in writing to the robot controller. 

Caution 

The unit of the element to be used differs for each robot used. Please refer to the operation manual 
of individual robot. 

Caution 

If you acquire the current position from a robot of a different model, you will get different position 
data from the assumed position, so be careful. 

Caution 
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11.7.4. Edit assist functions 

This explains the edit assist functions, which help in command editing. 
Auxiliary editing functions such as copy, cut, find, replace, and jump are used from the [Edit] and [Tool] tabs on the 
ribbon. 
 
 

11.7.4.1. Copy 
Copies a character string in the command being edited.  You can also copy multiple lines. 
Select the character string to copy, and then click the [Edit] tab -> [Command line] group -> [Copy] button on the 
ribbon. 
You can use the paste function, explained below, to paste this copied character string to another location in the 
program. 
For details on position data copying, see "11.7.4.4 Copying position variables". 
 
 

11.7.4.2. Cut 
Cuts a character string from the command being edited. You can also cut multiple lines. 
Select the character string to cut, and then click the [Edit] tab -> [Command line] group -> [Cut] button on the ribbon. 
You can use the paste function, explained below, to paste this cut character string to another location in the 
program.  
 
 

11.7.4.3. Paste 
Pastes the copied or cut character string to the specified location. 
Place the cursor at the position to paste the character string, and then click the [Edit] tab -> [Command line] group -> 
[Paste] button on the ribbon. The copied or cut character string is inserted at the specified location. 
For details on position data pasting, see "11.7.4.5 Pasting Position Variables". 
 
 

11.7.4.4. Copying position variables 
Copies the position variable. You can also copy multiple position variables. 
Select the position variable to copy, and then click the [Edit] tab -> [Position variable] group -> [Copy] button on the 
ribbon. 
 

To delete a position array variable, delete the command statement. 
"Dim" declaration. 

With this software, even if a position variable is deleted, if a program with a "Dim" declaration is 
written to a robot controller, the position array variables declared with the "Dim" are left at 0 for all 
their components. 

Caution 
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11.7.4.5. Pasting Position Variables 

Pastes the copied position variable. 
Activate the program to paste the position variable to, and click the [Edit] tab -> [Position variable] group -> [Paste] 
button on the ribbon. 
The copied position variable is inserted in the designated program. 
At this time, if there is already position data with the same name in that program, a confirmation message is 
displayed. 

 
Figure 11-39 Paste Position Data Confirmation Message 

 
 

11.7.4.6. Find 
This searches for the specified character string. 
Click the [Edit] tab -> [Find/Replace] group -> [Find] button on the ribbon. The find screen is displayed. 
 

 
Figure 11-40 Find Screen  

 
Input the character string to find, and then click [Find Next] or [Find Previous]. The character string search starts. 
Clicking [Display List] searches for all designated character strings in the program and displays them as a list in the 
Find window. 
 

 
Figure 11-41 Find Results List Display 

 
You can jump to a line containing the selected content by double-clicking the content from the list display in the Find 
window. 

Program location (robot controller/PC) 

Number of command lines that contain 
the character string to search 

Project name Line content 

Position variable name that contains the character string to search 

Program name 

Character string to 
search 

Jump by double-clicking 

Date that search was 
executed 
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11.7.4.7. Find in Files 

This searches for the specified character string in the "Online" or "Offline" program files registered in the current 
project. 
Click the [Edit] tab -> [Find/Replace] group -> [Find in Files] button on the ribbon. The find in files screen is 
displayed.   
 

 
Figure 11-42 Find in Files Screen 

 
Input the character string to find and select the location to search. 
When "PC" is selected as the location to search, all the offline programs registered in the current project are 
searched. 
When "Robot" is selected as the location to search, all the online programs registered in the current project are 
searched. In other words, all the programs in robot controllers in the "online" status connected to a robot are 
searched. If a simulation is running, all the programs in the virtual controller are searched. When you search in 
controllers, the communications with the controllers may take time. 
 

 
Figure 11-43 Results of Search from File 

 
You can open a program containing the selected content and jump to the corresponding line by double-clicking the 
content from the list display in the Find window. 
 

Jump by double-clicking 
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11.7.4.8. Replace 

This replaces the specified character string with another character string. 
Click the [Edit] tab -> [Find/Replace] group -> [Replace] button on the ribbon. The Replace Screen is displayed. 

 

 
Figure 11-44 Replace Screen 

 
[Find Next] : Searches for the next instance of the character string to be replaced. 
[Replace] : Replaces the found character string. 
[Replace All] : An item is displayed for specifying the range in which to replace all instances of the specified 

character string. 
 
In Replace All, you can specify a range in which to replace. 
When you click the [Replace All] button, all the instances in the specified range are replaced. 

 

 
Figure 11-45 Replace All Setting Screen 

 
 

11.7.4.9. Jump to specified line 
Jumps to a specified step number or label. 
Click the [Edit] tab -> [Command line] group -> [Jump] button on the ribbon. The jump screen is displayed. 
 

 
Figure 11-46 Jump Screen 

 
Input the step number or label to jump to, and then click the [OK] button. The display jumps to the specified step 
number or label. 



 

11-146  11-146 

 
11.7.4.10. Jump to label / procedure definition line 

If you left-click while holding down the [Ctrl] key for the label name or the procedure name of the instruction editing 
area, jump to the corresponding definition line. 
The robot program language corresponding to this function is as follows. 

 
Table 11-4 Job correspondence table for robot program language 

Program Language Label procedure 
MELFA-BASIC VI ○ ○ 
MELFA-BASIC V ○ × 
MELFA-BASIC IV ○ × 
Movemaster commands  × × 

        ○: Enable ×: Disable 

 
 

Figure 11-47 Jump screen to label definition line 
 
 
11.7.4.11. Partial writing 

Writes the selected program lines to the robot controller. 
This is handy for reflecting the contents of a partially revised program in the robot controller. But be careful, only the 
selected part of the program is written. 
Select the line to write to the robot controller, and click the [Edit] tab -> [Transmission] group -> [Partially] button on 
the ribbon. 
Check the contents to be written, and then click [Yes]. 

 

 
Figure 11-48 Partial Writing 

 

Jump to definition line 

[Ctrl] + Left-click 
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11.7.4.12. Transfer all lines of the program 

Write the all lines of the program to the robot controller. 
With the program opened, click the [Edit] tab -> [Transmission] group -> [All] button on the ribbon. After displaying 
the confirmation message, and then click “Yes”. 
 
 

11.7.4.13. Syntax check 
You can check whether or not an edited robot program is syntactically correct. Execute this before writing a program 
to the robot controller.  
Click the [Edit] tab -> [Command line] group -> [Syntax check] button on the ribbon. If there is a syntax error, the 
error location and details are displayed. 

 

 
Figure 11-49 Syntax Check Results Screen 

 
You can jump to the command statement containing an error by double-clicking the detected error. 
 

Program location (robot controller/PC) 

Error details 

Error content 

Project name Line content 

Number of lines where error was detected 

Program name 

Jump by double-clicking 

Date that syntax check was 
executed 
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11.7.4.14. Command template 

You can display a list of the commands and make insertions on the program command edit screen. 
Click the [Edit] tab -> [Command line] group -> [Template] button on the ribbon. 

 

 
Figure 11-50 Command Template 

 
When you select the template for the selected command from the list, then either click the [Insert Template] button or 
double click, the command is inserted onto the program command edit screen. 
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11.7.4.15. Program template 

You can create a program template containing comments or commands and insert them into the program being 
edited. 
 

 11.7.4.15.1 Create a program template 
 
When creating a program template, click the [File] tab on the ribbon -> [Insert/Edit] in the [Program Template] group 
to start the program template editing screen. 

 
Figure 11-4 Program template file edit  

Click the [Add] button and enter the template name. The created program template will be displayed in the template 
list. 
When appending the comment or the command to the program template, edit it in the state where the template is 
selected in the program template list. 
When the program being edited is saved as a template, please refer to "11.9.4Save as template". 
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 11.7.4.15.2 Insert program template 
You can insert the program template into the program being edited.  
The template can be inserted into the program by clicking the template name from the [File] tab of ribbon-> 
[Insert/Edit] drop-down menu of the [Program Template] group. 
 

 
Figure 11-5 Insert program template file 

 

 

Program template can only be used after MELFA-BASIC V. 
 

Program template can only be used after MELFA-BASIC V.  
MELFA-BASIC IV and MOVEMASTER are not available. 

Caution 
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11.7.4.16.  Batch editing of XYZ position variables and joint position variables  

You can batch-change the position variables in the program being edited and can batch-sum all the values. 
For example, you can add 10.00 to the X components of the P00, P01, P02, P03, and P04. 

 
To perform batch editing using XYZ type position variables, click the [Tool] tab -> [Position variable Batch edit] group 
-> [XYZ variable] button on the ribbon. 
To perform batch editing using joint type position variables, click the [Tool] tab -> [Position variable Batch edit] group 
-> [Joint variable] button on the ribbon. 
To perform batch editing using work coordinate type position variables, click the [Tool] tab -> [Position variable Batch 
edit] group -> [Work coordinate variable] button on the ribbon. 
All position variables contained in the respective program are displayed, and the currently selected position 
variables are displayed at [Target]. 

 

 
Figure 11-51 XYZ Position Data Variable Editing 

 
From the position variable list, select the position variable to change, then add it to the change list with the [->] 
button. 
Input the change value, select the change method [Add] / [Change], and then click the [OK] button. You cannot set 
both [Add] and [Change] for the same element. FLG1 and FLG2 only corresponds to the setting of [Change]. 

 
You can cancel the registration of a position variable for change with the [<-] button. 
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11.7.4.17. Renumbering 

The renumbering function can only be used with MELFA-BASIC IV and Movemaster commands. 
You can renumber line numbers in a batch. You can specify a range for renumbering. 
With the setting dialog, you can specify the start and end line numbers, the new starting line number, and the line 
number interval. 

 
During editing of programs created using MELFA-BASIC IV or Movemaster commands, click the [Tool] tab -> [Line#] 
-> [Renumber] button on the ribbon. The renumber set screen is displayed. 

 

 
Figure 11-52 Renumber Setting Screen 

 

 
 
 
11.7.4.18. Sort 

The sort function is available only with MELFA-BASIC IV and Movemaster commands. 
This sorts the edited program by line number. 
During editing of programs created using MELFA-BASIC IV or Movemaster commands, click the [Tool] tab -> [Line#] 
group -> [Sort] button on the ribbon. The confirmation message is displayed, then the line numbers are sorted in 
ascending order. 

 
Figure 11-53 Sort 

 

 

Sort is available only with MELFA-BASIC IV and Movemaster 
commands. 

 

The sort function is available only with MELFA-BASIC IV and Movemaster commands.  
This function is not available in MELFA-BASIC V and MELFA-BASIC VI. 

Caution 

Renumbering can only be used with MELFA-BASIC IV and 
Movemaster commands. 

 

The renumbering function can only be used with MELFA-BASIC IV and Movemaster commands. 
This function is not available in MELFA-BASIC V and MELFA-BASIC VI. 

Caution 
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11.7.4.19. Comment Selection/Uncomment Selection 

The selected lines are exchanged as a comment by the batch. Or the comments in the selected lines are removed 
comment by the batch. 

 
In the command edit area, select the line to output comments from, and click the [Edit] tab -> [Comment] group -> 
[Comment] button on the ribbon. Comment character “’ “is added to the head of the selected lines. 
You can remove a comment from a selected line by selecting the line to remove the comment from, and clicking the 
[Edit] tab -> [Comment] group -> [Uncomment] button on the ribbon. However, even if you select the line where 
"Rem" command is included, "Rem" is not removed.  

 
 

Figure 11-54 Comment Selection / Uncomment Selection 
 
Example for setting / removing of comment is as follows; 
 

Table 11-5 Example for setting / removing comment 
program language Set comment Remove comment 
 
MELFA-BASIC V 
MELFA-BASIC VI 

 
 

 
Movemaster 
command 
MELFA-BASIC IV 

  
 

 
 
 

Comment Selection 

Uncomment Selection 

Cautions for comment setting/release in programs opened in 
debugging status 
 

When the program is opened in debugging status, it is written to the robot controller as soon as 
the comment is set or removed. If continuous execution is underway, or the robot controller is 
running, an error will be generated. 

Caution 
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11.7.4.20.  Removing comments from all lines in the program 

It is possible to remove comments from all lines in the program. 
 
Click the [Edit] tab -> [Comment] group -> [Remove all] button on the ribbon. 
All comments in the program are removed except "’" (single quotation) and "Rem" commands. 

 

 
Figure 11-55 Removing comments from all lines in the program 

 

 

Remove comments from all line 

Removal process for special comment command "Rem" 
 

A space delimiter must be inserted between the comment command “Rem” and the line 
number or other command. In the case of a Robot Controller, it may judge the comment 
command “Rem” as a comment without space delimiter. But this software judges the comment 
command “Rem” to be a comment if “Rem” is delimited by a space. 

 
If there is a character “Rem” in the command line, this software doesn’t remove the comment 

content. After the processing, these command lines are displayed in the command editing screen. 
Confirm the contents and remove the comment content in the screen. Select the displayed 
command line and click the [Jump] button to jump to command line in the command editing 
screen. 

 
Figure 11-56 List of command line which includes “Rem” that cannot take as the comment 

Caution 
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11.7.4.21. Automatically aligning comment start positions  

All comment start digits currently set in the program being edited can be automatically aligned. 
 
Click the [Edit] tab -> [Comment] group -> [Arrange all] button on the ribbon. 
The start digits of all comments in the program are automatically aligned to the position that was set in the 
[Alignment comments start pos] dialog. Note, however, that lines containing only the comment command are 
excluded from this operation. 

Figure 11-57 Automatically Aligning Comment Start Positions in a Program 
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11.7.4.22. Bookmark 

You can make the cursor jump to a line set with a bookmark later by setting a bookmark to a program being edited. 
This feature is handy for temporarily making a note of lines in the process of being edited and label lines at jump 
destinations. 

 
[Adding a bookmark] 

Add a bookmark with the following procedure. 
Click the command line to set the bookmark to with the mouse, and click the [Edit] tab -> [Bookmark] group -> 

[Add] button on the ribbon. Command lines set with a bookmark are prefixed with a "「 」". 

 
Figure 11-58 Displaying Lines Set with a Bookmark 

 
[Deleting a bookmark] 

To delete a bookmark, click the command line to delete the bookmark from with the mouse, and click the [Edit] 
tab -> [Bookmark] group -> [Delete] button on the ribbon. 
To delete all bookmarks set to a program, click the [Edit] tab -> [Bookmark] group -> [Delete All] button on the 
ribbon. 

 
[Jumping to a line set with a bookmark] 

With a bookmark set in the program, click the [Edit] tab -> [Bookmark] group -> [Previous] or [Next] button on 
the ribbon. The cursor will jump to the previous or next bookmark. 

 
Bookmarks set to programs are valid only while the program edit screen is open. When the program edit screen is 
re-opened, all bookmarks set to the program will be deleted. 
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11.7.4.23. Collapsing command blocks  

When the program being edited contains a command block or a procedure, blocks can be displayed in an 
easier-to-view format as " " (expand state) or " " (collapsed state). The display can be changed to a collapsed 
state or expand state by clicking  or  button. 
 

 
 

Figure 11-59 Collapsed Display of Command Blocks 
 

All command blocks and procedures are displayed in a collapsed state by clicking the [Edit] tab -> [Command line] 
group -> [Collapse all] button on the ribbon. 
All command blocks and procedures are displayed in an expand state by clicking the [Edit] tab ->  
[Command line] group -> [Expand all] button on the ribbon. 
 
 

Procedure 

Click  button 

Click  button 

Command block 
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11.8. Position jump 
It is possible to move the robot to a registered position variable with a specified interpolation movement. 
This function is available when the program is being edited in the online or simulation mode. 
The pair of robot model and robot controller software version that this function can use is as follows. However when 
the program is in the simulation/debug state, you can use this function regardless of the following. 

 
Table 11-6 Robot model and robot controller software version that this function can use 

No. Robot model CR800 CR750/700 CRn-500 

1 Vertical type(6 axis) All version Ver.R3e/S3e or 
later 

Cannot be used 2 Vertical type(5 axis) Cannot be used Cannot be used 

3 Horizontal type(4 axis) All version Ver.R3e/S3e or 
later 

 
However, this function cannot be used with the variable of work coordinate type. 

 

 
Figure 11-60 Position jump 

 
The operation of "Position jump" function is as follows. 

(1) Select the robot. (In case of multiple robots) 
(2) Select a position variable to move. 
(3) Click the [Pos. Jump] button on the program edit screen or click the [Pos. Jump] button in the [Edit] tab -> 

(3) 

(4) 

(5) 

(6) 

(1) 

(2) 

(3) 
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[Position Variable] group from the ribbon. 
(4) Fine adjust the coordinate to be moved. By click the [Offset Reset] button, you can return the input value of 

the offset to 0. 
(5) Select the interpolation movement. (MOV: Joint interpolation movement, MVS: Linear interpolation 

movement, Direct movement (only for simulation)) 
(6) Click the [Move] button. 
(7) If moving the actual robot, a warning message is displayed. If moving the robot in a simulation, it is moved 

without a warning message. 
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11.9. Saving Programs 
Always save the edited program. 
There are three methods for saving: saving, saving to computer, and saving to robot controller. 

 

 
 
 

11.9.1. Save  

Saves the program being edited under its current name. 
To save a program, click the [File] tab -> [Save] group -> [Save] button on the ribbon. 

 
If you are editing a program on a robot controller, the "Save Items" setting screen is displayed. Set the items to write, 
and then click the [OK] button. 
For details on "Save Items", see "11.9.5 Items written when saving in robot". 
 

 
Figure 11-61 Writing Items 

 

Do not write a program with duplicate step  
numbers to the controller. 

 

Even programs with duplicate step numbers or that are still being edited and are not yet 
syntactically correct can be saved on the computer. However, be careful not to copy or otherwise 
transfer such a program to a robot controller with the program management functions. 

If a program with duplicate step numbers is written to the robot controller, the duplicate step lines 
will be overwritten. 

Caution 
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11.9.2. Saving on computer 

Saves the program being edited to the computer. At this time, you can set a new program name. 
Click the [File] tab -> [Save] group -> [Save As -> PC...] button on the ribbon. 

 

 
Figure 11-62 Saving on Computer 

 
Input the robot program name, and then click the [OK] button. 
 

 
 

 

About program names disabled on PC 
 

A Windows error will occur when the name of a program in the robot controller has same name 
as a “reserved word” in Windows. To solve this problem, it is necessary to change the program 
name in the robot controller. 

The “Reserved words” are special words used by Windows system. Therefore, it is impossible to 
use these words as a file name on a PC. The following words are “Reserved words”. 

 
AUX, COM1 to 9, CON, LPT1 to 9, NUL, PRN 

Caution 

Folder in which programs are stored 
 

Programs on the computer are managed in units of workspace projects. The folder they are 
stored into is workspace writing folder/project name/Program. 

To store into another folder, first store in this folder, then copy to the desired folder with the 
program management copy function. 

Caution 



 

11-162  11-162 

 
11.9.3. Saving in robot controller 

Saves the program being edited to the robot controller under a new name. You can set a new program name at this 
time. 
Click the [File] tab -> [Save] group -> [Save As -> Robot...] button on the ribbon. The "Save Items" setting screen is 
displayed, so set the save items, then click the [OK] button. 
For details on the "save items", see "11.9.5 Items written when saving in robot". 
 

 
 

Figure 11-63 Saving on Robot Controller 
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11.9.4. Save as template 

Save the edited program as a template. At this point, the program name can be newly created. 
Click [File] → [Save] group on the ribbon - [Save As Template]. 
 

 
Figure 11-6 Save as template 

 
Enter the program template name and click [OK]. 
 

 
 

 

About the computer cannot process the template name. 
 

If the program template name is the same as "Windows reserved word", it will be wrong when 
saving. 

"Reserved word" has the following character string. 
AUX、COM1～COM9、CON、LPT1～9、NUL 、PRN 

 

Caution 

The program template can be used after  MELFA-BASIC V. 
 

The program template can be used after  MELFA-BASIC V and it can not be used with 
MELFA-BASIC IV and MOVEMASTER. 

Caution 



 

11-164  11-164 

 
11.9.5. Items written when saving in robot 

When saving a robot program in a robot controller, write items can be set by categorizing them into instructions, 
position variables and program external position variables. 
 
This save item default values for when you have read a robot controller program are the same as the "Read Items" 
when you read the program.   When you have created a new program or opened a program on the computer, the 
display becomes as in "Save Item". 

 

 
Figure 11-64 Save Items 

 
We will explain the operations for saving to a robot when only command lines or only position variables are specified, 
using the following example for illustration. 
 

 

Example:  When there are programs in program editing on the computer or in 
the robot controller 

 

 

 

 

 

 

 

 

 
(1) When only command line written 

 

 

 

 

 

 

 

 

 
(2) When writing position variable only 

 
<<Program in the robot controller >> 

10 Mov P1 
20 Mov P2 
30 Mov P3 
40 End 
P1= (400.000,   0.000, 100.000,-90.000) (4, 0) 
P2= (   0.000, 400.000, 150.000, 0.000) (4, 0) 
P3= (-351.700, -49.370, 22.000,-95.170) (0, 0) 
P4= (276.500,-599.070, 264.970, 29.170) (0, 0) 
P5=( 535.790, 295.020, 102.000…148.420)(0,0) 

<<Program in the robot controller>> 
10 Mov P1 
20 Mov P2 
30 Mov P3 
40 End 
P1= (400.000,   0.000, 100.000, 90.000) (4, 0) 
P2= (   0.000, 400.000, 150.000, 0.000) (4, 0) 
P3= (-351.704, -49.369, 22.000,-95.168) (0, 0) 
P4=( 276.499,-599.066, 264.966, , , 29.170)(0,0) 
 

<< Program on computer >> 
100 Mov P1 
200 Mov P2 
300 Mov P5      ‘<- Change 
400 End 
P1= (400.000,   0.000, 100.000,-90.000) (4, 0) 
P2= (   0.000, 400.000, 150.000, 0.000) (4, 0) 
P3= (-351.704, -49.369, 22.000,-95.168) (0, 0) 
P5= (535.786, 295.021, 102.000, 148.420) (0, 0) 

<<Program in the robot controller>> 
100 Mov P1 
200 Mov P2 
300 Mov P5 
400 End 
P1= (400.000,   0.000, 100.000, 90.000) (4, 0) 
P2= (   0.000, 400.000, 150.000, 0.000) (4, 0) 
P3= (-351.700, -49.370, 22.000,-95.170) (0, 0) 
P4= (276.500,-599.070, 264.970, 29.170) (0, 0) 

Changing only the command line 

The position variables are not 
changed. 

The command line is not changed. 

The position variables on the computer are 
overwritten.  However, position variables 
that are in the robot controller, not on the 
computer, are left as is.  (Reference) 
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Timing at which program external position variables are written. 
 

The timing at which the program external variables can be backed up is at the next time the 
power supply is turned ON. 

Turn on the controller power again to use the program external position variable written in the 
controller. 

Caution 
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11.10. Program Printing 
You can print programs you have written.  
 
 
11.10.1. Checking a print image 

You can display a print image of the program on the screen. 
Activate the program to print, and click the [Home] tab -> [Print] group -> [Print preview] button on the ribbon. The 
print image for currently active program is displayed. 
 
 
11.10.2. Printing a program 

Activate the program to print, and click the [Home] tab -> [Print] group -> [Print] button on the ribbon. The currently 
active program can be printed. 
 
 
11.10.3. Program print settings 

You can customize the pages the program is printed with. 
Clicking the [Home] tab -> [Print] group -> [Print Setup] button displays the Page Setup screen. 
In this screen, you can set the file name, print date, whether or not to print the page No., whether or not to perform 
position variable formatting, whether or not to print a variable list, line pitch, and margins. 

 
Figure 11-65 Page Setup for Printing 
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11.10.3.1. Position variable formatting 

You can print position variables in the program to print formatted in an easy-to-view format the same as the screen. 

 
Figure 11-66 Printing Position Variables with Formatting 

 

Unchecked 

Checked 
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11.10.3.2. Variable list 

Variable names and comments can be extracted from the program being edited and printed as a variable list. 

 
Figure 11-67 Printing the Variable List 
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11.11. Program Debugging 

You can debug robot programs you have written. 
 

 
 
 
11.11.1. Starting debugging 

There are two ways of opening the robot program in the debug mode, from the project tree or by migrating the 
program being edited to the debug mode. 

 
[Method (1)] Opening the program in the debug mode from the project tree 

Select the program from [Online] or [Simulation] -> [Program] in the project tree, and click the mouse right 
button. If you click [Debug Open] from the right button menu, the program will be opened in the debug mode. 

 
Figure 11-68 Opening a Program in the Debug Mode from the Project Tree 

 

Debugging is for programs on a controller or on a virtual controller 
with a simulation running. 

 

When debugging, use a program on a controller or on a virtual controller with a simulation running.  
You can not debug a program stored on a computer. 

Caution 
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[Method (2)] Migrating the program being edited to the debug mode 

During editing of the program, click the [Debug] tab -> [Start/Stop] group -> [Debug start] button on the ribbon. 
The program being edited will be saved once and then will migrate to the debug mode. 

 
Figure 11-69 Migrating the Program Being Edited to the Debug Mode 

 
Once a program is opened in the debug mode by either of these methods, the execution line cursor " " will be 
displayed at the left edge of the command edit area. The line on which this execution line cursor is displayed is the 
line currently being executed. 
The display of this execution line cursor can be switched on/off with the menu bar [Debug] -> [Display/Do not display 
Execution Line]. 

 
If you debug a program which is set with “Read protection” (displaying  on the project tree), release it with 
reference to “11.12 Set / Release read protection” before you open the program in debugging. 
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11.11.2. Executing programs step by step 

 
 

A program that has been opened in debugging status can be run step by step. 
When a program opened in debug mode, operate with the [Operating panel] screen which is shown at the same 
time. 

 
For details on step operation on the operation panel, refer to "20.2.4 Step operation". 
 
 
11.11.3. Revising programs 

The command statements for a program that has been opened in debugging status cannot be edited in the 
command edit area. Command statements can be corrected from the [Edit] tab on the ribbon. Command 
statements can be edited by the [Edit] tab -> [Debug edit] group -> [Edit] button, [Debug edit] group -> [Insert] 
button and [Debug edit] group -> [Delete] button on the ribbon. 
Position variables can be edited as usual. 
 

 
Figure 11-70 Ribbon [Edit] Tab -> [Debug edit] Group 

 
(1) Edit command line 

You can edit the contents of the specified command line. 
Click the command line to edit with the mouse, and click the [Edit] tab -> [Debug edit] group -> [Edit] button on 
the ribbon. The screen for editing the command line is displayed. 

 

 
Figure 11-71 Command Line Editing (Online) 

 
Revise the command line, and then click the [OK] button. 
 
(2) Insert command line 

You can insert a command statement at the specified line. 
Click the line to insert the command statement into with the mouse, and click the [Edit] tab -> [Debug edit] 
group -> [Insert] button on the ribbon. The screen for inserting the command line is displayed. 

 

In program debugging, the robot may operate at 100% speed. 
Pay attention to safety around the robot. 
Also, keep a T/B handy and use the robot in a status in which an 

emergency stop can be made at any time. 

Danger 
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Figure 11-72 Command Line Insertion (Online) 

 
(3) Delete command line 

You can delete the specified command line. 
Click the line to delete the command statement from with the mouse, and click the [Edit] tab -> [Debug edit] 
group -> [Delete] button on the ribbon. The confirmation screen for the command line deletion is displayed. 

 

 
Figure 11-73 Confirming Command Line Deletion 

 
(4) Edit position variables 

For details on the method for editing the position variable, see "11.7.3 Position variable editing". 
 

 
 

 
 
 
11.11.4. Setting and deleting breakpoints 

You can set breakpoints in the online program. 
If you set a breakpoint, when you open the program in debugging status you can stop the program at the line 
while executing the Continuous execution. After stopping, you can execute the program continuously. 

 
Up to 128 breakpoints can be set. Even when you close the program, the settings are retained until you go 
offline. 
There are the following two types of breakpoints. 

Permanent breakpoint  : The breakpoint is maintained after stopping. 
One-time breakpoint  : At stop, the breakpoint is automatically deleted at the same time as the 

stop. It will be canceled when you close the program. 
 
Breakpoints can also be set during online program editing. (Continue breakpoint only) The breakpoint that is 

set will be handed over to debugging as well. All settings are canceled when you go offline. 

Partial writing cannot be performed while editing a program in 
debugging status. 

 

Caution 

Be careful when changing the value of a variable. 
 

When you change the value of a variable, the operation target position of the robot may change 
and result in a collision. This is particularly dangerous during robot operation, so check carefully 
before changing the value of a parameter. 

Caution 
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11.11.5. Set a Breakpoint 

Set a Breakpoint 
Set a breakpoint by the following procedure. 
1) Move the cursor to the command line where you want to set a breakpoint, click [Debug] -> 

[Breakpoint] group-> [Set] on the ribbon, or click the left side of the command line to be set. 
 

2) The breakpoint setting screen is displayed during debugging. 
Select the type of breakpoint to set, and then click the [OK] button. The breakpoint is set at the 
specified command line. 

 
Figure 11-74 Setting a Breakpoint 

 
3) " " is displayed at the left end of command lines at which breakpoints are set. 

 
Figure 11-75 Display of Lines with Breakpoints Set  

 
11.11.5.1. Delete a Breakpoint 

Delete a Breakpoint 
To delete the breakpoint, the cursor moves to the command line where the breakpoint is to be deleted.  
 
Click [Debug] -> [Breakpoint] group -> [Delete] on the ribbon, or click on the left side of the command line 
to be deleted. 
 
To delete all breakpoints set to a program, click the [Debug] tab -> [Breakpoint] group -> [Delete All] button 
on the ribbon. 
 
The setting and delete of the breakpoint can also be operated through the buttons on the ribbon. 

 
 

Breakpoints are available only with MELFA-BASIC V and 
MELFA-BASIC VI. 

Caution 
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11.11.6. Ending debugging 

When debugging is finished, click the " " button at the top right of the program edit screen opened in the debug 
mode or the [Debug] tab -> [Start/Stop] group -> [Debug stop] button on the ribbon to close the program. When 
debugging is stopped by the [Debug] tab -> [Start/Stop] group -> [Debug stop] button on the ribbon, the program 
is reopened in an editable state. 

 
Figure 11-76 Closing a Program Opened in Debug Status 

 
 

At this time, if the program has been changed, a confirmation message is displayed asking if you want to save 
the changed contents. 

 

 
Figure 11-77 Confirmation Message for Saving the Changed Contents 

 
Here, if you select "No", the changed contents are all discarded. To put the changed contents into effect, always 
select "Yes". 
 

This closes the program 
opened in debugging status. 

Reopens the program in an editable 
state after the program that was 
opened in the debug mode is closed 



 

11-175  11-175 

 
11.12. Set / Release read protection 
If you set read protection in the robot program, you can make sure a third party can’t read it easily. This function 
is available in controller software Ver.R5n/S5n or later of CR750-D/Q and CRnD/Q-700 series and all controller 
software versions of CR800D/R/Q series. 

 is displayed on the project tree on programs set with read protection. If you set read protection, you can 
restrict the following operations. 

- Opening a program (You can restrict the viewing or modification of the program content) 
- Starting debug of a program 
- Copy / Move / Delete / Rename / Compare a program 

 
If you set / release reading protection of a program, use the program management screen with reference to 
“11.13.6 Protect settings” or select [Set / Release reading protection] on the project tree. 
 

 
Figure 11-78 Set / Release reading protection operation on the project tree 

 
 



 

11-176  11-176 

 
11.13. Program Management 
You can copy, move, delete, compare the contents of, rename, and set protection for robot programs. 
 
From the project tree, select the target project program, then click the right mouse button. 
The right button menu is displayed. Select [Manage Programs]. The manage programs screen is displayed. 

 

 
Figure 11-79 Starting Program Management 

 

 
All the operations of these functions are for robot programs. 

 

Caution 
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11.13.1. Program list display 

The left and right lists display the designated folders and the programs inside the robot controller. 
 
(1) Project You can specify projects in the workspace. 
(2) Robot You can specify the robot controller that is currently connected. 
(3) […] button When you select [Project], you can specify any folder on the computer. 
 

 
Figure 11-80 Program List Display 

 
 

(1) Project 

(2) Robot 

(3) When selecting a 
folder on the 
computer 
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11.13.2. Copy 

This copies program files. Copying of the entire program file or only the command statements or only the position 
variables are possible. 
Select the transmission source program names from the list at the left, and designate the transmission 
destination folder on the right side. Multiple transmission source programs can be selected at the same time, but 
only one program must be selected when copying with a name change. Copying is executed when the [Copy] 
button is clicked and [Setting for copy] dialog is set. 

 
Figure 11-81 Copy Setting Screen 

 
It is possible to copy by using the project tree. 
 

 
Figure 11-82 Copying the program by using the project tree 

 
A program set with “Read protection” can only be copied to the identical controller. 
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It is possible to copy by drag and drop the project name on the project tree. 
 

 
Figure 11-83 Copying the program by drag and drop in the project tree 

 
Programs displayed on the desktop or in Windows Explorer also can be copied by dragging and dropping. 

 
Figure 11-84 Copying Programs Outside of Workspace by Drag and Drop 

 

 
 
 
11.13.3. Move 

The program files can be moved. 
Select the transmission source program names from the list at the left, and designate the transmission 
destination folder on the right side. Multiple programs can be selected at the same time. Movement is executed 
when the [Move] button is clicked. 
 
Programs set with “Read protection” cannot be moved. 

Drag 
and 
drop 

Drag and drop 

Program copy is the only operation possible in drag and drop. 
However, copying with name change cannot be done. 

 

Program copying is the only operation possible by drag-and-drop. However, the copy that changes 
the name cannot be done. 

When changing the program name and moving the program, do so on the program management 
screen. This operation is not possible for programs set with “Read protection”. 

Caution 
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11.13.4. Delete 

The program files can be deleted. 
Select the names of the programs to be deleted from the lists. Multiple programs can be selected in the Source 
and Destination lists. Select the program name in the Source and Destination lists, and click the [Delete] button 
under these lists. The deletion confirmation message is displayed. 

 
Figure 11-85 Deleting the program 

 
It is possible to delete the program by operating shown blow. 
After selecting the program name in the project tree, click the right button of mouse and select the "Delete 
Program" of right button menu.  The deletion confirmation message is displayed.  

 

 
Figure 11-86 Program deletion by using the project tree 

 
A program which is set with “Reading protection” cannot be deleted. 

 

 
Once the program files are deleted, they cannot be recovered. 

Caution 

It is not possible to delete the program which is being edited.  
When you delete the program which is being edited, an error message is displayed. Finish the edit 

before deleting the program. 

Caution 
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11.13.5. Rename 

This renames a program file name. 
Select the name of only one program to be renamed from the lists. Programs can be selected in the Source and 
Destination lists. Click the [Rename] buttons under the Source and Destination lists, set the new name in the 
[Setup for Rename] dialog, and click the [OK] button to rename the program. 
 

 
Figure 11-87 Rename Screen 

 
A program which is set with “Reading protection” cannot be renamed. 
 
 
11.13.6. Protect settings 

The program files in the controller can be protected. Settings can be made to protect the entire program file or 
just the command statements or position variables, as well as protection against readout, and protection release 
is possible 
You cannot move, delete, or rename a protected file. Release the protection prior to any of these operations. 
Select the names of the programs to be protected from the lists. Multiple programs can be selected in the Source 
and Destination lists. Click the [Protect] buttons under the Source and Destination lists, set the protect details in 
the [Setting for protect] dialog, and click the [OK] button to protect the program details. 
 

 
Figure 11-88 Protect Settings Dialog 

 

 
 

If you change the “Read protection status, the following “Register a reading password” or “The reading password 
delete” screens are displayed. Input the password to register or delete and click the [OK] button. 

 

The only programs to which protect operations apply are programs in robot 
controllers. 
 

Caution 
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Figure 11-89 Register a reading password Dialog 

 

 
Figure 11-90 The reading password delete Dialog 

 
 
11.13.7. Comparison 

The program files can be compared. Comparison of only the command statements or only the position variables 
is possible. Select the names of the programs to be compared from the left and right lists. A dialog displaying the 
corresponding comparison results will appear when the [Compare] button is clicked and the [Setting for compare] 
dialog set. The results are shown in the [Compare result] dialog. 
The selected program can be opened in the program edit screen by selecting the program line by the list controls 
on either the left or right, and clicking the [Edit] button or double-clicking the program line. 
 

 
Figure 11-91 Program Comparison Settings and Comparison Results 

 
A program which is set with “Read protection” cannot be compared. 
 

(2) 

(4) (3) 

(1) 
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You can select the background color of matching, mismatching and deleted lines. 

 
Figure 11-92 Setting the Color for Program Comparisons 

 
Move the selected line to the change location (mismatch or delete). 
Clicking the [Prev] button selects the change location in the line before the current position. 
Clicking the [Next] button selects the change location in the line after the current position. 
 
By the [Different lines only] checkbox, you can select to display all lines targeted for comparison or only different 
lines. 
 

 
Figure 11-93 Compare Results (Different Lines Only Display) 
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By the [Without comments] checkbox, you can select to exclude or include comments in the compare result. 
 

 
Figure 11-94 Compare Results (With Comments Excluded) 

 
 
11.14. Program Conversion 
Existing offline robot programs created in a different program language can be converted to the currently set 
program language. 

Table 11-7 Combination list of program conversion 
No. Source Target Content 

1 MELFA-BASIC III MELFA-BASIC IV The position data is converted. 
If “MELFA-BASIC V” is chosen for the 
target, the lines No. are also converted in 
addition to this conversion. 2 MELFA-BASIC III MELFA-BASIC V 

3 MELFA-BASIC IV MELFA-BASIC V/VI The lines No. are converted. 

4 MOVEMASTER command 
(CR-116/356) MOVEMASTER command The position data is converted. 

 
There are the following two types of conversion. 
For details, see "11.14.2 Converting line Nos. (from MELFA-BASIC IV to MELFA-BASIC V or VI)", "11.14.3 
Position data conversion (from E/EN/M1/M2 series to CR800/750/700/500 series)". 

 
(1) Conversion of the line Nos. 

Converts the line Nos. and relevant command line, because the handling of line Nos. in MELFA-BASIC 
IV is different from MELFA-BASIC V/VI. 

 
(2) Conversion of the position data 

Converts the format of position data and relevant commands, because the configuration of the 
E/EN/M1/M2 E/EN/M1/M2 series controller’s position data is different from the CR800/750/700/500 
series controller’s. 
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11.14.1. Starting program conversion 

From the project tree, select the conversion destination project with [Offline] -> [Program], then click the right 
mouse button. From the right mouse button menu, click [Program Convert]. 
The destination is in the program language set for this project. 
 

 
Figure 11-95 Starting Program Conversion 
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11.14.2. Converting line Nos. (from MELFA-BASIC IV to MELFA-BASIC V or VI) 

Converts the line Nos. and relevant command lines, because the handling of line Nos. in MELFA-BASIC IV is 
different from MELFA-BASIC V/VI. 
 
For the MELFA-BASIC V/VI, conversion is as follows. 
- The line Nos. are converted to step Nos. (Sequential No. starting from 1). 
 

 
 

- Line No. jumps are converted label jumps. 
 

 
 
Convert the program according to the following procedure. 

 
Figure 11-96 Conversion from MELFA-BASIC IV to MELFA-BASIC V/VI 

 
(1) Select the program language of the source and target for conversion. 

Startup program conversion in the project set with "MELFA-BASIC VI" or "MELFA-BASIC V". 
Choose “MELFA-BASIC IV” for the source and choose “MELFA-BASIC V/VI” for the target. 
It is NOT necessary to select the robot axis. 

(2) 

(3) 

(4) 

(1) 

100 MOV P1 
110 MVS P2 
120 GOTO 100 

: 

1 *LB00001: MOV P1 
2 MVS P2 
3 GOTO *LB00001 

: 

*LB00001 is the label name created automatically by this conversion. 

100 MOV P1 
110 MVS P2 
120 MOV P3 

: 

1 MOV P1 
2 MVS P2 
3 MOV P3 

: 
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(2) Designate a source file. 

Click the [Select] button of the source, and designate the MELFA-BASIC IV program file. 
 

 
 

(3) Input the name of the file to save the converted program into. 
 

(4) After designating the conversion source file and the conversion destination file, click the [Convert] 
button or the [Convert & Open] button. 
When [Convert] button is clicked, the designated selected file is converted and written in the target file. 
When [Convert & Open] button is clicked, the file is converted, written in the target file and opened 
through a Program edit tool. 
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11.14.3. Position data conversion (from E/EN/M1/M2 series to CR800/750/700/500 

series) 

This function converts the format of position data and the relevant commands (DJ, MP and PD MOVEMASTER 
commands), because the configuration of the E/EN/M1/M2 series controller’s position data is different from the 
CR800/750/700/500 series controller’s. 
 
 
Note1: The program conversion converts the position data as well as the commands related to the position 

data. It is not possible to convert commands automatically. Be sure to make a syntax check using this 
software before using the E/EN/M1/M2 series program with the CR800/750/700/500 series, and 
change the commands if necessary. 

 
Note2: The position data of the MOVEMASTER command programs for the M1/M2 series has the 

base-coordinate rotated 90º. When using the program for M1/M2 with the CR800/750/700/500 series, 
convert M1/M2 program into an EN program with the E/EN/M1/M2 series support software DOS version, 
before carrying out the program conversion. 

 
Note3: In the case of the E/EN/M1/M2 series support software DOS version and E/EN series Robot 

programming PC support software for Windows, the data can be saved separately such as command 
sentence only, position data only, or command sentence and position data. In this program conversion, 
it is possible to convert the file of command sentence only and the file of position data only to one 
program. The other combinations occurs error. (As following case 3 to 7.) 

 

Position data only

Command sentence only

Program

OK

NG

Case 1:

Case 2:

Case 3:

Case 4:

Program
conversionPosition data

Command
sentence

+ Program

OK

Program
conversion

Program
conversion

Program
conversion NG

Case 5:

Program
conversion NG

Case 6:
Program

conversion NG

Case 7:
Program

conversion NG

Position data

Command
sentence

+

Case 3:

Position data

Command
sentence

+

Case 4:Case 3:

Position data

Command
sentence

+

Case 5:Case 4:Case 3:

Position data

Command
sentence

+

Command sentence only

Command sentence only

Command sentence only

Position data only

Position data only

Position data only

Case 3:

Case 4:

Case 5:
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Convert the program according to the following procedure. 

 
Figure 11-97 Conversion from MELFA-BASIC III to MELFA-BASIC IV 

 
(1) Select the program language of the source and target for conversion. 

Startup program conversion in the project set with one of "MELFA-BASIC VI", "MELFA-BASIC V" or 
"MELFA-BASIC IV", and set the copy destination. 
For the source, choose “MELFA-BASIC III” or “MOVEMASTER (CR-116/356)” which is the program 
language of the E/EN/M1/M2 series. 
If “MELFA-BASIC V/VI” is chosen for the target, the line Nos. are also converted in addition to this 
conversion. 
 

(2) Select the robot axes. 
Select the correct number of axes, as the configuration of the E/EN/M1/M2 series controller’s position 
data is different depending on the number of axes. 

 
(3) Select the source file(s). 

Click the [Select] button for the conversion source, and select the E/EN/M1/M2 series program file(s). 
When selecting the multiple files, click the file while pushing the [Ctrl] key. 
 

 
 

(4) This specifies the file to write the converted program into. 
Input the name of the file to save the converted program into. 

 
(5) After designating the conversion source file and the conversion destination file, click the [Convert] 

button or the [Convert & Open] button. 
When [Convert] button is clicked, the designated file is converted and written in the target file. 
When [Convert & Open] button is clicked, the file is converted, written in the target file and opened in the 
Program edit tool. 

 

(2) 

(3) 

(4) 

(5) 

(1) 
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11.15. Position data editing for SQ Direct 
SQ Direct File is available in all versions of CR800-R/CR800-Q series controllers and in software version N8 or 
later on CR750-Q/CRnQ-700 series controllers. To use this function, you must set the parameter of controller. 
Available position data for SQ Direct is only 999 points of XYZ-origin whose position number is 1 to 999. 
These numbers are used as external position number P_DM (1) to P_DM (999) in controller. 
 
SQ Direct position data can edit online and offline. 
In the position data editing screen for the SQ Direct, command lines and joint (J) /work coordinate (W) variable 
lists are omitted unlike the program edit screen. 
 

 
Figure 11-98 Program editing and position data editing screen for SQ Direct  

 

 

As editing SQ Direct is similar to XYZ coordinate editing in program editing, the following page explains 
only the different function. For details on the operations for opening a program, see 11.7 Program 
Editing. 

Caution 

When the password is registered in “program” by robot controller's 
security function, the position data for SQ Direct cannot be read or written. 
When the password is registered in “program” by the robot controller's security function, the position 

data for SQ Direct cannot be read from the robot controller or written to the robot controller. 
 

○ : Enable、 × : Disable 
  Item to which password of security function is registered. 

Program Parameter File 
Position data writing 

× ○ ○ Position data reading 
 

Delete the password of the robot controller's security function when you operate these. Refer to 
"16.5.3 Delete Password" for the method of deleting the password.  
For details on setting security functions (registering passwords) and releasing security functions 
(deleting passwords) on robot controllers, refer to "Table 16-12 Compliant version of this function 
and controller". 

Caution 
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11.15.1. Differences with program editing 

11.15.1.1. Edit position data 
There are two ways of changing the position data. 
[Method (1)] Directly change the list 
Select the cell you want to change on the list, and enter the value directly. 

 
Figure 11-99 Changing the Position Data by Directly Editing the List 

 
[Method (2)] Change in the Edit Position data screen 
Select the target position data to be changed from the list and click the [Edit] button. The selected position data is 
displayed in the Edit Position data screen. Enter each of the element values of the position data, and click the 
[OK] button. 

 
Figure 11-100 Changing the Position Variable in the Edit Position Data Screen 

 
The variable name (position No.) cannot be changed by either method. 
When the program is being edited in the online or simulation mode, the current position of the robot can be read 
by the [Get current pos.] button. 

The variable type cannot be switched. 

The variable name (position No.) cannot 
be changed. 

Select cell and enter 
the value directly 

The variable name (position No.) cannot 
be changed. 
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Figure 11-101 Getting the Current Position 
 
 

11.15.1.2. Initializing position data 
Select the target position data to be initialized and click the [Initialize] button. The selected position data is 
initialized. Multiple position data can also be initialized at the same time. When you click position number with 
[Ctrl] or [Shift] key pushing, you can select plural position data. 
 
 

11.15.1.3. Editing support function 
The editing support function supports only copying and pasting of position data. 
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11.15.2. Online editing 

When you connect to controller supported SQ Direct, [SQ Direct] menu is added to [Online] menu in project-tree. 
When you double-click [Online] -> [SQ Direct] in the target project, 
SQ Direct screen is displayed with position data 1 to 999 loaded. 

 

 
Figure 11-102 position edit screen for SQ Direct (Online) 

 

 
 

Timing from which position data is written. 
 

The timing at which the position data is written by the controller is at the next time the power 
supply is turned ON. 

Turn on the controller power again to use the controller's position data after online edit. 

Caution 
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11.15.3. Offline editing 

You can edit SQ Direct position data in offline. 
Set [R/C-Type] to [CR800-R/CR800-Q/CR750-Q/CRnQ-700] and set [Language] to [MELFA-BASIC 
V/MELFA-BASIC VI] in [Edit Project], then [SQ Direct] menu is added to [Offline] menu in project-tree. 
You can manage plural SQ Direct files in offline editing. 
 

11.15.3.1. Creating a new SQ Direct file 
 

Select [Offline] -> [SQ Direct] menu in the project you want to create the new SQ Direct File. 
And click a right button with the mouse. 
Then right button menu is displayed, and click [New]. 

 

 
Figure 11-103 In the computer to create a new 

 
Input the SQ Direct file name and click the [OK] button. 
 

 
 

About SQ Direct restoration folder. 
 
SQ Direct Files are managed by each project in the personal computer. The folder named 
automatically as follows. 
  Workspace folder/project name/Program 
If you want another folder, use the copy function in program management. 

Caution 
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11.15.4. Program management  

You can copy, delete, compare and rename SQ Direct file. 
 

After selecting target program in project-tree, and click right button with the mouse. 
Then right button menu is displayed, and click [Program Manager]. 
Then the program manager screen is displayed. 

 

 
Figure 11-104 Launch program manager 

 
 
 
 
 
 
 
 

As the edit operation is similar to program management, the following page explains only different 
parts.  

Caution 

 
Position data 1 to 999 in the robot files for SQ Direct is shown as [*SQ Direct] in the program 
manager. 
“ * ” is to prevent customer from using as a file name by mistake. 
Keep in mind that this differs in meaning from the “*” indicating “all”. 

Caution 
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11.15.4.1. List of SQ Direct files 

When using SQ Direct, there are some differences in the program management screen. 
1. SQ Direct files in the project are displayed with the [sdp] extension. 
2. SQ Direct files in the robot file are displayed as [*SQ Direct]. 
3. [SQ Direct position (*.sdp)] is added in file type. 

 

 
Figure 11-105 List of SQ Direct files indication 

 

1. SQ Direct 
files in the 
project. 

3. File type 
2. SQ Direct file in 

the robot files. 
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 Restrictions 
 

SQ Direct files in the personal computer are handled similarly to as robot program files, but there are some 
restrictions. 
 

 
 

There are some limitations to operate SQ Direct Files. 
 
SQ Direct file names are fixed as [*SQ Direct] in the controller.  
File names can set freely in the project. But sdp is the only extension. 
 
 
○ : Operable × : NOT operable 
 

Function 
Operable 

Robot Project 

new × ○ 

open ○ ○ 

delete × ○ 

init ○ × 

protect × × 

rename × ○ 

compare ○ ○ 

 

Function Operable Remarks 

Copy 

robot to robot ×  

robot to project ○ Rename file to copy. 
Multiple files cannot be copied. 

project to robot ○ 
File name of controller is fixed as [*SQ 
Direct]. 
Multiple files cannot be copied. 

project to project ○ Rename the file to copy the same 
project. 

Move 

robot to robot ×  

robot to project ×  

project to robot ×  

project to project ○  

 

Caution 
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12. Create visual program 
This section describes how to edit the visual program. You can directly edit the program in the robot controller or 
edit the program saved in the personal computer. 

 
The visual program makes the robot program used in RT VisualBox (for MELFA ASSISTA) can be easily created 
by visually expressing it. With RT ToolBox3 2.00A or later, visual programming is possible even with the FR 
series. 
 

 Model 
Supported 

models 
MELFA ASSISTA 
All models of CR800-D/R/Q Ver.B1 or later (When using MELFA BASIC VI) 

 
Visual programs and workspaces created with RT VisualBox can be used with RT ToolBox3. 

 
 
12.1. Difference from RT VisualBox 
RT VisualBox is a product prepared to easily start MELFA ASSISTA. 
The differences between RT ToolBox3 and RT VisualBox are as follows: 
 

 

・RT VisualBox is a product specialized for MELFA ASSISTA. When using 
MELFA ASSISTA, it is recommended to use RT VisualBox. 
・RT ToolBox3 and RT VisualBox cannot be started at the same time. 

Caution 

Initial setting function of RT Visual Box 
 

The initial settings of the robot that are displayed when RT VisualBox connects to the robot for the first 
time are not provided in RT ToolBox3. Change various parameters to make the initial settings for the 
robot. 

 
RT Visual Box safety setting function 

 

For safety settings, please read “14.9 Parameters of Safety (CR800)” in RT ToolBox 3. 
 
RT VisualBox Maintenance function 

For the maintenance function of RT VisualBox, please read “18 Backup and Restore”， 
“16 Maintenance”，“14 Setting Parameters”. 

 
Vision settings cannot be made with RT ToolBox3. 

You cannot set the vision, arrange or edit the vision block with RT ToolBox3. Editing other than the 
vision block is possible for the visual program in which the vision block is placed in RT VisualBox. 

 
Visual programs for which program execution is set in the calculation 

block of RT ToolBox3 cannot be used in RT VisualBox. 
 

In RT VisualBox which does not have the editing function of MELFA BASIC, it is not possible to edit 
the visual program for which the program execution is set in the calculation block. 

 
RT ToolBox3 cannot be used on a touch panel.  

RT ToolBox3 is not compatible with touch panels. Please use a mouse. 
 

Difference from RT Visual Box 
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12.2. Enable editing of visual programs 
The visual program is initially set to "Not use". 
 
When using visual program, set it on the Option screen below. To display the Option screen, select the 
[Workspace] tab → [Option] menu on the ribbon. 
You can use visual program by checking [Use] under [Visual Program] in the [Program Editing] category and 
restarting RT ToolBox3. 

 
Figure 12-1  Use visual program 

 
When you enable editing of the visual program and connect online with the robot controller, the robot program 
named “MVP ***” format is transferred. 
Do not delete or rename these programs as they are required to run the visual program. 
 

 
Figure 12-2  Programs transferred when online 

 

Check ON 

Transferred program 
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12.3. Create New 
When creating a new program, "PROGRAMn" (n is an integer starting from 1) is given as a temporary program 
name. 
If "PROGRAMn" already exists, increase the value of n to give it a program name that does not exist. 
 
12.3.1. Create new on the computer 

Select [Offline]-> [Visual Program] for the new project, and click the right mouse button. 
When the context menu is displayed, click [New]. 

 
Figure 12-3  Create new on the computer 

 

 
 
 

About the program save destination folder 
 

Programs on the computer are managed on project unit of the workspace. The save destination is 
  Workspace create folder\Project name\Program 
. 
To save to any folder, use the copy function of Program Management to copy. 

Caution 
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12.3.2. Create new in the robot controller 

Select [Online] or [Simulation] → [Visual Program] for the new project, and click the right mouse button. 
When the context menu is displayed, click [New]. 

 

 
Figure 12-4  Create new in the robot controller 

 
12.3.3. Select from templates 

Select [Offline] or [Online] or [Simulation]→ [Visual Program] for the new project, and click the right mouse 
button. 

 
When the context menu is displayed, click [New]. 
(1) Select maker template or user template. A list of templates is displayed. 

Maker Template: Templates prepared by the maker. 
User Template: Templates created by the customer. For details on user template, refer to  
"12.7 Save program". 

(2) Select the template that will be the basis of the newly created program from the list. 
(3) Click [Create From Template] to create a program based on the selected template. 

The teaching position of the move block has not been set. Create a teaching position and set it to the 
move block. 
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Figure 12-5  Select from templates 

 
The template remembers the order of the program blocks and the contents of the properties, and is used when 
creating a new program by diverting the program. However, the teaching position is not saved. 
 

Click 

Click 

Click 

Program according to the template 
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12.4. Open an existing program 

12.4.1. Open the program saved on the computer 

Expand [Offline]-> [Visual Program] of the target project in the project tree. 
The saved program are displayed in the project tree, so double click the program you want to edit. 

 
Figure 12-6  Open the program saved on the computer 

 
12.4.2. Open the program saved in the robot controller 

Expand [Online] or [Simulation] -> [Visual Program] of the target project in the project tree. 
The saved program are displayed on the project tree, so double click the program you want to edit.  

 
Figure 12-7  Open the program saved in the robot controller 
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12.5. Explanation of screen layout 

12.5.1. When online 

 

 
Figure 12-8  Screen layout when connecting online 

 
Table 12-1 Explanation of screen layout when online 

No. Name Use 
(1) Program name Displays the program name. 
(2) Robot Operation 

button 
Displays a panel for operating the robot. 

(3) Mode display Displays the current mode of this software. 
• Edit mode: Program creation mode 
• Play mode: Program execution mode 

(4) Program execution 
button 

It will execute Program Start, Stop, Program Reset, Step execution. 

(5) Robot status display Displays the current position of the robot. 
The current position is the position and posture of the hand tip. 

(6) Override Specify the operating speed of the robot as a percentage. 
(7) Program area Arrange the program blocks so that they are connected, and create 

and display the program. 
(8) Block panel Select the program block to use for the program. (Displayed in edit 

mode) 
(9) Mode button Switch between edit mode and play mode. 

 
 
 

(2)  

(3)  
 

(1)  

(4)  
 

(5) 
 

(6)  
 

(7)  

(8) 
(9)  
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12.5.2. When offline 

 
Figure 12-9  Screen layout when offline 

 
Table 12-2 Explanation of screen layout when offline 

No. Name Use 
(1) Program name Displays the program name. 
(2) Program area Arrange the program blocks so that they are connected, and create and 

display the program. 
(3) Block panel Select the program block to use for the program. (Displayed in edit 

mode) 
 
12.6. Program editing 
Explains how to edit the robot program. 
When edit mode is set in the state of offline or connected to the robot controller, you can add, move, delete and 
make advanced settings for blocks. 
Please refer to the table below. 
In play mode, you can only check the settings content(display the block properties). 
 

Table 12-3 Program edit mode 
Status Controller Edit mode Internal 

state 
Explanation 

Offline - - Editing You can arrange program blocks and set 
command options. 
Cannot teach. 

Online MANUAL Edit Editing You cannot switch to debug or play mode, 
you can only edit the program. 

AUTOMATIC Edit 
 

Editing You can edit the program. 
Debugging You can debug the program on the edit slot. 

Play Stopping You cannot edit. 
Driving 

 
 

(1)  
 

(2)  
 

(3)  
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12.6.1. Add (Place) blocks 

To add (place) a program block to the program, follow the procedure below. 
(1) Select the block you want the robot to operate from the program block panel.  
(2) Drag the block to the place where you want to perform the action between the start and the end and release 

it. 
(3) Click the block placed as a program. 
(4) The block property (setting screen) is displayed. Please set the block details. 
(5) Repeat the above operation to create a program. 

You can move the location of the block in the program by dragging and dropping the placed block.  
You can zoom in and out by pinching in and out to make the program display easier to see. 
You can also move it by dragging. 

 
 

Figure 12-10  Add (place) program 
 
12.6.2. Add block (Copy / Paste) 

(1) Select the block to copy and select "Copy" from the context menu. 
(2) Open the context menu on the arrow or block in the program area and select "Paste". 
(3) The copied program block is copied to the tip of the selected arrow or block. 

The settings of the block copied by this method are also copied. 
 

Drag 
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Figure 12-11 Add block (Copy / Paste) 

12.6.3. Cut block 

(1) Select the program block to cut and select "Cut" from the context menu. 
(2) After that, if you perform "Paste", the block selected "Cut" will be deleted and the program block with the 

same settings will be "Paste". 

 
Figure 12-12  Cut block 

 
12.6.4. Delete block 

(1) Drag the program block on the program to move it to the Recycke Bin that appears at the bottom of the 
screen, and release it to delete it. 

(2) You can also delete it by selecting "Delete" from the context menu of the program block. 

Click 

Click 
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Figure 12-13  Delete block 

 

 

Drag 

Click 

Branch blocks and repeat blocks are also deleted along with blocks placed 
within the range of those blocks.  
 
You cannot redo it, so be careful when deleting them. 

Caution 
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12.7. Save program 
To save the program, follow the procedure below. 
 
12.7.1. Overwrite (Save) 

Save the program being edited by overwriting. 
 
 Click [Save] on the ribbon to display the program name input dialog. 

When online, it is saved in the robot controller. If you are offline or connected to the simulator, the 
program will be overwritten on the computer. 

 If the new program has a default program name, the program name input dialog is displayed. 
 Input a new program name in the program name. 
 Click the [Save] button in the dialog to change the program name and save it. 

 
Figure 12-14  Overwrite (Save) 

 

 
 

. 

Click 

Click 

If there is an error in the program, it cannot be saved. 
 
Check if there are any unset parts in the block properties of each block. (Teaching position, etc.) 

Caution 
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12.7.2. Save As -> PC 

Save the program to the computer. You can do this if you are in edit mode while offline or online. 
 
(1) Click [Save As-> PC] on the ribbon to display the program name input dialog. 
(2) Input a new program name in the program name. 
(3) Click the [Save] button in the dialog to save the program. 

 
Figure 12-15  Save As -> PC 

 

Click 

Click 
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12.7.3. Save As -> Robot 

Save the program by overwriting. You can do this if you are in edit mode while online or in the simulator. 
 
(1) Click [Save As -> Robot] on the ribbon to display the program name input dialog. 
(2) Input a new program name in the program name. 
(3) Click the [Save] button in the dialog to save the program. 

 
Figure 12-16  Save As -> Robot 

Click 

Click 
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12.7.4. Save As Template 

Save the program as a template. 
The program saved as a template is displayed in the list of user templates on the new program creation screen. 
Refer to “12.3.3Select from templates” for a list of user templates. 
 
 Click [Save As Template] on the ribbon to display the template name input dialog. 
 Input a new template name in the template name. 
 Click [Save] button in the dialog to save the template. 

 
Figure 12-17  Save As Template 

 

Click 

Click 
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12.8. Debug and run the program 
Describes debugging (operation check) and execution of visual programs. 
Debugging (operation check) is performed in edit mode. 
When the program is completed and automatic operation is performed, execute the program in play mode. 
 

 
 
12.8.1. Debug program(Edit mode) 

Program debugging (operation check) is performed in edit mode. 

 
Figure 12-18  Debug program (Edit mode) 

 
Table 12-4 Explanation of program debugging (Edit mode) 

No. Name Explanation 
(1) Current mode The current mode is displayed. 
(2) Mode switch Switch between edit mode and play mode. 
(3) Speed ratio (Override) You can set the operating speed of the robot as a percentage. 

Set in 10% increments within the range of 10 to 100%. 
(4) Program execution 

button 
When connected to a robot, the robot will operate. 

Make sure that the mode selector switch input on the robot controller is set to "AUTOMATIC". If not, set it to 
"AUTOMATIC". 
If the currently displayed program has never been saved or has been edited, a dialog will be displayed asking 
you to save it to the robot or computer (simulation) before starting the program. Please save. 
To start the program, click Program execution button (4). 
To check the operation of the program, first use the step execution button and check the operation of the program 
block by block. 
After confirming that there is no problem in the operation check by step execution, execute and check the 
operation check of one cycle through the program using the start button. 
 

Table 12-5 Explanation of Program execution button 
Name Explanation 

Step execution 
button 

 

Step execution is performed from the current execution position 
of the program. 
If executed one program block, program execution is suspended. 

Check the execution status of the program from this screen or the variable 
monitor. 
 
Check the execution status of the visual program from the block status or "12.9 Monitor". 
“15.2.2 Program monitoring" cannot properly monitor the execution status of the visual program. 

Caution 

(1)  

(4)  

(2)  

(3)  
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Start button 

 

Run the program from the start. 
If the program is suspended, it will resume from the current 
execution position of the program. 
Program execution is stopped when it reaches the end 

Stop button 

 

Stops all slots. 

Reset button 

 

Reset the program. The execution position of the program returns 
to the start. 

The program block is changed to the selected color for the current execution position of the program. 

 
Figure 12-19  Current execution position of the program 

When the execution of one program block is completed, the selected color moves to the next block. 
 

 
 

(1)  

The robot may move faster than expected. 
 
When debugging (operation check), please slow down the speed of the robot and check. Please 
be careful about the safety around the robot. 
When operating the robot, be sure to place an emergency stop switch nearby so that the robot can 
be stopped immediately. 

Caution 
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12.8.2. Execute Program (Play mode) 

Program execution (automatic running) is performed in play mode 

 
Figure 12-20  Play mode 

 
Table 12-6 Explanation of program execution (play mode) 

No. Name Explanation 
(1) Current mode The current mode is displayed. 
(2) Mode switch Switch between edit mode and play mode. 
(3) Speed ratio (override) You can set the operating speed of the robot as a 

percentage. 
Set in 10% increments within the range of 10 to 100%. 

(4) Program execution button When connected to a robot, the robot will operate. 
Make sure that the mode selector switch input on the robot controller is set to "AUTOMATIC". If not, set it to 
"AUTOMATIC". 
If the currently displayed program has never been saved or has been edited, a dialog will be displayed asking 
you to save it to the robot or computer (simulation) before starting the program. Please save. 
 

Table 12-7 Explanation of Program execution button 
Name Explanation 

Start button 
 

 

Run the program from the start. 
If the program is suspended, it will resume from the current execution 
position of the program. 
If the driving mode is continuous drive: The program continues to run 
until it stops. When the end is reached, it will continue from the start. 
When the driving mode is cycle drive: When the end is reached, the 
program execution is stopped. 

 

Indicates that the program is running. (While the program is running, 
the start button will be selected.) 

Stop button 

 

Stops all slots. 

Reset button 

 

Reset the program. The execution position of the program returns to 
the start. 

End button 

 

Switches from continuous driving mode to cycle driving mode. 
If switched to the cycle driving mode during driving, you cannot switch 
again until the cycle drive is completed. 

 

Indicates that the current mode is continuous driving mode. 

(2)  

(3)  

(1)  

(4)  
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Indicates that the current mode is cycle driving mode. 

 

 
 
 
 

When operating the robot, be sure to place an emergency stop switch nearby 
so that the robot can be stopped immediately. 

Caution 
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12.9. Monitor 

12.9.1. Teaching position list 

A list of taught position data is displayed. 
 Click [Position List] on the ribbon to display the teaching position list window. 

The teaching position list window is displayed.  
 Select the teaching name for which you want to check the details. 
 The taught coordinate values are displayed. 

Also, by clicking the icon in the table below, you can execute position jump, re-teach the teaching 
position, change the teaching position number, and delete the teaching position. 

 
Figure 12-21  Teaching position list 

 
Table 12-8 Explanation of Teaching position list 

Icon Use 

 
When connected to a robot, the position jump screen is displayed. 
For details on the position jump screen, refer to "11.8 Position jump". 

 

The robot operation screen is displayed. 
When the teaching is clicked on the robot operation screen, the teaching position is 
overwritten with the current position. 

 

The change screen of the teaching position number is displayed. 
Input the number you want to change and click [Change] button to change the 
teaching position number. 

 
The delete confirmation screen of the teaching position is displayed. 
Click [OK] button to delete the teaching position. 

 
 

Click 

Click Click 
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12.9.2. Variable Monitor 

Display the value of the variable. 
You can check the variables while observing the movement of the robot and the state of the running program. 
This function can be used only in play mode or edit mode (debuging). 
 
(1) Click [Variable Monitor] on the ribbon to display the variable monitor window. 

At the first display, the variables used in the current program are displayed in a list. 
From the second time onward, the same variable list as the one displayed last time will be displayed. 

(2) Click [Add] button. 
(3) Input the variable name to be monitored on the variable name input screen. 
(4) Click "Add" button. 

It is possible to add robot (system) state variables. 
(5) The added variable name and the current value are displayed in the list. When you select a variable name, 

the following icon will be displayed on the right. 
(6) By clicking the icon, you can change the value of the variable or delete it from the monitor list. 

The robot operates during the position jump. 
 
Be sure to place an emergency stop switch nearby so that the robot can stop immediately. 

Caution 
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Figure 12-22  Variable monitor 

 
Table 12-9 Explanation of the variable monitor icon 

Icon Use 

 

The variable value change panel is displayed. 
Input the value to be changed in the value input field in the specified format and click 
[Change] button to overwrite the value of the variable. 

 
The confirmation screen for deleting the variable from the monitor is displayed. 
Click [OK] button to delete it from the list. 

 

 
 
Click [Reload original variables] button to update the variable list to only the variables used in the current 
program. 

Click 

Click 

Click 

Variable monitor and modification do not display values when the program is 
not saved or running. 

Caution 
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Figure 12-23  Reload original variables button 

 
12.9.3. Signal Monitor 

Display the status of input / output signals. 
You can check the signal status while observing the movement of the robot and the status of the running 
program. 
On the signal monitor, you can check the status of the signal input from the external device to the robot controller 
and the signal output from the robot controller to the external device. 
For details, refer to "15.3.1General signals". 
 
Click [Signal Monitor] on the ribbon to see general signals. 
 

 
Figure 12-24  Signal Monitor display 

 

Click 

Click 



 

12-221  12-221 

 
12.9.4. Error History 

You can check the history of errors that have occurred up to now. 
The error history in the robot controller can be checked for each error level (High level, Low level, Caution). 
You can also save the error history to a file. 
For details, refer to "15.2.6Errors". 
 
Click [Error History] on the ribbon to display the error history. 
 

 
Figure 12-25  Error History display 

Click 
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12.9.5. Debug Start 

Move to debug mode. 
It is invalid when in play mode, offline, or if there is a debug mode dialog in the project. 
 
Click [Debug Start] on the ribbon to enable step execution of the visual program edit screen. 

 
Figure 12-26  Debug Start 

 
12.9.6. Debug Stop 

Exit debug mode. 
It is invalid when in play mode, offline, or when the open visual program edit dialog is not in debug mode. 
 
Click [Debug Stop] on the ribbon to exit the debug mode of the visual program edit screen. 

 
Figure 12-27  Debug Stop 

Click 

Click 
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12.10. Robot operation 
Explains how to operate the robot. 
The following robot operations can be performed with this software.  
• Direct teaching (For details, refer to "20.5Direct Teaching".) 
• Jog operation 
• Inching operation 
• Joint operation 
Direct teaching allows you to easily push and pull the arm by hand to teach the position of the robot. 
It is also possible to limit the operation direction to translation. 
In addition, by jog / joint operation, you can move along the axis and move the robot for each joint. 
In order to determine the precise position, it is also possible to operate the robot for each setting unit by inching 
operation. 
Mainly, use direct teaching, jog, and joints to move the robot's posture significantly, and use inching to fine-tune 
the position. 
Direct teaching can only be selected for some robots. For details, refer to "20.5Direct Teaching". 
Make sure that the mode selector switch input on the robot controller is set to "AUTOMATIC". 
If it is different, set it to "AUTOMATIC". 
 
(1) Click the robot operation to display the robot operation dialog. 
(2) On the robot operation screen (a), select each operation mode to operate the robot. 
(3) You can set the speed at which the robot is operated by the speed ratio (override) (b) on the screen. 
 

 
Figure 12-28  Robot operation screen display 

 

Click (b) 

(a) 
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12.10.1. Direct teaching 

You can easily push and pull the arm by hand to move it. 
It is also possible to limit the operation direction to translation and rotation. 
To teach the robot position, you can easily push and pull the arm by hand with direct teaching. 
The direct teaching function can be used only with the following actual robots. 
 

 Model 
Models that support direct 

teaching 
MELFA ASSISTA 

 
For details, refer to "20.5Direct Teaching". 
 
(1) Select the [Direct] tab on the robot operation screen. 
(2) Click the [Direct Teaching] switch on the robot operation screen to display the confirmation screen. 
(3) Click [OK] button on the confirmation screen to turn on direct teaching. 

Even if you take the finger off the [Direct Teaching] switch, the direct teaching ON state is maintained. 
(4) You can move the robot arm to the desired position and posture by holding it directly with the hand. 

Direct teaching is automatically turned off when switching to the [Jog], [Inching], or [Joint] screen or when an 
error occurs. 

 

 

Install an emergency stop switch in a location around the robot that can be 
easily operated, and connect it to the external emergency stop input 
terminal of the controller. 
 
• If the hand setting is incorrect, the robot arm may rise or fall when direct teaching is activated. 
Also, the safety function may not act properly. Please set the exact value. 
• In direct teaching, the robot may move by inertia, so keep your hand on until the robot arm 
stops. 
• In direct teaching, the work settings does not be reflected. Depending on the weight of the work, 
the robot may fall. Keep your hand on until the robot arm stops. 
• If HNDDAT1～HNDDAT8 are used in RT ToolBox3, it will be set to HNDDAT0 when the power 
is turned on again, so the robot arm may rise or fall when direct teaching is started. 

Caution 
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Figure 12-29  Direct teaching 

 
You can switch the operation system in order by clicking the [Switch operation system] button on the robot 
operation screen. 
• Free: Each joint of the robot operates in a free state. 
• Translational: The robot moves along the direction of the coordinate axes. 
• Rotational: The robot moves along the rotation direction of the coordinate axes. (Support by controller software 
version B1c or later) 

 
Figure 12-30  Operation system switch (Direct teaching) 

 
Direct teaching can be activated and the operation system can be switched using the operation button [DIRECT 
TEACHING] on the robot arm. 
 

Click 

Select 

Click 
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Table 12-10 Explanation of [Switch operation system] button on the robot operation screen 
Operation Direct teaching state Action 

Press and hold (2 
seconds or more) 
 

OFF Direct teaching is turned on. 
ON Direct teaching is turned off. 

Press OFF ― 
ON The operation system switches in the following 

order. 
Free →Translation → Rotation 
If you press it during rotation, it will return to free. 

 
12.10.2. Jog operation (Tool JOG) 

You can move the robot arm along the axis from the robot operation screen. 
The operation direction can be selected from translation and rotation. 
 
(1) Select [Jog] tab on the robot operation screen. 
(2) You can switch the operation system by clicking [Switch operation system] button on the robot operation 

screen. 
(3) You can switch the jog mode. 
 
• Translational: The robot moves along the axis of the tool jog. 
• Rotational: The robot moves along the rotation direction of the tool jog. 
For each jog operation, refer to the instruction manual of the controller "Detailed explanation of functions and 
operations". 
While clicking each move button (each arrow) on the robot operation screen, the robot moves in the specified 
direction. 
 

 
Figure 12-31  Jog operation 

Select 

Click 
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12.10.2.1. Operation system: Translational 

 
Figure 12-32  Operation system: Translational (Jog operation) 

 
Table 12-11 Explanation of the button in [Operation system: Translational] state on the jog screen 

No. Move Direction 
(1) Move in the Y axis - direction. 
(2) Move in the Y axis + direction. 
(3) Move in the Z axis - direction. 
(4) Move in the Z axis + direction. 
(5) Move in the X axis + direction. 
(6) Move in the X axis - direction. 
(7) Start the operation panel of the docking pane. For details, refer to "20.4Display the 

operation panel in the docking window". 
 

12.10.2.2. Operation system: Rotational 

 
Figure 12-33  Operation system: Rotational (Jog operation) 

 
Table 12-12 Explanation of the button in [Operation system: Rotational] state on the jog screen 

No. Move Direction 
(1) Rotate in the C + direction. 
(2) Rotate in the C - direction. 
(3) Rotate in the B - direction. 
(4) Rotate in the B + direction. 
(5) Rotate in the A + direction. 
(6) Rotate in the A - direction. 
(7) Start the operation panel of the docking pane. For details, refer to "20.4Display the 

operation panel in the docking window". 
 

(1)  

(5)  

(6)  

(2)  

(3)  

(4)  

(7)  

(2)  

(4)  

(6)  

(3)  

(1)  

(5)  

(7)  
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12.10.3. Inching operation 

The robot arm can be moved from the robot operation screen for each setting unit. 
The operation direction can be selected from translational and rotational. 
 
(1) Select [Inching] tab on the robot operation screen. 
(2) You can switch the operation system by clicking the [Switch operation system] button on the robot operation 

screen. 
• Translational: The robot moves along the axis of the tool jog. 
• Rotational: The robot moves along the rotational direction of the tool jog. 
For each jog operation, refer to the instruction manual of the controller "Detailed explanation of functions 
and operations". 

(3) In the inching unit input field, set the move amount in one inching operation. 
(4) Input value is not inherited during Translational ↔ rotational. 

• Translational: Input in mm units. 
• Rotational: Input in deg units. 
You can input up to 2 digits after the decimal point. 

(5) You can switch the jog mode. 
(6) While clicking each movement button (each arrow) on the robot operation screen, the robot operates by the 

set movement amount in the specified direction. 
(7) If it works up to the set value while clicking the button, it will not work anymore. 
 

 
Figure 12-34  Inching 

 

Select 

Click 

Input a value 



 

12-229  12-229 

 
(1) Operation system: Translational 

 

 
Figure 12-35 Operation system: Translational (Inching) 

 
Table 12-13 Explanation of the button in [Operation system: Translational] state on the jog screen 

No. Move Direction 
(1) Move in the Y axis - direction. 
(2) Move in the Y axis + direction. 
(3) Move in the Z axis - direction. 
(4) Move in the Z axis + direction. 
(5) Move in the X axis + direction. 
(6) Move in the X axis - direction. 

 
(2) Operation system: Rotational 

 
Figure 12-36  Operation system: Rotational (Inching) 

 
Table 12-14 Explanation of the button in [Operation system: Rotational] state on the jog screen 

No. Move Direction 
(1) Rotate in the C + direction. 
(2) Rotate in the C - direction. 
(3) Rotate in the B - direction. 
(4) Rotate in the B + direction. 
(5) Rotate in the A + direction. 
(6) Rotate in the A - direction. 

 
12.10.4. Joint operation (Joint JOG) 

You can move the robot arm for each joint from the robot operation screen. 
 
(1) Select [Joint] tab on the robot operation screen. 
(2) Click [Select Joint] button on the robot operation screen to switch the joint to be operated. 

(2)  

(3)  

(1)  

(4)  

(5)  

(6)  

(2)  (3)  

(1)  (4)  

(5)  (6)  
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(3) While clicking [+] or [-] button on the robot operation screen, the robot will move in the specified direction. 
• [-] button: Rotates in the specified joint axis - direction. 
• [+] button: Rotates in the specified joint axis + direction. 

 

 
Figure 12-37  Joint 

 
12.10.5. Hand Align operation 

The posture of the hand attached to the robot can be aligned to the posture in 90 degree increments. 
This function moves the robot to the closest value in 90 degree increments for the A, B, and C components of the 
current position. 

 
Figure 12-38  Hand align operation action 

 
Click [Hand Align] button on each operation screen to perform the hand align operation. 
For details, refer to the "Detailed explanation of functions and operations" in the instruction manual of the 
controller. 
 

Select 

Click 

Click Click 
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Figure 12-39  Hand Align 

 
12.10.6. Move to the home position 

The robot can be moved to the home point (a safe position that does not interfere with surrounding equipment). 
It is used to move the robot stopped due to an error to a safe position for performing error resolution work, or to 
move it to a fixed position before executing the program. 
 
(1) Click [Home Pos.] button on each operation screen to move the robot to the home position. 

For the parameters for setting the home position, refer to "Home Position" in the "Operation-related 
parameter list" in the "Detailed explanation of functions and operations" in the controller instruction 
manual. 

 

 
Figure 12-40  Move to the home posion 

 
12.10.7. Hand opening and closing operation 

Open and close the hand attached to the robot. 
(1) Specify a hand from the Hand No. list. 
(2) Click [Open / Close Hand] button on each operation screen to open / close the hand. 

・(a) button: Output hand close signal. 
・(b) button: Output hand open signal. 

 

Click 

Click 
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Figure 12-41  Open and Close Hand 

 
12.10.8. Teaching operation 

It will teach the current position of the robot arm. 
(It is stored in the program as the teaching position.) 
Teaching positions are automatically numbered and memorized in order from 001. 
The taught position data is displayed on the 3D monitor. 
Detailed coordinate data can be confirmed by selecting [File]-[Teaching Position List]. 
The taught position can be selected in the block properties of the move block. 
 
Click [Teaching] button to teach the current position of the robot. 

 

 
Figure 12-42  Teaching 

 

Click 

(a)  

(b)  
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12.11. Explanation of Program block 
This section explains the program block screen. 

 

 
Figure 12-43  Program block 

 
Table 12-15 Explanation of Program block 

Block name Explanation 
Move Move (and set) the robot. 
Hand Open and close (and set) the hand. 
Wait Wait (and set). 
Output Output (and set) the signal. 
Calculate Calculate (and set). 
Vision Recognize (and set) the vision. 

(cannot be edited) 
Pause Pause (and set). 
Branch Conditional branch (and set). 
Repeat Repeat (and set). 
Palette Performs pallet operation (and set). 

 
If you have set a block comment, the block comment will be displayed at the top of the block. 
It is displayed in a maximum of 2 lines, and is omitted if it cannot be displayed. 
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12.11.1. Move block 

12.11.1.1. Function 
Move the robot from the current location to the destination. 
 

12.11.1.2. Program block 

 
Figure 12-44  Move program block 

 
12.11.1.3. Block property 

 
Figure 12-45  Move block property 

 
Table 12-16 Explanation of Program block 

No. Name Use 
(1) Block 

Comment 
Record comments for this program block. 

(2) Position Select the movement destination position from the registered teaching 
names. 

 

When the teaching position is set (applied), the value of 
the teaching position set is displayed at the lower right of 
the program block. 

(3) Operate Robot Displays a panel for operating the robot. 
Move the robot arm and click [Teaching] on the robot operation screen to 
perform the following operations. 
When the teaching position is not selected: Create a new teaching 
position at the current position and set it as the teaching position. 
When the teaching position is selected: The selected teaching position is 
updated with the current position. 

(4) Position Data The coordinate data of the selected teaching position is displayed. 
(5) Movement Select the movement method. 

 

Straight: Performs linear interpolation operation. The linear 
interpolation operation is an operation mode in which the 
locus of the control point moves so that it becomes a 
straight line. 

(2)  (3)  

(1)  

(4)  

(5)  

(6)  

(7)  

(8)  

(10) 

(11)  

(9)  
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Non straight: Performs joint interpolation operation. The 
joint interpolation operation evenly interpolates the joint 
angle difference of each axis. 
Therefore, the locus of the tip is not guaranteed. 

(6) Speed Ratio Enables / disables the speed ratio (override). The default value is 100%. 
For the speed ratio, you can specify the speed ratio of the robot 
movement from 0 to 100%. 
Once set, the set speed percentage will be used until it is changed in the 
next move block, the program ends, or the program is reset. 
If the program ends or the program is reset, the default value is restored. 

 

Disable: Operates at the speed ratio specified in the 
previous operation. 

 

Enable: Operates at the speed ratio set by the slider. 
The slider is enabled and the speed ratio is specified from 
0 to 100%. 
Specify 0% to switch from enable to disable. 

(7) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top right of the dialog. 
Clicking on another program block will also cancel it. 

(8) Speed It can be set only when straight is selected as the movement method. 
Enables / disables speed. For speed, you can specify the speed when 
moving straight. 
Once set, the set speed will be used until it is changed in the next move 
block, the program ends, or the program is reset. 
If the program ends or the program is reset, the default value is restored. 

 

Disable: Operates at the speed specified in the previous 
operation. 

 

Enable: Operates at the speed set by the slider. 
The slider is enabled and specifies the speed. 
Specify 0mm / s to switch from enable to disable. 

(9) Acceleration It can be set only when straight is selected as the movement method. 
Enables / disables acceleration. 
The default value is 100%. 
For acceleration, the acceleration ratio during robot operation can be 
specified from 0 to 100%. 
Once set, the set acceleration will be used until it is changed in the next 
move block, the program ends, or the program is reset. 
If the program ends or the program is reset, the default value is restored. 

 

Disable: Operates at the acceleration specified in the 
previous motion. 

 

Enable: Operates at the acceleration of the value set by 
the slider. 
The slider is enabled and specifies the acceleration from 0 
to 100%. 
Specify 0% to switch from enable to disable. 

(10) Deceleration It can be set only when straight is selected as the movement method. 
Enables / disables deceleration. 
The default value is 100%. 
For deceleration, the deceleration ratio during robot operation can be 
specified from 0 to 100%. 
Once set, the set deceleration will be used until it is changed in the next 
move block, the program ends, or the program is reset. 
If the program ends or the program is reset, the default value is restored. 

 

Disable: Operates with the deceleration specified in the 
previous action. 

 

Enable: Operates with the deceleration of the value set by 
the slider. 
The slider is enabled and specifies the deceleration from 0 
to 100%. 
Specify 0% to switch from enable to disable. 

(11) Distance Enables / disables the distance above a position. The default value is 



 

12-236  12-236 

above a 
position 

disable. 
If the distance to the teaching position is long or if move diagonally 
toward the teaching position, there is a possibility to collide with an 
obstacle or cannot grasp the workpiece. 
The problem will be solved by enabling this setting and passing over the 
teaching position. 

 

Disable: Moves to the set teaching position. 

 

Enable: Moves to a position above the set teaching 
position by the distance specified here. 
Specify 0mm to switch from enable to disable. 

If the move method is "Straight", it may not be possible to move in a straight line and an error may occur 
depending on the positional relationship between the source and destination and the posture of the robot. 
In such a case, you can solve it by the following measures. 

 • Change the move method to "Non straight". 
 • Change the posture of the robot, the position of the move source and the move destination. 
 • Set a point to go through while moving from the move source to the move destination. 

 

 
 
 

If change the movement method, the path of the robot will change. Please note 
that the robot may interfere with peripheral devices such as workpieces. 

Caution 
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12.11.2. Hand block 

12.11.2.1. Function 
Perform hand operation. 
 

12.11.2.2. Program block 

  
Figure 12-46 Hand program block 

12.11.2.3.  Block property 

 
Figure 12-47  Hand block property 

 
Table 12-17 Explanation of Program block 

No. Name Use 
(1) Block 

Comment 
Record comments for this program block. 

(2) Hand No Select the Hand No. 
(3) Hand 

Operation 
Select a hand operation. 
Check the open/close status signal of the hand with the hand signal (wait 
block, output block, branch block). 

 

Open: Open the hand. 

 

Close: Close the hand. 

(4) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top right of the dialog. 
Clicking on another program block will also cancel it. 

 

 

Electric hands are not supported. 
 
The hand block cannot create an open/close motion for an electric hand. 

Caution 

(2)  

(3)  

(1)  

(4)  
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12.11.3. Wait block 

12.11.3.1. Function 
Wait until the specified conditions are met. 
If the block for which "Signal input" is set as the wait release condition is executed with the simulator connected, 
the block will immediately proceed to the next block without waiting for the signal input. 

 
12.11.3.2. Program block 

 
Figure 12-48  Wait program block 

12.11.3.3. Block property 

 
Figure 12-49  Wait block property 

 
Table 12-18 Explanation of Program block 

No. Name Use 
(1) Block Comment Record comments for this program block. 
(2) Wait-Release 

Conditions 
Select the conditions to release wait. 
• Signal Input: Release wait depending on the input status of the 
specified signal. 
•Time: Release wait after the specified time. 

(3) Signal No. 

 

Display when signal input is selected as the wait release 
condition. 
Set the input signal number as a condition. 
The signal number can be specified in the range of 0 to 
65535. 
When the input signal number is set (applied), the value 
of the input signal number set is displayed at the lower 
right of the program block. 

(4) Signal Status Display when signal input is selected as the wait release condition. 
Select the signal input status as a condition. 
• Off: If the set signal input is OFF, the wait is released. 
• On: If the set signal input is ON, the wait is released. 

(5) Waiting time 

 

Display when time is selected as the wait release 
condition. 
Set the waiting time. 
It can be specified in the range of 0 to 99.99 sec. 
When the wait time is set (applied), the set wait time 
value is displayed in the lower right corner of the program 
block. 

(6) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top right of the dialog. 

(2)  

(3)  

(1)  

(4)  

(6)  

(5)  
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Clicking on another program block will also cancel it. 
 
12.11.4. Output block 

12.11.4.1. Function 
Output a signal (bit). 
 

12.11.4.2. Program block 

  
Figure 12-50  Output program block 

 
12.11.4.3.  Block property 

 
Figure 12-51  Output block property 

 
Table 12-19 Explanation of Program block 

No. Name Use 
(1) Block Comment Record comments for this program block. 
(2) Signal No. 

 

Set the output signal No. to be output. 
The signal No. can be specified in the range of 0 to 
65535. 
When the output signal No. is set (applied), the value 
of the output signal No. set is displayed at the lower 
right of the program block. 

(3) Signal Status Select the status of the output signal to be output. 
• Off: Turn off the signal with the set output signal No.. 
• On: Turn on the signal with the set output signal No.. 

(4) Pulse Output It can be set when the signal status setting is On. 
Enable / disable the pulse output. 

 

OFF: Output the signal at the level. 

 

ON: Output the signal as a pulse. 

(5) Output time It can be set when the pulse output is On. 
Set the pulse output time. It can be specified in the range of 0 to 99.99 
sec. 

(6) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top right of the dialog. 
Clicking on another program block will also cancel. 

 

(2)  

(6)  

(1)  

(4)  

(5)  

(3)  
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12.11.5. Calculate block 

12.11.5.1. Function 
Perform calculation on variables. 
 

12.11.5.2. Program block 

 

 
Figure 12-52  Calculate program block 

  
12.11.5.3. Block property 

Click the Calculate program block placed in the program to open the Calculate Settings dialog. You can make 
detailed settings related to Calculate settings. 

 
 

Figure 12-53  Initialize / increment 
 

Table 12-20 Explanation of Program block 
No. Name Use  
(1) Block 

Comment 
Record comments for this program block.  

(2) Operation Select process method. 
• Initialize: Assigns an initial value to the 
variable. 
• Increment / Decrement: Adds / subtracts to 
a variable. 
• User-specified calculation: Performs the 
described calculation. 
•Program run: The program created by 
MELFA BASIC VI can be executed. 

 

(3) Variable 
Name 

Display when selected Initialize or Increment 
/ Decrement as the processing method. 
Select a variable name. 
When click (a), the set variable name will be 
displayed. Select the variable name to be set 
from the displayed variables. 
When click other than (a), the variable name 
can be input. Input the variable name to be 
set. 

 

(2)  

(3)  

(1)  

(4)  (5)  

(6)  

(a)  (a)  
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(4) Initial Value When select Initialize as the process method, 
it will be displayed. 
Input the value to be initialized. 

 

(5) Increase / 
decrease by 

When select Increment / Decrement as the 
process method, it will be displayed. 
Please input a value to increase or decrease. 
  •When input a positive value, it will be 
increased. 
  • When input a negative value, it will be 
decreased. 

 

(6) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top 
right of the dialog. 
Clicking on another program block will also 
cancel it. 

 

 

 
Figure 12-54  User-specified calculation/Program execution 

 
Table 12-21 Explanation of Program block 

No. Name Use 
(7) Formula If select free Explanation as the process method, it will be displayed. 

Please input the formula 
(8) Program 

name 
It is displayed when program execution is selected as the process method. 
Input the program name and click [Edit] button to start program editing and 
edit the program. 
If input a new program name, the newly created program edit will start. 

(9) Argument It is displayed when program execution is selected as the process method. 
Set the comma-separated arguments to pass to the program. 

 

 
 
 

(9)  

(7)  (8)  

Only the numeric type is the variable type that can be used to set the variable 
name. 
 
Do not set variable names that start with P, J, C, W. 
The type of the set variable name is a single-precision real type. 
For details on the language specifications for variables, refer to "MELFA-BASIC VI" in the "Detailed 
Explanation of Functions and Operations" in the instruction manual of the robot controller. 
 

Caution 
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12.11.6. Pause block 

12.11.6.1. Function 
Suspend the program and assume it is waiting. Click the start button or step execution button to restart the 
program. 
 

12.11.6.2. Program block 

  
Figure 12-55  Pause program block 

  
12.11.6.3. Block property 

This block has no block properties. 
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12.11.7. Branch block 

12.11.7.1. Function 
Branches the program to be executed next depending on the condition. 
If the conditions set in the branch block are met, it will execute the upper path. If not, execute the lower path. 
 

12.11.7.2.  Program block 

 
Figure 12-56  Branch program block 

  
12.11.7.3. Block property 

Click the branch program block placed in the program to open the branch settings dialog. 
You can make detailed settings related to branch settings. 

 
Figure 12-57  Branch  Signal input 

 
Table 12-22 Explanation of Program block 

No. Name Use 
(1) Block Comment Record comments for this program block. 
(2) Conditions Set the conditions that must be met to execute the upper path.  

• Signal input: Set the status of the specified input signal No. as the 
condition. 
• Variable: Set the status of the variable as the condition. 

(3) Signal No.  It is displayed when the condition setting is signal input. 
Set the input signal No. as a condition. 
The signal No. can be specified in the range of 0 to 65535. 

(4) Signal Status It is displayed when the condition setting is signal input. 
Set the status of the input signal to be set as a condition. 
• OFF: If the signal is OFF, it will execute the upper path. 
• ON: If the signal is ON, it will execute the upper path. 

(5) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top right of the dialog. 
Clicking on another program block will also cancel it. 

(2)  

(3)  

(1)  

(4)  

(5)  

Branch block in the 
block panel 

Branch block placed 
in the program 
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Figure 12-58  Branch  Variable 

 
Table 12-23 Explanation of Program block 

No. Name Use 
(6) Variable Name It is displayed when the condition setting is a variable. Select the variable 

name to use as a condition. 
If click (a), the set variable name will be displayed. 
Select the variable name to be set from the displayed variables. 
If click on other than (a), the variable name can be input. Input the variable 
name to be set. 

(7) Conditional 
Operator 

It is displayed when the condition setting is a variable. Select the formula to 
use as a condition. 

(8) Value It is displayed when the condition setting is a variable. Input the numerical 
value to use as a condition. 

 
 
 
 

(a)  (6)  

(7)  

(8)  

Only the numeric type is the variable type that can be used to set the variable 
name. 
 
Do not set variable names that start with P, J, C, W. 
The type of the set variable name is a single-precision real type. 
For details on the language specifications for variables, refer to "MELFA-BASIC VI" in the "Detailed 
Explanation of Functions and Operations" in the instruction manual of the robot controller. 

Caution 
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12.11.8. Repeat block 

12.11.8.1. Function 
Execute the program repeatedly. 
Repeat the execution of the program blocks placed in the repeat range for the number set in the repeat block or 
while the specified conditions are met. 
 

12.11.8.2.  Program block 

  
Figure 12-59  Repeat program block 

  
12.11.8.3. Block property 

 
Figure 12-60  Specify Number 

 
Table 12-24 Explanation of block property 

No. Name Use 
(1) Block Comment Record comments for this program block. 
(2) Repeating 

conditions 
Set the conditions to repeat. 
-Count: Repeats the operation for the number of specified executions. 
-Conditions: Repeats the operation as long as the specified conditions 
are met. 

(3) Number of 
executions 

Set the number to repeatedly execute the program block placed in the 
repeat range. 
It can be specified in the range of 1 to 32767. 

(4) Apply Click [Apply] button to apply each setting. 
To cancel the settings, click the [x] at the top right of the dialog. 
Clicking on another program block will also cancel it. 

 
A variable name called MRepeatN is automatically generated, and the current repeat number is stored in this 
variable when the program is executed. 
The N at the end is a number that indicates the hierarchy of the repeating block. 
For example, in the case of the figure below, the variable name is MRepeat1 for the repeat block in (a) and 

(2)  

(3)  

(1)  

(4)  

Repeat block in the 
block panel 

Repeat block placed 
in the program 

Repeat range 
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MRepeat2 for the repeat block in (b). 
This variable can also be set as a condition for branch blocks. 

 
Figure 12-61  Repeat set number 

 

 
Figure 12-62  Conditions  Signal input 

 
Table 12-25 Explanation of block property 

No. Name Use 
(5) Conditions Specify the repeat condition. 

Signal Input: Set the status of the specified input signal No. as the 
condition. 
• Variable: Set the state of the variable as the condition. 

(6) Signal No. It is displayed when the condition setting is signal input. 
Set the input signal No. as a condition. 
The signal No. can be specified in the range of 0 to 65535. 

(7) Signal status It is displayed when the condition setting is signal input. 
Set the status of the input signal to be set as a condition. 
• OFF: If the signal is OFF, repeat the process. 
• ON: If the signal is ON, repeat the process. 

 
 

 

(5)  

(6)  

(7)  

(b) (a) 
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Figure 12-63  Conditions  Variable 

 
Table 12-26 Explanation of block property 

No. Name Use 
(8) Variable Name It is displayed when the condition setting is a variable. Select the 

variable name to be used as a condition. 
If click (a), the set variable name will be displayed. 
Select the variable name to be set from the displayed variables. 
If click on other than (a), the variable name can be input. 
Input the variable name to be set. 

(9) Conditional 
Operator 

It is displayed when the condition setting is a variable. 
Select the formulas to be used as a condition. 

(10) Value It is displayed when the condition setting is a variable. 
Input the numerical value to be used as a condition. 

 

 
 

(9)  

(10)  

(8)  (a)  

Only the numeric type is the variable type that can be used to set the variable 
name. 
 
Do not set variable names that start with P, J, C, W. 
The type of the set variable name is a single-precision real type. 
For details on the language specifications for variables, refer to "MELFA-BASIC VI" in the "Detailed 
Explanation of Functions and Operations" in the instruction manual of the robot controller. 

Caution 
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12.11.9. Palette block 

12.11.9.1. Function 
Perform the work of arranging the workpieces regularly (Palletizing) or the work of taking out the workpieces 
arranged regularly (Depalletizing). 
The posture (orientation) of the hand when moving to the pallet cell is fixed to the posture of the starting point. 
 
< Limits on offline editing > 
Since the position cannot be taught offline, it is not possible to make new edits to the palette. 
Also, you cannot edit the position of a block that has already been placed. 
And, if you try to place a palette block in a program that does not have any palette data, an error message will be 
displayed. 
 

12.11.9.2. Program block 

 
 

Figure 12-64 Palette program block 
 

 
12.11.9.3. Block property 

 
Figure 12-65  Palette block property 

 
Table 12-27 Explanation of block property 

No. Name Use 
(1) Block Comment Record comments for this program block. 
(2) Select Palette Select the palette to use from the newly created or set palettes. 

If click (a), the set palette will be displayed. 
When this screen is displayed from the placed palette, it cannot 
be selected. 

(3) Set Set the palette definition (position, size, action pattern, etc.). 
It can be selected only when create new is selected in the 
palette selection, or when the palette is already placed. 
For the setting method of the palette definition, refer to 
"12.11.10 Palette definition settings". 

(4) Counter variable name 
for the pallet 

This is the variable name of the counter used during program 
execution. 

(2)  

(3)  

(1)  

(4)  

(5)  

(a) 
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This counter variable can be used when you want to only 
change the operation of a specific palette cell. 
The variable name is MPaletN, and the N at the end is the 
palette number. 
Displayed only for placed palettes. 

(5) Apply It can be selected only when the palette that has already been 
set is selected in the palette selection. 
By clicking [Apply] button, the program block will be 
automatically generated. 

 
 

 
 

• Only 8 types of palettes can be set in one program. If you cannot create a 
new one, delete unnecessary palette blocks. 
• Combination operation with vision is not supported. You cannot use 
vision to adjust the movement position of palette cells. 
• If an error occurs in this block when executing the program, check the 
set position. 
"12.11.10.2 When editing a placed palette" 
If the error persists, it may be due to the positional relationship between 
the robot and the pallet. For details, refer to "Def Plt(Def Palette)" in the 
"Detailed Explanation of Functions and Operations" in the instruction 
manual of the robot controller. 

注意 
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12.11.10. Palette definition settings 

12.11.10.1. When create new 
(1) Make basic settings for the palette. 
(2) Click "Next". 

 
Figure 12-66  Basic settings 

 
Table 12-28 Explanation of Program block 

No. Name Use 
(A) Name The number in (a) represents the pallet number of the pallet to be 

set. 
(B) Cell Set the number of cells in the palette vertically and horizontally. 

The number of cells can be specified in the range of 1 to 999. 
(C) Pattern Set the move direction of the palette. 
(D) Purpose Set the use purpose of the palette. 

Palletizing: Work to arrange workpieces on a pallet 
Depalletizing: Work to remove workpieces from pallet 

 

(B)  

(C)  

(A)  

(D)  

(a) 
 

Click 
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3) Click the cell to be the start point S of the palette among the cells in the four corners. 

Start point S: The first cell position to move. 
End point A: The cell position of one end point. The cell advances from the start point S to the end point 
A. 
End point B: The cell position of the other end point. 
Diagonal point C: Cell position of the diagonal point of the starting point S 

 

 
Figure 12-67  Select start point 

 
4) The operation direction of the pallet is displayed. By clicking (b), the end point A and the end point B are 

switched. 
If you click a corner other than the start point S, the move direction of the pallet will be displayed again. 

5) Click [Operate Robot] and move the robot to the position of the starting point S. 
6) Click [Teaching] on the robot operation screen. 
 

 
Figure 12-68  Teach start point 

Click 

(ｂ) 

Click 
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7) Follow the same procedure as steps ⑤ and ⑥ to teach the positions of end point A and end point B. 
(c) Position jump button: The "Position Jump" screen is displayed. 
 

 
Figure 12-69  Position jump 

 
8) Diagonal point C does not need to be set by default. 

If the palette is distorted or you want to improve the accuracy of the palette definition, turn on the [Set 
Diagonal Point C] switch (d) and teach the position of diagonal point C. 

(ｃ) 

The operation diagram at the top of the screen is an image, and the actual 
operation follows the positions of points S, A, B, and C set at the bottom of the 
screen. 
 
Please teach each point S, A, B, C so as to match the operation diagram. 

Caution 
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9) Click [Next]. 

 
 

Figure 12-70  Teach Diagonal point 
 
10) Specify the above position to pass before approaching the cell by the distance from the cell. 
11) Click [Finish] button. 

 
Figure 12-71  Set above position 

 
12) A program block that repeats the pallet operation for the total number of pallet cells is automatically placed 

on the left and right of the placed pallet block. 
The palette number of the set palette is displayed in the lower right (e) of the palette block. 

 
Figure 12-72  Palette program block automatic placement 

 
13) For palletizing work, create an action to pick up the workpieces just before (f) the pallet block. 

For depalletizing work, create an action to leave the workpieces immediately after (g) the last Calculate 
block. 
 

(e) 

Click 

Click 
(d) 
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Figure 12-73  Pallet program block palletizing work 

 
You can move the workpieces from pallet to pallet by placing the pallet block at position (f) or (g). 
In that case, change the conditions of the repeat block and the position of the calculate block that initializes the 
counter according to the program you want to realize. 

(f) (g) 
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12.11.10.2. When editing a placed palette 

Operate procedure 
(1) For the set pallet, change the operation direction and adjust the pallet position in the same procedure as 

when creating a new one. 
(a) Position jump button: "Position Jump" screen is displayed. 

(2) When you have finished making changes, click [Finish]. 
(3) To change the above position, change the Distance above a position from [Customize] of the move block. 
 

 
Figure 12-74  Edit the placed palette 

 
If the move position of the pallet shifts when the program is executed, setting the diagonal point C may improve 
the accuracy of the move position. 
 

12.11.10.3. Delete palette block 
To delete unnecessary palette blocks placed on the program, follow the procedure below. 
 
Operate procedure 
(1) Drag the block automatically added when arranging the pallet block and release it to the Recycke Bin that 

appears at the bottom of the screen to delete it. 
If delete a block repeatedly, you can delete the blocks in the range at once, but be careful of the operation 
because the blocks added manually are also deleted. 

(2) Save the program. 
 

 
Figure 12-75  Delete palette block  Operate procedure 

 
 
 
 

(a) 

Click 
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13. Creating the spline files 
 

The methods for creating the spline files for use in the spline interpolation function are explained below.  
For details, refer to the instruction manual “Detailed explanations of functions and operations 7.6 Spline 
interpolation”.  

 
13.1. New file 

13.1.1. Creating a new file on the computer 

Select [Offline] or [Simulation] -> [Spline] for the new project to be created, and click the mouse right button. The 
context menu will open. Click [New] and open the spline file edit screen. 

 
 

Figure 13-1 Creating a new file on the computer 
 
13.1.2. Creating a new file in the robot controller 

Select [Online] -> [Spline] for the project to be newly created, and click the right mouse button. The context menu 
will open. Click [New] and open the spline file edit screen. 

 
 

Figure 13-2 Creating a new file in the robot controller 
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13.2. Open file 

13.2.1. Opening a spline file saved on the computer 

Expand [Offline] or [Simulation] -> [Spline] for the target project. The saved spline files will appear in the project 
tree. Double-click the spline file to be edited. 
 

 
Figure 13-3 Opening a spline file saved on the computer 

 
 

13.2.2. Opening a spline file saved in the robot controller 

Select [Online] -> [Spline] for the target project and expand it. The spline files saved in the controller will appear 
in the project tree. Double-click the spline file to be edited. 

 

 
Figure 13-4 Opening a spline file saved in the robot controller 
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13.2.3. Selecting and opening a spline file from the list 

Select [Spline] from the project tree and click the right mouse button. The context menu will open. Click [Open]. A 
list of saved spline files will appear. Select the target spline file and click the [Open] button.  

 
Figure 13-5 Selecting and opening a spline file from the list 

 
 

13.3. Save file 

13.3.1. Save 

To save edits to a spline file, click the [File] tab -> [File] group -> [Save] button on the ribbon. The Save spline file 
screen will open when a new spline file is created. 

 
 

13.3.2. Save as 

By clicking the [File] tab -> [File] group -> [Save As] button on the ribbon, the Save spline file screen appears. 

 
Figure 13-6 Save spline file screen 

 
Select the destination from [PC] (save to the computer) or [Robot] (save to the robot controller). Select the 
number of the spline file to be saved from the [Spline file list], and click the [Save] button.  
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14. Setting Parameters 
 

You can reference and rewrite parameter information set on a PC / a robot controller / back up data(*1). 
You can set parameters by specifying parameter names and setting them or by making the settings on a 
per-function basis. 
 
(*1) Parameter setting of backup data is supported in Ver. 1.30G or later. 
 

 
 
To set parameters on a PC, select [Offline] or [Simulation] -> [Parameter] for the target project from the project 
tree. Parameters on the PC are handled in common at [Offline] and [Simulation]. 
To set parameters on the robot controller, select [Parameter] under [Online]. 
To set parameters on the back up data, select [Backup]->[All / Parameter]->[Parameter]. 
When [Parameter] item is expanded, items for starting up each parameter setting screen is displayed. 

 

When the password is registered in parameter by the robot controller 
security function, it is not possible to rewrite the parameters on the robot 
controller. 
When the password is registered in parameter by the robot controller security function, it is not 

possible to rewrite the parameters on the robot controller. 
○ : Enable、 × : Disable  

  Item to which password of security function is registered. 
Program Parameter File 

Rewrite of parameters  
on robot controller ○ × ○ 

 
Delete the password of robot controller's security function when you operate these. Refer to 

"16.5.3 Delete Password" for the method of deleting the password. 
It is possible to read the parameters even if the security function has been turned on. 
Refer to "Table 16-12 Compliant version of this function and controller" for the robot 

controller's compliant version. 

Caution 
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Figure 14-1 Items for Starting Up Parameter Setting Screens 

 

Parameter settings on PC 

Parameter settings on 
robot controller 

Parameter settings on 
back up data 
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14.1. Editing from parameter list 
You can reference and rewrite individual items of parameter information set in a robot controller by specifying the 
name of the parameter. 

 
14.1.1. Starting 

This is used in a state with the robot controller connected. 
Double-click [Parameter list] under the [Parameter] item to be edited from the project tree. 

 

 
Figure 14-2 Starting the Parameter List 

 
At this time, a confirmation message like the following concerning the parameter list is displayed. 
 

 
Figure 14-3 Confirmation Message for Parameter List 

 
This window will appear in the following cases. 

- When there is no parameter list information on the personal computer. 
- When the parameter list used in the robot controller is newer than the parameter list already stored in the 

personal computer. 
 
 



 

14-262  14-262 

 
 
When parameter list reading is specified, the screen for selecting where to read it from is displayed. 
 

 
Figure 14-4 Parameter List Select Screen 

 
Select either "Read from RC" or "Read from file", set the parameter list to be read, then click the [OK] button. 

 

What is the parameter list? 
The parameter list is a list of parameter information comprised of parameter names, explanatory 

text, etc. displayed on the parameter list screen.  This parameter list can be downloaded from the 
controller. The version of the parameter list may vary according to the version of the software on the 
controller. We recommend that you download the latest parameter list from the controller. 

Memo 
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14.1.2. Parameter editing 

Double-click a parameter displayed in the list or input its name, then click the [Read] button. The specified 
parameter information in the robot controller is displayed. 

 

 
Figure 14-5 Parameter Editing 

 
After you change a parameter, you can rewrite the specified parameter information in the robot controller by 
clicking the "Write" button. 
 
You can print the displayed parameter information by clicking the [Print] button. 
 

 
 

Use upper case letters when naming the programs 
 in alphabetic characters. 

Lower case alphabetic characters can be used in this parameter setting. 
Use upper case letters when naming the programs in alphabetic characters for the parameters of 

the base program (PRGUSR) or slot table (SLT*), etc. All of the program names within the robot 
controller will be expressed in upper case letters. 

If lower case letters are used, the programs will not be properly recognized. 
 

To put a changed parameter value into effect,  
switch the robot controller power Off, then On again. 

To validate the rewritten parameter information in the robot controller, the robot controller power 
must be turned ON again. 

Caution 
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14.1.3. Edit of parameter changed from default value 

It is possible to confirm the changed parameter by displaying the list of parameter changed from a default value. 
This function is limited to this software version and the software version of the connected controller. Please refer 
to the table as follows. 
 

Table 14-1 Compliant version of this function and controller 
 
 

Software version of robot controller 
CR800-D/R/Q CR750-D/CRnD-700 CR750-Q/CRnQ-700 CRn-500 

Combination with 
this software All versions Ver.P6 or later Ver.N6 or later not used 

The button for the display switch is not displayed in the upper part of the screen for “not used” combinations. 
 
When the parameter list is displayed after connecting with a controller of corresponding version, the button for 
the display switch is displayed in the upper part of the screen. 
When the parameter list screen is started, "All" is selected. When "Changed" is selected, the list of the 
parameters that have been changed from the default value is displayed.  
(However, according to the specification of the robot type, some parameters might be changed before shipment.) 
 

 
Figure 14-6 List of parameter changed from initial value 

 
It is possible to print only the parameters changed from initial value. Please refer to "14.11 Parameter printing” 
in this manual for details. 
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14.1.4. Parameter list reading 

If no parameter name is displayed on the parameter list screen, you can read the parameter list. 
Click the parameter list [Read] button in the upper-right of the parameter list screen. The Select parameter list 
screen is displayed. 

 

 
Figure 14-7 Parameter List Reading 

 
Select the source to read from ("Read from RC" or "Read from file"), and then set the parameter list to read and 
click the [OK] button. 

 
 
14.1.5. Finding parameters 

You can find a character string in the displayed parameter list. With the "Parameter list" screen active, click the 
[Parameter] tab -> [Find] group -> [Find] button on the ribbon. The character string Find screen is displayed. 
 

 
Figure 14-8 Finding a Character String 

 
Input the character string to search for, and then click the [Find] button.  Parameters that include the input 
character string are displayed. 
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14.1.6. Sort parameters 

By clicking an item in the parameter list, you can sort the items you clicked in ascending or descending order. 

 
Figure 14-9 Sort parameters  

 
14.1.7. Parameter initialization 

The initialization of parameters can be implemented by two types of methods. 
 
(1) Initialize individually 
Select the parameter and open the parameter editing dialog. Click the initialization button at the bottom left of the 
dialog to initialize the parameter. 
 

  
Figure 14-10 Parameter initialization 

Click → Sort 



 

14-267  14-267 

 
(2) Initialize the changes altogether 
Select [Changed] and click the [Initialize] button. Select the parameters to be initialized and click the [OK] button. 
 

  
Figure 14-11 Initialize the changes altogether  

 

Check in the [Changed] and click 
the [Initialize] button 

Select the parameters and click 
the [OK] button 
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14.2. Robot Controller Operation Modes for Parameter Writing 
With CRn-500 series robot controllers, when you write parameters to the robot controller, the controller software 
version may place restrictions on the operating mode in which you can write. For details, see below. 

 
However, parameters cannot be written while any program where a startup condition other than Always has been 
started. In such a case, stop the program, then write the parameters. 

 
Table 14-2 Download Operating Modes for Writing (for CRn-500 series only) 

CRn-500 series robot 
controller 

Operating mode 
TEACH AUTO 

(OP) 
AUTO 
(EXT.) 

J1 edition or later ○ ○ ○ 

H7 edition or earlier ○ × × 

○: Writing possible   ×: Writing impossible 
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14.3. Movement Parameters 

14.3.1. Motion limit parameter 

This sets the operating range of the robot 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [Motion Limit] under the [Parameter] item to be edited from the project 
tree. 
After you change the parameter value, you can rewrite the motion limit parameter in the robot controller by 
clicking the [Write] button. 

 

 
Figure 14-12 Motion limit parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 
14.3.2. Jog parameter 

This sets the speeds for joint jogging and orthogonal jogging. 
Set the parameters while connected to the robot controller.  
Double-click [Movement parameter] -> [Jog] under the [Parameter] item to be edited from the project tree. 
After you change the parameter value, you can rewrite the jog parameter in the robot controller by clicking the 
[Write] button.   

 

 
Figure 14-13 Jog parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.3.3. Hand Parameters  

This sets the parameters for the Hand of the robot. 
 

14.3.3.1. Hand parameter 
This sets the type of the hand (single solenoid/double solenoid, etc.) and work holding/non-holding when 
HOPEN* (open hand) and HCLOSE* (close hand) are executed.  
Set parameters while connected to the robot controller.  
Double-click [Movement parameter] -> [Hand] -> [Hand] under the [Parameter] item to be edited from the project 
tree. 
After you change the parameter value, you can rewrite the hand parameters in the robot controller by clicking the 
[Write] button. 

 

 
Figure 14-14 Hand parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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Hand macro functions 

 
You can specify the macro names UMACA – UMACZ to the HANDTYPE parameters, by providing a subroutine 
L_UMACA – L_UMACZ in the appropriate user base program (PRGUSR parameter). Run the hand macro open 
and close operation from TB.  

 

 
Figure 14-15 Hand macro settings 

 
 
 

HANDTYPE =  
UMACA/UMACB,  

1. Parameter setting 

1 *L_UMACA  ‘ Open Hand 1 

2 M_Out (900) =1 

3 M_Out (901) =0 

4 Return 

5 *L_UMACB  ‘ Close Hand 1 

6 M_Out (900) =0 

7 M_Out (901) =1 

8 Return 

2. Macro programing (User base program)  

L_UMACA subroutine is executed 
on the open operation of the hand 1 

L_UMACB subroutine is executed 
on the close operation of hand 1 

It is possible to describe signal output (e.g. M_Out (900) =1), variable assignment (e.g. 
M_Data=1) and the timer (Dly 0.5) in a subroutine.  
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14.3.3.2. Multi-hand base parameter 

You can set multi-hand base model name and standard coordinate values for each hand. 
When connecting robot and the robot controller supports multi-hand function, items related to multi hand are 
displayed in the project tree. 
For robots and robot controllers that can use multi hand base, please see”Table 14-3 The controller that can 
use parameters about multi-hand tool”.  
 
Parameter settings are used while connected to the robot controller. 
From the project tree, you double-click [Movement Parameter] -> [Hand] -> [Multi-Hand Base] under [Parameter] 
item to be edited. 
After changing the parameter value, you click the [Write] button to write the parameters to the robot controller. 
 

 
Figure 14-16  Multi-hand base parameter 

 
You can refer to the explanation of the displayed parameter with the [Explain] button. 
 
This parameter cannot be set by offline editing. 
 
 

14.3.3.3.  Multi-hand tool parameter  
You can set multi-hand tool selections and the offset value of each hand with respect to the selected hand base. 
The multi-hand tool can be connected to robot with remote I/O or parallel I/O.  
When connecting robot and the robot controller supports multi-hand function, items related to multi hand are 
displayed in the project tree. 
The robots and robot controllers that can use the multi-hand tool are as follows. 
 

Table 14-3 The controller that can use parameters about multi-hand tool 
Robot controller Software version of robot controller 

CR800-D/CR800-R/CR800-Q All versions 
CR750-D/CRnD-700 Ver.S2a or later 
CR750-Q/CRnQ-700 Ver.R2a or later 

 
Parameter settings are used while connected to the robot controller. 
From the project tree, you double-click [Movement Parameter] -> [Hand] -> [Multi-Hand Tool] under [Parameter] 
item to be edited. 
After changing the parameter value, you click the [Write] button to write the parameters to the robot controller. 

Set standard coordinates 
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Figure 14-17  Multi-hand tool parameter 

 
You can refer to the explanation of the displayed parameter with the [Explanation screen] button. 
 
This parameter cannot be set by offline editing. 
 
When multi-hand tool is connected to the robot using remote I/O, you can set behavior of output signal reset.  
You can set these parameters in output signal reset pattern parameter screen. 
When multi-hand tool is connected using remote I/O, these information is displayed on Board. 
 
 

14.3.3.4. Erectric hand parameter 
You can set multi-function electric hand selection and these parameter.  
Parameter settings are used while connected to the robot controller. 
From the project tree, you double-click [Movement Parameter] -> [Hand] -> [Electric Hand] under [Parameter] 
item to be edited. 
 
When you click [Initialize] button, initialize parameter is initialized to electric hand parameter of the model is 
selected. 
After changing the parameter value, you click the [Write] button to write the parameters to the robot controller. 
 
For robot controllers that can set parameters about multi-function electric hand, please see “Table 14-4 The 
controller that can use parameters about electric hand”.  
 

 
Figure 14-18 Electric hand parameter 

 
You can refer to the explanation of the displayed parameter with the [Explain] button. 

Set offset data 
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14.3.3.5. Erectric hand point parameter 

You can teach multi-function electric hand.  
Parameter settings are used while connected to the robot controller. 
From the project tree, you double-click [Movement Parameter] -> [Hand] -> [Electric Hand Point] under 
[Parameter] item to be edited. 
 

The robot controllers that can set the multi-function electric hand parameter are as follows. 
 

Table 14-4 The controller that can use parameters about electric hand 
Robot controller Software version of robot controller 

CR800-D/CR800-R/CR800-Q All versions 
CR750-D/CRnD-700 Ver.S2a or later 
CR750-Q/CRnQ-700 Ver.R2a or later 

 
When you click [Get Current Position] button, you can set electric hand position to currently selected position 
number. 
 
After you select point list, click [Set…] button. “Electric Hand Point Parameter Setting” screen is displayed. When 
you set position value and comments in this screen, click [OK] button. Point list of electric hand point screen is 
updated. You can also edit the parameters directly from the list.The robot controllers that can set comments are 
as follows. 

 
Table 14-5 The controller that can use parameters about electric hand point comment 

Robot controller Software version of robot controller 
CR800-D/CR800-R/CR800-Q All versions 

CR750-D/CRnD-700 Ver.S3e or later 
CR750-Q/CRnQ-700 Ver.R3e or later 

 
After changing the parameter value, you click the [Write] button to write the parameters to the robot controller. 

 

 
Figure 14-19 Electric hand point parameter 

 
You can refer to the explanation of the displayed parameter with the [Explain] button. 
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14.3.3.6. Erectric hand table parameter 

You can set multi-function electric handtable specified behavior. 
Parameter settings are used while connected to the robot controller. 
 
From the project tree, you double-click [Movement Parameter] -> [Hand] -> [Electric Hand Table] under 
[Parameter] item to be edited. 
 
The robot controllers that can set the multi-function electric hand table parameter are as follows. 
 

Table 14-6 The controller that can use parameters about electric hand table 
Robot controller Software version of robot controller 

CR800-D/CR800-R/CR800-Q All versions 
CR750-D/CRnD-700 Ver.S3e or later 
CR750-Q/CRnQ-700 Ver.R3e or later 

 
After you select electric hand and table list, click [Set…] button. “Electric Hand Table Parameter Setting” screen is 
displayed. You can also edit the table list directly. When you set parameters, click [OK] button. Table list of 
electric hand is updated. 

 
When you click [Electric hand point] button, the target “Electric Hand Point” screen is displayed. For electric hand 
point parameter, please see “14.3.3.5 Erectric hand point parameter”. 
 
After changing the parameter value, you click the [Write] button to write the parameters to the robot controller. 

 
Figure 14-20 Electric hand parameter 

 
You can refer to the explanation of the displayed parameter with the [Explain] button. 
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14.3.4. Weight and size parameters 

You can set the conditions for the hand mounted on the robot and the conditions for the work grasped by the 
robot. 
Set the parameters while connected to the robot controller.  
Double-click [Movement parameter] -> [Weight and Size] under the [Parameter] item to be edited from the project 
tree. 
After you change the parameter value, you can rewrite the weight and size parameters in the robot controller by 
clicking the [Write] button. 

 
Figure 14-21 Weight and size parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
It can also be set from "Step 8. Weight and Size" (8.9.8 Step 8. Weight and Size) on the project edit screen. 
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14.3.5. Tool parameter 

You can set the robot's standard tool coordinates, standard BASE coordinates and tool number. Set parameters 
while connected to the robot controller.  
Double-click [Movement parameter] -> [Tool] under the [Parameter] item to be edited from the project tree. 
Multi-Hand is available in all versions of CR800 series controllers and in software version S2a/R2a or later on 
CR750/700 series controllers. 
 
The tool coordinate system (MEXTL) can be input only when the TOOL number is "0". Also, when the tool 
number is changed from non-"0" to "0", the values of the tool coordinate system will all be set to 0. However, if the 
tool number on the screen is displayed as "0", when it is changed to non-"0" and then return to "0" again, the tool 
coordinate system will display the value before the changed. 
 
After you change a parameter value, you can rewrite the tool parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 14-22 Tool parameter 

 
It can also be set from "Step 7. Tool" (8.9.7 Step 7. Tool) on the project edit screen. 

Displayed when you are connected to a 
controller that supports position repair. 
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14.3.6. User-defined area parameter 

You can specify the region (cuboid) defined with two points in the robot XYZ coordinates and set the behavior for 
when the robot enters this region. 

 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [User-defined area] under the [Parameter] item to be edited from the 
project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-23 User-defined area parameter 

 
The default is to select[Not teach posture][Not teach L1L2]. In this state, clicking each teaching button of AREA * 
P1 and AREA * P2, the following values are set for robot attitude (A, B, C) and additional axes (L1, L2). 
 

Table 14-7 [Not teach posture][Not teach L1L2] values taught when checkbox is enabled 
 AREA*P1 AREA*P2 
Robot posture(A, B, C) -360 360 
Additional axes (L1,L2) -100000 100000 
 
If you want to teach the robot pusture and additional axes,please uncheck the checkbox. 
 
Click the [Explain] button to refer to the parameter description. 
 
 
14.3.7. Free plane limit parameters 

You can set the overrun limit for using the robot on a free plane. 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [Free plane limit] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
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Figure 14-24 Free plane limit parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.3.8. Home position parameters 

This sets the position of the escape point. 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [Home position] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-25 Home position parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button.
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14.3.9. Robot additional axis parameter  

You can set information related to addition axes of robots. 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [Robot additional axis] under the [Parameter] item to be edited from the 
project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 
You can set an addition axis by reading the profile of an electric actuator (SMC Ltd. THK Ltd. etc.). Download the 
profile from the homepage of each company. 
 

 
Figure 14-26 Robot additional axis parameter  

 
 
You can load the profile to selected axis by pressing the [Load profile] button. 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
You can read Additional Axis data saved in the file by pressing the [Read from file] button. 
You can save Additional Axis parameter to the file by pressing the [Save to file] button. 
You can edit the information of the selected axis by pressing the [Set] button. 
 

 
Figure 14-27 Robot additional axis parameter setting 

 
It can also be set from "Step 6. Robot Additional Axis" (8.9.6 Step 6. Robot Additional Axis) on the project edit 
screen. 
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14.3.10. Collision detection parameters 

You can set information related to the robot's collision detection functions. 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [Collision detection] under the [Parameter] item to be edited from the 
project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-28 Collision detection parameter 

 
The parameter setting values for the detection level during jog operation can be easily adjusted by displaying the 
"collision detection level reference value" data as a graph by the oscillograph function. 
For details, refer to "19.1 Oscillograph". 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 
14.3.11. Warm-up operation parameters 

You can set information related to the robot's warm-up function. 
Set the parameters while connected to the robot controller. 
Double-click [Movement parameter] -> [Warm-up operation] under the [Parameter] item to be edited from the 
project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-29 Warm-up operation parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.3.12. Movement parameters 

You can set information related to the optimum acceleration/deceleration for robot operation and set compliance 
errors. 
The information that can be set concerning movement parameters depends on the robot controller connected. 

 
Table 14-8 The controller which you can set information related to optimum acceleration/deceleration for robot 

operation and set compliance errors 
 CR800/CR750/700 series CRn-500 series 
Maximum acceleration/deceleration  
correction ratio 

Can be used with all versions 

J2 edition or later 

Compliance error function settings H6 edition or later 
Optimum acceleration/deceleration  
setting 

G1 edition or later 

Direction of gravity H4 edition or later 
 

Set parameters while connected to the robot controller.  
Double-click [Movement parameter] -> [Movement] under the [Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-30 Movement parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.3.13. Work coordinate paramaters 

Work coordinate parameters define the coordinate system for the work jog.8 work coordinates can define. 
Controller software versions that allow use of the work jog function are as follows. 

 
Table 14-9 The controller that can use the work jog 

Robot controller Software version of robot controller 
CR800-D/CR800-R/CR800-Q All versions 

CR750-D/CRnD-700 Ver.P8 or later 
CR750-Q/CRnQ-700 Ver.N8 or later 

 
Set parameters while connected to the robot controller.  
Double-click [Movement parameter] -> [Work coordinate] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-31 Work coordinate parameter 

 
Work coordinates are defined by “Origin WO”, “+X WX” and “+Y WY”. 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
These parameters cannot be set in offline editing. 
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14.3.14. Force control parameters  

You can set parameters related to force control in PC and robot controllers. 
For details of these parameters, refer to the user’s manual of the force control function. 
 
 

14.3.14.1. Force sensor parameter 
Double-click [Movement parameter] -> [Force control] -> [Force sensor] under the [Parameter] item to be edited 
from the project tree. 
Set the parameters, [Assign sensor], [Sensor coordinates], [Filter time constant], [Restriction], and [Tolerance 
level] which are used by the force control function. 
 

 
Figure 14-32 Force sensor parameter 

 
You can use the [Setting] button to initialize the force sensor. Values set by initial setting are as follows. 
 

Table 14-10 Sensor type initial setting value 

Sensor type Robot # Axis # Left-Handed/ 
Right-Handed Place/Angle 

Filter 
time 

constant 
Max offset Tolerance 

level 

1F-FS001-W200 

The first 
element 

is 1 
Otherwise 

0 

The first 
element 

is 9 
Otherwise 

0 

Left-Handed 

X 0.00 

1.70 

Position 200.00 

Fx 200.00 
Y 0.00 Fy 200.00 
Z 32.00 Fz 200.00 
A 0.00 Mx 4.00 
B 180.00 My 4.00 
C 0.00 Mz 4.00 

1F-FS001-W1000 

X 0.00 

Angle 150.00 

Fx 1000.00 
Y 0.00 Fy 1000.00 
Z 34.00 Fz 1000.00 
A 0.00 Mx 30.00 
B 180.00 My 30.00 
C 0.00 Mz 30.00 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change a parameter values, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 
 

14.3.14.2. Force control mode parameters 
Double-click [Movement parameter] -> [Force control] -> [Force control mode] under the [Parameter] item to be 
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edited from the project tree. 
Set the parameters, [Coordinate system], [Control mode of axes], [Stiffness coefficients], and [Dumping 
coefficients] which are used by the control mode of the force control function. 
  

 
Figure 14-33 Force control mode parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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14.3.14.3. Force control characteristics parameters 

Double-click [Movement parameter] -> [Force control] -> [Force control characteristics] under the [Parameter] 
item to be edited from the project tree. 
Set the parameters, [Force gain], [Force cmd.], and [Force detection] which are used by the control 
characteristics of the force control function. 
The controllers which can set the parameters [Mode switch judgment] and [Speed command] are as follows. 
 

Table 14-11 The controller which can set the parameters [Mode switch judgment] and [Speed command] 
Robot controller Software version of robot controller 

CR800-D/CR800-R/CR800-Q All versions 
CR750-D/CRnD-700 Ver.S3g or later 
CR750-Q/CRnQ-700 Ver.R3g or later 

 

 
Figure 14-34 Force control characteristics parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
 
 

14.3.14.4. Force log parameters  
Double-click [Movement parameter] -> [Force control] -> [Force log] under the [Parameter] item to be edited from 
the project tree. 
Set the parameters, [Configuration] and [FTP setting] which are used by the force control function. 
 

 
Figure 14-35 Force log parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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14.3.15. Collision avoidance parameters  

You can set collision avoidance parameters in the PC and robot controllers. 
For details of these parameters, refer to the robot controller's operations manual, See "Detailed explanations of 
functions and operations". 
 

14.3.15.1. Collision avoidance function parameter  
Double-click [Movement parameter] -> [Collision avoidance] -> [Collision avoidance function] under the 
[Parameter] item to be edited from the project tree. 
You can set information related to the Collision avoidance function. 
The controllers which can set the parameters [Collision avoidance function] are as follows. 
 

Table 14-12 The controller and the robot model which can set the parameters [Collision avoidance function] 
Robot controller Software version of the robot controller Robot model 

CR800-D(*1)/CR800-R/CR800-Q All versions RV-FR, RH-FR 
CR750-Q/CRnQ-700 Ver.R3a or later  RV-F, RH-F 

CR750-D/CRnD-700(*1) Ver.S6b or later  RV-F, RH-F 
 (*1) You can't do the following operations. 

・ Click the [Multiple CPU parameter screen] button 
・ Set the common coordinates for collision avoidance 
・ Click the [Apply from robot arrange of 3D monitor] button 
・ Click the [Reflect to robot arrange of 3D monitor] button 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14-36 Collision avoidance function parameter 
 
You can switch the robot with the combo box<a>. 
 
After you change a parameter values, you can rewrite the parameter in the robot controller by clicking the [Write] 
button. 
 
You can show the “Multiple CPU parameter” screen by pressing the [Multiple CPU parameter screen] button. 
(You can change the size of user setting area at the “Multiple CPU parameter” screen shown by the operation.) 
 
You can set the coordinates in this screen from the 22 3D Monitor by pressing the [Apply from robot arrange of 
3D monitor] button. 
 
You can update the 22 3D Monitor from coordinates in this screen by pressing the [Reflect to robot arrange of 3D 
monitor] button. 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 

<a> 
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14.3.15.2. Collision avoidance area parameter 

Double-click [Movement parameter] -> [Collision avoidance] -> [Collision avoidance area] under the [Parameter] 
item to be edited from the project tree. 
You can set information related to the Collision avoidance area. 
The controllers which can set the parameters [Collision avoidance area] are as follows. 
 

Table 14-13 The controller and the robot model which can set the parameters [Collision avoidance area] 
Robot controller Software version of the robot controller Robot model Model 

CR750-Q/CRnQ-700 Ver.R3a or later (*1) RV-F, RH-F Robot/Hand/Work 

CR750-Q/CRnQ-700 Ver.R6b or later RV-F, RH-F Robot/Hand/Work/ 
Free plane limit 

CR750-D/CRnD-700 Ver.S6b or later RV-F, RH-F Free plane limit 

CR800-R/CR800-Q All versions RV-FR, RH-FR Robot/Hand/Work/ 
Free plane limit 

CR800-D All versions RV-FR, RH-FR Free plane limit 
(*1) The version that corresponds to the cylinder model is Ver.R3m or later. 

 

 
Figure 14-37 Collision avoidance area parameter 

 
You can switch the robot by the combo box<a>. 
You can switch the collision avoidance area type (Robot/Hand/Work/Free plane limit) by the combo box<b>. 
If you select one collision avoidance area from the list<c>, and click set button or double-click list, the dialog for 
the collision avoidance area setting is displayed. The selected collision avoidance area is displayed in blue color 
on the 3D model<d>. 

<a> 

<b> 

<c> 

<d> 

Robot/Hand/Work Free plane limit 
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You can also edit parameters directly from the list. 
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
 
The perspective of 3D model<d.> can be changed as follows. 
 

Table 14-14 3D Model Perspective Change Operations 
Viewpoint of changing Mouse operations on the graphic 

Rotation While clicking the left button, move left/right -> Rotation around Z 
axis 
Move up/down -> Rotation around X axis 
Move left/right while clicking the left + right buttons -> Rotation 
around Y axis 

Move Move up/down/left/right while clicking the right button 
Enlargement/reduction Move up/down/left/right while clicking pressing [Shift] key and 

clicking the left button 
A similar operation can be used by the mouse wheel. 

 
Operating the [Robot Operation] slider moves the robot of the 3D model<d>. 
 
When a tick mark (for true) is set in the [Display] checkbox and a hand file is set, the robot hand is displayed on 
the 3D model<d>. Refer to "22.19 Hand Design" for designing the robot hand. 
 
You can give the robot in the 3D model <d> the same posture as the connected robot. 
 
You can set the base coordinate value by clicking the [Set Base of this robot model] button. When displaying with 
[World] selected in the coordinate system, the base coordinates in actual use are set. 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.3.16. Safety Parameters(CR750/CR700) 

You can set parameters of Robot Safety Option in the CR750/CR700 series robot controllers.  
For details of these parameters, refer to the "Robot Safety Option manual" (BFP-A3372). 
This function is available in CR750/CR700 controller software Ver.R6, S6 or later (robot safety option is needed). 
The setting method of the safety parameters of the CR800 series robot controller is different. For details, refer to 
"14.9 Parameters of Safety (CR800)". 
 
These parameters cannot be set by the offline editing. 
 
Double-click [Movement parameter] -> [Safety] under the [Parameter] item to be edited from the project tree. 
 

14.3.16.1. Enable Disable 
You can set Enable / Disable of the safety monitoring function in Robot Safety Options, set the DSI signal, and 
change the password. 
 

 
Figure 14-38 Safety parameter (Enable Disable) 

 
You can reference explanations of the displayed parameters by clicking the [Explain] button. 
After you change a parameter values, you can rewrite the parameter in the robot controller by clicking the [Write] 
button. 
The [CRC of parameter file output #] item is displayed in CR750/CR700 controller software Ver.R6b/S6b or later. 
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14.3.16.2. Position mon. (Plane)  

You can set the SLP function planes. The SLP function monitors that the “monitoring area” of the robot does not 
exceed the “Safety Limited Plane” defined by the user in advance. 
 

 
Figure 14-39 Safety parameter (Position mon. (Plane)) 

 
If you check [Display planes], the Position monitoring planes shown in the 3D display. You can check the 
relationship between the planes and the robot. This 3D display doesn't work with the 3D monitor. 
You can adjust the posture of the robot in the 3D display and the connected robot by clicking the [Current pos.] 
button. 
You can reference explanations of the displayed parameters by clicking the [Explain] button. 
 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
 
 

14.3.16.3. Position mon. (Position) 
You can set the positions of the SLP function. The SLP function monitors that the “monitoring area” of robot does 
not exceed the “Safety Limited Plane” defined by the user in advance. 
 

 
Figure 14-40 Safety parameter (Position mon. (Position)) 

 
If you check [Display monitoring positions], the Position monitoring spheres are shown in the 3D display. You can 
check the size of the sphere and relationship between the sphere and the robot. This 3D display doesn't work 



 

14-293  14-293 

with the 3D monitor. 
You can adjust the posture of the robot in the 3D display and the connected robot by clicking the [Current pos.] 
button. 
You can reference explanations of the displayed parameters by clicking the [Explain] button. 
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
 
 

14.3.16.4. Speed mon. 
You can set the speed of the SLS function. The SLS function observes the TCP Speed of the robot. 
 

 
Figure 14-41 Safety parameter (Speed Mon.) A 

 

 
Figure 14-42 Safety parameter (Speed Mon.) B 

 
You can reference explanations of the displayed parameters by clicking the [Explain] button. 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
Screen A is displayed when all versions of the CR800 series controller and CR750/CR700 controller software Ver. 
R6b, S6b or later are used. In other instances, screen B is displayed. 
 
 

14.3.16.5. Torque width mon. 
You can set the “Safety Limited Torque” of the STR function. The STR function monitors that the difference of 
“Torque FB” and “Estimated torque” does not exceed the “Safety Limited Torque”. 
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Figure 14-43 Safety parameter (Torque width Mon.) 

 
You can reference explanations of the displayed parameters by clicking the [Explain] button. 
 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.4. Program Parameters 

14.4.1. Slot table parameters 

Slot tables set the operating conditions of each task slot during multi-task operation. 
Set parameters while connected to the robot controller.  
Double-click [Program parameter] -> [Slot table] under the [Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the operating range parameter in the robot controller by 
clicking the [Write] button. 
 

 
Figure 14-44 Slot table parameter 

 
Select the task slot number you are changing and click the [Set] button. 
 

 
Figure 14-45 Slot table parameter setting 

 
When the modification window appears, set the program name, operating conditions, startup conditions and task 
priority, and then click [Write]. 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 



 

14-296  14-296 

 
14.4.2. Program language parameters 

You can set the robot program language used in a robot controller (MELFA-BASIC VI/MELFA-BASIC 
V/MELFA-BASIC IV/Movemaster commands).  
Double-click [Program parameter] -> [Program language] under the [Parameter] item to be edited from the 
project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-46 Program language parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
For the usable robot program languages, see "Table 10-1 Robot Programming Languages for Each 
Controller". 

 
 
 
14.4.3. Command parameters 

You can set parameters related to robot programs. 
Set parameters while connected to the robot controller.  
Double-click [Program parameter] -> [Command] under the [Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-47 Command parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 

About Movemaster commands  
The Movemaster commands are restricted by the robot models that can use them. For details on 

whether you can use Movemaster commands with your robot, refer to its standard specifications. 

Caution 
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14.4.4. User error parameters 

You can set the message, cause, and recovery method for user errors set with a program. 
Set parameters while connected to the robot controller.  
Double-click [Program parameter] -> [User error] under the [Parameter] item to be edited from the project tree. 
 

 
Figure 14-48 User error parameter 

 
Double click the error number from the list. The "User error parameter setting" edit screen is displayed. You can 
also directly edit error numbers from the list. 

 
Figure 14-49 User error parameter setting 

  
Input the error number, error message, cause, and recovery method, then click the [OK] button. The user errors 
input to the list are displayed. 
At this time, input an error number from "9000" – "9299". 
After you confirm the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
Please note that the list display is not sorted by error number. 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 

Double click 
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14.5. Signal Parameters 

14.5.1. Output signal reset pattern parameters 

These parameters set the operation when resetting the general-purpose output signals such as the CLR 
instruction and dedicated input (OUTRESET). 
Set parameters while connected to the robot controller.  
Double-click [Signal Parameter] -> [Output Signal Reset Pattern] under the [Parameter] item to be edited from 
the project tree. 
 

 
Figure 14-50 Output signal reset pattern parameter 

 
Set a signal number, and then select one of [OFF]/ [ON]/ [Hold]. The value of the signal having the specified 
number displayed in the list changes. You can also edit signal values directly from the list. After you changed the 
parameter value, you can rewrite the output signal reset parameter in the robot controller by clicking the [Write] 
button. 
 
Also, selecting a signal group (for example, "32-0") and then clicking the [Set] button changes 32 signals at once. 
 

 
Figure 14-51 I/O reset pattern parameter setting 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 

 
 

Read the parameter list of the connecting controller. 
Use this screen after reading the parameter list file of the connected controller. You can see the 

output signals corresponding to the function of the connected controller. You can read the parameter list 
file on the “Parameter list” screen. 

Caution 
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14.5.2. Assigning Dedicated Input/Output Signals 

Assign signal numbers to functions in order to perform the remote operations such as running and stopping robot 
programs, and to display/operate the execution progress information and servo power supply status, etc.  
Set parameters while connected to the robot controller. 
 
 

14.5.2.1. General1 parameters 
Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [General1] under the 
[Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-52 Dedicated input/output signals assignment - General1 parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 

14.5.2.2. General2 parameters 
Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [General2] under the 
[Parameter] item to be edited from the project tree. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
 

 
Figure 14-53 Dedicated input/output signals assignment - General2 parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.5.2.3. Data parameter 

Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Data] under the [Parameter] 
item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-54 Dedicated input/output signals assignment - Data parameter 

 
Controller software versions that allow use of the [Temp. in RC output req.] and [During output Temp. in RC] 
parameters are as follows. 
 

Table 14-15 The controller which you can set the parameters about  
“Temp. in RC output reg.” and “During output Temp. in RC” 

 

Controller S/W Ver. of the controller 
CR800-D/CR800-R/CR800-Q All versions 

CR750-D/CRnD-700 Ver.S1c or later 
CR750-Q/CRnQ-700 Ver.R1c or later 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 

14.5.2.4. Jog parameters 
Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Jog] under the [Parameter] 
item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-55 Dedicated input/output signals assignment - Jog parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
JOGNER (JOG command INPUT signal, During JOG OUTPUT signal) can be used with Version J2 or later of the 
CRn-500 series controller, or CR800/750/700 series controller. 
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14.5.2.5. Hand parameters 

Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Hand] under the [Parameter] 
item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-56 Dedicated input/output signals assignment - Hand parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 

14.5.2.6. Warm up parameters 
The warm-up operation parameters can be set when you are connected to a CRn-500 series robot controller ofJ8 
edition or later or a CR800/750/700 series robot controller. 
Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Warm Up] under the 
[Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-57 Dedicated input/output signals assignment – Warm up parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button.  
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14.5.2.7. Start (each slot) parameters 

Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Start (Each Slot)] under the 
[Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-58 Dedicated input/output signals assignment – Start (each slot) parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button.  
 
 

14.5.2.8. Stop (each slot) parameters 
Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Stop (Each Slot)] under the 
[Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-59 Dedicated input/output signals assignment - Stop (each slot) parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.5.2.9. Servo On/Off (each robot) parameters  

Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Servo ON/OFF(Each 
Robot)] under the [Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-60 Dedicated input/output signals assignment – Servo ON/OFF (each robot) parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 

14.5.2.10. Machine lock (each robot) parameters 
Double-click [Signal Parameter] -> [Dedicated Input/Output Signals Assignment] -> [Machine Lock(Each Robot)] 
under the [Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
Figure 14-61 Dedicated input/output signals assignment - Machine lock (each robot) parameter  

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
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14.6. Communication Parameters 

14.6.1. RS-232 parameters 

These parameters set up the communication environment of the RS-232 interface of the robot controller. 
Set parameters while connected to the robot controller.  
Double-click [Communication Parameter] -> [RS-232] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-62 RS-232 parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 
14.6.2. Ethernet parameters 

You can set robot controller Ethernet information. 
Set parameters while connected to the robot controller.  
Double-click [Communication Parameter] -> [Ethernet] under the [Parameter] item to be edited from the project 
tree. 
 
Click a menu. The screen corresponding to the selected menu is displayed. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 

14.6.2.1. IP address 
You can set the parameters related to the IP address in the robot controller. 
 

 
Figure 14-63 Ethernet parameter – IP address 

 
You can copy network settings of the computer to the screen by clicking the [Copy PC network settings] button. 
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14.6.2.2. Device & Line 

You can set the parameters related to devices and lines in the robot controller.  
 

 
Figure 14-64 Ethernet parameter – Device & line  

 
Select the device to edit and click the [Set] button. The “Device parameter setting” screen is displayed.  
 

 
Figure 14-65 Ethernet parameter – Device parameter setting  

 
 
If you select the [MELFA-3D Vision] or [Network Vision Sensor (2D)] item from the [Autoconfiguration] combobox, 
the contents of the screen take on the value corresponding to the selected item. 
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14.6.2.3. Realtime monitor 

You can set the parameters related to the “Realtime monitor” function in the robot controller.  
The controllers which can use the “Realtime monitor” function are as follows.  
 

Table 14-16 Controller which can set the “Realtime monitor” function parameters 
Robot controller Software version of the robot controller 

CR800-D/CR800-R/CR800-Q All versions 
CR750-D/CRnD-700 Ver. S3q or later 
CR750-Q/CRnQ-700 Ver. R3q or later 

 

 
Figure 14-66 Ethernet parameter – Realtime monitor  

 
 

14.6.2.4. Real-time external command 
You can set the parameters related to the communication settings for the real-time external commands in the 
robot controller.  
 

 
Figure 14-67 Ethernet parameter – Real-time external command  

 

 

Using a CRn-500 series robot controller 
When using Ethernet with a CRn-500 series robot controller, the "Ethernet interface" option is required. 

Caution 
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14.7. Field Network Parameters 

14.7.1. CC-Link parameters 

This sets the CC-Link information in the robot controller. 

 
 

Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [CC-Link] under the [Parameter] item to be edited from the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 

 
Figure 14-68 CC-Link parameter 

 
You can reset CC-Link interface card errors by pressing the [Err. Cancel] button. After that the same error will not 
occur. It is valid while the power supply of the Robot Controller is ON. When the power supply is turned OFF, the 
error may occur again. 
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 

This function can only be used with CR800-D/CR750-D/CRnD-700/CRn-500 series robot controller.   
Caution 

CRn-500 series robot controller CRnD-700 series robot controller 
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14.7.2. CC-Link IE Field Parameters 
Set the information of CC-Link in the robot controller. 

 
 

Set parameters while connected to the robot controller. 
 

From the project tree, double click the target project [Online] -> [Parameter] -> [Field network parameter] -> 
[CC-Link IE Field]. 
After you change the parameter value, you can rewrite the parameter in the robot controller by clicking the [Write] 
button. 

 

 
Figure 14-69 CC-Link IE Field parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
 
 

This function can only be used with a CRnD-800 series robot controller.   
Caution 



 

14-309  14-309 

 
14.7.3. CC-Link IE Field Basic parameters 

This sets the CC-Link IE Field Basic information in the robot controller. 

 
 

Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [CC-Link IE Field Basic] under the [Parameter] item to be edited from 
the project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-70 CC-Link IE Field Basic parameters 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 

This function can only be used with CR800-D/CR800-R/CR800-Q series robot controller.   
Caution 
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14.7.4. PROFIBUS parameters 

This sets the PROFIBUS information in the robot controller. 

 
Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [PROFIBUS] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 

 
Figure 14-71 PROFIBUS parameters 

 
You can reset PROFIBUS interface card errors by pressing the [Err. Cancel] button. After that the same error will 
not occur. It is valid while the power supply of the Robot Controller is ON. When the power supply is turned OFF, 
the error may occur again. 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 

This function can only be used with CR800-D/CR750-D/CRnD-700/CRn-500 series robot controller. 
Caution 
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14.7.5. PROFINET parameters 

This sets the PROFINET information in the robot controller. 

 
Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [PROFINET] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button.  
 

 
Figure 14-72 PROFINET parameters 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
When the PROFINET IO 2-Port module is mounted, the contents of the option card information are displayed in 
“Network base card information”. When the module is not mounted, nothing is displayed. 
 

 
Figure 14-73 PROFINET parameters (Network base card information)  

 

This function can only be used with CR800-D/CR750-D/CRnD-700/CRn-500 series robot controllers. 
Caution 
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14.7.6. DeviceNet parameters 

This sets the DeviceNet information in the robot controller. 

 
Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [DeviceNet] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button.  
 

 
Figure 14-74 DeviceNet parameters 

 
You can reset DeviceNet interface card errors by pressing the [Err. Cancel] button. After that the same error will 
not occur. It is valid while the power supply of the robot controller is ON. When the power supply is turned OFF, 
the error may occur again. 
 
You can reference explanation of the displayed parameters by pressing the [Explain] button.  
 
 

This function can only be used with CR800-D/CR750-D/CRnD-700/CRn-500 series robot controllers. 
Caution 
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14.7.7. EtherNet/IP parameters 

This sets the EtherNet/IP information in the robot controller.  

 
Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [EtherNet/IP] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button.  
 

 
Figure 14-75 EtherNet/IP parameters 

 
You can copy network settings of the computer to the screen by clicking the [Copy PC network settings] button. 
 
You can reference explanation of the displayed parameters by pressing the [Explain] button.  
 

This function can only be used with CR800-D/CR750-D/CRnD-700/CRn-500 series robot controllers. 
Caution 
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14.7.8. EtherCAT parameters 

This sets the EtherCAT information in the robot controller.  

 
Set parameters while connected to the robot controller.  
Double-click [Field network parameter] -> [EtherCAT] under the [Parameter] item to be edited from the project 
tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button.  
 

 
Figure 14-76 EtherCAT parameters 

 
You can reference explanation of the displayed parameters by pressing the [Explain] button.  
 

This function can only be used with CR800-D series robot controllers. 
Caution 
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14.8. PLC Cooperation Parameters 

14.8.1. Multiple CPU parameters 

You can set the Multiple CPU-related parameters in order to use CR800-R/CR800-Q/CR750-Q/CRnQ-700 series 
robot controllers. 
These parameters can be set when you are connected to a CR800-R/CR800-Q/CR750-Q/CRnQ-700 series 
robot controller. 
 
Set parameters while connected to the robot controller.  
Double-click [PLC cooperation parameter] -> Multiple CPU] under the [Parameter] item to be edited from the 
project tree. 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
 

 
 

Figure 14-77 Multiple CPU parameters 
 
CR800-R series controller, only the number of CPU settings. 
When connecting to the CR800-Q / CR750-Q / CrnQ-700 Series Controller, click the [Check] button to check the 
number of points entered and the total range. 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
 
Please refer to the Universal model QCPU manual (QCPU User’s Manual (Multiple CPU System)) for details on 
Multiple CPU setting. 
 

 

Connected with CR800-R series controller Connected with CR800-Q/CR750-Q/CRnQ-700 
series controller 
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14.8.2. IO unit parameters 

You can set information related to the I/O unit of the PLC. 
You can set when connected to CR800-Q / CR750-Q / CRnQ-700 series controller. 
Set parameters while connected to the robot controller.  
Double-click [PLC cooperation parameter] -> [IO unit] under the [Parameter] item to be edited from the project 
tree. 
 

 
Figure 14-78 IO unit parameters 

 
When a unit number in [Unit #] is specified, the parameter of the specified unit number is displayed in the PC IO 
unit. 
[IO sharing when using Multiple CPUs], sets up whether XY signals are read or not  
 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change a parameter value, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
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14.9. Parameters of Safety (CR800) 

 
14.9.1. Safety diagnosis function 

You can select the pulse output function of test pulse signal output from emergency stop (EXTEMG11, 
EXTEMG21).For the safety diagnosis function (test pulse diagnosis), please refer to the “Standard 
Specifications” of each series. 

This function can be used with the CR800 series robot controller and the parameter cannot be set for offline 
editing. 

 
Double-click [Safety Parameter] -> [Safety Diagnosis Function] under the [Parameter]. 
 

 
Figure 14-79 Safety diagnosis function parameter 

 
After changing the parameter value, click the [Write] button to write the parameter to the robot controller. 
 
This parameter requires a password to be written.Enter the correct password and press the [OK], the 

parameters will be written to the controller. If the password is wrong, the parameter will not be written. 
The password is required only when writing the first parameter after displaying the parameter editing screen of 

the safety diagnosis function. 

 
Figure 14-80 Password input screen 

 
The default password is 「MELFASafetyPSWD」.You can click the [Change Password] to change the password 

on the [Register / Change Password]. Enter the old and new password on this screen to change the password. 
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Figure 14-81 Register/change password 

 
Please use 8 to 32 single-byte characters, which include numbers, A to Z, a to z for the password. 
Passwords are case-sensitive. 
 

 
 

Please be careful about password management. 
If you forget your password, you will not be able to change the settings of the safety diagnostic 

function. Please be careful when managing the set password. If you forget your password, you need to 
reset it to the default by resetting the model. Refer to “Detailed explanation of functions and operations” 
for model reset operations. 

Caution 
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14.9.2. Safety option 

 
You can set parameters of Robot Safety Option / Safety communication function in the CR800 series robot 
controllers.  
For details of these parameters, refer to the "Robot Safety Option manual" (BFP-A3531) / “Safety 
Communication Function Instruction Manual” (BFP-A3772). 
 
This function can be used with CRn800 series robot controller (robot safety option / safety communication 
function required). 
CR750/CR700 series safety parameters of the robot controller are set differently. For details, refer to "14.3.16 
Safety Parameters(CR750/CR700)". 
 
These parameters cannot be set by the offline editing. 
 
 
14.9.3. Basic Configuration Parameter 

Set the basic safety function. 
Double-click [Safety parameter] -> [Safety option] -> [Basic Configuration] under the [Parameter] item to be 
edited from the project tree. 

 

 
Figure 14-82 Basic Configuration Parameter 

 
CC-Link IE TSN safety communication function is supported for CR800-R controllers version C2 and later 
manufactured after April 2021(Note 1). 
Note 1:The date of manufacture can be found in the DATE column on the rating plate located on the right side of 
the controller. 
 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.4. Robot Model Parameter 

Set the robot model to be used for monitoring safety functions. 
Double-click [Safety parameter] -> [Safety option] -> [Robot Model] under the [Parameter] item to be edited from 
the project tree. 

 

 
Figure 14-83 Robot Model Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.5. Safety Logic 

Set parameters for safety logic. 
 

14.9.5.1. Safety Input Parameter(Safety IO) 
Set parameters related to the input signal of the safety function. 
Double-click [Safety parameter] -> [Safety option] -> [Safety Logic] -> [Safety Input(Safety IO)] under the 
[Parameter] item to be edited from the project tree. 

 

 
Figure 14-84 Safety Input(Safety IO) Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.5.2. Safety Input Parameter(Safety Communication) 

Set parameters related to the input signal of the safety communication function. 
This function is supported for CR800-R controllers version C2 and later manufactured after April 2021(Note 1). 
Note 1:The date of manufacture can be found in the DATE column on the rating plate located on the right side of 
the controller. 
 
Double-click [Safety parameter] -> [Safety option] -> [Safety Logic] -> [Safety Input(Safety Communication)] 
under the [Parameter] item to be edited from the project tree. 

 

 
Figure 14-85 Safety Input(Safety Communication) Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.5.3. Area Input Parameter 

Set the parameters for the area where safety is to be monitored. 
Double-click [Safety parameter] -> [Safety option] -> [Area Input] -> [Safety Input] under the [Parameter] item to 
be edited from the project tree. 

 

 
Figure 14-86 Area Input Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.5.4. Safety Output Parameter(Safety IO) 

Set parameters related to the output signal of the safety function. 
Double-click [Safety parameter] -> [Safety option] -> [Area Input] -> [Safety Output(Safety IO)] under the 
[Parameter] item to be edited from the project tree. 

 

 
Figure 14-87 Safety Output(Safety IO) Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
 

 
 

Allocation of SS1 and SS2 is possible with 1.90U and later versions.  
The output settings for the safety monitoring status of SS1 and SS2 are possible with Ver.1.90U or later. 

When assigning SS1 or SS2 to the DSO output, set it in Ver.1.90U or later. If SS1 and SS2 are assigned to 
the DSO output and [Write] on the safety output setting screen is executed in Ver.1.82L or earlier, the 
assignment of SS1 and SS2 will be deleted. 

Caution 
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14.9.5.5. Safety Output Parameter(Safety Communication) 

Set parameters related to the output signal of the safety communication function. 
This function is supported for CR800-R controllers version C2 and later manufactured after April 2021(Note 1). 
Note 1:The date of manufacture can be found in the DATE column on the rating plate located on the right side of 
the controller. 
 
Double-click [Safety parameter] -> [Safety option] -> [Area Input] -> [Safety Output(Safety Communication)] 
under the [Parameter] item to be edited from the project tree. 

 

 
Figure 14-88 Safety Output(Safety Communication) Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.6. SOS Parameter 

Set parameters related to stopping the operation of the robot when the safety function is activated. 
Double-click [Safety parameter] -> [Safety option] -> [SOS] under the [Parameter] item to be edited from the 
project tree. 

 

 
Figure 14-89 SOS Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.7. SLS  

Set parameters related to SLS (Safe Limited Speed). 
 
 

14.9.7.1. Speed Parameter 
Set parameters related to speed control. 
Double-click [Safety parameter] -> [Safety option] -> [SLS] -> [Speed] under the [Parameter] item to be edited 
from the project tree. 
 

 
Figure 14-90 SLS Speed Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.7.2. Opearation Check 

Check control operation of SLS. 
Double-click [Safety parameter] -> [SLS] -> [Operation Check] under the [Parameter] item to be edited from the 
project tree. 
 

 
Figure 14-91 SLS Operation Check 

 
Parameters are not set on this screen. 
Click the [Reset] button to reset the maximum value of the measurement value. 
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14.9.8. SLP 

Set parameters related to SLP (safety position limit). 
 
 

14.9.8.1. Plane Parameter 
Set parameters related to plane monitoring. 
Double-click [Safety parameter] -> [Safety option] -> [SLP] -> [Plane] under the [Parameter] item to be edited 
from the project tree. 
 

 
Figure 14-92 SLP Plane Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.8.2. Area Parameter 

Set parameters related to area monitoring. 
Double-click [Safety parameter] -> [Safety option] -> [SLP] -> [Area] under the [Parameter] item to be edited from 
the project tree. 

 

 
Figure 14-93 SLP Area Parameter 

 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
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14.9.8.3. Operation Check 

Check control operation of SLP. 
Double-click [Safety parameter] -> [Safety option] -> [SLP] -> [Operation Check] under the [Parameter] item to be 
edited from the project tree. 
 

 
Figure 14-94 SLP Operation Check 

 
Parameters are not set on this screen. 
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14.10. Additional Axis Cooperative Control Parameters 
You can set parameters related to Additional axis cooperative control in PC and robot controllers. 
This function can be used if the setting language is MELFA-BASIC VI and CR800 series robot controller and 
additional axis cooperative control of MELFA Smart Plus function is effective. 
 
For more information see “MELFA Smart Plus Instraution Manual (BFP-A3559)”. 

 
These parameters cannot be set by the offline editing. 
 
14.10.1. Base Coordinate Offset Data parameter 
Double-click [Movement parameter] -> [Additional Axis Cooperative Control] -> [Base Corrdinate Offset Data] 
under the [Parameter] item to be edited from the project tree. 

 

 
Figure 14-95 Base cordinate offset data parameter(Robot1) 

 

 
Figure 14-96 Base coordinate offset data parameters(Robot2/3) 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change a parameter values, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
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14.10.2. Base Coordinate Cooperative parameter 
Double-click [Movement parameter] -> [Additional Axis Cooperative Control] -> [Base Coordinate Cooperative] 
under the [Parameter] item to be edited from the project tree. 
 
 

 
Figure 14-97 Base coordinate cooperative parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change a parameter values, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
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14.10.3. Additional Axis Tracking parameter 
Double-click [Movement parameter] -> [Additional Axis Cooperative Control] -> [Additional Axis Tracking] under 
the [Parameter] item to be edited from the project tree. 
 

 
Figure 14-98 Additional axis tracking parameter 

 
You can reference explanations of the displayed parameters by pressing the [Explain] button. 
 
After you change a parameter values, you can rewrite the parameters in the robot controller by clicking the [Write] 
button. 
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14.11. Parameter printing 
You can print the parameter values held in a robot controller. 

 
Display the parameter to print, and click the [Home] tab -> [Print] group -> [Print] button on the ribbon. The print 
screen is displayed, so check the printer, then click the [OK] button. Printing starts. 
You can preview how a printed page will look by clicking the [Home] tab -> [Print] group -> [Print preview] button 
on the ribbon. 
 

 
Figure 14-99 Parameter Printing 

 

 
 

Install the printer beforehand. 
Install the printer beforehand. For details on how to install printers, refer to the operation manuals 

for your printer and computer. 

Caution 
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It is possible to print only the parameter changed from initial value. This function has the limitation in this 

software version and the software version of the connected controller. Please refer to the table as follows. 
 

Table 14-17 Versions capable of printing a list of parameters changed from default values 
 
 

Robot controller 
CR800-D/R/Q CR750-D/CRnD-700 CR750-Q/CRnQ-700 CRn-500 

Software version of 
robot controller All versions Ver.P6 or later Ver.N6 or later not use 

 
Display "Changes" in the parameter list, and click the [Home] tab -> [Print] group -> [Print] button on the ribbon. 
The printing screen is displayed. Click [OK] button after confirming the printer to begin printing.  
You can preview how a printed page will look by clicking the [Home] tab -> [Print] group -> [Print preview] button 
on the ribbon. 
 

 
Figure 14-100 Printing the parameter changed from initial value 
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15. Status Monitoring 
 
You can set various information in the currently connected robot controllers to be constantly displayed. 
The monitor functions are roughly divided into the following three. 
 

1. Robot movement monitor.......... Items related to robot movement are monitored. 
2. Operation monitor....................... Items related to the robot's operation are monitored. 
3. Servo monitor............................. The robot's servo system information is monitored. 

 
Table 15-1 Summary of Each Monitor 

 Monitor name Description 

R
obot m

ovem
ent m

onitor 

Slot run state The operation state of each slot can be confirmed. 
Program monitor The program execution line set for each slot, the contents of the 

variable used in the program, and the robot current position, etc., can 
be confirmed. 
It can also monitor general-purpose signals and registers. 

Program external 
variables 

Monitor the external variables of the program. 

Movement State The current position information and hand open/close state of each 
connected mechanism can be confirmed. 

Error The currently occurring error can be confirmed. 
The history of the errors that have occurred can be confirmed. 

3D Monitor You can display the robot and its movements in 3D for confirmation. 

Signal m
onitor 

General signals You can check the status of signals input to the robot controller from 
outside equipment and signals output from the robot controller to 
outside equipment. 
Pseudo-input and forced output of signals are also possible. 

Named signal The status can be checked by naming the status of a dedicated I/O 
signal that has been set in the robot controller, as well as each bit or 
within the range of 32 bits of the general-purpose signal. 
The signals are set via parameter setting (maintenance tool). 

Stop signal The stop signal input into the robot controller can be confirmed. 
Registers (CC-Link) You can monitor the input registers and output registers for the 

CC-Link functions. 
Pseudo-input and forced output of registers are also possible. 

IO unit monitor You can monitor XY devices of the sequencer IO unit. 
DSI CNUSER2 
input signal 

You can monitor input signals related to safety monitoring function. 
O

perating 
m

onitor 
Operating time The robot operation time (power ON, etc.) can be confirmed. 

Production 
information 

The operating time of the program in the robot controller and the No. 
of program cycles can be confirmed. 
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15.1. Ribbon command for monitor screen 
The [Monitor] tab is displayed on the ribbon when a monitor screen is active. Start and stop of monitoring can be 
changed by commands on the [Monitor] tab. When a screen is started up, monitoring is already started. 
 

 
Figure 15-1 Ribbon Monitor Tab 

 
Table 15-2 Command on the Monitor tab 

Command name Description 
Start Start monitoring the active monitor screen. 
Stop Stop monitoring the active monitor screen. 
Start 
 All 

Monitoring of all displayed monitor screens will start. 

Stop 
All 

Monitoring of all displayed monitor screens will stop. 

 
 

15.2. Robot Movement Monitoring 

15.2.1. Slot operation status 

The state of the slots in the robot controller can be monitored. 
From the project tree, double click the target project  [Online] -> [Monitor] -> [Movement Monitor] -> [Slot 
Status].  
It is possible to stop All slots for which the start condition is "ALWAYS" by clicking [Stop All Program] button. 
It is necessary to stop all slots to edit the program for which the start condition is "ALWAYS". 

 
 

Figure 15-2 Slot Run Status 
 
The No. of displayed slots is determined by the parameters. 
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15.2.2. Program monitoring 

Variables, general-purpose signals, and register information on the running program can be monitored.Please 
refer to the “15.2.3Program external variables” for monitoring program external variables. 
 
From the project tree, click the target project  [Online] -> [Monitor] -> [Movement Monitor] -> [Program Monitor], 
then double click the "Task slot" to monitor.  

 
Figure 15-3 Program monitor(Signal monitor, register monitor display) 

 

 
Figure  15-4  Program monitor（Signal monitor, register monitor not display） 

 
(1) Program information 

You can check the currently selected program, the operating status of the program, and the program name. 
The program will highlight the currently executed line. 

(1) Program information 
 

(2) Display Format 
 

(3) Signal 
 

(4) Register 
 

(5) Variable monitor 
 

(6) Add 
 

(7) Select 
 

(8) Delete 
 

(10) Change (11) Load (12) Save 

(14) Signal monitor 

(16) Register Monitor 

(13) Setting 

(15) Setting 

(9)Rename 
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(2) Display format 

The value displayed in variable monitor, signal monitor, and register monitor can be switched. 
 

Table 15-3 Change display of variable monitor, signal monitor, register monitor 

Variable 
monitor 

Integer  The displayed variable can be switched between hexadecimal / unsigned 
decimal / signed decimal. 

Real 

It is possible to switch between hexadecimal / signed decimal if 0 under the 
decimal point. 
However, the value can only be displayed within a range of -9999999 - 
9999999.This will be displayed as a floating point if this range is exceeded. 

String Can not switch display. 
Position 
Data 

Switching display is not performed for both orthogonal / joint / work 
coordinate 

Signal The displayed variable can be switched between hexadecimal / unsigned 
decimal / signed decimal. 

Register The displayed variable can be switched between hexadecimal / unsigned 
decimal / signed decimal. 

As for the value displayed by the hexadecimal number, “&H” is added to the head of the value. 
 
(3) Signal check box 

Display / non-display of signal monitor by ON / OFF of check box. 
 
(4) Register check box 

Display / non-display of Register monitor by ON / OFF of check box. 
Register check box is not displayed if option card is not installed. 

 
(5) Variable monitor: 

You can check the names of variables being used in the selected program. You can select the variables to 
monitor with the buttons displayed at the bottom of the screen.  

 
(6) Adding variables 

This adds more variables to monitor. 
 

 
 

Figure 15-5 Add Variables 

A dropdown list 
is displayed. 

Move to the variable 
name that matches the 
input character 
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Input the variable name or select it from the dropdown menu, set the variable type, then click the [OK] button. 
The variables being used in the program are displayed in a dropdown list. If you enter a variable name midway, 
it automatically moves to the variable name that matches the input character. When you select variables from 
the dropdown list, the variable type is automatically selected. 

 
(7) Selecting variables 

You can batch select variables to monitor from the variable list used in the program. 
 

 
Figure 15-6 Variable Selection 

 
The "Variables not displayed" are displayed in the list on the left side and the "Displayed variables" are 
displayed in the list on the right side. From the "Variables not displayed" list, select the variables to monitor, 
then click the [Add->] button. The selected variables are added to the "Displayed variables" list. If you select 
variables from the "Displayed variables to " list, then click the [<-Delete] button, the selected variables are 
deleted from the "Displayed variables" list and added to the "Variables not displayed" list. 
When you click the [OK] button, the variables registered in the "Displayed variables" list are displayed on the 
variables monitor and you can reference their values. 

 
(8) Deleting variables 

This deletes variables registered on the variables monitor from the monitor list. This operation does not delete 
the variables themselves from the program. 

 
(9) Rename 
You can change the variable to be monitored by changing the name of the variable registered in the variable 
monitor. 
 
 

 
Figure 15-7 Rename 
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(10) Changing variables 

You can change the values of variables registered on the variables monitor. 
On the variables monitor, select the variables to change the values, then click the [Change] button. 
 

    
Figure 15-8 Changing Variable Values 

 
After confirming the variable name, input the value of the variable, and then click the [OK] button. 

 

 
 

 
 
(11) Load 

You can load variables to be monitored on the variables monitor from a file. 
When you click the [Load] button, you can load variable names and variable types and add them as variables 
to be monitored. 

 
(12) Save 

You can save a list of the variables being monitored on the variables monitor to a file. 
When you click the [Save] button, you can save the names, types, and values of the variables currently being 
monitored into a file. This file is saved in text format. 
 

Be careful when changing the value of a variable. 
When you change the value of a variable, the operation target position of the robot may change and 

interference with the surroundings may result. This is particularly dangerous during robot operation, 
so check carefully before changing the value of a parameter. 

Caution 

Depending on the type of variable, the Format drop-down menu 
will not be displayed. 
You can change the display format only when the type of the variable is "integer type" and the 

value after the decimal point is "real type". 
However, "real type" can not be changed to "unsigned decimal". 

Caution 
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(13) Signal setting 

The start number of input signal and output signal can be set within the range of 0 to 32703. 
 
(14) Signal monitor 

You can check the signal input from the external device to the robot controller or the state of the signal output 
to the external device.  
Pseudo input and forced output of bits can be performed by double clicking on the signal list. 

 
Figure 15-9 Double click pseudo input 

 

 
Figure 15-10 Double click forced output 

 
 

(15) Register setting 
   The start register of input register and output register can be set within the range of 6000 to 6496. 
 
(16) Register monitor 
   You can check the register value input from the external device to the robot controller or the state of the 

register value output to the external device. 
 
At the end of the screen, the set display format, variables, signal number, register number are automatically 

saved and reflected at the next display. 
The setting contents are saved for each task slot. 

Double click 

Double click 
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15.2.3. Program external variables 
You can monitor program external variables.Please refer to ”15.2.2 Program monitoring” for monitoring of running 
programs. 
Double-click [Online] -> [Monitor] -> [Robot Movement] -> [Program external variable] of the target project to 
start. 

 
Figure 15-11  Program external variables monitor 

 
 
(1) Display format 

The value displayed in variable monitor, signal monitor, and register monitor can be switched. 
 

Table 15-4 Change display of variable monitor, signal monitor, register monitor 

Variable 
monitor 

Integer  The displayed variable can be switched between hexadecimal / unsigned 
decimal / signed decimal. 

Real 

It is possible to switch between hexadecimal / signed decimal if 0 under the 
decimal point. 
However, the value can only be displayed within a range of -9999999 - 
9999999.This will be displayed as a floating point if this range is exceeded. 

String Can not switch display. 
Position 
Data 

Switching display is not performed for both orthogonal / joint / work 
coordinate. 

As for the value displayed by the hexadecimal number, “&H” is added to the head of the value. 
 
(2)  Program external variables monitor 
  You can check the program external variables. You can select the variables to monitor with the buttons 
displayed at the bottom of the screen. 
 
※For details on (3) to (9) below, refer to (6) to (12) of ”15.2.2 Program monitoring”. 
(3)  Adding variables 

Add program external variables for monitoring. 
 
(4)  Selecting variables 

You can batch select variables to monitor from the program external variable list used in the program. 
 
(5)  Deleting variables 

This deletes variables registered on the program external variables monitor from the monitor list. This 
operation does not delete the program external variables themselves from the program. 

(2) Program external variables monitor 

(1) Display Format 

(3) Add 

(4) Select 

(5) Delete (7) Change (8) Load (9) Save (6) Rename 
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(6) Rename 

You can change the variable to be monitored by changing the name of the variable registered in the variable 
monitor. 
 
(7)  Changing variables 

You can change the values of program external variables registered on the variables monitor.  

 
 

 
 

(8)  Load 
You can load variables to be monitored on the program external variables monitor from a file. 

 
(9)  Save 

You can save a list of the variables being monitored on the program external variables monitor to a file. 
At the end of the screen, the set display format, variables are automatically saved and reflected at the next 

display. 
 

Be careful when changing the value of a variable. 
When you change the value of a variable, the operation target position of the robot may change and 

interference with the surroundings may result. This is particularly dangerous during robot operation, 
so check carefully before changing the value of a parameter. 

Caution 

Depending on the type of variable, the Format drop-down menu 
will not be displayed. 
You can change the display format only when the type of the variable is "integer type" and the 

value after the decimal point is "real type". 
However, "real type" can not be changed to "unsigned decimal". 

Caution 
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15.2.4. Movement status 

You can check the current position, destination position, hand open/close status, etc., of the robot. 
 
From the project tree, double click the target project [Online] -> [Monitor] -> [Movement Monitor] -> [Movement 
Status]. 

 
Figure 15-12 Movement Status 
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15.2.5. Event Hisyory 

You can check the history information of the operation event of the robot controller. This function can only be 
used with a CRnD-800 series robot controller.   
From the project tree, double click the target project [Online] -> [Monitor] -> [Movement Monitor]  
-> [Event History]. 
Right-click [All] of the ROBOT controller backup data of the CR800 series, select and click [Event History] in the 
Context menu to display the event history of the backup data. 
 
 

15.2.5.1. Event Monitoring 
It monitors events generated by the robot controller. The latest occurrence event is displayed in the first line. 
Up to 10,000 events will be registered. If it exceeds 10,000, it will be deleted from the old event. 
 

 
 

Figure 15-13 Event History(Monitoring) 
 
For each event the following information is displayed. 

Item Explanation 
Date The date and time when the event occurred is displayed. 
Event The contents of the event that occurred is displayed. 
Note In the case of a specific event, additional information is displayed. 

(Selected program name, software connected on line, etc.) 
Device The device that issued the operation request to the robot controller is 

displayed. 
Details will be described later. 

 
The types of devices displayed are as follows. 

Device Explanation 
IO() It means that it is an event by signal input of a sequencer or the like. 

The input signal number is displayed in (). 
TB(422) It means that it is an event by RS-422 communication of TB. 
PC(LAN) 
PC(USB) 

It means that it is an event by support software such as RT ToolBox of 
personal computer. The communication route is displayed in (). 

none It means that you manipulated the robot controller directly. (Power ON / OFF 
etc.) 

 
By clicking the [Save] button, you can save the list of event information displayed in the list in text file format (. 
Txt). 
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15.2.5.2. Checking hisyory 

By changing this screen to the "Monitor Stopped" state, it is possible to narrow down events and search for 
events that occurred near the specified date and time. To make the monitor stop state, click the [Monitor] group 
-> [Stop] button on the ribbon. 
 

 
Figure 15-14 Event History(Monitor stopped) 

 
The functions that can be used while monitoring is stopped are as follows. 
 
 
(1) Refine 

You can narrow down and display events with the specified device name. 
Select the device you want to narrow down from the [Device name] dropdown and click the [Refine] button. 
To display all events, select the blank at the top of the dropdown and click the [Refine] button. 

 
(2) Jump to specified date and time 

You can search for events that occurred in the vicinity of the specified date and time and jump to the 
corresponding line in the list. 
Specify the date and time you want to search and click the [Jump] button. 
Clicking the  icon is convenient because you can select a date from the calendar. 

 
(3) Refresh event history 

If you want to get the latest event history while monitoring is stopped, click the [Refresh] button. 
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15.2.6. Errors  

The errors currently occurring in the robot controller are displayed. 
 
 

15.2.6.1. Referencing the current error 
From the project tree, double click the target project [Online] -> [Monitor] -> [Movement Monitor] -> [Error]. 
 

 
Figure 15-15 Error Screen 

 
[Details] You can check details (cause and recovery method) on errors. 
[History] You can reference the history of errors that have occurred. 
[Record] You can reference the records of the errors that have occurred. This function is available in all 

versions of CR800 controllers and in CR75n/CR700 controller software version R1j/S1j or 
later. 

 
 

15.2.6.2. Details 
You can check details (cause and recovery method) on errors that have occurred. On the error screen, select an 
error, then either click the "Details" button or double-click the error. 

 
Figure 15-16 Error Details Screen 

 
 

Click or double click the [Details] button. 
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15.2.6.3. History information 

The history of errors that have occurred in the past can be referred to. 
You can check the error history in the robot controller for each error level (high level, low level, caution). You can 
also save the error history to a file. 

 
Click the [History] button. Select the level to reference and click the [OK] button. 

 
Figure 15-17 History Information Error Level Setting 

 

 
Figure 15-18 Error History 

 
This display is not constantly displayed. To refresh the information, click the [Refresh] button. 
 

(1) Error level (display switching) 
You can redisplay the displayed error history for each error level. 

 
(2) Details 

After selecting a displayed error, you can check the cause and recovery method for the error by clicking this 
button.  
You can also check details by double clicking a displayed error. 

 
(3) Save 

This saves the displayed error history information to a file. For the saved error history information, select 
"Read from file" in "Figure 15-17 History Information Error Level Setting". Refer to "Figure 15-19 Error 
History Information Read from File" on the screen, after you have selected “From history file”. 
The file is saved in text format. You can also print it with Notepad or other general text editors. 
The file name of the error history file is set by, "Controller serial number “_”Present data “_”Present time". 
 
Example of file name: AR0703001_20100924_092623.txt 

 

(1) Error level 
(display switching) 

(2) Details (3) Save (4) Refresh 

(5)Show event  
history 



 

15-351  15-351 

 
(4) Refresh 

To refresh the error history, click the [Refresh] button. 

 
Figure 15-19 Error History Information Read from File 

 
(5) Show event history 
    This function can only be used by CR800 series controller that supports the event history function. The event 
and error history can be displayed at the same time. (Event history after the date when error summarization 
starts will be displayed). 

 
Figure 15-20 Display error and event history at the same time. 
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15.2.6.4. Record information 

The record of errors that have occurred in the past can be referred to. 
You can check the error record in the robot controller for each error level (high level, low level, caution). You can 
also save the error record to a file. 

 
 

Controller software versions that allow use of the error record function are as follows. 
 

Controller S/W Ver. of the controller 
CR800-D/CR800-R/CR800-Q All versions 

CR750-D/CRnD-700 Ver.S1j or later 
CR750-Q/CRnQ-700 Ver.R1j or later 

 
Click the [Record] button. Select the level to reference and click the [OK] button. 

 
Figure 15-21 Record Information Error Level Setting 

 

 
Figure 15-22 Error record 

 
This display is not constantly displayed. To refresh the information, click the [Refresh] button. 

 
 

Timing from which error information is registered in the error 
record 
When you reset an error, the error information is registered in the robot controller's error record file. 
Note that an occurring error is not registered in error record when the power supply is turned off 

without doing error reset. 

Caution 

(1) Error level 
(display switching) 

(2) Details (3) Save (4) Refresh 
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(1) Error level (display switching) 
You can redisplay the displayed error record for each error level. 

 
(2) Details 

After selecting a displayed error, you can check the details of the occurred history of the selected error can 
be confirmed by clicking this button. 
You can also check details by double clicking a displayed error. 
However, detailed information cannot be confirmed when reading from the error record file. 

 
Figure 15-23 Details of occurred error history 

 
(3) Save 

This saves the displayed error record information to a file. For the saved error record information, select 
"Read from file" in "Figure 15-17 History Information Error Level Setting". Refer to "Figure 15-24 Error 
Record Information Read from File" on the screen, after you have selected “From record file”. 
The file is saved in text format. You can also print it with Notepad or other general text editors. 
The file name of the error record file is set by, "Controller's serial number “_”Present data “_”Present time 
“_”Character string that shows error record, "REC".”. 
 
Example of file name: AR0703001_20100924_092623REC.txt 

 
(4) Refresh 

To refresh the error record, click the [Refresh] button. 
 

 
Figure 15-24 Error Record Information Read from File 
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15.3. Signal Monitoring 

15.3.1. General signals 

You can check the statuses of signals input to the robot controller from external equipment and signals output 
from the robot controller to external equipment.  
From the project tree, double-click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [General Signals]. 
The upper level displays the statuses of the input signals and the lower level displays the statuses of the output 
signals. 
On the right end of each respective field, you will see the signal value in the notation selected in [Display format]. 
You can select display format from among hex, unsigned decimal, and signed decimal. 
A continuous range for the display signals can be set freely in [Monitor Settings]. 
Pseudo-input and forced output of registers are also possible. 
 
At the end of the window, the set input and output signal numbers and lines are automatically saved and reflected 
on the next display. 
 

 
Figure 15-25 General Signals 

 
 

15.3.1.1. Monitor settings 
For the displayed signals, the continuous range can be set freely. 
Set the lead numbers for the input signal number and output signal numbers to display, set their respective 

display ranges on the line, and then click the [OK] button. 

 
Figure 15-26 General Signal Monitor Settings 
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15.3.1.2. Pseudo-input 

Pseudo-input means signals are input to the robot controller from the computer, not from external 
equipment. 

Click the [Pseudo-Input] button. A screen for inputting pseudo signals is displayed. 
 

 
 

 
Figure 15-27 Pseudo-Input 

 
① First, read the signals you want to pseudo input. 

You can set 32 signals at the same time. Input the head number for the signals you want to read, and then 
click the [Set] button. 

② The input statuses of the 32 signals starting from the specified head signal number are displayed. Set the 
pseudo-input status, and then click the [Bit Pseudo-INPUT] button.(*1) 

③ You can specify the values of signals and make pseudo input for the 32 signals starting from the head signal 
number. 
Input the values of the signals, and then click the [Port Pseudo-INPUT] button. 
 
You can enter the signal values in the notation selected in the display format of the General signal monitor. 
The selected display format is displayed to the right of the signal value input field. 
Hex: Hex Unsigned decimal: UDec Signed decimal: SDec 
 

While the robot controller is in pseudo-input mode, signal input from 
external devices is not accepted. 

 

To use pseudo-input, put the robot controller into pseudo-input mode. While the robot controller 
is in pseudo-input mode, the robot controller does not accept signal inputs from external devices. 

Click the [Pseudo-Input] button. The following confirmation message is displayed before the 
robot controller goes into pseudo-input mode. 

 
 
To release a robot controller from pseudo-input mode, switch the 
power for the robot controller Off, then On again. 

Caution 
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(*1) The [Bit Pseudo-INPUT] can also be set from the double click of the signal ist.  
 

 
Figure 15-28 Pseudo input by mouse double click 

 
 

15.3.1.3. Forced output 
You can force signals to external equipment from the robot controllers. 
Click the [Forced Output] button. The screen for forcibly outputting signals is displayed. 

 

 
Figure 15-29 Forced Signal Output 

 
① First, read the signals you want to forcibly output. 

You can output 32 signals at the same time. Input the head number for the signals you want to read, and then 
click the [Set] button. 

② The output statuses of the 32 signals starting from the specified head signal number are displayed. Set the 
output status, and then click the [Bit Forced OUTPUT] button.(*1) 

③ You can specify the signal values and force output for the 32 signals starting from the head signal number. 
Input the signal values, then click [Port Forced OUTPUT] button. 

 
You can enter the signal values in the notation selected in the display format of the General signal monitor. 
The selected display format is displayed to the right of the signal value input field. 
Hex: Hex Unsigned decimal: UDec Signed decimal: SDec 
 
(*1) The [Bit Forced-OUTPUT] can also be set from the double click of the signal ist.  
 

Double click 
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Figure 15-30 Forced output by mouse double click 

 
 

 
 
 

Double click 

Forced signal output 
- Signal numbers assigned (used) as dedicated output signals cannot be forcibly output. 
- Forced output is possible if the robot controller mode is either [AUTOMATIC] or [MANUAL] (for a 

CRn-500 series robot controller, [TEACH], [AUTO (OP)], OR [AUTO (EXT.)]), but if even one 
program is running, forced output is not possible. (Except ALWAYS programs) 

Caution 
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15.3.2. Named signals 

You can give names to general input/output signals and check their statuses. 
With "Named signals", you can check the status of dedicated input/output signals and named general 
input/output signals. When starting up, you can load a definition file for named signals in the robot controller. 
From the project tree, double click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [Named Signals]. 
 

  
Figure 15-31 Named Signal 

 
[Add] : This registers a new general input/output signal name. 
[Edit] : This changes the setting for an existing general input/output signal selected in 

the list. 
[Delete] : This deletes a signal selected in the list. 
[Input/Output] : This input pseudo input or output forced output in the list. 
[Load] : This loads a file defining named signals saved in the robot controller and in the 

computer. 
[Save] : This saves the information on the set named signals to the robot controller or 

computer. 
[Delete signal 
file in robot] 

: This deletes the named signal information in the robot controller. 

 
 

15.3.2.1. Adding new named signal or revising one 
To add a new named signal, click the [Add] button.  To revise one, select the signal to be revised from the list 
and click the [Edit] button. 

 
Figure 15-32 Signal Name Editing  

 
Input the general signal numbers and names, and select the signal type and display method, then when adding a 
new named signal, click the [Add] button. The set signal is added to the list. 
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The [Add] and [Change] buttons do not close the "Signal name edit" screen, so you can continue to add more 
signals. 
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15.3.2.2. Deleting a named signal 

Select the signals to delete from the list. You can select multiple signals by clicking them while holding down the 
[Ctrl] key or the [Shift] key on the keyboard.  
However, dedicated input/output signals cannot be deleted. 
Also, you cannot delete input signals and output signals at the same time.  Finally, delete the select signals in 
the list with a mouse click. 
 

15.3.2.3. Pseudo-input / forced output of named signal 
Pseudo input / forced output is executed for the I/O signal selected in the list. 
 
If you select an input signal in the list and click the [Input/Output] button, the pseudo input setting screen will be 
opend.Set the value of Bit or Port to execute the pseudo input.  

 
 
If you select an output signal in the list and click the [Input/Output] button, the forced output setting screen will be 
opend.Set the value of Bit or Port to execute the forced output. 
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15.3.2.4. Named signal definition information reading 
When you click the [Load] button, a message asking you to confirm that you want to delete a registered general 
input/output signal is displayed. 

This message asks you to confirm that you want to clear the current general input/output signal display. 
 

 
Figure 15-33 Deletion Confirmation Message for Registered General Input/Output Signal 

 
If you select [Yes] on this confirmation screen, the "Select locate" screen asking you to select the load source is 
displayed. 

 

  
Figure 15-34 Device Selection 

 
Select the device to load from, and then click the [OK] button. 
When PC is selected, the screen for selecting files on the PC is displayed. 
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If you select the robot controller, the named signal definition file is loaded from the robot controller. 
 
 

15.3.2.5. Saving definition information for named signals to a controller 
When you click the [Save] button, the "Select locate" screen asking you to select the save destination is 
displayed. 

 

  
Figure 15-35 Device Selection 

 
Select the device to save to, and then click the [OK] button. 
When PC is selected, the screen for selecting files on the PC is displayed. 
If you select the robot controller, the named signal definition file is saved to the robot controller. 
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15.3.3. Stop signal 

You can reference the statuses of stop signals (stop/not stop) input to the robot controller. 
From the project tree, double-click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [Stop Signals]. 
 

 
Figure 15-36 Stop Signal (Connected with CR800 series controller) 

 

 
Figure 15-37 Stop Signal (Connected with CR750/700/500 series controller) 

 
 
Stop O/P Operation panel 

T/B Teaching box 
I/O Dedicated input signal STOP and STOP 2, stop dedicated input（SKIP 

input） 
PC Stop by communication from PC etc. 

Emergency 
stop 

O/P Operation panel 
T/B Teaching box 
I/O External emergency stop input（CNUSR connector, EMGIN connector） 
EMG1/EMG2 Input state of external emergency stop (EXTEMG11/EXTEMG12) 
DOOR1/DOOR2 State of door switch connection（DOOR1/DOOR2） 
OPKEY1/OPKEY2 The state input of Mode selector switch（OPKEY1/OPKEY2） 
TBEMG1/TBEMG2 Input state of the emergency stop button switch of the teaching box 
TBENA1/TBENA2 Teaching box operation enable switch input state（TB ENABLS） 
DM1/DM2 Input state of the enable switch of the teaching box(3 position switch) 

Pin name of CNUSR 11 connector of controller  
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15.3.4. Register (CC-Link/EtherCAT) 

 
 

You can check the statuses of registers input to the robot controller from external equipment and registers output 
from the robot controller to external equipment.  
From the project tree, double-click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [Register 
(CC-Link) or Register (EtherCAT)]. 
The left side of the screen displays the status of the input registers and the right side displays the status of the 
output registers. 
A continuous range of registers to display can be set freely in [Monitor Settings]. 
Pseudo-input and forced output of registers are also possible. 

 

   
Figure 15-38 Registers (CC-Link/EtherCAT) 

 
 

This can only be used if the CC-Link/EtherCAT option card is mounted 
 on the robot controller or CC-Link IE Field Basic function is enable. 
 

 
Table 15-5 Register (CC-Link) Screen Correspondence Table 

Robot Contoroller CC-Link CC-Link 
IE Field 

CC-Link 
IE Field Basic EtherCAT 

CRn-500 ○ × × × 
CR750-D/CRnD-700 ○ × × × 
CR750-Q/CRnQ-700 × × × × 
CR800-D ○ ○ ○(A1c or later) ○(A3b or later) 
CR800-Q × × ○(A1c or later) × 

       ○ : Enable, × : Disable 
 

Caution 
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15.3.4.1. Monitor setting 
A continuous range of registers to display can be set freely. 
Set the lead numbers for the input register number and output register numbers to display, set their respective 
display ranges on the line, and then click the [OK] button.  

 
 
 

 
Figure 15-39 Registers (CC-Link/EtherCAT) Monitor Settings 
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15.3.4.2. Pseudo-input  

Pseudo-input means registers are input to the robot controller from the computer, not from external equipment. 
Click the [Pseudo-Input] button. A screen for inputting pseudo signals is displayed. 

 

 
 

 
Figure 15-40 Pseudo-Input 

 
(1) Read the signals you want to pseudo input. 

You can set 16 registers at the same time. Input the head number for the signals you want to read, and 
then click the [Set] button. The input statuses of the 16 registers starting from the specified head signal 
number are displayed.  

(2) Set the pseudo-input status, and then click the [Input] button. The set register values are pseudo input to 
the robot controller. 

(3) You can display and make pseudo input for register values in hexadecimal. If you have selected [Hex], input 
values as hexadecimals. 

 
When you click the [Refresh] button, the latest register information is displayed. 

 
 

While the robot controller is in pseudo-input mode, register input 
from external devices is not accepted. 

 

To use pseudo-input, put the robot controller into pseudo-input mode. While the robot controller is 
in pseudo-input mode, the robot controller does not accept register input from external devices. 

Click the [Pseudo-Input] button. The following confirmation message is displayed before the robot 
controller goes into pseudo-input mode. 

 
 
To release a robot controller from pseudo-input mode, switch the 
power for the robot controller Off, then On again. 

Caution 
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15.3.4.3. Forced Output 
 

You can forcibly output register values to external equipment from robot controllers. 
Click the [Forced Output] button. A screen for forcibly outputting registers is displayed. 

 
 

 
Figure 15-41 Forced Signal Output 

 
(1) First, read the registers you want to forcibly output. 

You can output 16 registers at the same time. Input the head number for the registers you want to forcibly 
output, and then click the [Set] button. The output statuses of the 16 registers starting from the specified 
head register number are displayed. 

(2) Set the output status, and then click the [OUTPUT] button. The specified register values are forcibly output 
from the robot controller. 

(3) You can also display and forcibly output register values in hexadecimal. If you have selected [Hex], input 
values as hexadecimals. 

 
When you click the [Refresh] button, the latest register information is displayed. 
 

 
 
 

Forced register output 
Forced output is possible if the robot controller mode is either [AUTOMATIC] or [MANUAL] (for a 

CRn-500 series robot controller, [TEACH], [AUTO (OP)], OR [AUTO (EXT.)]), but if even one program 
is running, forced output is not possible. (Except ALWAYS program) 

Caution 
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15.3.5. IO unit monitor 

You can monitor the XY device variables of the IO unit. 
From the project tree, double-click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [IO unit]. 
The statuses of the input signals are displayed on the upper table, and the statuses of the output signals are 
displayed on the lower table. 
The signal values can display signed 16-bit integers or signed 32-bit integers in decimals or hexadecimals. 
A continuous range for the display signals can be freely set in [Monitor setting]. 
This function is available in all versions of CR800-R/CR800-Q series controllers and in CR750-Q/CRnQ-700 
controller Ver.R3 or later. 

 

 
Figure 15-42 IO unit monitor 

 
 

15.3.5.1. Monitor setting 
Click the [Monitor setting] button. The PLC IO unit monitor setting screen is displayed. 
Set the starting number of each device and indicate the number of lines to display also indicate the data size 
display method when displaying signals. 
After setting, click the [OK] button. 

 

 
Figure 15-43 IO unit setting screen 
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15.3.6. DSI CNUSER2 input signal monitor 

You can monitor the DSI1 and DSI2 input signals and the Monitoring mode. The DSI1 and DSI2 input signals are 
used for switching the monitoring mode of the safety monitoring function. For details of these parameters, refer to 
the "Robot Safety Option manual" (BFP-A3372). 

 
This function is available in all versions of CR800 series controllers and in CR750/700 controller software Ver.R6, 
S6 or later. The items monitored by this connected controller differ on this screen. 

 

 
Figure 15-44 DSI signal monitor (Connected with CR800 controller) 

 

 
Figure 15-45 DSI CNUSER2 input signal monitor (Connected with CR750/700 controller) 
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15.3.7. SCNI signal monitor 

You can monitor the SCNI input signals and the Monitoring mode. The SCNI input signals are used for switching 
the monitoring mode of the safety monitoring function. For details of these parameters, refer to the “Safety 
Communication Function Instruction Manual” (BFP-A3772). 

 
This function is supported for CR800-R controllers version C2 and later manufactured after April 2021(Note 1). 
Note 1:The date of manufacture can be found in the DATE column on the rating plate located on the right side of 
the controller. 

 
Figure 15-46 SCNI signal monitor 
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15.3.8. Device Monitor 

You can check the bit status of the device of the robot CPU (R16RTCPU) accessible from the external device. 
This function can be used with CRn800 series robot controller. 
From the project tree, double-click the target project [Online] -> [Monitor] -> [Signal] -> [Device]. 
Multiple screens can be launched from one project. 
 

 
 Figure 15-47 Device monitor start  

 
For [Device name], a list of accessible devices is displayed. When you select a device, it will start monitoring the 
bit status of that device. 

 
Selectable devices are as follows. 

Connected with CR800-D  
series controller 

Connected with CR800-R  
series controller 

Connected with CR800-Q 
series controller 

X(Bit device) 
Y(Bit device) 
D(Word device) 
SM(Bit device) 
SD(Word device) 
U3E0\HG(Word device) 
U3E1\HG(Word device) 

X(Bit device) 
Y(Bit device) 
M(Bit device) 
D(Word device) 
SM(Bit device) 
SD(Word device) 
U3E0\G(Word device) 
U3E1\G(Word device) 
U3E2\G(Word device) 
U3E3\G(Word device) 
U3E0\HG(Word device) 
U3E1\HG(Word device) 
U3E2\HG(Word device) 
U3E3\HG(Word device) 

X(Bit device) 
Y(Bit device) 
M(Bit device) 
D(Word device) 
SM(Bit device) 
SD(Word device) 
U3E0\G(Word device) 
U3E1\G(Word device) 
U3E2\G(Word device) 
U3E3\G(Word device) 

 
 



 

15-372  15-372 

 
Figure 15-48 After device setting 

 
On the right end of the field, in the rightmost column, in the notation selected in [Display format], the value of the 
bit of that line is displayed. 
You can select display format from hex, unsigned decimal, signed decimal. 

 
By double-clicking the bit value of the device or pressing the space key, the value of the bit at that position is 
changed. 

 
By clicking (the space key) the bit value of the device, the value of the bit at that position is changed. 
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15.4. Operation Monitoring 

15.4.1. Operating Information 

You can check the robot work time, battery usage time, etc. 
From the project tree, double-click the target project [Online] -> [Monitor] -> [Operation Monitor] -> [Operating 
Information]. 

 

 
Figure 15-49 Operating Information 

 
When connected to the CR800 series robot controller, the remaining battery time is not displayed. 
You can initialize the battery remaining time with [Maintenance] -> [Initialize]. For details on operation methods, 
see "16.2.4 Initializing the battery remaining time". 
 
 
15.4.2. Production Information 

You can check the latest tact time, run time, cycle count, and average tact time for each program in the robot 
controller. The latest tact time, run time, and average tact time can be measured up to 1193 hours (about 49 
days). 
From the project tree, double click the target project [Online] -> [Monitor] -> [Operation Monitor] -> [Production 
Information]. 
 

 
Figure 15-50 Production Information 

 
The production information is not constantly updated. Click the [Refresh] button as necessary. 
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15.5. Servo Monitor 
This monitors servo information. 

 
Table 15-6 Supported robot 

Controller Type Supports 
CR500 Not available 
CR700/CR750 Except for RP Micro working type 
CR800 All robot 

 
The servo data items can be monitored by simulation as follows.  

 
Table 15-7 Supported servo data items by simulation 
 Items possible 
1 Position feedback ○ 
2 Position in 1 rotation × 
3 Fdt command × 
4 Position droop ○ 
5 Max. position droop ○ 
6 Position command ○ 
7 Speed command ○ 
8 Speed feedback ○ 
9 Speed MAX. ○ 
10 Current cmd ○ 
11 Current feedback ○ 
12 Max. current cmd1 ○ 
13 Max. current cmd2 ○ 
14 RMS current ○ 
15 Tolerable cmd- ○ 
16 Tolerable cmd+ ○ 
17 Axis load level ○ 
18 Max. axis load level ○ 
19 Encoder temp. × 
20 Motor power voltage × 
21 Motor power voltage (MAX) × 
22 Motor power voltage (MIN) × 
23 Regeneration level × 
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15.5.1. Position (ABS) 

Data concerning the position of each axis motor can be monitored.  
The following data can be monitored.  

 
- Position feedback 

Current motor rotation position is displayed by the pulse value of the encoder.  
- Position in 1 rotation 

Present single motor rotation position of the encoder is displayed.  
(It is not displayed in the CR800/750/700 series controller. It is always 0.)  

- Fdt command 
The amount of the change of the position command between the control cycles is shown.  
(It is not displayed in the CR800/750/700 series controller. It is always 0.)  

- Position droop 
The amount of deflection at the motor rotation position relative to the position command is shown.  

- Max. position droop 
The maximum value of position droop after robot controller’s power supply is turned on is displayed.  

- Position command 
The command of the motor rotation position for the servo is displayed by the pulse value.  

 
Click the [Reset] button to reset all Servo Monitors.  

 

 
Figure 15-51 Servo monitor - ABS 
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15.5.2. Speed 

The following data concerning the rotational speed of each axis motor can be monitored.  
 
- Speed feedback 

A present motor speed is displayed in units of rpm.  
- Speed MAX.  

The maximum value of the speed feedback after the robot controller power supply is turned on is 
displayed.  

- Speed command 
The motor speed command is displayed by the unit of rpm.  

 
Click [Reset] button to reset all Servo Monitor.  

 

 
Figure 15-52 Servo monitor - Speed 

 
 



 

15-377  15-377 

 
15.5.3. Current 

Data concerning the electrical current value of each axis motor can be monitored. 
The following data can be monitored.  

 
- Current cmd 

The current command of the motor is displayed.  
- Max. current cmd1 

The maximum value of the current command after robot controller power supply is turned on is displayed.  
- Max. current cmd2 

The maximum value of the current command for the last 2 seconds is displayed.  
- Current feedback 

A present value of the motor current is displayed.  
- Tolerable cmd-/+ 

The limit value of the minus side and the plus side of the current command set to the motor is displayed.  
- RMS current 

Present RMS value of the motor current is displayed.  
 

Click [Reset] button to reset all Servo Monitor.  
 

 
Figure 15-53 Servo monitor - Current 
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15.5.4. Load 

The load state of each axis motor and the temperature of the encoder (Only the robot that corresponds to the 
function of the encoder temperature) can be monitored.  

The following data can be monitored.  
 

- Axis load level 
The present load ratio of each motor is displayed as an alarm level.  
An overload error occurs when this value reaches 100%.  

- Max. axis load level 
The maximum value of the axis load level after the robot controller power supply is turned on is displayed.  

 
Click the [Reset] button to reset all Servo Monitors. 
The robot controllers supporting the encoder temperature function are as follows.  

 
Robot controller Software version of the robot controller 

CR800-D/CR800-R/ CR800-Q All versions 
CR750-D/CRnD-700 Ver.S3 or later 
CR750-Q/CRnQ-700 Ver.R3 or later 

 

 
 

Figure 15-54 Servo monitor – Load 
 
When the [Change] button is clicked, the following dialog for changing the ambient temperature is started up. The 
ambient temperature parameter can be changed in this dialog. 
 

 
Figure 15-55 Screen of change ambient temperature 
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15.5.5. Power 

The following data concerning robot controller’s main circuit power supply can be monitored.  
 

- Motor power voltage 
A present power-supply voltage value is displayed.  

- Motor power voltage (MAX)  
The maximum value of the motor power voltage in servo ON is displayed.  

- Motor power voltage (MIN)  
The minimum value of the motor power voltage in servo ON is displayed.  

- Regeneration level 
The regenerative current value of each axis is displayed as an alarm level.  
The excessive regeneration error occurs when this value reaches 100%.  

 
Click [Reset] button to reset all Servo Monitor.  

 

 
Figure 15-56 Servo monitor - Power 
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16.  Maintenance  
 
In maintenance, you can maintain the robot in various ways, including setting origin data and initializing various 
information. 
 
16.1. Setting Origin Data 
You can save robot origin data to a file, edit it, and transfer it to a robot controller. 

 
Set origin data while connected to the robot controller.  
From the project tree, double-click the target project [Online] -> [Maintenance] -> [Origin Data]. 

 

 
Figure 16-1 Starting up the Origin Data Setting Screen 

 
 

 
Figure 16-2 Origin Data Screen 

 

About controller modes in which origin data can be read/written 
The controller modes (TEACH/AUTO (OP)/AUTO (EXT.)) in which origin data can be read/written 

depend on the CRn-500 series robot controller version.  For details, see "Table 16-1 Origin Data 
Reading Robot Control Operation Mode" and "Table 16-2 Origin Data Writing Robot Control 
Operation Mode". 

Caution 
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* About robot controller run modes when origin data is read/written 

 
In CRn-500 series robot controllers, when robot origin data is read/written using this software, there are 
restrictions on the controller run mode according to the robot controller software version. 
See the table below. 

 
(1) Reading 

Table 16-1 Origin Data Reading Robot Control Operation Mode 

CRn-500 series robot controller 
Operating mode 

TEACH AUTO 
(OP) 

AUTO 
(EXT.) 

J1 edition or later ○ ○ ○ 

H7 edition or earlier × × ○ 

○: Reading possible, ×: Reading not possible 
 
 
(2) Writing 

Table 16-2 Origin Data Writing Robot Control Operation Mode 

CRn-500 series robot controller 
Operating mode 

TEACH AUTO 
(OP) 

AUTO 
(EXT.) 

J1 edition or later ○ ○ ○ 

G9 edition – H7 edition ○ × ○ 

G8 edition or earlier ○ × × 

○: Writing possible, ×: Writing not possible 
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16.1.1. Origin data input 

You can save robot origin data to a file, edit it, and transfer it to a robot controller. 
Click "origin data input" on the origin data screen to display the screen. 
 

 
Figure 16-3 Origin Data Input Technique Screen 

 
 

[Write] : Writes the origin data displayed on the screen to the robot controller. 
[Save to file] : The displayed origin data can be saved to a file. 
[Read from a file] : Stored origin data can be read from a file and displayed on the screen. 
[Refresh] : Reads the origin data from a robot controller and displays the latest 

status. 
 
In this method, the origin is set by inputting the origin data of each axis. The origin data is pasted on the cover of 
the robot body. Please input the origin data by the following procedure. 
 
1)  Turn off the power and remove the robot cover that records the origin data. 
2)  Enter origin data in D, J1 - J8 by the above setting screen. 
3)  Click the write button. 
 
The origin data position pasted on the robot body cover will vary depending on the model. Please refer to [Robot 
Setup to Maintenance]. 
 

 
 

Input the correct values for the J7 and J8 origin data. 
For the J1-J6 axis origin data, the compatibility of values in the robot controller are checked but 

the J7 and J8 origin data are not checked. Always input correct values. 
The J7 and J8 axis origin data is only displayed when there is a supported additional axis. 

Caution 
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About DJNT (origin error) parameters 
DJNT shows the origin position error. When revising the origin position using the position repair 

tool, the value is set in DJNT. (When not revising the origin position using the position repair tool, 
all the elements become 0. However, for RV-4A, the values are entered beforehand.)  

DJNT is not released to general customers, so the values can not be directly changed. 
 

About DJNT parameter display 
Sometimes DJNT parameters are not displayed for certain robots (for example, robots that do not 

support the position repair function, etc.). 

Memo 
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16.1.2. Mechanical stopper  

This uses the robot mechanical stoppers to set the robot origin. 
Click the [Mechanical stopper] button on the origin data screen to display the screen. 

 
After moving the robot to a mechanical stopper origin position, select the axis to set the origin for with the 
checkbox, and then click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. This is sometimes not displayed for some 
robot controller software versions. 
 

 
Figure 16-4 Origin Setting (Mechanical Stopper) Screen 

 
In this method, we use the state where the robot arm is in contact with the mechanical stopper. Please follow the 
procedure below. 
 
<Common to RH / RV series> 
1)  Release the brake and then use jog to bring the robot arm into contact with the mechanical stopper. 
Mechanical stopper is located on the + side and the - side, you can check which is to be contacted by the sign of 
the parameter. (MORG) 
2)  End brake release and servo OFF. 
3)  Select the axis form the above screen and click the [Set Origin] button.( Can be set simultaneously on 
multiple axes) 
4)  1 - 3 correspond to the J1 - J2 axes of the RH series, and the J1 - J4 axes of the RV series. 
 
< RH series > 
5)  Set the origin of the J3 and J4 axes at the same time. Release the brake of J3 and contacted with the + side 
of the machine stopper. In this state, align the J4 axis with the mark. 
6)  End brake release. 
7)  Select the J3 and J4 axes from above screen and click the [Set Origin] button. 
 
< RV series > 
5)  Set the origin of the J5 and J6 axes at the same time. First, Fix the J5 axis by the procedure of 1 - 3. In this 
state, align the J6 axis with the mark. 
6)  Select the J5 and J6 axes from above screen and click the [Set Origin] button. 
 

 

Release the brake, there is an axis falling by its own weight. 
Depending on the posture of the robot, the arm falls by its own weight when releasing the brake. 

For safety reasons, take measures to prevent it from falling before releasing the brake. 

Caution 
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16.1.3. Tool  

This uses the origin setting tool to set the robot origin. 
Click the origin data screen [Tool] button to display the screen. 

 
After moving the robot to the tool origin position, select the axis to set the origin for with the checkbox, and then 
click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. This is sometimes not displayed for some 
robot controller software versions. 
 

 
Figure 16-5 Origin Setting (Tool) 

 
In this method, wo use the tool to set the origin data for each axis. The tool is used by inserting each axis into a 
pin hole for origin setting when each axis is moved to the origin position. Please follow the procedure below. 
 
<Common to RH / RV series> 
1)  Release the brake and ues the jog to match the pin hole for origin setting.  
2)  Move the axis back and forth so that the tool passes through the pin hole. 
3)  End brake release and servo OFF. 
4)  Select the axis form the above screen and click the [Set Origin] button. 
5)  1 - 4 correspond to the J1 - J2 axes of the RH series, and the J1 - J4 axes of the RV series. 
 
< RH series > 
6)  Set the origin of the J3 and J4 axes at the same time. Release the brake of J3 and contacted with the + side 
of the machine stopper. In this state, align the J4 axis with the mark. 
7)  End brake release. 
8)  Select the J3 and J4 axes from above screen and click the [Set Origin] button. 
 
< RV series > 
6)  Set the origin of the J5 and J6 axes at the same time. First, Fix the J5 axis by the procedure of 1 - 4. In this 
state, align the J6 axis with the mark. 
7)  Select the J5 and J6 axes from above screen and click the [Set Origin] button. 
 
* If you need an origin setting tool, please contact our service department. 
* The position of pin hole will vary depending on the model. Please refer to [Robot Setup to Maintenance]. 
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Release the brake, there is an axis falling by its own weight. 
Depending on the posture of the robot, the arm falls by its own weight when releasing the brake. 

For safety reasons, take measures to prevent it from falling before releasing the brake. 

Caution 
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16.1.4. ABS  

This uses the robot's ABS origin position robot to set the robot origin. 
Click the origin data screen [ABS] button to display the screen. 

 
After moving the robot to the ABS origin position, select the axis to set the origin for with the checkbox, and then 
click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. This is sometimes not displayed for some 
robot controller software versions. 
 

 
Figure 16-6 Origin Setting (ABS) Screen 

 
In this method, we use the ABS mark to set the origin. The ABS mark is a triangular mark attached to each axis or 
Scribe line. The robot stores the position within one revolution of the encoder,you can set the exact origin by 
matching the ABS mark within 1mm of the deviation. Please follow the procedure below. 
 
<Common to RH / RV series> 
1)  Move with jog so that the deviation amount of ABS mark is within 1 mm. 
2)  Select the axis form the above screen and click the [Set Origin] button.( Can be set simultaneously on 
multiple axes) 
3)  1 - 2 correspond to the J1 - J2 axes of the RH series, and the J1 - J4 axes of the RV series. 
 
< RH series > 
4)  Set the origin of the J3 and J4 axes at the same time. Release the brake of J3 and contacted with the + side 
of the machine stopper. In this state, align the J4 axis with the mark. 
5)  End brake release. 
6)  Select the J3 and J4 axes from above screen and click the [Set Origin] button. 
 
< RV series > 
6)  Set the origin of the J5 and J6 axes at the same time. J5, J6 axis simultaneously execute 1 - 2. 
 
* The position of ABS mark will vary depending on the model. Please refer to [Robot Setup to Maintenance]. 
 
 
16.1.5. User Origin Method  

This uses the robot user origin to set the robot origin. 
Click the origin data screen [User origin method] button to display the screen. 

 
After moving the robot to the user origin position, use the checkbox to select the axis to set the origin of, and then 
click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. For some robot controller software versions, 
this is sometimes not displayed. 
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Figure 16-7 Origin Setting (User Origin Method) Screen 

 
In this method, we use the user-determined origin position and the joint value at that time to set the origin. 
However, before using this method, you need to use other methods to preset the origin. Please follow the 
procedure below. 
 
< When the origin setting is the first time > 
1)  Move the robot by jog operation and decide the posture to be the user origin. At this time, please put a 
landmark so that you can move to the same posture again by jog. 
2)  Write the user-specified origin position parameter (USERORG) after recording the current joint value read 
from T/B or RT ToolBox3. This operation associates the current pose with the joint value and displays it as the 
origin data on the origin setting (user origin method) screen. 
 
 

 
 
 
< When the origin setting is the second time or later > 
3)  Move to the posture decided in 1. 
4)  Select the axis form the above screen and click the [Set Origin] button. By this operation, the current posture 
is set as the joint value determined in 2. 
 
* Please refer to [Robot Setup to Maintenance]. 

Posting 
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16.1.6. Origin Parameter Backup 

You can back up the parameters that make up the origin data. Also, you can transfer the backed-up data to a 
robot controller. 
Click the origin data screen [Backup origin parameter] button to display the screen. 
 

 
Figure 16-8 Robot Origin Parameter Backup Screen 

 
 

[Save to file] : This saves origin parameters read from a robot controller (displayed 
parameters) to a file. 

[Select file for writing 
to robot] 

: Transfers origin parameters stored in a file to a robot controller. 
When transferring to a CRn-500 series robot controller with edition H7 or 
earlier, set "Teach" mode. 

 

 
 
 

When a password is registered in “Parameters” by the robot controller's 
security function, it is not possible to restore backed-up origin data strings to 
the robot controller by the "origin parameter backup" screen. 

When the password is registered in “Parameter” by the robot controller's security function, it is not 
possible to restore the origin data strings to the robot controller by the "origin parameter backup" 
screen. 

 
○ : Enable、 × : Disable 

  Item to which password of security function is registered. 
Program Parameter File 

Restore the origin data ○ × ○ 

 
Please delete the password in the robot controller's security function when performing restoration 

of backed-up origin data. See "16.5.3 Delete Password" for how to delete the password.  
For details on setting security functions (registering passwords) and releasing security functions 

(deleting passwords) on robot controllers, refer to "Table 16-12 Compliant version of this function 
and controller". 

Caution 
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16.2. Initialization 
This initializes information in a robot controller. 
Here, you can initialize the following information in a robot controller. 
(1) Setting the robot controller clock  
(2) Initializing all programs in the robot controller 
(3) Initialize the remaining battery time in the robot controller 

(When connected to the CR800 series robot controller, the remaining battery time is not displayed.) 
(4) Check the serial number in the robot controller and set the serial number for the connected robot  

(Serial number checking and setting can only be used with CR800/750/700 series robot controllers.) 
 
 
16.2.1. Starting 

Use the initialization function while connected to the robot controller.  
From the project tree, double-click the target project [Maintenance] -> [Initialize]. 
 

 
Figure 16-9 Starting Initialization Screen 

 
 
16.2.2. Setting the time in the robot controller 

You can set the robot controller clock. 
On the initialization screen, click the [Set time] button. 
 

 
Figure 16-10 Time Setting Screen 

 
Set the new date and time, then click the [OK] button. 
You can set the current date and time from your computer by clicking the [Get PC time] button. 
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16.2.3. Deletion of all robot programs 

This deletes all the programs in the robot controller. 
On the initialization screen, click the program group [Initialize] button. 
A confirmation screen is displayed, so input "Yes", and then click the [OK] button. 
 

 
Figure 16-11 Confirmation Screen for Program File Initialization 

 

When a password is registered in programs by the robot controller's 
security function, it is not possible to delete all the programs in the robot 
controller. 

 

When a password is registered in programs by the robot controller's security function, it is not 
possible to delete all the programs (initialize the programs) in the robot controller.  

○ : Enable、 × : Disable 
  Item to which password of security function is registered. 

Program Parameter File 

Deletion of all robot programs. × ○ ○ 

 
Delete the password of robot controller's security function when you operate these. Refer to 

"16.5.3 Delete Password" for how to delete the password.  
For details on setting security functions (registering passwords) and releasing security 

functions (deleting passwords) on robot controllers, refer to "Table 16-12 Compliant version of 
this function and controller". 

Caution 
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16.2.4. Initializing the battery remaining time 

This initializes the remaining battery time in the robot controller. This function cannot be used when connected to 
the CR800 series robot controller. 
On the initialization screen, click the remaining battery time [Initialize] button. 
A confirmation screen is displayed. Input "Yes", then click the [OK] button. 

 
Figure 16-12 Confirmation Screen for Battery Time Remaining 

 
 
 
16.2.5. Serial number 

This checks the serial number in the robot controller and sets the serial number for the connected robot 
On the initialization screen, click the serial number group [Set] button. 

 
This function can only be used with CR800/750/700 series robot controllers. 
The first time you start up a CR800/750/700 series robot controller after purchase, the C0150 or C0152 warning 
(robot main unit serial number not set) is generated. On this screen, set the robot main unit serial number. 

 

 
Figure 16-13 Serial Number Input Screen 

Do not initialize unless the battery has been replaced. 
Be careful. If you initialize the remaining battery time other than when the battery is replaced, it will 

become impossible to reference a correct reading of the remaining battery time. 

Caution 
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16.3. Maintenance Forecasting 
With "Maintenance forecasting", you can reference the parts replacement timing (re-greasing, battery and belt 
replacement) from the operation data collected up to now in the robot controller. 
 

 
 
 
16.3.1. Specifications 

With CRn-500 series robot controllers, there are restrictions on the maintenance forecast functions according to 
robot models and versions supported. The robot controller software versions and models supported by the 
maintenance forecast function are as follows. 

 
Table 16-3 Supported models and software versions 

No. Robot CR800/750/700 series 
Robot controller 

CRn-500 series 
Robot controller 

1 RV-6S  series 
RV-12S series 

The supported models 
are not restricted 

Ver. J2 or later 

2 RV-3S  series 
RV-3SJ series Ver. K1 or later 

3 
RH-6SH  series 
RH-12SH series 
RH-18SH series 

Ver. K4 or later 

4 RV-2S series - 

 
 
 
16.3.2. Startup 

Use the maintenance forecast function while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Maintenance] -> [Maintenance Forecast]. 

 
Figure 16-14 Maintenance Forecasting Startup 

 

The results of calculations in Maintenance Forecast merely show 
reference values. 
Perform daily inspection and periodic inspections to prevent 
breakdowns beforehand, and to ensure safety. 

Caution 
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16.3.3. Forecasting 

You can reference the "time until battery replacement", "time until re-greasing”, and “time until belt replacement".  
 

 
Figure 16-15 Forecast Screen 

 
By clicking the [Refresh] button, you can reacquire information on maintenance from the robot controller. 
 
 
(1) Battery  

If the number of remaining hours of battery life has reached 

 
the hours and bar graphs are displayed in orange. 
(The battery replacement time is calculated during the time when the controller’s power is not on.) 
When connected to the CR800 series robot controller, the remaining battery time is not displayed. 
 

(2) Grease 
If the hours until replenishment time has reached 

 
the hours and bar graphs are displayed in orange. 

 
 
(3) Belt 

If the hours until belt replacement time has reached 

 
the hours and bar graphs are displayed in orange. 
 
 

(4) Display units 
You can switch the display units for "Grease" and "Belts" between hours and days.  When days are selected 

as the display unit, the number of days of operation is calculated from the number of operating hours per day and 
that number of days is displayed. 
 

(Hours until replacement time) < ([Remaining days of expected operational life] on the Setup 
screen) x ([Daily operation time]), 

(1) Battery 

(2) Grease 
(3) Belt 

(4) Display units 

(Remaining time) < [Remaining days until expected maintenance time] on the Setup screen) x 
(24 - [Daily operation time]) 

(Hours until replenishment time) < ([Remaining days until expected maintenance time] on the 
Setup screen) x ([Daily operation time]), 
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16.3.4. Settings 

Here, you can set the timing for collecting information concerning maintenance forecasts, the notification method, 
etc. 

 
Figure 16-16 Setup 

 
When the [Write parameters] button is clicked after setting each item, the setting values are written into the 
controller. All items take effect after they are written into the controller, except for signal numbers of dedicated 
outputs. If a dedicated output signal has been changed, it is necessary to power on the controller again. 

 
For details on the setting items, see "Table 16-4 Description of the Setup Screen". 

 

 
 

(1) Enables maintenance 
forecasting 

(2) Information 
collection level 

(3) Notice interval 

(4) Warnings 

(5) Output dedicated 
output signal 

(6) Operating time 
per day 

(7) Remainder 
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Table 16-4 Description of the Setup Screen 

Item Explanation 
Factory 
preset 
value 

(1) Maintenance Forecast is 
made effective. 

If this is checked, the Maintenance Forecast function is enabled. 
* If the checkmark is removed, the collection of Maintenance Forecast 

information stops, and the correct maintenance times cannot be 
calculated. 

Check 
ON 

(2) Collection level of information Five levels can be specified to collect the information on maintenance. 
* As the information collection level gets higher, the accuracy of the 

maintenance improves, but it affects the tact time more. 

1 
(Recomm 

ended) 
(3) The interval of the forecast Specify the interval of maintenance time notification. 6 hours 
How to inform When the grease replenishment, belt replacement, and other maintenance times 

have been reached, they can be notified by generating a warning or outputting a 
dedicated signal. As for the battery replacement time, one of warnings, C7500, 
C7510, and C7520, is generated, regardless of whether or not [Warning] under 
[How to inform] is checked. 

The warning generated varies depending on each situation. 

 (4) Warning If this item is checked, the maintenance time is notified as a warning. 
The warning numbers are listed as follows: 
Grease   : C753* (* is the axis No.) 
Belt      : C754* (* is the axis No.) 

Check 
ON 

(5) Output Signal If this item is checked, signal numbers can be entered. If this item is 
checked and a signal number is entered correctly, the maintenance 
time is notified using the output of the designated signal. 

Check 
OFF 

(6) Assumption operation 
time of a day 

Enter an estimated robot operation hours per day. 16 hours 

(7) The remainder days until 
presumed maintenance 
time 

Specify the number of days remaining until estimated maintenance 
time for use as a reference to notify the maintenance time. 

14 days 

 
 

 
 
 

How to reset the generated warning and output warning signal 

There are output of warning occurrence (C753 *, C754 * (* is the axis number)) and dedicated output 
signal (M * PTEXC (* is the robot number)) as a notification method of each part replacement time. 
When both are set by the notification method, it is possible to turn off the warning occurrence and turn off 
the signal output by the error reset operation. 

If you wish to invalidate "warning occurrence" and make only the output of the dedicated output signal 
valid with the notification method, even if you press the reset button on the front of the controller, the output 
signal will not turn OFF. In this case, if you press the [ERROR RESET] key of the teaching pendant or input 
the error reset signal (ERRRESET), the signal output turns OFF. 

Notification method 
setting Notification 

method 

How to reset notification (warning occurrence or dedicated 
signal output) 

Warnings 
Dedicated 

Output 
Signal 

On the front of the 
controller  
[RESET] 

T / B's  
[ERROR RESET] 

From the outside 
Error reset signal 

  
Warning 

occurrence Possible Possible Possible 

  

Warning 
occurrence 
Dedicated 

signal output 

Warning, 
dedicated signal 
Resetable 

Warning, 
dedicated signal 
Resetable 

Warning, 
dedicated signal 
Resetable 

  
Dedicated signal 

output Can not reset Possible Possible 

 

MEMO 
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16.3.5. Reset screen 

The information (about battery, grease and belt) for Maintenance Forecast kept in the controller can be reset. 
 

 
Figure 16-17 Reset 

 
 

Table 16-5 Description about each reset 
Type of reset Explanation Note 

At time of battery 
replacement 

It is used when an alarm urging to replace 
the batteries (C7500, C7510 or C7520) 
occurs and the batteries have been replaced. 
Be sure to reset the remaining battery time 

after a battery has been replaced. 

  

At time of grease 
replenishment 

When an alarm urging to perform periodic 
inspection and grease replenishment (alarm 
numbers in the 7530s) occurs, replenish the 
grease and reset the replenished axis. 

Axes are reset in units of joint 
axes. Multiple joint axes can be 
reset at the same time. 

At the time of belt 
exchange 

When an alarm urging to perform periodic 
inspection and to replace the belt when it is 
damaged (alarm numbers in the 7540s) 
occurs, replace the belt and reset the axis for 
which the belt is replaced. 

Axes are reset in units of joint 
axes. Multiple joint axes can be 
reset at the same time. 

 
These reset operations can be executed using the teaching box. See the following section for further details. 
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When the [Log] button is clicked in the upper-right corner of the window, the previous reset date/time and reset 
count can be checked. 
However, the battery reset count is not displayed. 
If no reset has not made previously, “----/--/-- --:--:--“is displayed. 

 

 
Figure 16-18 Reset Log 
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16.3.6. Resetting maintenance forecast information in Teaching Box 

When an alarm urging to replace the batteries, replenish the grease, or to replace the belt is issued based on the 
Maintenance Forecast function and these parts are replaced or replenished, the information that has been 
accumulated within the controller needs to be reset for the axis where such replacement or replenishment has 
been performed. 
The information that has been accumulated within the controller can be reset using not only this software, but 
also the teaching box. 

 
(1) Resetting the remaining battery time 

Table 16-6 Resetting the time of battery remaining 
 Explanation Operation 

Remaining 
battery time 

This is used when an alarm urging to 
replace the batteries (C7500, C7510 or 
C7520) occurs and the batteries have 
been replaced. 
Be sure to reset the remaining battery 
time after a battery has been replaced. 

From the teaching box (R32TB) menu screen, 
execute "5. Settings and Initialization" -> "1. 
Initialization" -> Battery. 

 
For details on how to initialize the remaining battery time using the teaching box, see "Detailed explanations of 
functions and operations" in the robot controller's operations manual. 

 
(2) Resetting the grease and belt information 

The grease and belt information can be reset by entering parameters to the controller. 
The following is the list of parameter names and the values to be entered. 
 

Table 16-7 Resetting the grease and belt information 
 Explanation Parameter Value 
Grease 
information 

When an alarm urging to perform 
periodic inspections and replenish 
grease (alarm numbers in the 7530s) 
occurs, replenish the grease and reset 
the replenished axis. 

MFGRST 

0      : Reset information on all 
axes 

 
1 to 8  : Reset information on the 

specified axis 

Belt 
information 

When an alarm urging to perform 
periodic inspections and to replace the 
belt when it is damaged (alarm 
numbers in the 7540s) occurs, replace 
the belt and reset the axis for which 
the belt is replaced. 

MFBRST 

(*These parameters cannot be read into Teaching Box unless the entire text is input.) 
 

The grease or belt information will be reset immediately after a parameter name and the value are entered. (In 
this case, the controller power does not need to be restarted.) If a value other than 0 is entered, the reset process 
will be executed for each axis. 
Repeat the parameter input operation when resetting information on two or more axes. 
Also note that the value read is always 0 regardless of the previously entered value. If you continue the input 
operation in this state, all axes will be reset. Exercise caution. 

 
See “Controller INSTURCTION MANUAL – Detailed explanations of functions and operations” for how to input 
parameters using the Teaching Box. 
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16.3.7. Others 

The information for Maintenance Forecast kept in the controller can be backed up and/or restored. 
 

 
 

 
Figure 16-19 Others 

 

The backup and restore operations are performed when the 
controller (CPU) is replaced. 
When the controller (CPU) is replaced, perform both backup and restore operations in a batch 

using the Backup/Restore tool. Also, be sure to back up the information for Maintenance Forecast 
before replacement, and restore the backed-up information after replacement. 

Perform Backup/Restore between controllers of the same version. If the version is different, an 
error might occur. 

After the controller (CPU) has been replaced, if the information for Maintenance Forecast is not 
restored, or it is restored after a substantial time has elapsed since the time of backup, please note 
that the reliability of Maintenance Forecast will be degraded. 

Caution 
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16.4. Position Repair Function 
The position repair function is restricted by the usable models and controller software versions.  See "Table 
16-9 Supported Robot Controllers and Model". 
 
The "position repair function" is used when a tool is deformed by a collision or the origin is out of place because 
the motor has been replaced. It is possible to use the previous position data in the controller simply by reteaching 
part of the position data within the robot program. (Position repair generates parameters to correct the position 
deviation and corrects all the position data in the robot controller.) 
However, understand that there are some cases that position repair cannot restore, such as applications 
requiring high precision and major mechanical damage to a robot from a collision. 
Also, restrictions on a robot's degrees of freedom can make it impossible to recover with position repair.  Since 
vertical 5-axis robots and horizontal 4-axis robots are restricted as shown in "Table 16-8 The limit by degree of 
freedom", positional deviations related to these restrictions cannot be corrected with this function.  In this case, 
either reteach manually or correct the deviating section (for example, by replacing a bent hand). 
 

Table 16-8 The limit by degree of freedom 
No. Robot model The limit by degree of freedom 

1 Vertical 5-axis robot It cannot move in the direction of the C element of the 
Cartesian position. 

2 Horizontal 4-axis robot It cannot move in the direction of the A, B elements of the 
Cartesian position. 

 
 
 
 

 

When a password is registered in parameters or files by the robot 
controller's security function, it is not possible to operate the Position repair 
Function. 

 

When a password is registered in “parameters” or “files” by the robot controller security function, it 
is not possible to operate the Position Repair Function. 

○ : Enabled、 × : Disabled 
  Item to which password of security function is registered. 

Program Parameter File 
Position repair Function ○ × × 
 

Please delete the password of robot controller's security function when you operate these. 
Please refer to "16.5.3 Delete Password" for how to delete the password.  

For details on setting security functions (registering passwords) and releasing security functions 
(deleting passwords) on robot controllers, refer to "Table 16-12 Compliant version of this 
function and controller". 

The position repair function cannot be used  
with Movemaster commands.  

The position repair function is only supported by MELFA-BASIC IV, MELFA-BASIC V and 
MELFA-BASIC VI. It cannot be used with Movemaster commands. 

Caution 

Caution 
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16.4.1. Specifications 

The robot models and robot controller versions with which the position repair function can be used are as follows. 
 

Table 16-9 Supported Robot Controllers and Models 

No. Robot model CR800/750/700 series 
Robot Controller CRn-500 series Robot Controller 

1 Vertical 6-axis robot 

The supported models 
are not restricted by the 

version 

Version J2 or later 
Only correction of origin data is 
supported in versions prior to J2. 

2 Vertical 5-axis robot 
Version K1 or later 

Only correction of origin data is 
supported in versions prior to K1. 

3 Horizontal 4-axis robot 
(RH-SH series only) 

Version K4 or later 
Any versions prior to K4 are not 
available. 
Moreover, This function cannot be 
used for the RH-AH series robot. 

 
 
16.4.2. Startup  

Use the position repair function while connected to the robot controller.  
From the project tree, double-click the target project [Online] -> [Maintenance] -> [Position repair]. 

 

 
 

Figure 16-20 Starting Position Repair 
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16.4.3. Flow of operations  

The position repair takes the form of a wizard. You can automatically generate the parameters by proceeding with 
operations according to the instructions on each screen. You can directly set the parameter values. 
 

 

Specify the target robot 

Specify the program to use for parameter 

generation (within robot controller) 

Move robot to re-teaching position 

(Use the teaching box) 

Specify the parameters to be generated 

Enter parameter values 

Parameter generation 

 

Write parameters to robot controller 

Execute re-teaching calculation 

Write parameters to robot controller 
 

Repeat as necessary 

Automatic parameter 

generation 
(Normal operation) 

If setting parameters 

Re-teaching Work Procedure 

Backup the parameters before 

 

 

Back up the selected program 

Restart robot controller power 
 

Restart robot controller power 
 

 
Figure 16-21 Operation Flow 

 
The explanation follows the normal operations flow. For a description of parameter value setting, see "16.4.16 
Revision parameter editing". 
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16.4.4. Introduction  

 

 
Figure 16-22 Starting Use Window 

 
This is an explanation of the position repair function.  Read it carefully, then click the [Next] button. 
 
 
16.4.5. Communication settings 

 

 
 
Check the communication settings and connected to the robot controller, click the [Next] button.  For the setting 
method, see "9 Connecting to the Robot". 
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16.4.6. Robot selection and parameter backup 

 

 
Figure 16-23 Robot and Backup Parameters Selection Window 

 
Select the robot to execute the re-teaching. 
The Robot is displayed as follows. 

 
 

To backup parameters, click [Backup].   
The dedicated backup screen starts.  For more details on backups, see "18 Backup and Restore". 
Backed up parameter files can be written back to a robot controller using the "backup/restore" functions of this 
software. 

 
When the preparations are completed, click the [Next] button. 

 
 
 

Controller number : Controller Name + Mechanism Name #Mechanism No. 

Displayed only in multi-mechanism mode. 

Parameter Backup  
During its operation, this software overwrites parameters to the robot controller. 
It is recommended that the parameters be backed up at this point to allow the controller to revert to 

the original parameters. 

Memo 
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16.4.7. Selection of Revision parameter generation procedure 

 

 
Figure 16-24 Select generation procedure of revision parameter Window 

 
In the next step, the software can either automatically generate parameters or accept manually entered 
parameter values. Normally, [Generate revision parameter automatically] is selected. 
 
Select [Generate revision parameter automatically] and click [Next] to proceed to “Select Program” window. 
Select [Edit the value of revision parameter directly] to proceed to the “Edit Revision Parameter” window. 
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16.4.8. Program selection 

 

 
Figure 16-25 Program Selection Window 

 
Select the robot program to use for revision parameter generation, then click the [Next] button. 
Here, perform the reteaching using the XYZ-coordinate position data in the selected program. 
 
For details on the required position data numbers, see "Table 16-10 Selection of Revision Parameters". 
 

 
 

 

Points on selecting the program 
Select the program with the positions data on the various locations and postures. 
Moreover, higher accuracy of revision parameters can be obtained by selecting the following type 

of position data programs. 
・ Programs with positions that are easy to re-teach 
・ Programs with positions that require high precision 

Memo 
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16.4.9. Program reading and backup 

 

 
Figure 16-26 Program Read and Backup Window 

 
To backup a program, click [Backup]. 
The special screen for backup is started. For details on backups, see "18 Backup and Restore".   
You can use the backup/restore functions in this software to write a backed-up parameter file back into a robot 
controller. 
 
When the preparations are completed, click the [Next] button. 
 

 
 
 
 

Robot Program Backup 
During its operation, this software may overwrite robot controller program (position data). 
It is recommended that the program be backed up at this point to allow the controller to revert to the 

original program. 

Memo 
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16.4.10. Tool setting check 

 

 
Figure 16-27 Tool Setting Check Window 

 
Parameter values for tool data set in the present robot controller are displayed. The row for the tool selected by 
the tool number (MEXTLNO) is highlighted in red. 
Please check whether the tool data and tool number used during teaching is set. 
If necessary, change the value from parameter setting in Teaching Box. Click [Renew List] to update the contents 
of the display. 
(If the CRn-500 series robot controller’s version is older than J2, only the standard tool (MEXTL) will be 
displayed.) 
 
Click [Next] when ready to proceed. 
 

 
 

 
 

Do not change tool data or base data. 
After this window, do not change tool data or base data. 
If they are changed during re-teaching operation, re-teach calculation cannot be done correctly. 
When correcting tool data, if teaching was performed switching back and forth between multiple 

tools, perform the re-teaching operation for each tool. 

Caution 
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16.4.11. Revision parameter selection 

 

 
Figure 16-28 Revision Parameter Selection Window 

 
Select the revision parameter that becomes the target for re-teaching calculation. 
 
The revision parameter will be selected automatically if an item is selected from [Select revision parameter]. 
Choose [Select all] to select all the revision parameters. If you wish to specify a particular combination of revision 
parameters, choose [Select arbitrarily] and specify the revision parameters. 
 

Vertical 6-axis robot If the CRn-500 series robot controller’s version is older than J2, only 
[Error of joint axis] can be selected. 

Vertical 5-axis robot If the CRn-500 series robot controller’s version is older than K1, only 
[Error of joint axis] can be selected. 

Horizontal 4-axis robot 
(RH-SH series only) 

The CRn-500 series robot controller’s any versions prior to K4 are not 
available. 
(This function cannot be used for the RH-AH series robot.) 

 
The supported models are not restricted by the version in the CR800/750/700 series robot controller. 
 
Click [Details] to see the description of the difference between checking and not checking [Use the posture 
elements of position data]. 
 
In the following section, details regarding revision parameters and posture elements of position data are 
explained. 
 
After choosing the revision parameters, click [Next]. 
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16.4.11.1. Revision parameters 

Parameters revised by items selected with "Select revision parameters" become as in "Table 16-10 Selection of 
Revision Parameters". 
 

 
 
 

 
 
 
 

Some elements cannot be calculated according to 
the robot type and the combination of revision parameters. 

In this function, the amount of the robot deviation is calculated as a correction value, and the 
revision parameter is generated. However, some elements cannot be calculated (the value becomes 
0) as the following two kinds of cases. 

 
* Cases which cannot be calculated due to the degree of freedom limitations of the robot 
Some elements of revision parameter cannot be reflected because Vertical 5-axis robots and 

horizontal 4-axis robots have limited degrees of freedom. 
 
* Cases condensed by the combination of robot mechanism and revision parameters 
Some revision parameter elements become the value on the same rotation axis due to the 

combination of the robot mechanism and revision parameters. In such cases, the calculated deviation 
value is condensed to the one element of the revision parameters. 

At this case, though the correction parameters become 0, the others are condensed and corrected. 
So it is not necessary to correct it again. 

Memo 
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Table 16-10 Selection of Revision Parameters 

No. Item Description Revised 
Parameter 

Minimum number of 
teaching points 

Vertical 
6-axis 
robot 

Vertical 
5-axis 
robot 

Horizo
ntal 

4-axis 
robot 

1 Error of 
joint axis 

Rectifies origin data when joint axis moves or when 
motor is replaced. 
Specify the target axes using the check boxes. 
The number of teaching points differs according to 
how the axis was specified. 

Origin data 

 

1 to 6 
points 

1 to 5 
points 

1 to 4 
points 

2 

Tool 
exchange 

or 
modified 

Rectifies attachment error when robot tool is 
exchanged. In addition, rectifies tool data error when 
the tool is transformed due to interference between 
robot and peripheral devices. 

Vertical 5-axis robot: 
* Only Z element of position data is corrected. 

  

Tool data 

 

3 to 6 
points 1 point 3 to 4 

points 

3 Transfer 
the robot 

Rectifies base data of robot position setup when the 
robot is transferred to another location. 

Vertical 5-axis robot: 
* Only X, Y, Z elements of position data are 
corrected. 

  

Base Data 

 

6 points 3 
points 

4 
points 

4 Exchange 
the robot 

When a robot is exchanged using the original tooling, 
it rectifies origin data error and base data of the robot 
position setup. 
Attachment error is also rectified for horizontal 4-axis 
robots only. 

Vertical 6-axis robot: 
* Origin data J1 is included in base data. 
Vertical 5-axis robot: 
* For base data, only the X, Y, Z elements are 

Corrected. 
Horizontal 4-axis robot: 
* Origin data J1 and J3 are included in base data. 
* Origin data J3 and J4 are included in tool data. 
* Select which to be requested because tool data 
and base data Z elements are not corrected at the 
same time. 

 
  

Base data 
Origin data 
 
Tool data 
(4-axis robot 

only) 
 

 
(5-axis and 
6-axis robot) 

 

 
(4-axis robot) 

10 to 
11 

points 

7 to 8 
points 

7 to 8 
points 

5 Select all 

Selects all revision parameters. 
 

Vertical 6-axis robot: 
* Origin data J1 is included in base data. 
* Origin data J6 is included in tool data. 
Vertical 5-axis robot: 
* For tool data, only the Z element is corrected. 
* For base data, only the X, Y, Z elements are 

corrected. 
Horizontal 4-axis robot: 
* Origin data J1 and J3 are included in Base data. 
* Origin data J3 and J4 are included in Tool data. 
* Select which is to be requested because Z 
elements of tool data and base data are not 
corrected at the same time. 

 
  

Origin data 
Tool data 
Base data 

 

13 to 
16 

points 

8 to 9 
points 

7 to 8 
points 
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No. Item Description Revised 
Parameter 

Minimum number of 
teaching points 

Vertical 
6-axis 
robot 

Vertical 
5-axis 
robot 

Horizo
ntal 

4-axis 
robot 

6 Select 
Arbitrarily 

Specify revision parameters. 
Vertical 6-axis robot: 
* Since origin data J1 is included in base data, if 
base data is selected, turn off the Checkbox of 
origin data J1. 

* Since origin data J6 is included in tool data, if tool 
data is selected, turn off the Checkbox of origin 
data J6. 

Vertical 5-axis robot: 
* For tool data, only Z element is corrected. 
* For base data, only X, Y, Z elements are 
corrected. 

Horizontal 4-axis robot: 
* If base data is selected, turn off the Checkboxes 
of origin data J1 and J3. 
Origin data J1 and J3 are included in base data. 

* If tool data is selected, turn off the Checkboxes of 
origin data J3 and J4. 
Origin data J3 and J4 are included in tool data. 

* If tool data and base data are selected together, 
select which Z element to be requested, because 
Z elements of tool data and base data are not 
corrected at the same time. 

  
  

    

* Revision parameter names correspond to the following. 
Origin data: DJNT 
Tool data: MEXDTL, MEXDTL1 to 4 (Parameter of the tool selected by tool number) 
Base data: MEXDBS 
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16.4.11.2. Position data posture components 

The position data of MELFA-BASIC IV, MELFA-BASIC V and MELFA-BASIC VI consists of tip position (X, Y, Z) 
and tip posture elements (A, B, C) (*1). 
This section describes the cases where [Use the posture elements of position data] is checked and not checked. 

 
 
(1) When [Use the posture elements of position data] is checked  

Not just the robot tip position (X, Y, Z) but also the tip posture elements are used for position correction 
calculation. 
The precision of generated revision parameters improves if the tip posture elements are also re-taught 
correctly. 
However, if the tip posture elements are not re-taught correctly, as shown in the diagrams below (re-teaching 
positions P1 and P2), error occurs in the position correction calculation, decreasing the precision of the 
calculation result. 

If posture elements are
re-taught accurately

Re-teaching
position P1

Re-teaching
position P2

Original position and posture

Position and posture before
re-teaching

Position and posture after
re-teaching

Re-teaching position

Original position
and posture

Re-teaching
position P3

If posture elements are not re-taught accurately

 
 

(2) When [Use the posture elements of position data] is not checked  
Posture elements in the position data taught during re-teaching are not used for position correction calculation. 
If it is not necessary to exactly match the tip posture elements during re-teaching, clear the checkbox [Use the 
posture elements of position data]. In such a case, position correction calculation is performed using only the 
tool tip position data (X, Y, Z), ignoring the error from posture deviation. This increases the precision of location 
correction. 
However, there are some restrictions.  For details, see "Table 16-11 About Posture Elements of 
Re-teaching Position Data". 

 
 

(*1) The posture elements of position data 
In vertical 6-axis robots, the position data posture elements are (A, B, C). 
In vertical 5-axis robots, the position data posture elements are (A, B). 
In horizontal 4-axis robots, the position data posture element is (C). 

Memo 
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Table 16-11 About Posture Elements of Re-teaching Position Data 

Condition Merit Note 
When using posture elements of position 

data 

 

Precision of generated 
revision parameter 
improves if the tip position 
(X, Y, Z) and tip posture 
elements are re-taught 
correctly. 

During re-teaching, posture must 
be taught correctly. If posture 
data is incorrect, precision of 
revision parameter actually 
decreases. 
 

When not using posture elements of 
position data 

 

During re-teaching, 
revision parameters can be 
generated simply by 
correctly teaching position 
(X, Y, Z). 
(Posture elements need 

not be accurate.) 

In vertical 6-axis robots: 
* Posture elements (A, B, C) of 
tool revision parameters cannot 
be obtained. 

* The J6 axis of origin revision 
parameters cannot be 
obtained if both X and Y 
components of the tool 
parameter are 0.0. 

In vertical 5-axis robots: 
* The J6 axis of origin revision 

parameters cannot be 
obtained. 

In horizontal 4-axis robots : 
* Posture elements (C) of tool 
revision parameters cannot be 
obtained. 

* The J4 axis of origin revision 
parameters cannot be 
obtained if both X and Y 
components of the tool 
parameter are 0.0. 
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16.4.12. Reteaching work 

 

 
Figure 16-29 Reteach Work Window 

 
[Remainder] 

 

Displays the number of remaining points until revision parameters are 
generated. 
However, at some positions, re-teaching may not decrease the number 

of remaining points. 
[Re-teach] button Specifies the positions selected in the list and opens “Re-teach the 

position” screen. 
[Clear] button Clears the re-teaching information for positions selected in the list. 

[Check of tool data] Displays current tool data setting in the robot controller. 
 

 
 

The position data for the selected program selected are is displayed. 
Select the position to re-teach from the list and repeat re-teaching to generate revision parameters. 
 
The re-teaching work procedure can be described as follows. While the “Re-teach the position” screen is open, 
move the robot to the re-teaching position and click the [Load current position] button on the screen. 
 

Position data of the targeted program is write-protected. 
When displaying this window, the position data of the targeted program in the controller is 

write-protected. If this tool is interrupted when not communicating with the controller, the protection 
cannot be released. Please release the protection using the Teaching Box or Program manager of this 
software. 

Caution 
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Figure 16-30 Re-teach the position Screen 

 
 

 

Revision parameter generation 

Re-teaching 

Repeat 

Click [Re-teach] button Re-teach the position Screen opens 

Move the robot to re-teaching position 
(Use the teaching box to move) 

 

Click [Load current position] button 

Select the position to re-teach from the list 

(Re-teaching calculation) Position Re-teaching window closes 

Re-teach the position Screen 

 
Figure 16-31 Re-teaching Work Procedure 

 
The row of the re-taught position will be highlighted in light blue. 
Re-teaching does not change the position data values shown in the list. 
 

 
 
 

Do not perform position correction using the teaching box. 
When you move the robot to the re-teaching position using the teaching box, be careful not to 

correct the position. 
During re-teaching, the position data of the applicable program in the controller is write-protected 

Caution 
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It is possible to change the revision parameters to be generated. 
Go back one step to the “Revision parameter selection” window to change the setting. Note that if you go back 
one more step to the “Tool Setting Check” window, all information set by re-teaching work will be cleared. 
 

 
 
 

When go back to “Tool setting check” window, all information set by 
re-teaching work will be cleared. 

Caution 

Cautions on using a robot with the additional axis. 
When restoring the position with a robot with a travel axis, reteach at a position where the travel 

position becomes the same as in the original position travel axis data.  (Move the robot so that the 
travel axis data becomes the same as the original position.) If the retaught position travel axis data 
differs from the original travel axis data, it is impossible to find the correct revision parameters. 

Caution 

Select position data with a different posture element,  
when re-teaching two or more positions. 

Select position data with a different posture element, when re-teaching two or more positions. 
When position data of the same posture element are selected, there is a possibility that the 

parameter is not correctly calculated. 

Caution 

Do not change tool data, tool number, or base data. 
Do not change tool data, tool number, or base data during re-teaching. Re-teaching calculation will 

not be performed correctly.  
When correcting tool data, if teaching was performed switching back and forth between multiple 

tools, perform re-teaching operation for each tool. 

Caution 
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16.4.13. Writing parameters 

 

 
Figure 16-32 Write Parameters Window 

 
[Print] Prints the revision parameter information displayed in the list. 
[Save position data to file] Saves position data used in re-teaching as a robot program with 

positions only. The position data will be the values converted by the 
revision parameters. 

 
Revision parameters and their values generated by re-teaching are displayed. 
Click the [Next] button to write the parameters into the robot controller. 

 
 

 
 

If revision parameters could not be generated 
If revision parameters could not be generated, parameters will not be displayed in the list. 
If you click the [Next] button, the position data used in re-teaching is written into the robot 

controller. 
Since parameters were not generated, the position data will not be converted. 
 
Parameters may not be generated under the following conditions. 
* When one of the specified re-teaching positions is of a significantly low precision 
* When one of the original position data is of a significantly low precision 
* When the difference between the original position data and the re-teaching position is too large 
* When tool data or base data was changed during re-teaching 
 
Clicking the [Back] button and redoing a part of the re-teaching may generate revision parameters. 
Delete the re-teaching information for position data that meets one of the criteria mentioned above 

and perform re-teaching again. 

Caution 
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16.4.14. Controller power supply Off, On 

 

 
Figure 16-33 Re-start the power supply of the controller Window 

 
To activate the written parameters, turn off and then turn on the power of robot controller. 
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16.4.15. Exit 

 

 
Figure 16-34 Finish Window (After Re-teaching) 

 
When the writing of revision parameters is done, operation of this function is complete. 
 
 

 
 

 
 

 
 

Perform an operation check before exiting this function. 
Before exiting this window, make sure that all position data works properly. 
If the revision is not correct, click the [Return to re-teach] button to continue re-teaching. (However, 

if you exited from “Edit revision parameters” window, the [Return to re-teach] button will not be 
shown.) 

Caution 

Back up the parameters. 
This Function has changed the revision parameters. Back up the parameters before exiting this 

window. 

Caution 

Position data close to operation area boundaries may not be 
rectifiable. 

There may be cases near the border of the operation area, where position error may put a point 
outside the operation area, in which case this function cannot rectify the point. 

Caution 



 

16-422  16-422 

 
16.4.16. Revision parameter editing 

When you select "Edit the value of revision parameter directly" with "16.4.7 Selection of Revision parameter 
generation procedure", this screen is displayed. 
 

 
Figure 16-35 Edit Revision Parameters Window 

 
[Print] Print the revision parameter information displayed in the list. 
[Reset] Reset all changes. 

 
This displays values of current revision parameters in the robot controller. 
Select a parameter from the list and double-click it to display the setting screen. Set the parameter values. 
(If the CRn-500 series robot controller version is older than J2, only the origin revision parameter (DJNT) is 
shown.) 

 
Click [Next] to write all parameters into the robot controller and proceed to the “Re-start the Power Supply of 
the Controller” window. 
 
 

Double click 
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16.5. Robot controller security function (Password Setup) 
It is possible to forbid access to the robot programs, parameters, and files in the robot controller. 
The security function can be achieved by setting a password in the robot controller. The robot controller software 
versions where this can be used are as follows. 
 

Table 16-12 Compliant version of this function and controller 
Robot Controller Software version 

CR800-D/CR800-R/CR800-Q All versions 

CR750-D/CRnD-700 series Ver.S3 or later 

CR750-Q/CRnQ-700 series Ver.R3 or later 
CRn-500 series Unavailable 

 
The functions where a password can be set are as follows. It is possible to individually set and release 
passwords for access to programs, parameters, and files. The factory default setting of "Password Setup" is “off”. 
 

Table 16-13 Function that access is limited. 
Type Limited functions Remarks 

Program ・ Writing the programs.  
・ Reading the programs. 
・ Copying the programs. 
・ Renaming the programs. 
・ Deleting the programs. 
・ Writing the position data for SQ Direct.  
・ Reading the position data for SQ Direct.  
･ Initialization of robot programs. 
･ File Manager It is not possible to delete or rename the 

file. 
Parameter ・ Writing the parameters. It is possible to read the parameters 

from the robot controller. 
・ Position repair function. It is not possible to write the revision 

parameter created by “Position repair 
function” in the robot controller.  

･ Restore the origin backup data.  
･ Restoring the program information 

File ・ Backup  
・ Restore 
・ Position repair function 

 
 
Perform registration, change, and the deletion of the password while connected to the robot controller. From the 
project tree double-click the target project [Online] -> [Maintenance] -> [Password Setup]. 
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Figure 16-36 Password setup 

 
 
When the security function has been turned on in the controller, the mark  is displayed in the left of the button 
of the item to which access is forbidden. 

 
（for example：                 ） 



 

16-425  16-425 

 
16.5.1. Register Password 

The password is registered to the robot controller. 
Click the "Register/Change" button of the item to which a password is to be registered in the "Password Setup" 
screen. After inputting the password in the "Register/Change Password" screen, click the [OK] button. The input 
password is displayed with "*" or "●". 

 
Please input a password of 8 characters or more, and 32 characters or less. The characters that can be used are 
as follows  
 

Table 16-14 Character that can be used by password 
Characters that can be used by passwords (8 characters or more, and 32 characters or less) 
Numbers ( from 0 to 9 ) 
Letters (from A to Z, and from a to z) 

 
(Note) Upper case and lower case letters are 
differentiated. 

 

 
Figure 16-37 Register Password  

 

 
 
 
 
 

Pay full attention to password management  
It will be impossible to release the security function of the robot controller if the password is 

forgotten. Pay sufficient attention to password management. 

Caution 
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16.5.2. Change Password 

This changes the password set in the controller. 
Click the "Register/Change" button of the item in which the password is to be changed in the "Password Setup" 
screen. Input the currently-set password set and the new password in the "Register/Change Password" screen, 
and click the [OK] button. 
 

 
Figure 16-38 Change Password  

 
 
When the password is changed with the "All" button, it is necessary to register the same password to all items.  
 
 
16.5.3. Delete Password 

This deletes the password set in the controller. 
Click the "Delete" button of the item to which delete the password in "Password Setup" screen. After inputting a 
password set now in the "Delete Password" screen, click [OK] button. 
 

 
Figure 16-39 Delete Password  

 
When a password is deleted by the "All" button, it is necessary to register the same password to all items.  
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17. Option Cards  
You can check information on option cards mounted on the robot controller. 

 
When you open [Option Card] on the project tree, the slots in which option cards are currently mounted and the 
option card names are displayed. If you place the mouse cursor on an option card name, the information for that 
option card is displayed. When the "Properties" window is displayed, the information is displayed in the 
"Properties" window also. 
If no option card is mounted on the robot controller, nothing is displayed. 

 

 
Figure 17-1 Option Card Information 
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18.  Backup and Restore 
 
You can back up information in a robot controller to the computer. 
You can also restore backup information saved to the computer back into a robot controller. 
 

Backup 
(Robot -> Personal computer) 

Saves the backup data on the robot controller to the personal 
computer. 

Restore 
(Personal computer -> Robot) 

Transfers the backup data saved on the personal computer to the 
robot controller. 

 
 

 
 
In the RT ToolBox 3, you can back up the content that set in offline and you can restore the backup data to the 
offline project. 
For details, refer to the “18.3 Offline backup (Offline project -> PC)” and “18.4 Offline restore (PC -> Offline 
project)”. 
 

Offline backup 
(Offline project -> Personal computer) 

Save the contents that set in offline as backup data 
to the personal computer. 

Offline restore 
(Personal computer -> Offline project) 

Rewrite the offline project with the backup data 
saved on the personal computer. 

 
 

Do not pull out the cable during communication.  
 

Never pull out the cable during communication with the robot controller. If the communication 
cable is removed during communication, the status of the robot controller or the personal computer 
may be affected. Please remove the cable when the status is not “Online” or this software exited. 

Also, do not pull out the USB cable when communicating by USB  
until the communication is completed. 

Caution 
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When a password is registered in “file” by the robot controller security 
function, it is not possible to back up information in a robot controller to the 
personal computer, or to restore backup information saved to the computer 
back into a robot controller.  

 

When a password is registered in “file" by robot controller security function, it is not possible to 
back up the information in the robot controller to the personal computer or to restore backup 
information saved to the computer back into a robot controller. 

○ : Enable, × : Disable 
  Item to which password of security function is registered. 

Program Parameter File 

Backup 

All files ○ ○ × 

Programs ○ ○ × 

Parameter files ○ ○ × 

System programs ○ ○ × 

R
estore 

All files ○ ○ × 

Programs ○ ○ × 

Parameter files ○ ○ × 

System programs ○ ○ × 
 
Delete the password of the robot controller security function when performing backup and 

restore. Refer to "13.7.3 Delete the Password" for how to delete the password.  
For details on setting security functions (registering passwords) and releasing security functions 

(deleting passwords) on robot controllers, refer to "Table 16-12 Compliant version of this 
function and controller". 

Caution 
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18.1. Backup(Robot -> PC) 
You can save information in a robot controller to a file in the computer. 
Use the backup function while RT ToolBox3 is connected to the robot controller.  

 
There are two methods for saving data as follows. 

<1> Saving data from one robot controller. 
<2> Saving data by batch processing from all robot controllers which connected with this software. 

 

 
 

 
 
 

Cautions on when backup is interrupted 
 

Backup again when a communication fault occurs during backup or when the backup is interrupted 
by clicking the “cancel” button. 

 
"[NG]" is added to the head of folder name when the backup is interrupted. Do not restore the 

backup folder because the folder’s information is incomplete. There is a possibility that the controller 
won’t start if restore is performed. When you select a designated “[NG]” when restoring, the following 
warning dialog will be displayed. Select “No” in most cases. 

 

 
 

Caution 

Cautions on backups 
 

When backing up system status variable values and program external variable values, switch the 
robot controller power Off, then On again, then perform the backup operations. 

 
The files BKUP.SYS and MECHA.SYS are automatically created in the specified folder. These files 

record the saved robot controller mechanical information and save format. Be aware that if you delete 
or rewrite these files, this may make it impossible to restore them to the robot controller. 

 
Although backup data is intended for backing up information on the robot controller, backed up 

programs can be opened for editing of programs. Refer to "11.2.4 Editing a program in the backup 
data" in this manual for details. 

Caution 
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18.1.1. Saving data from one robot controller 

(1) From the project tree, open the target project [Backup]. In the backup tree, "All", "Program", "Parameter", and 
"System program" are displayed. 
 

 
Figure 18-1 Backup Project Tree Diagram 

 
All Saves all files (robot programs, parameter files, etc.) in the robot controller into 

the designated folder. 
Performs batch backup during the backup and restore for the same robot. 

Program Saves the robot program file into the designated folder. 
It will back up only the robot program file. This is useful when you want to restore 
only the robot programs to another robot. 

Parameter Saves the parameter files into the designated folder. 
It will back up only the parameter file. This is useful when you want to restore 
only the parameters to another robot. 

System Program Saves the system base program file into the designated folder. 
The system based program files are included, such as program external 
variables. Use this when you want to back up only the program external 
variables. 

 
(2) Double click the items to backup. 

 
Figure 18-2 Backup (When Batch Is Selected) 

 
The backup screen opens, and the check box of the selected backup will be ON. 
With the subject check box ON, you can change the backup method. 

 
[Parameter List Files] : This is used to edit the parameter information saved by backup in offline 

mode, and is not required for backup. If this is not checked, the time 
required to save all files will be shortened. 

 

Double-click 
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(3) Specify the backup destination. The default value is the folder where the workspace was created/project 

name/Backup/today's date and time. 
You can change the backup destination folder with the […] button at the right of the displayed backup 
destination. 

 
You can also back up other items at the same time by putting checkmarks in their checkboxes. In this case, the 
data is backed up to the selected backup destination, with the identifier added to the folder name according to 
the backup type. The identifiers are as follows. 

  All…ALL   Program information…PRG   Parameter information…PRM   System program…SYS 
 

The folder name at this time is displayed on the right side of the respective backup items. 

 
Figure 18-3 Backup (When Multiple Selected) 

 
(4) Specify the back destination, then click the [OK] button. The confirmation screen is displayed. Confirm, then 

click [Yes], to start backup. 

 
Figure 18-4 Backup Confirmation Screen 

 
When backup is completed, the backup data is displayed under [Backup] in the project tree.

 
Figure 18-5 Display of Backup Information 
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18.1.2. Saving data from all robot controllers(Online Project Backup) 

It is possible to save data by batch processing from all robot controllers which connected with RT ToolBox3. 
 

(1) Select the name of workspace and click the right mouse button. Or, select the "Backup" of the project that is 
online and click the right mouse button. Select "Online project backup" in the right mouse button menu. The 
backup item selection screen is displayed. 

 
Figure 18-6 Online Project Backup 

 
 

(2) Select the backup item in the "Backup" group. Input the backup destination folder name in "Folder Name", 
and click the [OK] button. 
The input folder name is added to "Backup" of each project. 
 
The backup confirmation screen is displayed. After confirming, click the [Yes] button. The backup will then 
begin. 

 

 
Figure 18-7 Confirmation screen of "online project backup" 
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(3) When the batch processing for saving data from all robot controllers is completed, the saved data is 

displayed under [Backup] in the project tree. 

 
 

Figure 18-8 The information of saving data from all robot controllers by batch processing. 
 
 

Backup data 
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18.2. Restore (PC -> Robot)  
You can transfer the backup information on the computer to the robot controller. 
Use the restore function while connected to the robot controller.  

 
 

(1) From the project tree, open the target project [Backup]. In the backup tree, the information backups for "All ", 
"Program", "Parameter", and "System program", respectively, is displayed. 

 
Figure 18-9 Backup Project Tree Diagram 

 
 
 
(2) Select the information listed on the controller, then click the right mouse button. From the right mouse button 

menu, select [Restore]. 
 

 
Figure 18-10 Restore 

 

 Caution on individual restoration of individually backed up by 
selecting "All" 

It is possible to restore each item (Program, Parameter files and System program) of the data 
backed up by selecting "All files". 
At this time, the data files of the specified item are transferred to the robot controller, without 
clearing (initializing) all the information in the robot controller. 

Caution 
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Program : When [All] is designated, all of the robot program files in the folder will be sent 

to the robot controller. 
When [Select] is designated, the specified robot program files in the folder will 
be sent to the robot controller. To specify which files to send, click the [Select...] 
button and specify the files in the screen that is displayed. 

Restore after deleting 
programs of 
existence. 

: All robot programs in the robot controller are deleted, and then the restore is 
performed. 

Parameter : When [All] is designated, all of the parameter files in the folder will be sent to the 
robot controller. 
When [Select] is designated, the parameters designated from among 
parameters in the folder will be sent to the robot controller. To specify which 
parameters to send, click the [Select...] button and specify the parameters in the 
screen (described later) t is displayed. 

System Program : System base program files in the designated folder will be sent to the robot 
controller. 

(All Files) : If batch backup information is restored with all programs, parameters, and 
system programs selected, all of the files (excluding BKUP.SYS and 
MECHA.SYS) in the designated folder will be sent to the robot controller. 

Restore history file 
data 

 Restore the robot controller history file data. Only valid when the programs, 
parameter files, and system programs are all selected. 

Change Robot Origin 
Data 

: This is valid only when parameter information is selected in the backup 
information. Operations for when this checkbox is checked and when it is not 
are as in "Table 18-1 Operations for "Change Robot Arm Serial Number 
Too"". 

Change Robot Arm 
Serial Number 

: The robot arm serial number also is rewritten. 

Restore the file 
manager’s data 

: Files targeted by the file manager function (refer to 19.4) also are rewritten. 

Restore Operating 
Information 

: The operating information (power ON time, operating time, servo ON time, 
battery remaining time) of the robot controller is rewritten. 

Restore maintenance 
forecast data. 

: Information relating to maintenance forecasts also is rewritten. (same 
information as the information restored at "16.3.7 Others") 

 
By click the [Select...] button, the screen for selecting parameters for restore is displayed. Only select the 
parameters you want to transfer to robot controller and click the [OK] button. 

 
By unselect the parameters related the kind of robot model, the backup data can be used to different kind of 
robot. 

 
Figure 18-11 Backup Project Tree Diagram 
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Table 18-1 Operations for "Change Robot Arm Serial Number Too" 

Controller  
Check ON 

 

Check OFF 
 

CR800/ 
750/ 
700  

series 
 

or 
 

CRｎ-500 
series 

J2 edition 
or later 

 
 

Restore 
files 

<after restore> 

controller 

 

 Origin data(A) 

 parameters for 
position repair (A) 

 Parameters(A) 

<リストア前> 

 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

controller 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

<before restore> 

An initial value will be used if the file to 
be restored does not have any 
revision parameter for position repair. 

 
Transfers the backed-up file as is. The origin 
data is overwritten. 

 

 
 

Restore 
files 

<after restore> 

controller 

 

 Origind ata(A) 

 

 Parameters(A) 

<リストア前> 

 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

controller 

 

 Origin data(A) 

 parameters for 
position repair (A) 

 Parameters(B) 
 

<before restore> 

parameters for 
position repair (A) 

 
 
 
 

A backed-up file is transferred. However, for 
the origin data and the parameters for 
recovering positions, the information inside the 
controller is retained. 

CRｎ-500 
series 

H7 edition 
or earlier 

 

<after restore> 

controller 

 

 Origin data (A) 

 Parameters(A) 

controller 

 

 Origin data (B) 

 

 Parame ters(B) 

<before restore> 

Revision parameters for position 
repair will not be written 

Restore 
files 

<リストア前> 

 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

 
Transfers a backed-up file as is. The origin data 
is overwritten. 

 

Restore 
files 

<after restore> 

controller 

 

 Origin data(A) 

 Parameters(A) 

<リストア前> 

 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

controller 

 

 Origin data(B) 

 

 Parameters(B) 

<before restore> 

Revision parameters for position 
repair will not be written. 

 
A backed-up file is transferred. However, as for 
the origin data, the information inside the 
controller is retained. 

 
Be aware that if communication is cancelled during a series of restore processes, the position revision 
parameters generated with the "Position repair" function and the origin data may be changed. 
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Do not restore backup information with an “[NG]” on the folder 
name 

 

Do not restore the backup information with an “[NG]” on the folder name because the backup 
information will be incomplete. 

 
"[NG]" is added to the folder name when a communication fault occurs during backup or the 

backup is interrupted by clicking the “cancel” button. Do not restore this backup folder because the 
folder’s information is incomplete. The controller may not start if restoring is continued. When you 
select a folder with an “[NG]” is selected when restoring, the following warning dialog is displayed. 
Select “No” in most cases. 

 

 

Caution 
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18.3. Offline backup (Offline project -> PC) 
This function is save the offline setting/data as backup data to the personal computer. In this function, the kind of 
backup is fixed "All". 
Use this function in the offline mode. 

 
(1) In the project tree, select the [Offline] in the target project and right click, then the context menu will be 

displayed. 
(2) Select the [Backup] in the context menu, then “New Backup folder” dialog will be displayed. 
(3) In this dialog, specify the folder location and name for save the backup data, and click the [OK] button. 
(4) After the backup is completed, the backup data is displayed in the [Backup] -> [All] in the project tree. 

 

 
Figure 18-12 Offline backup 

 
The backup data created by this function can be used not only for restore to the offline project described in "18.4 
Offline restore (PC -> Offline project)" but also for restore to the robot controller described in "18.2 Restore 
(PC -> Robot)". 
By restore the backup data to the robot controller, you can be reflected the contents of simulation setting to the 
robot controller. 
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18.4. Offline restore (PC -> Offline project) 
You can rewrite the offline project with the backup data in the personal computer. For this restore function, only 
the backup data it kind is [All] and [Parameter] can be used. 
Use this function in the offline mode. 

 
(1) In the project tree, open the [Backup] in the target project and open the [All] or [Parameter]. 
(2) In there, right click the backup data for restore, then the context menu will be displayed. 
(3) In this context menu, select the [Restore], then the message confirming restore to offline project will be 

displayed. 
(4) By click [Yes] in this message, the offline project is rewritten with the backup data. 

 

 
Figure 18-13 Offline restore 

 
The backup data used in this function, not only the backup data described in "18.3 Offline backup (Offline 
project -> PC) " (back up from the offline) but also it described in "18.1 Backup(Robot -> PC)" (back up from the 
robot controller) can be used. 
By restoring the backup data of the robot controller to the project, on the simulation you can check and edit the 
environment of the robot controller. 
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18.5. Property Display of Backup Data 
By selecting the backup data displayed in the project tree, you can display the information of the backup data in 
the property. 

 
Figure 18-14 Property Display of Backup Data 

 
 
By checking the contents of the [Comment] field of the property, you can check the backup data for either robot 
controller or offline project. 
 
<For robot controller> Comments entered during backup (blank if no comment is entered) 
<For offline projects> Project: (project name) 

 
Figure 18-15 Confirmation of backup target 

In the case of robot controller For offline projects 



 

18-442  18-442 

 
18.6. Deleting Backup Data 
You can delete the backed up information. 
Select the information to delete, then click the right mouse button. From the right mouse button menu, select 
[Delete]. 
 

 
Figure 18-16 Deleting Backup Data 

 
It is also possible to delete all the backup data.   
Right click [Backup] for the target project.  From the right mouse button, click "Delete All". 
 

 
Figure 18-17 Deleting All the Backup Data 

 

 
 
 
18.7. Open Backup program 
Robot programs in backed up information can be opened and their content can be checked and edited. 
For details, refer to "11.2.4 Editing a program in the backup data". 

 
Figure 18-18 Open Backup programs 

Be aware that once backup data is deleted, you can not restore it. 

Caution 
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18.8. Check Backup programs 
You can confirm that there are no errors in backed-up programs. 
Select the backed-up information, and click the right mouse button. From the right mouse button menu, select 
[Check Backup programs]. You can use this function in “All”, “Program” and “System Program”. 
If there is an error in the program the robot controller will not be able to execute the program. In this case, do the 
following: 
 
1. Do NOT restore the backed-up information in which there is an error program. 
2. After you restore the backed-up information, the error program from the controller. 
 
 

 
Figure 18-19 Check Backup programs 

 
18.9. Open the event history from backup data 
Click the right mouse button on the backup data and click "Event History" from the menu to open the event 
history of backup data. Display the event history up to the point when the backup was created. 
This function is available only for "All" backup data of CR800 series robot controller. For details, refer to 
"15.2.5Event Hisyory". 
 

 
Figure 18-20 Event history 

 
18.10. Open the error history form backup data 
Click the right mouse button on the backup data and click "Error History" from the menu to open the error history 
of backup data. Display the error history up to the point when the backup was created. 
This function is available only for "All" backup data of CR800 series robot controller. For details, refer to 
"15.2.6Errors". 
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Figure 18-21 Event history 

 
18.11. Open the error record form backup data 
Click the right mouse button on the backup data and click "Error record" from the menu to open the error record 
of backup data. Display the error record up to the point when the backup was created. 
This function is available only for "All" backup data of CR800 series robot controller. For details, refer to 
"15.2.6.4Record information". 
 

 
Figure 18-22 Event record 

 
The software version of the controller that can use the error record function is as follows. Error record can not be 
displayed form all backup data  acquired by controller other than the version below. 
 

Controller Software Version 
CR800-D/CR800-R/CR800-Q All 

CR750-D/CRnD-700 Ver.S1j or later 

CR750-Q/CRnQ-700 Ver.R1j or later 
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19. Tool functions 
19.1. Oscillograph 
The oscillograph function is explained. 
 

 
 
 
19.1.1. Outline 

The oscillograph can display a graphical representation of a robot's various internal data. 
The data acquired from the robot can be saved in a CSV file. Prolonged data recording is possible by specifying 
a storage interval. A program name, an execution row number, and an input-and-output signal are also 
simultaneously recordable in a CSV file. 
 
 
19.1.2. Communication method 

The communication methods which acquire various internal data from a robot include the following two systems 
are among. 

 
 
19.1.2.1. Ordinary communication 

This is a communication method which uses a communication server.  
Therefore, it can be used in an environment where connection to a communication server is possible. 
The characteristics of ordinary communications are shown below. 

 
Table 19-1 Ordinary communication 

Item Explanation 
Maximum number of 
data held 

30,000 
(About 50-minutes can be obtained at a data acquisition 
interval of 100msec.) 

Acquirable data types Fixed (See 19.1.3 Acquirable data) 
Data acquisition interval 50, 100, 200, 500, 1000, 2000, 5000, 10000, 30000msec 

 
 
19.1.2.2. High speed communication 

High-speed communication can use a real-time monitor function to acquire data at intervals of 3.5 msec or 7.1 
msec. The real time monitor function cannot be used unless the environment allows the robot controller to 
connect with a personal computer by Ethernet. To enable real-time monitor, see “ 14.6.2.3 Realtime 
monitor”. 
If you cannot get data from a robot controller, see “Communications (Ethernet)” (4) in “29.1 Q&A”. 
The feature is explained. 

 
Table 19-2 High speed communication 

item explanation 
Maximum recording  data 80,000 (About 9-minute acquisition possible） 
Acquirable data types Maximum of 4 data selection (See 19.1.3 Acquirable data) 

32 points of a continuous signal (IN/OUT) can be acquired 
Data acquisition interval CR800 series : Maximum of 3.5 msec 

CR750/700 series : Maximum of 7.1 msec 
Robot software version CR800 series : All versions 

 
With the oscillograph, the maximum number of screens that can be opened is limited to eight since this 
increases the load on the PC. Keep in mind that memory may be insufficient if many screens which 
need memory such as program editors and parameter editors are opened. 

Caution 
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CR750/700 series : S4b, R4b or later 
 
At the simulator start up, only the first project can use the real-time function. 

 
 

 
When high-speed communication is used on the high-load PC、there is a possibility that Part of the 
monitor data will lose. 
If the loss frequently occurs, please use normal-speed communication. 

Caution 
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19.1.3. Acquirable data 

The list of the data that can be acquired from the robot is shown below. 
 

Table 19-3 Oscillograph data list 
Notation on the graph Unit Explanation High Ord 

Current feedback [Arms] Present value of the motor current. ○ ○ 

Max current cmd2 [Arms] The maximum value of the current command for 
the previous 2 seconds. 

- ○ 

Max current cmd1 [Arms] The maximum value of the current command after 
robot controller power supply is turned on. 

- ○ 

Axis load level [%] A preset load ratio of each motor is displayed as an 
alarm level. 

○ ○ 

Max axis load level [%] 
The maximum value of the axis load level after 
robot controller’s power supply is turned on is 
displayed. 

- ○ 

Position feedback [Pulse] Current motor rotation position is displayed in 
encoder pulse value. 

○ ○ 

Joint position(CMD) [mm deg] Joint position (command) ○ ○ 
XYZ position(CMD) [mm deg] XYZ position (command) ○ ○ 
Joint position (FB) [deg] Joint position (feedback) ○ - 
XYZ position (FB) [mm deg] XYZ position (feedback) ○ - 

Position droop [Pulse] The amount of deflection at the motor rotation 
position to a position command is shown. 

○ ○ 

Speed (FB) [rpm] The feedback of the motor speed is displayed by 
the unit of rpm. 

○ ○ 

Voltage [V] A present power-supply voltage value is displayed. ○ ○ 

RMS current [Arms] Present RMS value of the motor current is 
displayed. 

○ - 

Regeneration level [%] The regenerative current value of each axis is 
displayed as an alarm level. 

○ ○ 

Encoder temperature [deg C] Temperature of the encoder of each axis 
Correspondence since F series. 

○ ○ 

Current command [Arms] The current command of the motor. ○ ○ 

Tolerable command + [Arms] The limitation value of the plus side of the current 
command set to the motor. 

○ ○ 

Tolerable command - [Arms] The limitation value of the minus side of the current 
command set to the motor is displayed. 

○ ○ 

Force sensor [N Nm] The input value from a force sensor. ○ - 

Force sensor(+resultants) [N Nm] The input value from a force sensor (The resultant 
force and resultant moment values exist). 

○ - 

Force pos CMD(XYZ) [mm rag] Force sense position command(XYZ) ○ - 

COL threshold + 
[0.1%] 

rated 
current 

The higher rank side detection threshold of a 
collision detection function (plus side) 

○ - 

COL threshold - 
[0.1%] 

rated 
current 

The higher rank side detection threshold of a 
collision detection function (minus side) 

○ - 

COL presumed torque 
[0.1%] 

rated 
current 

Presumed torque of the collision detection function. 
○ - 

COL torque 
[0.1%] 

rated 
current 

Actual torque of the collision detection function. 
○ - 

Ref. value of COL level 

[%] Show the gap between the estimated torque and 
actual torque by COL level (The values of COLLVL 
command, COLLVL and COLLVLJG parameters). 
The value is shown if COL is enabled and servo 
ON. 

○ - 

Error of presumed torque 

[% 
rating] 

The absolute value of the error between the 
estimated torque and actual torque of each axis. 
You can get this value only if the torque monitoring 
function of safety option is enabled. 

○ - 
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Ex-T coordinates speed [mm/s] Speed of the Ex-T coordinates during execution of 
the Ex-T control/the Ex-T spline interpolation 

○ - 

Ex-T coordinates position [mm deg] The current position in the Ex-T coordinates ○ - 

Spline path point  
of adjusted speed 

- The path point number that speed adjustment has 
occurred during execution of the spline 
interpolation/the Ex-T spline interpolation 

○ - 

 Tool point speed(FB) [mm/s] Speed of a tool center point（feedback） ○ - 

R
ob

ot
 in

fo
rm

at
io

n 

Remaining distance(FB) [mm] The remaining distance to the target position (in 
mm) while the robot is moving（feedback）. 

○ - 

Tool point speed(CMD) [mm/s] Speed of a tool center point（command） 
Same as status variable values “M_RSpd” 

○ - 

Remaining 
distance(CMD) [mm] 

The remaining distance to the target position (in 
mm) while the robot is moving（command）.  
Same as status variable values “M_RDst”.  

○ - 

Gap of CMD and FB [mm] 
The gap of a command position and a feedback 
position. 
Same as status variable values “M_Fbd”. 

○ - 

Transport factor(CMD) [%] Speed of a tool center point（feedback） ○ - 

Acceleration state(CMD) 

- The current acceleration/deceleration status.
（command） 
[0=Stopped,1=Accelerating, 2 = Constant speed, 3 
= Decelerating] 
Same as status variable values “M_AclSts”. 

○ - 

Controller temperature [deg C] Controller temperature ○ ○ 

Safety input - It turns ON when either safety input signal A or 
safety input signal B is OFF. 

○ - 

Safety input signal A - Input signals 128 to 135 ○ - 
Safety input signal B - Input signals 160 to 167 ○ - 
SCNI Signal - Input signals 1264 to 1271 ○ - 
INPUT - Consecutive input signal for 32 points ○ - 
OUTPUT - Consecutive output signal for 32 points ○ - 
Predictive maintenance score 
(speed reducer abnormality) 

- Current abnormality score of reducer (wave gear 
device) 

○ - 

Predictive maintenance score 
(encoder data error) 

- Current abnormality score of encoder data ○ - 

Predictive maintenance score 
(encoder communication error) 

- Current abnormality score of encoder 
communication 

○ - 

※High :High speed communication Ord :Ordinary communication 
 
 
19.1.4. Starting 

From the project tree, double-click [Tool] -> [Oscillograph]  
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Figure 19-1 Starting the Oscillograph 
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19.1.5. Communication settings 

Display the Communication setting dialog by clicking the [Communication…] button. 
Ordinary communication can be used as choosing the [Communication server].  
High speed communication can be used by choosing the [Real time monitor]. 
 

 
Figure 19-2 Communication setting dialog 

 
Select the data reception interval in ordinary communication via the communication server. 
In High speed communication which uses the real time monitor function, indicate the data acquisition type up to a 
maximum of 4, and the start numbers for the input signal/output signal, common preset data combinations are as 
follows. 
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Table 19-4 Real time monitor: Preset Data 

Name Data usefulness 
Force sense setting Force sensor(+resultants) Guess the optimum posture and motion while 

watching the value of the force sensor. Force pos CMD(XYZ) 
XYZ position(FB) 
Robot information 

Collision detection setting COL torque Adjust the optimum value of collision detection. 
COL threshold + 
COL threshold - 
Ref.value of COL level 

Collision detection error 
investigation 

Speed(FB) Investigate the cause of abnormality detection of 
collision detection. Current feedback 

Ref.value of COL level 
Robot information 

Failure investigation(General) Current feedback Investigate the cause of failure when the error 
occurred. (for general survey) Speed(FB) 

Joint position(FB) 
Robot information 

Failure investigation(Overload 
error) 

Speed(FB) Investigate the cause of failure in the event of an 
overload error. Current feedback 

Axis load level 
Robot information 

Failure investigation(Power 
supply voltage) 

Speed(FB) Investigate the cause of the failure in the event of 
a power supply voltage related error. Current feedback 

Voltage 
Regeneration level 

Predictive maintenance 

Predictive maintenance 
score (reduction gear) 

Early detection of abnormalities and deterioration 
of robot components. 
* Only available when the predictive maintenance 
function of MELFA Smart Plus is enabled. 

Predictive maintenance 
score (ENC data) 
Predictive maintenance 
score (ENC communication) 
- 
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It is also possible to set the data combination and signal number that customers often use as a preset (up to 8). 
The preset is displayed in the format of "Digital: Preset Name" in the preset of the communication settings dialog 
box. 

 
Figure 19-3 User preset setting dialog 

 
 
Also, when using high-speed communication, it is necessary to enable the real-time monitor mode in the 
Ethernet parameter screen. 
 

 
Figure 19-4 Real time monitor mode setting  
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・To display the program name and an execution row number in high-speed communication it is 
necessary to include "robot information" in the demand data. 
・In "Ordinary communication", IN and OUT signals are unacquirable. 

Caution 
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19.1.6. Start／Stop 

Check before starting that the target project is in an on-line state. 

Clicking the [Start Record] ( ) button in the [Oscillograph] tab -> [Record] group on the ribbon, data will be 
acquired from a robot and graph drawing will start. 

Clicking the [Stop Record] ( ) button will stop acquisition of data. 
 

 
 
 

19.1.7. Graph setting 

The [Graph...] button of the oscillograph screen can be clicked and the items displayed on a graph set up. The 
graph setup can also be changed in data acquisition. 

 
 

Figure 19-5 Graph setting dialog 
Table 19-5  Setting Items 

Item Explanation 
Refresh time Select the interval of time to refresh the graph. 
Display points Specify the number of points displayed in the graph with fixed number or time scale. 
Horizontal Axis Select the horizontal axis of the graph from acquisition data or time. 
Graph Output Select the category of data displayed to the graph. 
1-1 -> 2-8 Select the data displayed to each graph. 

 
In addition, a simple graph setting function is also provided on the oscillograph screen. Display/non-display of the 
data selected in the graph setting screen can be switched from the lower left list of the oscillograph screen. 

 
The program name to be executed must be 6 characters or less. If it is set to 7 or more characters, the 
program will not be displayed on the "Program / Signal Monitor" screen even if "Robot Information" is 
included in the request data. 

Caution 
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Figure 19-6 Switch of display/non-display of graph 

 
You can change the graph drawing interval during data recording using the [Refresh time] drop-down list and the 
number of display points displayed on the graph in the [Display points] drop-down list. The number of points to 
display can be changed only by slider operation. 
By using the [<-] [->] key on the keyboard, you can fine-tune the display range (horizontal axis) while looking at 
the graph. 
 

 
Figure 19-7 Switch of [Refresh time] / [Display points] 

 
 

19.1.8. Graph range setting 

The [Range...] button of the oscillograph screen can be clicked and the display ranges of the vertical data axes 
set. When [Auto adjust] is checked, the display ranges of the vertical axes in the graph are automatically 
adjusted.  

 

 
Figure 19-8 Graph range setting dialogue 
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The [Edit...] and [Reset] can make two data or more a target at the same time. 

 

 
Figure 19-9 Range editor of the graph 

 
 
19.1.9. Data confirmation 

Clicking the [Detail…] ( ) button in the [Oscillograph] tab -> [Drawing] group on the ribbon, you can check the 
data displayed on the graph by numerical value. When acquiring data and playing back data, the current value is 
displayed in [Data]. 
 
You can change the acquisition range of [Minimum] [Maximum] by switching [Target Data]. 
“All Data”: The minimum and maximum values of the entire data (including the invisible range) displayed on the 
screen are displayed. 
“In Screen”: The minimum and maximum values in the range displayed on the screen are displayed. However, 
when the number of display points of the graph is "Time Scale", “All Data" is automatically selected. 
 
The data column is displayed in the same color as the graph. 

 
 

Figure 19-10 Detailed data dialogue 
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By clicking the [Stop Drawing] ( ) button in the [Oscillograph] tab -> [Drawing] group on the ribbon 
while retrieving data from a robot, you can stop drawing of the graph and trace back the lines of the retrieved data 
by shifting the slider. 

 

 
Figure 19-11 Oscillograph graph screen during data acquisition (top) 

 
A cursor is displayed while operating the slider. The value at the cursor position is displayed in [Data] of the 
detailed data dialogue. 

 

 
Figure 19-12 Cursor movement by slider operation 

 
After acquiring data from the robot or after reading the data of the data file, double-clicking the value of 

[Minimum] [Maximum] will move the cursor to the corresponding part according to the specified search direction. 
However, it can not be used during data playback. 
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Figure 19-13 Cursor movement by double click [Maximum] (in screen) 
 

 

 
When jumping to [Minimum] [Maximum] with the data "Time Scale" displayed for a long time, the value 
of [Data] may not match the value of the graph. At that time, change the number of display points to 
"Fixed number" and check the graph. 

Caution 

Double-click 
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19.1.10. Playing back data 

Clicking the following buttons in the [Oscillograph] tab -> [Playing Back Data] group on the ribbon, data can be 
played back along the time axis while the cursor is moved automatically. 
 

 
Figure 19-14 Data Playback Buttons 

 
Clicking the [Playback] button moves the cursor along the time axis. 
Clicking the [Rewind] or [Fast Forward] button moves the cursor at [x1] or [x2] speed, respectively. You can select 
the speed from [x1]/[x2]/[x10] by clicking the button again. 
To stop playback midway, click the [Pause] button. 

 

 
 
 

Figure 19-15 Data Playback States on Oscillograph 
 
 

19.1.11. Save Data／Log Setting 

Clicking the [Save Data] ( ) button in the [Oscillograph] tab -> [Data File] group on the ribbon, the data 
acquired up to that point in time can be saved in CSV file format. 

 

The newest data can be written out to a log file at a set time interval. Clicking the [Log Setting] ( ) button in 
the [Oscillograph] tab -> [Data File] group on the ribbon, select the [Log the Measurement Data] check box in the 
operation dialog of the displayed log file. The time interval written in a log file is specified in the [Select the 
Interval Log] drop-down list.  
 

 
Figure 19-16 Log file operation 

Rewind (x1) Fast Forward (x10) 
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If you select 3 minutes or more in the log preservation interval, you can set [Recording time]. When [Recording 
time] is set, log data for the specified time is saved for each log preservation interval specified. [Recording time] 
can be set up to half the log preservation interval. However, when the log preservation interval is set to 10 
minutes or more, [Recording time] is 3 minutes (180 seconds). 
When [Recording time] is set to 0, the latest data is written to the log at regular time intervals as when log 
preservation interval is specified to 2 seconds or less. 
 

  
Figure 19-17 Log output image when log interval is 10 minutes and recording time is 1 minute 

 
Click the [Set] button to complete log file setup. 

Log Start 

10 min 10 min 10 min 

1 min 1 min 1 min 

A log file will be created during this time 
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The data save / log file name, and its save folder are as follows. 

 
Table 19-6 Data saving file name / Log file name / Data saving folder 

Item Explanation 
Data saving file name Store<time stamp>.csv 

 
The <time stamp> shows the time which clicked the [Data save] button.  
“<A.D(4chars)>< month(2chars)><day（2chars）> -  
<time(2chars)><minutes（2char）><second（2chars）>” 
 
Example： 
Store20130911-183525.csv 

Log file name Log<time stamp>.csv 
 
The <time stamp> shows the time at the time of a data acquisition start. 
(Same as data save file name) 
(Same when [Recording time] is set) 
 
Example： 
Log20130911-183525.csv 

Data save folder “Workspace \ Project \ Oscillograph \ Log” 
 
The save folder of the log file can be changed. 

Select the interval to 
log 

When you select the [Real time monitor] of the [Select the interval to log] 
drop-down list, you can save all the data acquired in real time monitor to the log 
file. If the data is more than 50 million cases (about 1 hour), it will be saved to a 
new time stamp log file. 

Recording time Save the log for the specified time. 
If you select "3'00.0" or more from the [Select the Interval to log] drop-down list, 
the recording time can be set. 
It is possible to set it to half the log preservation interval (maximum 3 minutes 
(180 seconds)). 
When set with "0" (second), only one data is output as with normal log. 

 

 
 

 
If you select the [Real time monitor] in [Select the interval to log]  
 
・Cancel the power saving settings of the personal computer such as screensavers, disk stoppage, 
PC sleep, etc. 
・File save will stop if the disk capacity is less than or equal to 500M bytes. 
 
If you are using a low-performance PC 
 
・It may not be possible 3.5/7.1msec interval. 
・High-speed communication writing to files takes CPU power, and screen operation may not be 
possible. In such cases, shut off the communication with the robot by, for example disconnecting the 
communication cable of the robot. Screen operation will then recover. 
If screen operation is not possible, select a save interval of [1.0”] or more. 

Caution 
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19.1.12. Load Data 

The data file and log file which were saved in "19.1.11 Save Data／Log Setting" can be displayed on the graph 

by clicking the [Load Data] ( ) button in the [Oscillograph] tab -> [Data File] group on the ribbon. 
 
19.1.13. Save Image 

Clicking the [Save Image] ( ) button in the [Oscillograph] tab -> [Data File] group on the ribbon, the graph 
currently displayed can be saved as a bitmap image 
The image file name and the image save folder name are as follows. 

 
Table 19-7 image filename & Image saving folder 

Item Explanation 
Image file name Img<time stamp>.bmp 

 
The <time stamp> shows the time stamp when the [Image save] button was 
clicked. 
 
Example： 
Img20130911-183525.csv 

Image save folder “Workspace \ Project \ Oscillograph \ Image” 
 
 
19.1.14. Gray scale 

When the gray scale checkbox is turned on, the graph is displayed in gray scale.  
 
 
19.1.15. Reflect to 3D monitor 

Clicking the [Reflect to 3D monitor] button () in the [Oscillograph] tab -> [Monitor] group on the ribbon, you can 
reflect the joint position (FB) or joint position (CMD) which you acquired from the robot on the 3D monitor.  
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Figure 19-18 Operation of reflected to the 3D monitor 

 
Clicking the [Reflect to 3D monitor] button ( ) and pushing down, the joint position (FB) or 
the joint position (CMD) selected by the cursor<b> is reflected in the 3D monitor.  

 
By moving the cursor<b> with the slider, you can change the posture of the robot in the 3D monitor. 

 
You cannot click the [Reflect to 3D monitor] button if the log data that you acquired from the robot includes 
neither the joint position (FB) nor the joint position (CMD). 
The joint position (FB) is reflected in the 3D monitor if the log data that you acquired from the robot has both the 
joint position (FB) and the joint position (CMD). 

 
You cannot click the [Reflect to 3D monitor] button if the robot model displaying log data in the oscillograph 
screen does not match the robot model set in the project. In this case, it is necessary to change the robot model 
in the project to match the robot model set in the log data. 

<b> 

[Reflect to 3D monitor] button 

<a> 
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Set the robot model in the project as follows. 
 

Table 19-8 Setting the robot model in the project 
Log data displayed in oscillograph 

screen 
Robot model set in project 

Log data acquired from the connected 
robot 

Robot model of the connected robot 

Log data read from the log file Robot model set in the header row of the log file 
 

 
 

 
 
 
19.1.16. Program and Signal Monitor 

Clicking the [Program and Signal Monitor] button ( ) in the [Oscillograph] tab -> 
[Monitor] group on the ribbon, you can check the program execution line and the signal status at the cursor 
position of the data displayed on the graph. 
If the data contains robot information, the contents of the program are displayed and the execution line is 
highlighted. 
The signal displayed on the signal monitor is the range of the signal acquired at the time of oscillograph recording 
for both input and output. Refer to "15.3.1 General signals" for how to see the signal. 

 

 
Figure 19-19 When displaying data recorded via Communication Server 

 
 

 

The graph display will be disturbed by operations requiring CPU 
power 

Regardless of which software is operated, when an operation needing CPU power, or file 
read/write operation, is carried out, the communication with the controller will be delayed/dropped, 
disturbing the graph display. 

Please keep in mind that graphing is mainly disturbed by the following operations. 
 
・Data saving operation 
・Image saving operation 
・Graph setting operation 

Caution 

This function can be used in offline status(  ) only. 

You cannot use this function in online status or simulation status (  ). 
 

Caution 
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Figure 19-20 When displaying data recorded via realtime monitor 

 

 
 

 

- If the program executed during oscillograph recording does not exist in the offline program list, 
the program will not be displayed. Please copy from online to offline and read the data again. 

- If the name of the program executed during oscillograph recording is 7 characters or more, or if 
you change the program name, the program will not be displayed. 

- If you change the contents of the program executed at the time of oscillograph recording after 
recording, the execution line highlighted on the program monitor may not match the graph data. 

- The range of the input / output signal to be displayed can not be changed. 

Caution 

This function can be used in offline status(  ) only. 

You cannot use this function in online status or simulation status (  ). 
 

Caution 
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19.2. DXF file import 
Here we will explain the DXF file import function. 
This function is not available in the mini edition. 
 
 
19.2.1. Outline 

This imports the DXF files can be converted into robot programs / spline files. 
The version and entity data of the DXF files that are compatible with this function are shown below. 
 

Table 19-9 DXF files compatible with this function 
Item Explanation 

Version To AutoCAD 2014. 
Entity data LINE 

ARC 
CIRLE 
POLYLINE/LWPOLYLINE 
SPLINE 

* DXF is a CAD data format developed by Autodesk, Inc.  
* Unit system is treated in millimeters (mm).  
 
 
19.2.2. Starting 

Select [Tool] – [DXF File Import] from the project tree and click the right mouse button. The context menu will 
open. Click [Open]. DXF file selection dialog is displayed. 
Select a DXF file, and press the [Open] button. The “DXF File import” dialog appears. 

 

 
Figure 19-21 DXF File Import Startup Screen 
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19.2.3. Flow of operations 

 

Select a DXF file to be imported <a> 

Spline file output <g> 

Select the layer to be imported <b> 

Setting of the gripping position of the imported 

entity and Ex-T coordinates <d> 

Set the posture of each point <f> 

Select the entity you want to import <c> 

 

Calibration performed for coordinate 

transformation <e> 

Use the Ex-T control Not use EX-T control 

Spline file selection 

Robot program output <h>  

Robot program selection 

 
Figure 19-22 Flow of operations 

 
For detailed operation method of <a> ~ <f>, refer to "7.4.5 Creating a spline file (2) Creating with DXF file 
import function" in the robot controller owner's manual. 
 
<g> Output to spline file 
Select the [Spline file] as the output format in the [Generated Points] page and click the [Finish] button. The 
spline file edit screen opens, and the generated point sequence data will be output. Click the [Yes] button in the 
import completion message to display the spline file save dialog. Specify the spline file number you want to save 
and click the [Save] button to save the spline. 
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Figure 19-23 Output to spline file 

 
 

 
<h> Output to robot program 
Select [Robot program] as the output format in the [Generated Points] page and click the [Finish] button. A 
“New Robot program” dialog appears. In the "New Robot program" dialog, enter the name of the robot program 
you want to save, and click the [OK] button to display the program edit screen. 

Selection 
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Figure 19-24 Output to Robot program 

 

Selection 
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19.3. User definition screen 
It is possible to edit the user definition screen which can be operated by highly efficient T/B.  
You can make a customized screen by arranging parts such as buttons and lamps that synchronize with the I/O 
signal. You can make two or more pages of definition screens. These pages are managed by a file (called “User 
definition screen file”) as one group. It is possible to create two or more user definition screen files. 

 
You can make a customized screen in the high-function T/B by arranging parts such as buttons and lamps that 
synchronize with the I/O signal. You can make two or more pages of definition screens. 

 

 
 
T This screen can be used by the following applications in in high-function T/Bs. 

- As an operation monitor. 
- With T/B is enabled, peripheral devices such as conveyers can be made to work by the buttons on the 

screen. 
 

T/Bs which can use user definition screens, and their software versions, are as follows. 
Table 19-10 T/B which you can use an user definition screen, and its software version 

T/B Software version of T/B 
R56TB Version 2.2 or later 
R57TB Version 2.2 or later 

 
Parts that can be displayed on the user definition screen are as follows. 

 
Table 19-11 List of parts 

 Parts Explanation 
1 Buttons A signal can be output from the robot controller by clicking the 

button. 
The signal can be output only in T/B-enabled state. 

2 Lamps Lamps can be turned on/off by the state of an I/O signal. 
3 Robot 

information 
Variable The value of a specified variable can be displayed. 
Exe lines The executing program lines can be displayed. 
Program name The executing program name can be displayed. 
Exe line num. The executing line number of the program can be displayed. 
Cur pos Current position data of the XYZ coordinate system can be 

displayed. 
Cur jnt Current position data of the joint coordinate system can be 

displayed 
4 Label A character string can be displayed. 
5 Operation Panel Button You can display each the button that exists in the operation 

panel ([START] button etc.). 
6 Menu Button You can display the menu button that moves to the specified 

screen. But click the button and move to the corresponding 
window only. 
This software can be used after Ver.1.40S. T/B software 
version can be used after Ver.4.1 

User definition screen file 
 (yyyyy.uds) 

 

Editing User definition screen  

User definition screen 

User definition screen file 
(xxxxx.uds) 

 

User definition screen 
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7 Jog Button The jog button for manipulating the axes of the robot can be 
displayed. But click the button and manipulate the robot axes 
only T/B 
This software can be used after Ver.1.40S. T/B software 
version can be used after Ver.4.1 

8 Message You can display a message when the set conditions met (It is 
not always displayed on the screen). 
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19.3.1. Creating a new User definition screen file 

In order to create a user definition screen, it is necessary to create a user definition screen file.  
Select [Tool] -> [User definition screen] in the project tree and click the right mouse button and select "New” in the 
right button menu. Click the [OK] button after inputting a new file name. The newly-created user definition screen 
file is added to the bottom row of the [user definition screen].  

 

 
Figure 19-25 Creating a new User definition screen file 

 

 
 
 

About User definition screen files 
It is possible to create a user definition screen file name as desired. But user definition screen 

files are used as folder names in Windows, so you cannot use characters that cannot be used in 
Windows folders names (\ /: *? “ < > | ). 

An error will occur when an inputted user definition screen file already exists.  
 

About the extension of user definition screen files 
The extension of the user definition screen file is “.uds”. If the extension is omitted, or when the 

wrong extension is input, the .uds extension is attached automatically. 

Caution 
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19.3.2. Editing the user definition screen page 

Double-click [Tool] -> [User definition screen] -> [“User definition screen file”] -> [“Page name”] in the project tree. 
The edit dialog of the user definition screen is displayed. 

 
When you create a new user definition screen, select [Tool]->[User definition screen] -> [“User definition screen 
file”]-in the project tree then click the right mouse button and select "New” in the right button menu. A new “User 
definition screen” is displayed.  

 

 
Figure 19-26 Editing the existing user definition screen 

 
 

 
Figure 19-27 creating a new user definition screen 
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The grid lines (<a>) are displayed in the edit display of the user definition screen. Each part can be registered 
with the block units (<b>) delimited in this grid line. 

 

 
Figure 19-28 Editing the user definition screen 

 
<1> Name : Set the page name. The name can be input by the [Edit] button. 
<2> Line : The ruled lines are drawn on the "User definition screen". 
<3> Save : Saves the edited content. 
<4>message  You can edit the message (see Table 18-10). 
 

<a> 
<b> 

<1> <2> <3> 
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19.3.2.1. Button 
(1) Click the position (block) in which a button is made (<a>). The left side of the button is arranged in this 

position. 
(2) After the "Select item" window is displayed, click the [Button] button (<b>). 
(3) Set the button name, button size and the kind of button in the "Create button" window. 
(4) The operation when the button is clicked is set by the [Set] button (<c>).  The set content is displayed in 

"Operation setting" (<d>). 
(5) After the setting is completed, click the [OK] button (<e>). 

 

 
Figure 19-29 Creating a button 

 
 

<1> Name : Sets the name of the button.   
The button name can be input by the [Button name edit] button. 
The button name can be displayed with two lines by checking "2 lines". 

<2> Size : The width of the button can be set. 
The settable button widths are 1/2/3. 

 

<a> 

<b> 

<1> 

<2> 

<3> 

<4> 

<e> 

<c> 
<d> 
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<3> Button type : The kind of the button can be set.  
Alternate When the button is clicked once, the button keeps ON state. And 

when the button is clicked again, it returns to OFF state. 
The signal output is kept too. 

Momentary The button stays in an ON state while it is being pushed. 
 

<4> Operation setting : This sets the preconditions and the signal output operation when the button ON. 
 
The preconditions can be selected as follows. Set the signal number etc., when a 
signal state is the precondition. The precondition is judged when the button is ON or 
OFF. 

- Unconditionally 
- State of the specified Input signal 
- State of the specified output signal 

 
The signal output operation can be selected as follows. Please set the signal 
number etc. when this signal is output. 

- Do nothing  
- Output the specified output signal 

 
Up to two operation settings can be registered. 
Two operation settings operate individually by using their respective preconditions. 
Moreover, when High and Low are set to output to the same signal number, and 
both conditions become true, Condition2 is given priority. 
If the operation is set to signal output, when the button is OFF an inverse signal to 
the High/Low state will be output at ON. 

 
 
Button operation setting examples 
Here we will describe an example of a button that outputs output signal number 20 at High when input signal 
number 20 is high. 

(1) A default value of the “Button operating 
condition” window is shown in the figure at right. 

 

 
 

(2) Set the operation conditions. 
Click <d>, and select the signal type. 
If something other than "Unconditionally" is 
selected, the input area of the signal number 
and the combo box to select the status are 
displayed. 
Now, select "input signal". 

 

 

<d> 
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(3) Input "20" in the signal number (<f>). 

Click the status of the signal (<g>), and select 
"High". 

 

 
(4) Select "High" as the signal operation when 

clicking the button (<h>). 
 

 
(5) The input area of the output signal number is 

displayed.  
Input "20" to the signal number (<i>).  

 
(6) After the setting is completed, click the [OK] 

button (<k>). 
 

 
 
 

<i> 

<k> 

<h> 

<f> 

<g> 
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19.3.2.2. Lamp 

(1) Click the position (block) in which the lamp is made (<a>). The lamp will be arranged at this position. 
(2) After the “Select item” window is displayed, click the [Lamp] button (<b>). 
(3) Select the lighting color of the lamp in the “Create lamp” window. 
(4) Click the [On/Off condition] button (<c>), and set the lighting condition and the turning off condition on 

"The lamp on/off condition” window.  
After setting the lighting condition and the turning off condition, click the [OK] button (<f>).  The set 
content is displayed (<d>) to the right of the [On/Off condition] button. 

(5) After setting the lamp color and lighting condition and the turning off condition, click the [OK] button 
(<g>). 

 

 
Figure 19-30 Creating a lamp 

 
<1> Lamp color : The lighting color of the lamp can be selected. 
<2> Setting : The lamp turning on / off conditions can be set. 

If only one condition is set, the lamp will operate as if the other condition is set to the 
opposite High/Low state for the same signal number. 
Moreover, when both the ON condition and the OFF condition are true, the ON condition 
is given priority. 

 

<a> 

<b> 

<1> 

<2> 

<g> 

<f> 

<c> 

<d> 
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Example of setting lamp ON/OFF 
Here we will describe an example where a lamp is turned on when the input signal number 20 is high, and is 
turned off when the input signal number 20 is Low.  

(1) The default value of “The Lamp on/off 
condition” window is shown in the 
figure at right. 

 

 
 

(2) Set the “On condition”.  
Click <h>, and Select the signal type. 
Now, select “input signal”.  
 

 

 
 

(3) Input “20” for the signal number (<i>). 
 

 

 
 

(4) Select "High" (<k>), as signal state to 
light the lamp. 

 
 

(5) Similarly, set the condition for turning 
off the lamp, and click the [OK] button 
(<l>). 

 

 

<l> 

<k> 

<i> 

<h> 
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19.3.2.3. Variable 

The value of the specified variable is displayed. 
 
(1) Click the position (block) in which the variable is displayed (<a>).  Left side of the variable is arranged at this 

position. 
(2) After the "Select item" window is displayed, click the [Robot information] button (<b>). 
(3) Select "variable" (<c>) as the type in the “Create robot information” window. 
(4) After setting the information of the variable, click the [OK] button (<d>). 

 
Figure 19-31 Creating a display of the variable 

 
<1> Size : Set the width of box in which the variable is displayed. A value from 1 to 16 

can be set. 
<2> Slot : Select task slot number for which the variable is used. 

The range of slot numbers that can be set differs according to the system 
using it. 

<3> Name : Set the variable name. Robot Status Variables also can be set. 
<4> Variable type : Select the variable type. 
<5> Edit : Select the edit permissions of the variable 

When set to Enable, while displaying this screen you can change the value 
of this variable by touching this part and displaying the input value screen. 
(Only when T/B state is enabled.) 

<6> Arrangement : Select the position at which the variable is arranged. 
<7> Color : Select the background color of the area where the variable is displayed. 

<a> 

<b> 

<1> 

<c> 

<d> 

<2> 

<3> 
<4> 

<5> 

<6> 

<7> 
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19.3.2.4. Program execution content 

The content of the program being executed is displayed. Up to 7 lines can be displayed. 
 
(1) Click the position (block) in which the content of the program is displayed (<a>). The left side of the program 

execution content is arranged in this position. 
(2) After the "Select item" window is displayed, click the [Robot information] button (<b>). 
(3) Select "Exe line" (<c>) as the type on “Create robot information” window. 
(4) After setting the information on the execution content, click the [OK] button (<d>). 
 

 
Figure 19-32 Creating a display of the program execution content 

 
<1> Size : Set the width of the box in which the content of program is displayed. A value 

from 1 to 16 can be set. 
<2> Slot : Select the task slot number for which the program is executed. 

The range of slot numbers that can be set differs according to the system using it. 
<3> Color : Select the background color of the area where the program execution content is 

displayed. 

<a> <b> 

<1> 

<c> 

<d> 

<2> 

<3> 

When User definition screen (TB) is shown 
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19.3.2.5. Program name 

The name of program being executed is displayed. 
 
(1) Click the position (block) in which program name is displayed (<a>). The left side of the name display box is 

arranged in this position. 
(2) After the "Select item" window is displayed, click the [Robot information] button (<b>). 
(3) Select "Program name" (<c>) as the type in the “Create robot information” window. 
(4) After setting the information regarding program name display, click the [OK] button (<d>). 
 

 
Figure 19-33 Creating a display of the program name 

 
<1> Size : Set the width of box in which program name is displayed. A value from 1 to 

16 can be set. 
<2> Slot : Select task slot number displaying the program name. 

The range of slot numbers that can be set differs according to the system 
using it. 

<3> Arrangement : Select the position in which the program name is arranged. 
<4> Color : Select the background color of the area where the program name is 

displayed.  

<a> 

<b> 

<1> 

<c> 

<d> 

<2> 

<4> 

<3> 

When User definition screen (TB) is shown 
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19.3.2.6. Execution line number of program 

The line number of the program being executed is displayed. 
 
(1) Click the position (block) at which execution line number is displayed (<a>). The left side of the execution line 

number display is arranged in this position. 
(2) After the "Select item" window is displayed, click the [Robot information] button (<b>). 
(3) Select "Exe line num" (<c>) as the type in the “Create robot information” window. 
(4) After setting the information on the execution line number, click the [OK] button (<d>). 
 

 
Figure 19-34 Creating a display of the execution line number of program 

 
<1> Size : Set the width of box in which execution line number is displayed. The value 

from 1 to 16 can be set. 
<2> Slot : Select the task slot number for which the program is executed. 

The range of slot numbers that can be set differs according to the system 
using it. 

<3> Arrangement : Select the position at which execution line number is arranged. 
<4> Color : Select the background color of the area where the execution line number is 

displayed. 

<a> <b> 

<c> 

<d> 

<1> 
<2> 

<4> 

<3> 

When User definition screen (TB) is shown 
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19.3.2.7. Current position data (the XYZ coordinate system) 

The current position data of robot is displayed for each XYZ coordinate system axis. 
To display the current position data (the XYZ coordinate system) all together, use the “Variable” type and set the 
Robot Status Variable “P_CURR”. Refer to “19.3.2.3 Variable" for details. 
 
(1) Click the position (block) at which the current position data is displayed (<a>). The left side of the display is 

arranged in this position. 
(2) After the "Select item" window is displayed, click the [Robot information] button (<b>). 
(3) Select "Cur pos" (<c>) as the type in the “Create robot information” window. 
(4) After setting the information of the current position data (the XYZ coordinate system), click the [OK] button 

(<d>). 

 
Figure 19-35 Creating a display of the current position data (the XYZ coordinate system) 

 
<1> Size : Set the width of box in which the current position data (the XYZ coordinate system) 

is displayed. A value from 1 to 16 can be set. 
<2> axis : Select the displayed axis of the current position data (the XYZ coordinate system). 
<3> Robot # : Select the robot number for which the current position data is displayed. 
<4> Arrangement : Select the position at which the current position data (the XYZ coordinate system) 

is arranged. 
<5> Color : Select the background color of the area where the current position data (the XYZ 

coordinate system) is displayed. 

<a> 

<c> 

<d> 

<1> 
<2> 

<5> 

<4> 

<3> 

When User definition screen (TB) is shown 

<b> 
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19.3.2.8. Current position data (the joint coordinate system) 

The current position data of robot is displayed for each joint coordinate system axis. 
To display the current position data (the joint coordinate system) all together, use the "Variable" type and set the 
Robot Status Variable "J_CURR". Refer to "19.3.2.3 Variable" for details. 
 
(1) Click the position (block) at which the current position data is displayed (<a>). The left side of the box is 

arranged in this position. 
(2) After the "Select item" window is displayed, click the [Robot information] button (<b>). 
(3) Select "Cur jnt" (<c>) as the type in the “Create robot information” window. 
(4) After setting the information on the current position data (the joint coordinate system), click the [OK] button 

(<d>). 

 
Figure 19-36 Creating a display of the current position data (the joint coordinate system) 

 
<1> Size : Set the width of the box in which the current position data (the joint coordinate 

system) is displayed. A value from 1 to 16 can be set. 
<2> axis : Select the displayed axis of the current position data (the joint coordinate system). 
<3> Robot # : Select the robot number for which the current position data is displayed. 
<4> Arrangement : Select the position at which the current position data (the joint coordinate system) 

is arranged. 
<5> Color : Select the background color of the area where the current position data (the joint 

coordinate system) is displayed. 

<a> 

<c> 

<d> 

<1> 
<2> 

<5> 

<4> 

<3> 
When User definition screen (TB) is shown 

<b> 
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19.3.2.9. Operation Panel Button 

You can place each the button that exists in the operation panel ([START] button etc.) at the specified position. 
T / B can be used with Software Ver. 4.1 or later. 
 

(1) Click the position (block) in which the operation panel button is made (<a>).  The operation panel button 
is arranged in this position. 

(2) After "Select item" window is displayed, click [Operation Panel Button] button (<b>). 
(3) Select the kind of operation panel button on “Create Operation Panel Button” window (<c>). 
(4) After the above selection, click [OK] button on “Create Operation Panel Button” window (<d>). 

 

 
Figure 19-37 Create of a operation panel button 

 

<a> 
<b> 

<c> 

<d> 
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You can place each the button that exists in the operation panel ([START] button etc.) at the specified position. 

Button image Button name Explanation 

 
SVO ON Turn on the servo. 

 
SVO OFF Turn off the servo. 

 
START Start the driving. 

 
STOP Stop the driving immediately. 

 
RESET Reset the robot program. 

 
END End the driving. 
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19.3.2.10. Menu 
Menu buttons can be configured at the specified location.  
This function can be used after the software version Ver.1.40S and T/B software version er.4.1. 
 
(1) Click the Location <a> to make menu button. The button uses 2 areas from the left of the current position. 
(2) Select [Menu Button] <b> in the [Select Item] dialog. 
(3) Select the menu button <c> to be created in the [Create menu button] dialog. The menu button image at the 

time of execution will be displayed at the bottom left of the dialog. 
(4) Click the [OK] button. 
 

 
Figure 19-38 Creat menu button  

 

<a
 

<b
 

<c> 

<d
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The menu button type is as follows. Click and move to this screen function only corresponds to T/B. 
Runtime button image Creation button image Description 

  
Move to program list screen. 

  
Move to slot run state monitor screen. 

  
Move to program monitor screen. 

  
Move to movement state monitor screen. 

  
Move to error monitor screen. 

  
Move to general signal monitor screen. 

  
Move to named signal monitor screen. 

  
Move to stop signal monitor screen. 

  
Move to register<CC-Link> monitor screen. 

  
Move to IO unit monitor screen. 

  
Move to operation hours screen.  

  
Move to production information monitor screen. 

  
Move to additional board screen. 

  
Move to position monitor screen. 

  
Move to speed monitor screen. 

  
Move to load monitor screen. 

  
Move to power monitor screen. 

  
Move to current monitor screen. 

  
Move to parameter edit screen. 

  
Move to backup screen. 

  
Move to restore screen. 

  
Move to origin data menu screen. 
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Move to initialize screen. 

  
Move to maintenance forecast screen. 

  
Move to setup guidance screen. 

  
Move to password setup screen. 

  
Move to tool auto calculation screen. 

  
Move to version screen. 

  
Move to system option screen. 

  
Move to SQ direct position edit screen. 

  
Move to operation panel screen. 
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19.3.2.11. Jog 

Jog buttons can be configured at the specified location.  
This function can be used after the software version Ver.1.40S and T/B software version er.4.1 
 
(1) Click the Location <a> to make jog button. 
(2) Select [JOG Button] <b> in the [Select Item] dialog. 
(3) Select the jog button <c> to be created in the [Create menu button] dialog. The jog button image at the time 

of execution will be displayed at the bottom left of the dialog. 
(4) Select the Fixed-dimension. 
(5) Click the [OK] button. 
 

 
Figure 19-39 Creat jog button  

 

<a
 

<b
 

<c> 

<d
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Fixed-dimension Description 

Off Press the button to move the axis. 

High The axis will move the amount specified by the JOG parameter 
movement amount H. 

Low The axis will move the amount specified by the JOG parameter 
movement amount L. 

 
 
 
Runtime button image Creation button image Description 

    
Move J1 axis. 

    
Move J2 axis. 

    
Move J3 axis. 

    
Move J4axis. 

    
Move J5 axis. 

    
Move J6 axis. 

    
Move J7 (additional axis) axis. 

    
Move J8 (additional axis) axis. 

    
Move in X coordinate direction. 

    
Move in Y coordinate direction. 

    
Move in Z coordinate direction. 

    
Rotate around the X axis. 

    
Rotate around the Y axis. 

    
Rotate around the Z axis. 

    
Move L1 (additional axis) axis. 

    
Move L2 (additional axis) axis. 
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19.3.2.12. Label 

A label can be displayed at the specified position. 
 

(5) Click the position (block) at which the label is made (<a>). The label is arranged in this position. 
(6) After the "Select item" window is displayed, click the [Label] button (<b>). 
(7) After setting the label in the “Create label” window, click the [OK] button (<c>). T 
 

 
Figure 19-40 Create of a label 

<a> 

<b> 

<c> 
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19.3.2.13. Message 

You can display a message when the set conditions met (It is not always displayed on the screen). You can also 
set the behavior when clicking the button displayed on the message. 
 

(1) Click the [Message] button (<a>), then “Message List” window will be displayed. 
(2) To add a new message, click the [Add] button (<b>). To edit the existing message, select the target 

message and click the [Edit] button. Then “Message Editor” window will be displayed. 
(3) A Set the kind of displayed icon, displayed message, etc., and click the [OK] button. Then the set 

contents will be displayed in the list (<c>). 
 

 
Figure 19-41 Create of a message 

 
 

<a> 

<b> 

<c> 
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19.3.2.14. Save and end of editing user definition screen 

After editing the user definition screen, click the [Save] button (<a>). 
Click [x] (<b>) to conclude the edit. 

 
Figure 19-42 Save and end of editing user definition screen 

 
 
19.3.3. Editing of existing parts 

Edit already-registered parts by the following operation. 
(1) Click the part to be edited (<a>). 
(2) After the "Edit menu" window is displayed, click the [Edit] button (<b>). 
(3) The edit screen for the selected parts is displayed. Change the setting contents and click the [OK] button 

(<c>). 
 

 
Figure 19-43 Edit of existing parts 

 
 

<a> 

<b> 

<c> 

<a> 

<b> 
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19.3.4. Copying/Pasting of parts 

Parts can be copied. 
 

(1) Click the part to copy to select it (<a>). 
(2) After the "Edit menu" window is displayed, click the [Copy] button (<b>).  
(3) Click the position (block) where the part is copied onto (<c>). 
(4) After the "Select item" window is displayed, click the [Paste] button (<d>). 

At this time, the position (block) where the part is copied onto is green. 
A copy confirmation message will be displayed. Click the [Yes] button. 

 

 
Figure 19-44 Copy/Paste of parts 

 
 

<a> 

<b> 

<c> 

A copy confirmation massage is displayed 
when you click a click the [Paste] button. 

<d> 
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19.3.5. Movement of parts 

Parts can be moved. 
  

(1) Click the part to move to select it (<a>). 
(2) After the "Edit menu" window is displayed, click the [Move] button (<b>).   
(3) Click the position (block) where the part is moved to. 

At this time, the current position (block) of part is red, and the position (block) where the part is moved onto is 
green. 
A move confirmation message will be displayed. Click the [Yes] button. 

 
Figure 19-45 Movement of parts 

 
 

<a> 

<b> 

<c> 

A move confirmation massage is displayed 
when you click a move destination. 
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19.3.6. Deletion of parts 

Parts can be deleted. 
 

(1) Click the part to delete to select it (<a>). 
(2) After the "Edit menu" window is displayed, click the [Delete] button (<b>). 
(3) Click the [Yes] button on the confirmation message. 
 

 
Figure 19-46 Deletion of parts 

 
 
19.3.7. Changing the page name 

The page name can be changed in [Name] in the lower left of the window. 

 
Figure 19-47 Change of page name 

 
 
 

<a> 

<a> 

<b> 

 
When an already-registered page name is input, an error will result. 

Caution 
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19.3.8. Edit of ruled lines 

Ruled lines can be drawn on the user definition screen. 
 

19.3.8.1. Drawing the ruled line 
(1) Click [Line] button (<a>) on the window. 
(2) The buttons (“[Top], [Bottom], [Left], [Right]”) (<b>) for the ruled line are displayed at the right of [Line] button. 

These buttons for drawing the ruled lines disappear when [Line] button (<c>) is clicked again. 
 

 
(3) Select the kind of ruled line (<d>). Only one kind of ruled line can be selected.  

 
(4) Click the block (<e>) where the ruled lines are drawn. Ruled lines can be drawn at the specified position on 

the selected block. 

 
(5) After editing the ruled lines, click the [Line] button (<f>) again. 
 
 

<e> 

<f> 

<d> 

<a> 

<b> <c> 
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19.3.8.2. Erasing the ruled line 

(1) Click the [Line] button (<a>) on the window. 
(2) The buttons (“[Top], [Bottom], [Left], [Right]”) (<b>) for the ruled lines are displayed at the right of the [Line] 

button. These buttons for drawing the ruled lines disappear when the [Line] button (<c>) is clicked again. 

 
(3) Select the kind of ruled line (<d>). Only one kind of ruled line can be selected. 

 
(4) Click the block (<e>) where the ruled lines are erased. The ruled line can be erased at the specified position 

on the selected block. 

 
(5) After editing the ruled line, click the [Line] button (<f>) again. 
 

<e> 

<f> 

<d> 

<a> 

<b> <c> 
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19.3.9. Display of user definition screen  

You can actually execute (display) the user definition screen you created in the editing screen when online.  
 

(1) In the project tree, right click the screen name to be displayed and select the [view] from the displayed 
context menu. Then the Selected user definition screen will be displayed. 

(2) In the displayed screen, the button, lamp and etc. actually work according to the state of connected 
robot controller. 

 

 
Figure 19-48 Display of user definition screen 

 

<a> 
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19.3.10. Deletion of user definition screen 

It is possible to delete the existing "User definition screen". 
There are two methods to delete a user definition screen. 

 
(1) Deleting the user definition files. In this case, all the user definition screens in a user definition screen file 

are deleted. 
(2) Deleting selected user definition screen from the inside of a user definition screen file. 
 

However, the user definition screen during editing cannot be deleted.  
 
 

19.3.10.1. Deletion of user definition screen file  
All the user definition screens in a user definition screen file are deleted. 

 
Select [Tool] -> [User definition screen] -> [“User definition screen file”] in the project tree, click the right mouse 
button and then select "Delete” in the right button menu. A confirmation message is displayed. Click the [OK] 
button. The entire selected user definition screen file and the user definition screens in it are deleted. 
 
The user definition screen during editing cannot be deleted. 
 

 
Figure 19-49 Deletion of user definition screen file 

 

All the user definition screens (in this case, 
Page1 to Page6) in an "Panel_ 01.uds" file 
and the file are deleted. 
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19.3.10.2. Deletion of page  

The selected user definition screen pages in the user definition screen file are deleted. 
 

Select [Tool] -> [User definition screen] -> [“User definition screen file”] -> [“User definition screen page”] in the 
project tree, click the right mouse button and then select “Delete” in the right button menu. A confirmation 
message is displayed. Click [OK] button. The selected user definition screen pages are deleted. 

 
The user definition screens cannot be deleted during editing. 
 
 

 
Figure 19-50 Deletion of page 
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19.3.11. Import of user definition screen 

It is possible to import a user definition screen files created in other work spaces and projects. 
There are two methods for import. 

 
(1) Importing the user definition screen files. 

In this case, all the pages in the user definition screen files are imported. 
(2) Importing the selected pages in the user definition screen file. 
 

 
19.3.11.1. Importing the user definition screen files. 

All the pages in the user definition screen files are imported. 
 

Select [Tool] -> [User definition screen]-in the project tree, click the right mouse button and then select "Import” in 
the right button menu. The “Select import user definition screen file” screen is displayed. After selecting the 
import files, click the [OK] button. The selected user definition screen file and all the pages in the file are imported 
to the current project. Two or more user definition screen files can be imported simultaneously. When a file of the 
same name exists in the project, an overwrite confirmation message is displayed. 

 

 
Figure 19-51 Importing the user definition screen files 

 

The default folder when starting this software is "My 
Documents". While the software is running, it is the 
folder in which the last import was performed. After 
closing this software, it returns to "My Documents." 
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19.3.11.2. Importing the page of the user definition screen 

Importing the selected pages in the user definition screen file. 
 

Select [Tool] -> [User definition screen] -> [“User definition screen file”] in the project tree, click the right mouse 
button and then select the "Import” in the right button menu. The “Select import user definition screen file” screen 
is displayed. Select the import files and click the [OK] button. The “Select import user definition screen” screen is 
displayed, and all the pages in the selected file are displayed. Select the import pages and click the [OK] button. 
The selected pages in the file are imported to the current project. Two or more pages can be imported 
simultaneously. The imported pages are added to the lowest row. 
 

 
Figure 19-52 Importing the page of the user definition screen 

 
When existing file of the same name exists in the project, the overwrite confirmation message is displayed. 
Clicking the “Overwrite” button will replace all the pages in the file. Import can also be performed after name 
change. 
 

The default folder when starting this 
software is "My Documents". While the 
software is running, it is the folder in which 
the last import was performed. After closing 
this software, it returns to "My Documents." 
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19.3.12. Export of the user definition screen 

It is possible to export the user definition files in the current project so that it can be used in other projects. The 
user definition screen is exported in file units. 
 

Select [Tool] -> [User definition screen] in the project tree, click the right mouse button and then select the 
"Export” in the right button menu. The “Select export user definition screen file” screen is displayed. Set the 
export path and select the export file, then click [OK] button. The selected user definition screen file is copied in 
the "export path" folder. Two or more pages can be exported simultaneously. 

 

 
Figure 19-53 Export of the user definition screen 

 
 

When a file of the same name exists in the "export path" folder, the overwrite confirmation message is displayed. 
Clicking the “Overwrite” button will replace all the pages in the file. Export can also be performed after name 
change.  

 

 
Figure 19-54 User definition screen Export- confirmation message 

 
 

The default folder when starting this software is "My 
Documents". While the software is running, it is the 
folder in which the last import was performed. After 
closing this software, it returns to "My Documents." 
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19.4. File Manager 
You can copy, delete, and rename the files in the robot controller. 
Double-click [Online] -> [Maintenance] -> [File Manager] in the project tree. 

 
Figure 19-55 Starting File Manager 

 

The following operations cannot be performed on CR750/700 
controllers before Ver.R3e/S3e. 

・ You cannot delete or rename a file without an extension. 
・ You cannot delete or rename the file of a name that is longer than 16 

characters. 
・ You cannot operate a file in which '0' is attached at the head of the file 

name.  

Caution 
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19.4.1. File list display 

The left and right lists display lists of the files displayed in the robot controller and the specified folder. 
 
(1) Transmission setup You can select “PC->Robot” or “Robot -> PC”. 
(2) PC You can specify files in the personal computer. 
(3) Robot You can specify a robot controller that is currently connected 
(4) [Browse…] When you select [PC], you can specify any folder on the computer. 
 

 
Figure 19-56 File list display 

 
There are files which you cannot operate on this screen, such as robot programs, parameter files in the robot 
controller, etc. Files which cannot be operated are not displayed in the lists. Files which cannot be operated on 
this screen are as follows. 
 

(2) PC 

(3) Robot 

(4) You can specify any 
folder on the computer. 

(1)Transmission 
Setup 

When a password is registered in “program” by robot controller security 
function, the file cannot be deleted or renamed.  
When a password is registered in “program” by robot controller security function, the file cannot be 

deleted or renamed  
○ : Enable、 × : Disable 

  Item to which security function password is 
registered. 

Program Parameter File 
Delete the file 

× ○ ○ Rename the file 
 

Delete the password of the robot controller security function when you operate these. Refer to 
"16.5.3 Delete Password" for the method of deleting the password.  

For details on setting security functions (registering passwords) and releasing security functions 
(deleting passwords) on robot controllers, refer to "Table 16-12 Compliant version of this 
function and controller". 

Caution 
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Table 19-12 The file which cannot be operated on a file management screen, and its extension 

No. Files File name or 
extension  

1 Robot program files .MB4/.MB5/.prg 
2 Parameter files .PRM 
3 Error log files AError.log 

CError.log 
HError.log 
LError.log 

4 I/O Log (Input/Output)  IOLogInp.log 
IOLogOut.log 

5 Trap function log files(program execution log files) .trp 
6 Servo data log files 

(This file is reconstructed at power supply ON.) 
.sdl/.sdb 

7 Force control log file  
(This file is deleted at power supply OFF.) 

.fsl 

8 Error record log files TTLERROR.DAT 
9 ERRORLOG.CSV 
10 Command information file COMMANDS.XML 
11 System files 

(Backup information etc.) 
.SYS 

12 Serial information file  
(This file is created at the time of backup) 

.ser 

 
 
19.4.2. Copy 

This copies the files. 
Select t the transmission source file names from the list at left, and designate the transmission destination folder 
on the right side. Multiple transmission source files can be selected at the same time. 
Click the [Copy] button after choosing the file(s) to copy and setting up the transmission destination. The file is 
copied after copy confirmation message display. 
When the file of the same name exists in the transmission destination, an overwrite confirmation message is 
displayed. 
 
 
19.4.3. Delete 

This deletes the files. 
Select the file(s) to delete in the list. It is possible to select multiple files at the same time. All the files selected in 
the left and right lists are deleted. Click the [Delete] button after selecting the files in the lists. A deletion 
confirmation message is displayed. 
 
 
19.4.4. Rename 

This renames the files. 
Select a file in the list. It is possible to select a file from both lists. Click the [Rename] button, and input the new 
file name in the “Setup for Rename” dialog. 
 

 
Figure 19-57 Setup for Rename 
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19.5. 2D vision calibration 
This section explains the 2D vision calibration function. 
 
 
19.5.1. Summary 

(1) Summary 
2D vision calibration is a function to determine the relationship between the vision sensor’s coordinates and 
the robot’s coordinates. You can have up to 8 switchable vision calibration data sets. 

(2)  

 
Figure 19-58 Summary of 2D vision calibration 

 
The software version of the controller which can use this function is as follows. 
 

Table 19-13 Supported robot controllers and model 
No. Model CR800 CR750/700 CRn-500 
1 Vertical 6-axis robot All versions R5/S5 or later. 

Not available. 2 Vertical 5-axis robot All versions R5/S5 or later. 
3 Horizontal 4-axis robot All versions R5/S5 or later. 

 
(3) System components 

The figure below shows the system components.  
Perform the connection of the equipment before using this function Refer to the instruction manual of your 
vision sensor. 

 

R32TB/R33TB or 

R56TB/R57TB 

PC 

Robot 

CRnD / CRnQ-700 

Q172DRCPU 

CR75x-Q / CR75x-D 

Vision sensor 

Ethernet （TCP/IP） 

Windows / RT ToolBox2 

Robot controller 

 
Figure 19-59 System component of 2D vision calibration 

 

Robot’s coordinates Vision sensor’s coordinates 

 

Determining 
 the relationship 
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19.5.2. Operating procedure of 2D vision calibration 

This section explains operating procedure of vision calibration 
 

(1) Starting 2D vision calibration 
Use this function while connected to a robot controller. 
Double-click the target project [Tool] -> [2D Vision] -> [2D Vision Calibration] on the project tree to start 2D 
vision calibration. 

 

 
Figure 19-60 Starting 2D vision calibration 

(2) Select calibration number 
Select the tab of a desired number. 
The maximum number of calibration settings combo box switchingly usable is 8. 

 

 
Figure 19-61 Calibration number tab 

(3) Teaching points 
Click the row which you want to teach a point, to move the selected line cursor. 
Position the tool center point at the calibration marker. 
Click the [Get the robot position] button to get the current robot position.  
Robot.X and Robot.Y in the selected row are filled in and the [Enabled] checkbox is checked automatically  
You cannot edit teaching points before clicking the [Get the robot position] button. 
Measure the position of the calibration marker with the vision sensor.  
Enter the X, Y pixel coordinate positions in Camera.X and Camera.Y respectively.  
For the method of getting the pixel coordinates, refer to your vision sensor’s manual. 

 
Figure 19-62 Input teaching points 

 
If the combination of vision sensor coordinates and robot coordinates is wrong or the teaching points are closely 
spaced, incorrect calibration data may be calculated. 

 
Automatic input Manual input 
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Vision calibration needs a minimum of 4 teaching points. For accurate calibration, 9 or more points arranged 
separately are recommended.   

 
Figure 19-63 Example of 9 markers in camera vision (Image) 

 
 

(4) Calculate vision calibration data 
When 4 or more data on the list of [Teaching points] are enabled, the [Calculate after selecting 4 points or 
more] button becomes enabled. Click the button to calculate the vision calibration data and display the data in 
the [Result homography matrix]. 

 

 
Figure 19-64 Calculating vision calibration data 

 
(5) Write to robot 

Click the [write to robot] button to write the calculated vision sensor calibration data [VSCALBn] (“n” is the 
calibration number) to the robot controller.  
As shown in the figure below, the values of the calibration calculation results are displayed at the top, and the 
values currently set in the controller are displayed at the bottom for confirmation. 
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Figure 19-65 Writing to robot 

 
(6) Saving a file 

Click the [Save] button or [Save as ...] button to save the teaching points and the calculation results as a 
camera calibration coordinate file. The extension of the camera calibration coordinate file is “ccc”. 
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(7) Other function 
・Move robot to selected point 

 
Click the [Move robot to selection point] button to move the robot to the position selected on the list of 
[Teaching points].  
Indicate the trajectory in Mov (Joint interpolation movement) and MVS (Linear interpolation movement). 
You can specify the offset (unit [mm]) in the tool coordinate system. For example, when a Z direction offset of 
“-50” is specified, the robot moves to a position shifted 50mm toward the Z direction in the tool coordinate 
from the teaching point.  
Note that the orientation of the tool coordinate system differs between vertical robots and horizontal robots. 

 

 
Figure 19-66 Move the robot to selected point 

 
 
 
19.5.3. 2D vision calibration screen 

 This section explains each button on the 2D vision calibration screen.  

 
Figure 19-67 2D vision calibration screen 

(2) 

(4) 

(5) 

(8) (9) 
(10) (11) 

(1) 

(6) (7) 

Check to be used for calculation. 

The robot may operate at 100% speed. Pay attention to 
safety around the robot. 

Also, keep a T/B at hand and use the robot in a status in 
which an emergency stop can be made at any time. 

Danger 

(3) 
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(1) New 

Add new 2D vision calibration settings. 
The current settings displayed on the screen are removed. 
 

(2) Open… 
Load a Camera calibration coordinate file saved on your PC. 
The current settings displayed on the screen are removed. 
 

(3) Save / Save as … 
Save the current calibration settings as a Camera calibration coordinate file. 

 
(4) Get the robot position 

Get the current robot position (XYZ coordinate). 
 

(5) Calculate after selecting 4 points or more 
Calculate the calibration data using teaching points where the [Enable] checkboxes are checked. 
The calculated result is displayed in [Result homography matrix]. 

 

(6)  
Move the selected cursor.  
 

(7)  
Delete a row selected on the list of [Teaching points]. 

 
(8) Write to robot 

Write the values of [Result homography matrix] to the robot controller. 
The current values of the calibration data in the robot controller are displayed in [Current homography 

matrix]. 
 
(9) Move robot to selected point 

Display the [Move robot to selection point] screen for a selected row on the list of [Teaching points].  
 

(10)  

 
Joint interpolation (Mov) or linear interpolation (Mvs) can be selected for interpolation operation. 

 
(11) Move 

Executes robot movement according to the setting in (10). 
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19.6. Automatic Calibration 
You can set item about automatic calibration and generate the robot program. 
This function can be used if the setting language is MELFA-BASIC VI and CR800 series robot controller and 
automatic calibration control of MELFA Smart Plus function is effective. These parameters cannot be set by the 
offline editing. 
 
For more information see “MELFA Smart Plus Instraution Manual (BFP-A3559)”. 
 
You click [Tool] -> [2D Vision] -> [Automatic Calibration] from the project tree.  
 
 

 

 
 

Figure 19-68 Automatic calibration screen 
 
 



 

19-517  19-517 

19.7. 2D vision sensor enhancement function 
You can use 2D vision sensor enhancement function of MELFA Smart Plus function. 
This function can be used if the setting language is MELFA-BASIC VI and CR800 series robot controller and 2D 
vision sensor enhancement function of MELFA Smart Plus function is effective. These parameters cannot be set 
by the offline editing and simuration. 
 
For more information see “MELFA Smart Plus Instraution Manual (BFP-A3559) / MELFA Smart Plus 2D 
Vision Sensor Enhancement Function Instruction Manual (BFP-A3785)”. 
 
You click [Tool] -> [2D Vision] -> [2D vision sensor enhancement function] from the project tree, and the 2D vision 
sensor enhancement function will start. 

 

 
 

Figure 19-69 Start 2D vision sensor enhancement function 
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19.8. Force sensor calibration 

19.8.1. Outline 

Force sensor calibration is the function that calculates the weight and center of gravity position of the robot hand 
attached to a force sensor. 
The data calculated by force sensor calibration (robot hand weight and center of gravity position) is needed 
during force offset cancellation. Execute the force sensor calibration before the execution of gravity offset 
cancellation. 
The table below shows the robot controller versions and robot models. 
 

Table 19-14 Supported robot controllers and model 
No. Robot model CR800 CR750/700 CRn-500 

1 Vertical 6-axis robot All versions 
(RV-FR series models) 

Version R6h/S6h  
or later 

(RV-F series models) 

not used 2 Vertical 5-axis robot not used not used 

3 Horizontal 4-axis robot not used not used 

 
 
19.8.2. Starting 

From the project tree, double-click [Tool] -> [Force sensor] -> [Force sensor calibration]  

Figure 19-70 Startup screen of force sensor calibration 
 
This function can be used when connected with a machine supporting force sensor function. For details on the 
setup method, refer to the user’s manual of the force sensor function (BFP-A8940). 
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19.9. Force control log file viewer 
The Force control log file viewer is a function to display a graph of force control log data in the PC and robot 
controllers. 
From the project tree, double-click the target project [Tool] -> [Force sensor] -> [Force control log file viewer]. 
 

 
Figure 19-71 Force control log file viewer 

 
This screen can be used when connected with a machine supporting the force control function. 
For details, refer to the user’s manual which contains a complete description of the force control function. 

Double-click. 
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19.10. Tool automatic calculation 
With “Tool automatic calculation”, the tool length is calculated automatically by teaching a same position by 3 to 8 
points to the robot with an actual tool mounted, setting up the value of a tool parameter (MEXTL). 

 
For details on supported models and robot controllers, refer to "Table 19-15 Supported Robot Controllers and 
Models". 

 

 
Figure 19-72 Summary the “Tool automatic calculation” 

 
 
19.10.1. Specifications 

The robot models and robot controller versions with which the “Tool automatic calculation” can be used are as 
follows.  
 

Table 19-15 Supported Robot Controllers and Models 

No. Robot model CR800 series  
Robot Controller 

CR750/700 series 
Robot Controller 

CRn-500 series  
Robot Controller 

1 Vertical 6-axis robot All versions Version R3e/S3e  
or later 

Not used 2 Vertical 5-axis robot not use not use 

3 Horizontal 4-axis robot All versions Version R3e/S3e  
or later 

 
 
19.10.2. Starting 

The “Tool automatic calculation” is used in a state with the robot controller connected.  
 

When the robot model and robot controller to which it is connected support this function, [Tool automatic 
calculation] is displayed under [Tool] in the project tree. Double-click [Online] -> [Tool] -> [Tool automatic 
calculation] in the project tree.  

 

Teach the same position by 3 to 8 points to a robot with a tool mounted 
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Figure 19-73 Starting the “Tool automatic calculation” 
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19.10.3. Flow of operations 

 

Select the target robot (<a>) 

Write the tool coordinate to robot controller (<e>) 

Repeat as necessary 

(When a value is set to “Calculated tool coordinate”,  

a [Write] button (<e>) becomes effective) 

Select the tool number for setting (<b>) 

Select the line of “Auxiliary point” (<c>) 

Teach selection line (<d>) 

Move the robot to the auxiliary point 
(Use the teaching box) 

Enter checks to the check box of the line 

used to calculation (<c>) 

(After teaching, the check box is updated) 

Re-teaching Work Procedure 

 
Figure 19-74 Operation Flow 
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Figure 19-75 The “Tool automatic calculation” screen 

 
Select the robot (<a>) and the tool number (<b>).  

 
Move the robot with a tool mounted. Select a line of the “Auxiliary point” list (<c>) and click the [Teach selection 
line] button (<d>). It will teach the same position at 3 to 8 points with different postures.   

 
When a value is set in “Calculated tool coordinate”, the [Write] button (<e>) becomes effective. When the [Write] 
button (<e>) is clicked, the values of a tool parameter (MEXTL) are written to the robot controller.  

 
When the [Error information] button (<f>) is clicked, it is possible to check the deviation from a teaching point.   

 

 
 

<d> 

<a> 

<b> 

<e> 

<c> 
 

<f> 

Teach the position by greatly varying the posture of the robot. 
The tool coordinates might be not computable if the postures are similar. (e.g. when only A axis is 

different)  

Caution 
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20. Operating the Robot 
To operate the robot from RT ToolBox3, you use the operation panel. 
 
20.1. About the Operation Panel 

 
 
20.1.1. Starting the operation panel 

In RT ToolBox3, you can start up the operation panel for operating the robot. The operation panel can be started 
up by clicking [Online] -> [Operation panel] from the project tree when the PC is connected online with the 
controller or the PC is in the simulation mode. 

 
Figure 20-1 Displaying the Operation Panel 

 
On the operation panel, you can execute robot programs, operate the hand and execute jog operation. 
Although hand operation and jog operation are possible on an actual robot controller, operate with sufficient 
attention paid to the robot's surroundings. 
The operation panel remembers the display position and is displayed at the same position the next time it is 
started up. To return the display position to the initial position, after changing to the offline mode, close all the 
displayed screens and click the [Reset] button on the [View] tab of the ribbon -> [View] group Please give me. 

 

 
Figure 20-2 Operation Panel Screen 

 
 

With program running and debugging, the robot might operate at 100% speed. 
So, pay attention to safety around the robot. 
Also, prepare a T/B nearby at hand, and use the robot in a state in which an 

emergency stop can be made at any time. 

Danger 
 

(1) Task slot state and 
selection 

(2) Override 

(3) Operation panel 

(4) Step 

(7) D-EXEC 

(9) Monitor 

(5) HAND 

(6) JOG 

(8) Driving speed 
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(1) Task slot state and selection 
This shows the task slot state, currently selected program and currently executing line No. 
- You can select the program to execute by clicking the [Select] button. 
- You can select the line for which the program is executed by clicking the [Jump] button. 

 
(2) Override 

This displays and sets the robot speed override. 
You can also set this by operating the drop-down list. 5%, 2%, and 1% also can be selected by this 

operation. 
 
(3) Operation panel 

This is used for controlling the robot. You can start, stop, reset and exit program operation, and turn servos 
ON and OFF. 

 
(4) Step 

This controls the program in the debug mode. 
- [FORWD] and [BACKWD] execute the current executing line of the robot program, and move the 

executing line to the previous or next line. 
- [CONT] executes a program that has stopped by a breakpoint or by the stop command continuously from 

the stopped line. 
 
(5) HAND 

This operates the robot hand. Clicking this button displays the hand operating screen. 
You can open and close each of the hands, and align and move hands to the home position. 
You can also operate an actual robot controller. 

 
(6) JOG 

This performs jog operation on the robot. Clicking this button displays the jog operating screen. 
You can also operate an actual robot controller. 

 
(7) D-EXEC 

This is for performing direct execution, that is, execute any command directly on the robot regardless of 
the robot program. 

 
(8) Driving speed 

You can select the robot driving speed between normal and low. 
When "Low" is selected, the robot moves at the maximum jog operation speed. 
This function is available in all software versions of CR800 series controllers and in software version 
S6h/R6h or later on CR750/700 series controllers. 
 

(9) Monitor 
This displays the 3D monitor of the robot. Clicking the [Error] and [Program] buttons displays the "Error 

Monitor" and "Program Monitor" screens, respectively. 
 
When program execution is started or D-EXEC is used, the following caution screen is displayed. Clicking the 
[OK] button starts robot operation. For this reason, make sure to check the safety around the robot and prepare a 
T/B before executing robot operation. 

 
Figure 20-3 "Caution" Screen Displayed at Start of Operation. 
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If JOG operation can not be performed smoothly, please try the 
following. 

 

 Close the open monitor screen. 
 Connect by Ethernet. 

Caution 
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20.1.2. Operation panel commands on the ribbon 

The same operations as the operation panel can be performed by using the [Online] tab -> [Operation panel]/ 
[Step execution] group commands on the ribbon. 

 

 
Figure 20-4 Ribbon Commands for Operation Panel Operations 

 
The following operations can be performed on any robot or simulator. 

 
Table 20-1 Explanation of Operation Panel Operation Commands 

Group name Command name Description 
Operation Panel RC Selects the robot or simulator to be operated. 

When "0: All robots" is selected, operations can be performed 
simultaneously on all currently connected robots and 
simulators. 

Show/Hide OP. Displays and hides the operation panel. 
OVRD: The current override is displayed. 
Up Increases the override. 
Down Decreases the override. 
Servo on Turns the servo ON. 
Servo off Turns the servo OFF. 
Start Starts operation. 
Stop Immediately stops operation. 
Rest Resets the program. 
End Ends operation. 

Step Execution Backward Executes the current executing line of the program and moves 
the executing line to the previous line. 

Forward Executes the current executing line of the program and moves 
the executing line to the next line. 

Continue Executes the program continuously from the stopped line. 
I/O Simulator Start Start the I/O simulator. For details, refer to "24.4Starting I/O 

Simulator". 
Exit Exit the I/O simulator. For details, refer to "24.6 Stopping I/O 

simulator". 
Monitor  3D Display the 3D monitor screen. 

Error Display the error monitor screen. 
Program Display the program monitor screen. 

 

 
 
 
 

When "0: All robots" is selected and "Start" is executed, all robots will start to 
operate at the same time. 

So, pay attention to safety around each of the robots. 
Also, prepare a T/B nearby at hand, and use the robot in a state in which an 

emergency stop can be made at any time. 

Danger 
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20.2. Functions of Operation Panel 
The following describes the functions of the operation panel. 
 
20.2.1. Jog operation 

You can perform the jog operations displayed in the robot view in the online or simulation mode. Click the [JOG] 
button in the operation panel screen. The screen for jog operation is displayed under the operation panel 
operation screen. 
WORK JOG operation is not available when work coordinate parameters are not set or on CRn-500 series 
controllers. 
To perform jog operation online, the PC must be set to acquire operation rights. When the MODE key on the 
robot controller is set to "AUTOMATIC" and external I/O signals are used, set input of operation rights from 
external I/O to OFF. If an attempt is made to perform jog operation when operation rights cannot be acquired, the 
"The operation is disabled (602000000)" error dialog is displayed. 

 

 
Figure 20-5 Starting Jog Operation 

 
(1) Robot model selection 

When multiple robots are set as connected, select the robot model to operate. 
 

Screen for jog operation 
 

(9) Current robot position 
 

(7) Hand Align 
 

(11) Operation by slider bar 
* In simulation mode only 

 

(12) Position value specified 
move 
 

(10) Axis jog operation 
 

(5) Change Base 

(1) Robot model selection 
 

(3) Movement distance setting 
 

(6) Change WORK 
 

(4) Change TOOL 
 

(8)Home Position 

JOG 
 

(2) Move method 
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(2) Move method 

Select the robot move method. The move methods shown below can be selected. 
For details on each jog operation, refer to "Detailed Explanations of Functions and Operations" in the 
robot controller instruction manual. 

 
Move method 

Joint 
XYZ 

TOOL 
3-axis XYZ 

Cylinder 
WORK 

 
The display of the robot current position and the jog operation button for each axis varies according to the 
move method selected here. Also, these displays vary according to the axis configuration of the connected 
robot. Operation by slider bar is enabled only in the simulation mode. On actual robot controllers, the slider bar 
is not displayed. 
 

 
Figure 20-6 Changes in Screen for Jog Operation According to Move Method Selection 

 
(3) Movement distance setting 

This selects the robot move distance. Selectable move distances are "off", "High", and "Low". 
For details on move distances, refer to "Detailed Explanations of Functions and Operations" in the robot 
controller instruction manual. 

 
(4) Change TOOL 

Select the TOOL of robot. The tools that can be selected differ according to the specifications of the connected 
robot. 

   
(5) Change Base 
  Select the base coordinate number of the robot. It can be selected are “Base 0” to “Base 8”. 

"Base *" will be displayed if base is switched by not using base coordinate number. 
It cannot be used on a controller that does not have the base coordinate number parameter (MEXBSNO). 

 
(6) Change WORK 

This selects the workpiece when moving the robot by "WORK JOG". The workpieces that can be selected are 
"WORK1" to "WORK8". 

When "Joint" is 
selected 

When "XYZ" is 
selected 

When "TOOL" is 
selected 

When "WORK" 
is selected 

When "3-axis 
XYZ" is selected 

When "Cylinder" 
is selected 
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WORK JOG operation is not available when work coordinate parameters are not set or on CRn-500 series 
controllers. 

 
(7) Hand Align 

You can align the posture of the hand installed on the robot in 90 degree units. 
This function moves the robot to a multiple value of 90 degrees that is closest to the A, B and C components of 
the current position. 
 

(8) Home Position 
You can move the robot to the position set to the evacuation point position parameter (JSAFE). 
 

(9) Current robot position 
This displays the current robot position. 

 
(10) Axis jog operation 

This performs jog operation on each robot axis. 

 Moves the selected robot axis in the "-" direction. 

 Moves the selected robot axis in the "+" direction. 
These buttons move the robot while the mouse button is held down. 
 

(11) Operation by slider bar 
When Joint or XYZ jog is selected, the corresponding coordinate axis can be moved by dragging the slider bar 
to the left and right. Operation by slider bar is enabled only in the simulation mode. On actual robot controllers, 
the slider bar is not displayed. 
The following might occur regarding the operation range of the X, Y or Z axis in XYZ job depending on your 
environment. 

 
The movement area of the robot is outside the operation range of the slider bar. 
The operation range of the slider bar is too wide, making it difficult to operate the robot. 
In such cases, change the operation range of the slider bar for each axis in the "XYZ Slider range" screen that 

is displayed by clicking the  button at the lower right corner of the XZY jog screen. 
 

 
Figure 20-7 XYZ Slider Bar Range Screen 

 
In XYZ job on a vertical 6-axis robot, you can use the slider bar on axes other than the A- and B-axes. 
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(12) Position value specified move 

You can move the robot by specifying the joint or XYZ coordinates directly. 
When you double-click the coordinate value display part on the joint or XYZ jog screen or click the [P.Jump] 
button, the "Position Jump" screen corresponding to the jog mode will be displayed. When you enter the 
coordinate value in this screen, the robot will move to that position. 
Coordinate value specification model and robot controller version are available below. 
In the case of simulation, this function can be used regardless of the following model or robot controller. 

Table 20-2 Supported robot controllers and model 
No. Model CR800 CR750/700 CRn-500 

1 Vertical 6-axis robot All versions R3e/S3e or later 

Unavailable 2 Vertical 5-axis robot Unavailable Unavailable 

3 Horizontal 4-axis robot All versions R3e/S3e or later  

 
If the entered position is outside the movement area of the robot, the robot will not move. 
This operation is invalid while the robot is running. 
If you are using a vertical 5-axis robot, the 6th axis in FLG2 cannot be used. 

 
You can specify "offset" to specify relative movement amount. When you click the [Offset] button, the input 
value of the offset returns to 0. 
As the "Interpolation" can choose Joint (Mov) ,Linear (Mvs) ,Arch(Mva) and Direct.  
Direct can only be selected during simulation. 

 
 

Figure 20-8 Operation of Position Value Specified Move 
 

Double-click the 
coordinate value 

area 
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Arch interpolation can choose to specify the Arch number for Arch movement. 

 
Figure 20-9 Arch Number 

 
Direct can be selected only during simulation. Arch cannot be selected when it is MOVEMASTER command or 
Joint or multi-mech. 
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20.2.2. Program execution 

You can execute a program selected on the operation panel or a program that has been opened in the debug 
mode. 
For details on how to make programs, refer to "11 Writing Programs". 

 
Table 20-3 Differences Between Program Execution and Debugging 

 Program Execution Program Debugging 
Program selection Use [Select] button on operation panel Open program in debug mode 
Program operation Use buttons on [Operation panel] Use buttons on [Step] 
Program starting 
conditions 

Starting conditions specified in slot table Finished in one cycle (*1) 

(*1) Note that programs that are repeated infinitely do not end automatically. 
 

 
Figure 20-10 Program Execution 

 
To forcibly stop a program that is executing, click the [STOP] button. 
 
 
20.2.3. Specifying the starting line for program execution 

You can freely specify the line in the program from which to start execution. Click the [Jump] button in the 
operation screen. The "Jump" screen is displayed. In this screen, enter the step number to start execution from. 
The current execution line moves to the specified step number. 
 

 
Figure 20-11 Specifying the Line for Program Execution 

 

Select 

Operation panel 

Step 

"Jump" screen 

Jump button 
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20.2.4. Step operation  

You can execute a program that has been opened in the debug mode one step at a time. 
In the online or simulation mode, open the program in the debug mode. The step function on the operation panel 
is enabled. 
 

 
Figure 20-12 Step Operation in Operation Panel Screen 

 
Operate with the [FORWD] or [BACKWD] button in the "Step" group on the operation panel. 
Clicking the [FORWD] button executes the command on the current execution line and advances the current 
execution line by one line. Clicking the [BACKWD] button executes the command on the current execution line 
and returns the current execution line by one line. Backward execution by one line can be executed only for 
interpolation commands. The maximum number of lines that can be returned to by backward execution is four 
lines. 

Step 
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20.2.5. Direct execution 

You can enter command statements to operate the robot directly. 
Click the [D-EXEC] button on the operation screen. 
 

 
Figure 20-13 Starting Direct Execution 

 
Enter the command to execute in the "Command" box, and either press the [Enter] key on the keyboard or click 
the [Execute] button. The entered command is executed. At this time, if a position variable is specified by a move 
command, for example, the position variables defined in the currently open program are used. A position variable 
not defined in the program cannot be used. 
A command that has once been entered to the "Command" box is added to the history, and can be selected from 
the command box drop-down list. Note, however, that when the simulation is ended, the history and drop-down 
list commands are cleared. 

 
Figure 20-14 Command Drop-down List in the "Direct execution" Screen 

 
This operation cannot be performed during automatic operation by the [CONT] button. 
 

 

When executing directly, select the program to execute. 
Direct execution cannot be performed unless a program is selected. 

Caution 

D-EXEC 
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20.3. Change to the small operation panel 
You can change the display of operation panel to the type of small size. 

 
Figure 20-15 Comparison of the display types of operation panel 

 
20.3.1. How to change the display type  

You can change the display type of operation panel from the option screen. To display the option screen, you will 
select the [Option] in [Workspace] tab from the ribbon. 
By the [Small Size] in [Operation Panel] is checked, the operation panel will be displayed in type of small size 
when RT ToolBox3 is executed next time or later. 
If you want to return the operation panel to the standard type, please uncheck the [Small Size].  

Standard type Small size type 
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Figure 20-16 Comparison of the display types of operation panel 

 
 
20.3.2. How to operate 

On the small type operation panel, there are the buttons with the same name as one for the case where the 
operation panel is the standard size. By operating the corresponding button, you can use the same function as 
the operation panel of standard type. 

 
However, [Monitor] group and [Step] group are not on the operation panel of small size type. If you want to use 
these functions, please use the commands in the [Online] tab from the ribbon. 
 
 
20.4. Display the operation panel in the docking window 
You can display the same type as the small type of the operation panel in the docking window. 
When connecting to multiple projects, switch the project to be operated with "RC" dropdown. 
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Figure 20-17 Operation panel of docking window 

 
20.4.1. Display method 

Check the [Display] tab → [Operation panel] of the ribbon to display it. Please remove the check if you want to 
hide it. 
 

 
 
 

Switching the connected project 

It can not be displayed unless the operation panel has been activated 
at least once. 
After the project is connected, the operation panel check box on the ribbon will not be valid unless the 
operation panel has been activated at least once. 
Projects that have never been launched on the Operations Panel will not be added to the RC dropdown. 

Caution 
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20.4.2. Change the display type 

The operation panel of the docking window can be displayed with the large jog button. 
 

 
Figure 20-18 Display the large jog button 

 
Select the [Workspace] -> [Option] on the ribbon. When [Large JOG Button] of [Operation Panel] is selected, the 
operation panel of large jog button style will be displayed, it will be valid from next start. 
 

 
Figure 20-19 Docking window operation panel display style change 

The position of the X and Y is rotated 
when the spin button is pressed. 

For robot movement in the XY direction. 
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20.5. Direct Teaching 
To teach the position of the robot, you can easily push and move the arm by direct teaching. 
The direct teaching function can be used only with the following robot. 
 

 Model 
Robot model that supports direct teaching. MELFA  ASSISTA  

 
 

 
 
 
 
 

. Jog operation and hand operation cannot be performed while direct teaching is 
ON. 

 
. If the servo OFF, stop operation, or an error occurs, direct teaching is 

automatically turned OFF. 
 
. Direct teaching is automatically turned off when the jog operation panel, hand 

operation panel, or operation panel is closed. 
 
. Before using direct teaching, confirm that the mass, center of gravity, and size of 

the robot hand are set correctly. If the set value is incorrect, the robot arm may move 
up or down when starting direct teaching. 

 
. In direct teaching, the robot may move by inertia, so do not let go of the robot arm 

until it stops.  
 
. Work settings are not reflected in direct teaching. The robot may descend 

depending on the weight of the work. Do not let go until the robot stops securely. 
 

. If you are using HNDDAT1 to HNDDAT8, it will be set to HNDDAT0 when the 
controller power is turned on again, so the robot arm may move up or down when 
starting direct teaching. 

 
. Direct teaching cannot be operated while the large JOG button is displayed. 

 

Caution 
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20.5.1. Teach procedure by direct teaching 

Teaching position to the robot program by direct teaching is possible by the following procedure. 
(4) Check that the mode selector switch input on the robot controller is set to "AUTOMATIC" and operation 

mode is set to collaborative(standard or low speed). 
(5) Open operation panel and click direct teaching switch. 

Click the [OK] button on the confirmation screen to turn on the direct teaching.  

 
(6) Open the robot program to which teaches position data and select the XYZ or joint tab. 

(Work coordinate position data cannot be taught by direct teaching.)  
 

 
(7) Hold the robot arm directly with your hand and move it to the destination position / posture, and then 

press the [TEACH] button on the robot arm. 

Bring the program edit screen to the front and make the screen 
active. Please note that the position data cannot be taught if the 
screen is not active. 



 

20-542  20-542 

 
(8) If no position data is selected on the program edit screen, new position data is added, and if selected, the 

value of the selected position data is updated.  

 

If no position data is selected, new position data will be added. 

If the position data is selected, the selected position data will be updated. 
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20.5.2. Direct teaching mode switching 

You can switch the direct teaching mode by mode selection combo box. When "Pan" is selected, the operation 
direction is limited to the translation direction. 
 

 
Figure 20-20 Direct teaching mode switching 

 
Table 20-4  Direct teaching mode 

Mode Option 
Free Operates with each joint of the robot free. 
Pan The robot moves along the direction of the coordinate 

axes. 
Rotational The robot moves in the rotational direction of the 

coordinate axes. (Supported with controller 
software version B1c or later.) 

 
 
You can also use the operation button [DIRECT TEACHING] on the robot arm to start direct teaching and switch 
the direct teaching mode. 
 

Table 20-5  Direct teaching startup and mode switching 
Operation Direct teaching status Motion 
Long push 
(2 seconds or more) 

OFF Direct teaching turns on. 
ON Direct teaching turns off. 

Push OFF - 
ON The operation system switches in the 

following order. 
Free → Pan → Rotational 
If it is pressed during Rotational, it will 
return to free. 
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21. Simulation 
 
This chapter explains the simulation operation methods. 
 

 
 

Simulation can not be used with the mini edition. 
The simulation function only supports the "RT ToolBox3" standard edition. It can not be used with the 

mini edition. 
 

Simulation can not be used with Movemaster commands. 
Be aware that even with the standard edition, the simulation function can not be used when 

Movemaster commands are selected.  
 

You can not communicate with the robot controller during a 
simulation. 
You can not communicate with the robot controller during a simulation. To communicate with the robot 

controller, click on the [Home] tab → [Mode] group → [Online] button to change to online mode. 
 

With an actual robot, an overload error might occur. 
Be aware that even if you run the simulation with the work and hand weight set and this works 

properly in the simulation, when you actually operate with the robot, an overload may occur and make 
operation impossible.  

 
If there is an input signal wait in the program, use pseudo-input. 

When you execute a program in simulation and there is an input signal wait in the program, the 
program does not move to the next step until that command is executed.  Therefore, if there is an input 
signal wait, use the pseudo-input function from the signal monitor.  

 
Operation that depends on external input can not be simulated. 
It is not possible to simulate actions dependent on external input such as force sensors. 
 
In simulation mode of MELFA ASSISTA, “Wait” command is disabled. 
If “Wait” command is executed in simulation mode of MELFA ASSISTA, next command is executed 

without waiting. 
 

Caution 
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21.1. Starting a Simulation 
Click the [Home] tab -> [Mode] group -> [Simulator] on the ribbon. If there are two or more projects in the 
workspace at this time, the screen for selecting the screen to conduct the simulation is displayed. 
You can simulate eight projects or less. 

 

 
Figure 21-1 Project Selection When Simulation is Started 

 
[(Select all)] Selects and deselects all projects. 
[Start I/O Simulator with the 
definition file used last.] 

When the I/O Simulator was started up beforehand, the I/O 
Simulator is started up using the same definition file as last time. 

 
Select the project to start the simulation, and then click the [OK] button.  

 

 
 

You can also start simulations from the title bar. 

 
Figure 21-2 Explanation of Title Bar 

 
When the simulation start-up is complete, the operation screen for the simulation is displayed on the screen. Also, 
the virtual controller for the simulation is automatically started stored in task tray. (Figure 20-3) 

 

 
Figure 21-3 Virtual Controller stored in task tray 

 
The simulation is run by this virtual controller. The virtual controller closes automatically when the simulation 
ends. Do not close the virtual controller manually. 
3D monitor is automatically started when the simulation starts. The explanation of 3D monitor, see "22 3D 
Monitor". 

Switch to "Offline". 
 
Switch to "Online". 
 
Switch to "Simulation". 

Simulation may not start in cases of multiple projects. 
Be aware that it may not be possible to start multiple simulations due to PC performance. 

Caution 
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21.1.1. About the warning at first-time startup simulation 

After installing RT ToolBox3, when you first start the simulation, the following warning screen may be shown. If 
the screen is displayed, confirm that checkbox corresponding to the environment is set to ON, and click [Allow 
access]. You need to select the [Allow access] button to use all the functions of the simulation. 

 

 
Figure 21-4 The warning screen at first-time startup simulation 

 
 
21.2. Explanation of the Simulation Operation Screen 
Use the [Operating panel] screen to operate simulations. 
Refer to "20.1 About the Operation Panel" to understand how to operate the “Operation panel”. 
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21.3. Tact Time Calculation 
You can calculate the tact time and axis load level of the operation command section of programs created by 
using the simulation function. 
RV-F and RH-F series robots can calculate the axis load level. 

 

 
 

 
 

 
 
 
21.3.1. Conditions for tact time calculation 

Note that the following restrictions are applied to calculation of the tact time. 
 

Tact time calculation 
The calculated tact time varies with the performance and load status of the computer used and will 

not completely match the actual robot operating time (tact time). 
Use this function as a rough yardstick for tact time study. 
 
Under correct conditions, the results of tact time calculation with this software have an error of 

about ±3% compared to the actual robot operating time (tact time). 
 
For details on tact time deviation, see "21.3.3 Causes of tact time deviation". 

Caution 

Be aware that tact time may not be calculated correctly when measuring 
tact time with the XYZ position variables, layout parts, or Robot information 
displayed in the 3D monitor. 

Caution 

Axis load level calculation 
The axis load level numerically expresses the motor load. 
 
The robot will generate an overload error and stops protecting the motor when the axis load level 

exceeds 100%.The calculated axis load level assumes multiple iterations of the same operation. 
However, be aware that stop will not occur in simulation even if the load level exceeds 100%. 

 
There is a possibility that continuous operation will not be possible in an actual robot when the 

calculated axis load level is high. You should lower the operation frequency with the Dly command, 
and lower operation speed and the acceleration with the Accel and the Ovrd commands, etc. 
Changing the operation point may lower the operation point. 

 
 Complete agreement with the calculated axis load level cannot be guaranteed because the axis 

load level of an actual robot is influenced in robot individual differences, the ambient temperature, the 
condition of the robot, etc. Use this function as a rough yardstick for studying robot movement. 

Caution 
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Do not start multiple simulations. 
Correct measurement may not result due to the PC load. 

Do not set the [Tool] and [Collision area] displays ON 
Correct measurement may not result due to the PC load. 

Do not use a program that has signal input or robot status 
changes. 

For programs that have signal input from the outside or that have changes in robot status 
variables or the like, either comment out such sections or extract just the section for which you 
want to calculate the tact time for and then perform calculations.  

When studying the tact time for such a program, take this into account by adding an 
approximate input wait time to the calculation results. 

 

Do not use a program with an infinite loop. 
The tact time for a program that falls into an infinite loop cannot be correctly calculated. Confirm 

that the robot program does not fall into an infinite loop in a FOR statement or GOTO statement. 
 

Do not use M_TIMER(1). 
Do not use M_TIMER(1). This software's tact time calculation uses M_TIMER(1). If 

M_TIMER(1) is used during the program, the tact time can not be calculated accurately. Change 
the program to use any timer from M_TIMER(2) to M_TIMER(8) instead, then calculate the tact 
time. 

 
If the program contains a position array variable or joint array 
variable, include the Dim declaration in the tact time calculation 
range. 

If the program whose tact time is to be calculated contains a position array variable or joint array 
variable, also include the Dim declaration in the tact time calculation range. 

 
Set hand data correctly. 

Please set the actually used hand and work conditions (mass, center of gravity, and shape) 
correctly. If the setting is different from the actual robot, the tact time and axis load factor cannot 
be correctly calculated. The setting of the hand and work condition is set by parameter HNDDAT*, 
WRKDAT *. The hand and work conditions are specified by the Loadset command.  

 

Caution 
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Include the GoTo or GoSub jump destinations in the tact time 
calculation range. 

For example, the tact time can not be calculated for a program like the following. 
The location displayed inverted in black in the program is set for tact time calculation.) 
 

 
 
 
 
 
 
 
 
 
 
 
 

Commands other than move commands cannot be calculated. 
Tact time cannot be correctly calculated for programs that doesn't accompany the movement of 

robots, such as calculation processing, branch processing, etc.  

Caution 

No destination selected 
for GoTo statement 

No destination selected 
for sub-routine 
 

1 xxx 
:   : 

10 Mov P01 
11 Mov P02 
12 Mov P03 
13 GoTo *L10 
14 END 
 

1 Mov P00 
:   : 

10 GoSub *SUB1 
11 End 
12  : 
20 *SUB1 
21 Mov P01 
22 Return  
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21.3.2. Tact time measurement 

This explains tact time measurement. 
 
1. Start simulation. 

Start the simulation. For details, see "21.1 Starting a Simulation". 
 
 
2. Open the program, and start tact time calculation. 

There are two ways of starting tact time calculation, by starting from the project tree or by starting from the 
program edit screen. 

 
(1) Starting tact time calculation from the project screen 

Select the program whose tact time is to be calculated from the project tree and click "Tact time 
Calculation" from the context menu. 

 
 

(2) Starting tact time calculation from the program edit screen 
1) Open the program. 
Open the program whose tact time is to be calculated. You can calculate the tact time for both “offline” 

and “online” programs. Note, however, that the tact time of programs opened in the debug mode cannot 
be calculated. Always open programs by “Open Program”. 

 
For details on the operations for opening a program, see “11.2 Opening an Existing Program”. 

 
2) Specify the range in which the tact time of the program is to be calculated. 

Drag the section of the program to calculate the tact time to select the range. 

 
Figure 21-5 Selecting the Tact Time Calculation Range 
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3) Click the [Tool] tab -> [Tact time Calculation] group - [Run calculation] button on the ribbon. 

 
Figure 21-6 Toolbar "Tool" Menu 

 
 
3. Check the range in which the tact time is to be calculated. 

The "Tact calculation" screen for checking the tact time calculation range is displayed. Check the contents of 
this range, and click the [OK] button. 

 

 
Figure 21-7 Checking the Tact time Measurement Range 

 
 

The tact time calculation is started. During tact time calculation, "Tact time Calculation" is displayed at "Status" 
in the simulation operation screen. Do not perform any other operations until this display ends. 

 
Figure 21-8 Simulation Operation Screen During Tact Time Calculation 

 
 

4. The tact time calculation results are displayed. 
When the tact time calculation is completed, the "Tact time calculation results" screen is displayed. The tact 
time calculation results are displayed in milliseconds. The tact time calculation results are also displayed in the 
output window. 

 

“Tact time Calculation” 
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Figure 21-9 Tact Time Calculation Results (Calculation of Axis Load Level Impossible) 

 
The axis load level (J1-J6 each axis) and the tact time are displayed for robots that can measure the axis load 
level. 
The calculation result for axis load level is displayed as %. 
 

 
Figure 21-10 Tact Time Calculation Results (Calculation of Axis Load Level Possible) 

 
 

The tact time 
calculation results 
are added 
sequentially. 
This information is 
cleared when the 
simulation is started 

i  

The tact time 
calculation results 
for this calculation 
are displayed. 

The calculation results are added 
sequentially. 
This information is cleared when 
the simulation is started again. 

The tact time calculation 
results for this calculation 
are displayed. 

The axis load level 
calculation results for this 
calculation are displayed. 
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Figure 21-11 Tact time calculation result (Output window) 

 

J7, J8 axis are the outer. 
Caution 

Name of source program from which tact 
time calculation result was obtained 

Project name 

Program name automatically 
generated by tact time calculation 

Line No. where tact time calculation 
was interrupted ("1" at completion) 

Time at which a 
single tact time 
calculation ended 

Tact time calculation 
result 

Date/time that tact time 
calculation was started 
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21.3.3. Causes of tact time deviation 

With this software, you can use the simulation function to calculate the robot movement tact time. 
However, the calculated tact time varies with the performance and load status of the computer used, and will not 
completely match the actual robot operating time (tact time). 
Use this function as a rough yardstick for tact time study. 
Also, there are the following causes of tact time calculation results deviating from actual robot tact time. 
 
(1) An application other than "program editing" of this software is running. 

This software's tact time calculation has parts that are processed on the computer in the background. For 
example, if you are working running an application such as a Word document that is saved automatically, the 
background processing for this software will take more time and sometimes the correct tact time will not be 
calculated. The tact time will increase.) 
When calculating the tact time with this software, first close other applications. 
Also, in this software itself, first close all the screens except "Program edit". 

 
(2) Using commands that depend on the robot main unit status and external equipment. 

There is no connection with the robot main unit or external equipment in this software's tact time calculation. 
Therefore, commands that are executed by communicating with such equipment are executed as if ideal 
information were sent from that equipment. Therefore, the calculated cycle time will be shorter than the 
actual cycle time. 
The commands to which this applies are shown in the following table. 

 Function Command Explanation 
1 Positioning 

completion wait 
FINE Monitors the robot's status until it 

reaches the target position. 
2 Compliance CMP JNT/POS/TOOL/OFF 

CMPG 
Monitors external force on the robot. 

3 Collision detection COLCHK、COLLVL Monitors external force on the robot. 
4 Servo control SERVO ON/OFF Monitors the servo amp status 

 
For example, if the servo On command is executed in the program, the actual robot takes a few seconds, but 
the simulation requires almost no time at all (500 ms or less). To calculate the tact time precisely, write the 
program using only move commands and none of the previously mentioned commands. If you are executing 
a program you already have, either comment out such commands or extract and use just the part you want 
to measure. 

 
(3) Using functions that depend on the CPU processing speed and OS. 

The tact time calculation in this software runs on Windows, but the robot controller control software runs on a 
real-time OS, so the internal operations are different. For example, in the real-time OS, the tact time may be 
increased by the postponement of calculations with a high load that could not be fully processed, but in this 
software's tact time calculations, such an increase in the tact time cannot be calculated. Therefore, if you 
use the following high-load functions, the calculated tact time may be a few percent less than the actual tact 
time. 
The commands to which this applies are shown in the following table. 

 Function Cause of increased processing on actual robot 
1 CC-Link Because there is more signal processing with the CC-Link 

option than without it 
2 Multi tasking Because multiple robot programs are executed at the same 

time 
3 Added axes Because of the need to control the additional axes 
4 Maximum 

acceleration/deceleration control 
Because the optimum movement for the robot load is 
calculated 

5 Collision detection Because processing to detect collisions is executed (*1) 
6 Maintenance forecast Because the processing time is longer when the maintenance 

forecasting information collection level is raised (*1) 
In tact time calculation, the same results are calculated as for 
information collection level 1 (the factory default setting). 

(*1) On actual robots, the tact time is roughly 3-10% longer. 
 
By changing a robot program to eliminate the above factors, you can reduce the 
difference between the simulation tact time and that on the actual robot. However, 
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because the simulation executes the next movement command without waiting for 
static determinacy after movement or for the conditions to be established, the tact time 
calculated differs from the tact time on the actual robot. 
We recommend that you finally confirm operation on the actual robot. 
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21.4. Cooperative control simulation 
Cooperative control by multiple robots can be simulated. Cooperative control is available only when 
CR800-R/CR800-Q/CR750-Q/CRnQ-700 controller is selected. 

 
The correspondence between the robot number used for coordinated control and the slot number of the robot 
CPU installed in the PLC base unit is as shown below. The robot CPU must be installed in order from the first 
slot. 

 

 
Figure 21-12 Correspondence between robot number and mounting position of robot CPU 

 
The correspondence between the project in the workspace and the robot number is as follows. 
From the first project, it is assigned as Module No. 2 (Robot No. 1) -> Module No. 3 (Robot No. 2) -> Module No. 
4 (Robot No. 3). This function can not be used if there are projects other than CR800-R/CR800-Q/CR750-Q/ 
CRnQ-700 on the way. 

 

 
Figure 21-13 Correspondence between robot number and mounting position of robot CPU 

 
With cooperative control simulation support, the following state variables can now be used in simulation. 
For details, refer to the instruction manual “Detailed explanations of functions and operations 4.14 Detailed 
explanation of Robot Status Variable”. 

 
Variable name Explanation 
M_UDevW Reads/Writes the signals per word directly with two or more robot CPUs.  
M_UDevD Reads/Writes the signals per double word directly with two or more robot CPUs. 

 
 

21.4.1. Cooperative operation 

It is possible to simulate the operation of conveying one work in cooperation with up to three robots. 
For details, refer to the instruction manual “Detailed explanations of functions and operations 7.5 Cooperative 

operation function”. 

Module No. 2 (Robot No. 1) 

Module No. 3 (Robot No. 2) 

Module No. 4 (Robot No. 3) 
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Cooperative operation simulation setting 
 
When using cooperative action on actual machine, it is necessary to absorb installation error and 

manufacturing error. However, there is no error in the virtual space of the simulation, so you can use the following 
simple method. 

 
1. Preparation 
Set up two CR800-R/CR800-Q/CR750-Q/CRnQ-700 Series robots and start the simulation. After that, open the 

3D monitor, display the "Robot arrangement list" screen from the "3D View" menu, and place the robot. In this 
example, the robot 1 and the robot 2 are arranged to face each other. 

*Robot 1 (-50,-300, 0, 0, 0, 90), Robot 2 (50, 300, 0, 0, 0,-90) 
 

 
Figure 21-14 Robot arrangement example 

 
2. Base setting 
In cooperative operation, one is the master and the other robot is the slave that follows the master. In this 

example, since the robot 1 is the master, set "the position of the robot 2 seen from the robot 1" on the base of the 
robot 2. 

In this example, it becomes (600, -100, 0, 0, 0, 180). 
 
3. Tool setting 
Set the tool of two robots. When controlling the center of the work grasped by two robots, set both the robot 1 

and robot 2 tools to the work center. In this example, it is the tool coordinates (0, 375, 100, 0, 0, 0) of robot 1 and 
the tool coordinates (0, 375, 100, 0, 0, 180) of robot 2. 

*The tool Z elements is set to 100 mm from the mechanical interface. 
*The tool C elements of the robot 2 is rotated 180 degrees to match the tool direction of robot 1. 
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Figure 21-15 Example of controlling the center of the work 

 

 
Figure 21-16 Example of controlling the center of the work (Detail image) 

 
The control point need not be the center of the workpiece. When moving a long work with two robots, it may be 

easier to teach if there is a control point at the tip of the work. For example, in the above example, the control 
points of robots 1 and 2 are (0, 375 -> 750, 100, 0, 0, 0), (0, 375 -> 0, 100, 0, 0, 180) respectively. 

 
4. Confirmation of collaborative operation 
To move robot 2 (slave) according to the movement of robot 1 (master), specify the shared memory of robot 1 

and execute the Mxt command.  
In the next sample program, Mxt instruction is executed after confirming preparation completion. The robot 2 

reads the posture of the robot 1 and moves to the grasping posture of the work. The robot 1 pauses with the Hlt 
command, but since the robot 2 continues cooperative operation, if JOG operation is performed on the robot 1, 
the robot 2 will follow up. 

*To execute the program, start up in order of robot 2 -> robot 1. 
 

Robot 1 

Robot 2 

Hand 1 origin 

Hand 2 origin 

X 

Y 

Y 

X 

X 

X 

Y 

Y 

Center of 
work 

750mm 

Robot 1 

Robot 2 hand 

Robot 2 

Work (750mm) 

Center of the work 

Robot 1 hand 
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Figure 21-17 Sample program 
 
M_Mxt (CPU number) is a special variable that can communicate state between CPUs. Take the timing of 

starting and ending cooperative operation using this variable.  
When coordinated operation is controlled from a robot program, the robot 1 executes a movement command 

while the robot 2 is executing the Mxt command. If the slave side cannot keep up with over speed or outside the 
operating range, it generates an error and stops. 

 
 

21.4.2. Interference avoidance 

It is possible to operate the robot while checking interference with other robots. 
For details, refer to the instruction manual “Detailed explanations of functions and operations 5.24 Interference 
avoidance function”. 
Also, refer to "14.3.15 Collision avoidance parameters" for how to set the interference avoidance parameters 
with this software. 

 

 
Figure 21-18 Image of interference check with two robots 

 
 

M_Mxt(2)=0 

Wait M_Mxt(3)=0 

' 

M_Mxt(2)=1 

' 

' 

Wait M_Mxt(3)=1 

Hlt 

' 

Cnt 1 

Dly 0.5 

Ovrd 15 

' 
‘ Automatic operation execute here 
' 

M_Mxt(2)=0 

Wait M_Mxt(3)=0 

Hlt 

Wait M_Mxt(2)=0 

M_Mxt(3)=0 

' 

Wait M_Mxt(2)=1 

Open "MXT:QRBUS2" As #1 

Mov P_GCurr(2) 

M_Mxt(3)=1 

' 

Mxt 1,0 

' 

M_Mxt(3)=0 

Hlt 
 

Robot 1 (Master) Robot 2 (Slave) 

Robot 2：Wait for preparation completion of robot 1 

Robot 1：Wait for preparation completion of robot 2 

Robot ２：Wait for activation request from robot 1 

Robot ２：Open shared memory of robot 1 (# 1) 

Robot 2：Move to the current position of the robot 1 

Robot 1：Wait for activation request from robot 2 

Robot 2： Start cooperative operation with reference to #1 

Robot 2：End of coordinated operation 

Robot 1：Wait for completion of completion from robot 2 

JOG operation possible 
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21.5. Ending Simulation 
To end the simulation, close the robot program in debugging status. Then click the [Home] tab -> [Mode] group -> 
[Offline] button or [Online] button on the ribbon, or click "Offline" or "Online" on the application tab. 

 
Figure 21-19 Switching Between "Offline" and "Online" on the Application Tab 

 
When the simulation ends, the virtual robot controller, robot view, and simulation operation screen close and the 
controller goes back offline. 

 

Switch to Offline. 

Switch to Online. 
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22. 3D Monitor 
 
You can display the robots and their movements in multiple projects in 3D to check them. 

 

 
 
 
22.1. Starting Up 3D Monitor 
Either double-click [3D Monitor] or [Online]/ [Offline]/ [Simulation] -> [<Robot model name>] from the project tree 
or select [3D Monitor] from the context menu. The 3D display for the selected robot is displayed in the "3D 
Monitor" screen. If the "Travel base setting for display" is set to the project, the travel base also is displayed. 
In the offline mode, the robot is basically displayed at its fixed posture. 

 

 
Figure 22-1 Starting Up 3D Monitor 

 
 

Double-click [3D Monitor] or  
[robot model name, or select  

[3D Monitor] in the context menu 

When using the 3D monitor, we recommend using a high-performance PC. 
Jog operation may not be performed properly if low-performance PC is used. 

Caution 
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22.2. Change 3D Monitor Display Method 
You can change the display method of the 3D monitor on the option screen. 
Select the [Workspace] tab -> [Options] menu on the ribbon. 
By checking [Always display in front] in [3D Monitor], it will always be displayed on the front from the time the next 
3D monitor is started up and you can move outside the screen of RT ToolBox 3. 
If you want to display the 3D monitor on the display tab and display it in line with other windows, please uncheck 
the [Always display in front] check box. 
 

 
Figure 22-2 Change display method of 3D monitor 
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22.3. 3D Monitor Operations 
On the 3D monitor, you can rotate the display, move it in parallel or enlarge and reduce it. 
Also, all 3D monitor operations can be executed basically by operating the mouse on the 3D monitor. 
 
 
22.3.1. List of operations 

The following table lists operations in the 3D monitor. 
 

Table 22-1 List of 3D Monitor Operations 
Operation Motion Details 

[Shift] key + drag up/down Enlarge/reduce 22.3.2 Zoom operation 
Mouse wheel operations 
Drag  
(mouse left button + move 
mouse) 

View rotation (around X- and Z-axes) 22.3.3 Rotating the view 

Drag both buttons  
(both mouse left/right buttons + 
move mouse) 

View rotation (around Y-axis) 22.3.3 Rotating the view 

Drag right  
(mouse right button + move 
mouse) 

Parallel movement of view 22.3.4 Parallel movement 
of view 

[Ctrl] key + [Shift] key + click Selecting robot/object 22.3.5 Selecting objects 
[Ctrl] key + [Shift] key + drag  
(only arrow of reference position) 

Moving the position of robot/object 22.3.6.1 Moving objects by 
the  

[Ctrl] key + click Moving the robot by clicking  
(only in simulations) 

22.15 Moving the Robot by 
Clicking 

[Space] key + click Measuring distance  
(only when distance measurement 
screen is displayed) 

22.17 Distance 
measurement 

[Ctrl] key + [Z] key Returning the editing state of robot 
and object one time ago 

22.4.2.16Restore 

 
 
22.3.2. Zoom operation 

In the 3D monitor, the display can be enlarged or reduced by mouse wheel operation. 
Rotating the mouse wheel upwards enlarges a display, while rotating the mouse wheel downwards reduces a 
display. 

 
Also, the center of enlargement/reduction also can be changed by selecting the zoom type. 
The zoom type can be selected by [3D view] tab -> [Zoom type] group on the ribbon. 

 

 
Figure 22-3 Zoom Type Select Button 

 
 

The following table summarizes the relationship between zoom type and center of enlargement/reduction. 
 

Table 22-2 Zoom Type and Center of Enlargement/reduction 
Zoom Type Center of Enlargement/reduction 

Zoom toward origin Origin of 3D monitor 
Zoom toward screen Center of screen 
Zoom toward mouse Mouse cursor point 
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Besides this, the display can also be enlarged and reduced while holding down the [Shift] key and the mouse left 
button. Moving the mouse upwards in this state enlarges the display, and moving the mouse downwards reduces 
the display. Note, however, that enlargement/reduction is performed around the center of the screen when this 
operation is performed with "Mouse" selected at "Zoom type". 
 
Changes made to the zoom type setting are also reflected in operations in the following screen: 
･ Collision avoidance area screen 
･ Hand edit 
･ Robot parts edit 
･ User mech. edit 
 
 
22.3.3. Rotating the view 

On the 3D monitor, the view can be rotated by moving the mouse with the mouse left button or the mouse left and 
right buttons held down. The rotation angle is reflected in the following order: around the Z-axis -> around the 
Y-axis -> around the X-axis. 
The following table summarizes the correspondence between operation and rotation. 

 
Table 22-3 View Rotation Operations 

Operation Rotation 
Move mouse left or right with mouse left button held down Rotation around 

Z-axis 
Move mouse up or down with mouse left button held down Rotation around 

X-axis 
Move mouse left or right with mouse left and right buttons 
held down 

Rotation around 
Y-axis 

 
In addition to mouse operations, the view can be rotated by using numerical values, that is, by changing the 
values of [3D view] tab -> [View angle] group -> [X]/[Y]/[Z] on the ribbon. 
 

 
Figure 22-4 View Angle Setting 

 
 

Also, in view rotation operations using the mouse, the view center of rotation can be changed to match the zoom 
type. 
With zoom toward screen and zoom toward mouse operations, the center of rotation can be changed according 
to the center of the screen and presence of an object at the mouse position when the mouse left button is clicked 
on the 3D monitor. 
 

Table 22-4 Changing the View Center of Rotation in 3D Monitor 
Selected Zoom Type Monitor When Left Button Is Clicked View Center of Rotation 
Zoom toward origin Always Origin 
Zoom toward screen Opaque object exists in center of screen Center of screen 

Opaque object does not exist in center of 
screen 

Origin 

Zoom toward mouse Opaque object exists at mouse position Click point on object 
Opaque object does not exist at mouse 
position 

Origin 
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If you are rotating the view around a point other than the origin, small coordinate axes as shown below are 
displayed at the center of rotation point. 
 

 
Figure 22-5 View Center of Rotation 

 
The view can also be changed to a position visible on a plane, such as the X-Y plane or X-Z plane, by clicking the 
following buttons in the [3D view] tab -> [View angle] group on the ribbon. 

 
Figure 22-6 Buttons for Setting a Plane View 

 
 
 
22.3.4. Parallel movement of view  

In the 3D monitor, the view can be moved by moving the mouse with the mouse right button held down. 
If parallel movement is performed repeatedly, the origin of the 3D monitor is sometimes lost. However, if this 
happens, exit the 3D monitor and then restart it. The origin will return to its initial view position. 
 

 
Figure 22-7 Parallel Movement of View 

 
 
 
22.3.5. Selecting objects  

In the 3D monitor, a corresponding item on the layout tree is selected and its display information is displayed at 
"Properties" if a robot or layout object is clicked with the [Ctrl] and [Shift] keys held down. When display data held 
by the robot, such as hand or free plane limit, is clicked with the [Ctrl] and [Shift] keys held down, the robot will be 
selected. 
Alternatively, if a location where no 3D monitor information is displayed is clicked with the [Ctrl] and [Shift] keys 
held down, the layout tree will become deselected. 
When a robot or layout is selected in the layout tree, arrows such as shown below are displayed at the reference 
positions of the corresponding object in the 3D monitor. 

Move mouse to left 
with mouse right 
button held down 
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This method allows you to check correspondence between object display in the 3D monitor and items in the 
layout tree. 
 

 
Figure 22-8 Currently Selected Object Display 

 
 

 
Figure 22-9 Selecting an Object by the Mouse 

 
 

 
 

[Ctrl] key + [Shift] key  
+ click 

When you select an object on the 3D monitor, the wire frame object is 
sometimes selected if there is a wire frame object at the front even if its 
surface is not displayed. 

Caution 
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22.3.6. Moving Objects Mouse 
You can move the object by mouse operation on the 3D monitor. 
The movement method can be changed on the option screen, and it can be selected from [Move Along 
Movement Axis] and [Free Movement]. 
To display the options screen, select the [Workspace] tab -> [Option] menu on the ribbon. 
 

 
Figure 22-10 Mouse move method of object changes 

 
 

22.3.6.1. Moving objects by the Axis 
 
By selecting [Move along Movement Axis (Arrow)] and [Move along Movement Axis] on the option screen, you 
can move the selected object along the movement axis with the mouse operation on the 3D monitor. 
 
The currently selected object can be moved by mouse operation on the 3D monitor. 
For details on selecting objects, refer to "22.3.5 Selecting objects". 
 
When a currently displayed object is selected, arrows are displayed at its reference positions. 
If an arrow is dragged on the 3D monitor with the [Ctrl] and [Shift] keys held down, the object moves along the 
arrow that is being dragged. 
 

 
Figure 22-11 Moving Objects by the Mouse 

 
After pressing the [Ctrl] key + [Shift] key, drag the sphere on the axis and the part will rotate along the axis. 

[Ctrl] key + [Shift] key 
+ 

Drag in arrow direction 
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Figure 22-12 The object rotates along the axis of rotation 

 

 
 
 

22.3.6.2. Free Movement 
If you select [Free Movement] on the option screen, you can move the object freely by operating the mouse on 
the 3D monitor.  
While holding down [Ctrl] + [Shift], dragging an object on the 3D monitor moves the object in the direction you 
drag. 
 

 
Figure 22-13 Free movement of objects 

 
 
To move the object on the XY plane or the XZ plane, click the [3D display] tab -> [view change] group -> [XY 
plane] button on the ribbon, move the viewpoint to a position visible on the plane and then move the object.
  

When you drag an arrow, a wire frame object will be selected if there is a 
wire frame object at the front even if its surface is not displayed. 

When projection type is perspective, the object sometimes moves in the 
direction opposite to the move direction of the mouse when the mouse is 
dragged to move the object in the arrow direction. 

Caution 

[Ctrl] key + [Shift] key 
+ 

Drag in arrow direction 

[Ctrl] key + [Shift] key 
+ 
Drag in Y direction 
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Figure 22-14 Free movement on object plane 

 

 

When dragging an object, if there is an object of wireframe in front, 
the object of the wireframe is selected even if the face is not 
displayed. 

Caution 

[Ctrl] key + [Shift] key 
+ 

Drag in arrow direction 
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22.4. Layout Tree  
Data that is displayed on the 3D monitor can be selected in the layout tree. 
Also, display information relating to items selected in the layout tree is displayed at "Properties", and respective 
display information can be edited. 

 
 

22.4.1. Content of layout tree 

 
 
(1) 3D Monitor 

When this is selected, the display information relating to the entire 3D monitor is displayed at "Properties" 
and can be changed. 
Checkboxes cannot be changed. 

 
(2) Robot 

When these are selected, the display information relating to the robot is displayed at "Properties" and can be 
changed. 
In modes other than offline, only currently connected robots are displayed in the layout tree. 
 

(3) Hand 
When these are selected, the display information relating to the hand is displayed at "Properties" and can be 
changed. 
The hand file name is displayed as the name of the hand. 
 

(4) Robot Parts 
When these are selected, the display information relating to the robot parts is displayed at "Properties" and 
can be changed. 
The robot parts file name is displayed as the name of the robot parts. 
 

(5) User Mechanism 
When selected, the display information on the user mech. is displayed in the property and can be changed. 
“User Mech. Name” display the selected user mech. name. 

 
(6) Spline 

When these are selected, the display information relating to the spline curve is displayed at "Properties" and 

(2) Robot 

(7) Layout objects 

(3) Hand 

(6) Spline 

(1) 3D Monitor 

Checkbox  
(displayed when 
checkbox is selected) 

(4) Robot Parts (5)User Mechanism 
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can be changed. 
The name is changed according to the display information, and "Opened spline file" or "01(PC)", for example, 
indicating the specified spline file is displayed. 
 

(7) Layout objects 
When these are selected, the display information relating to layout objects is displayed at "Properties" and 
can be changed. 
The [Name] set in the display information is displayed as the name. 
 

22.4.2. Operations in layout tree 

22.4.2.1. Add hand 
To add a hand to the layout tree, right-click the robot to add the hand to, and select [Add hand] from the context 
menu. A hand item will be newly added at the bottom of the list of hands. Or, a hand can be added immediately 
under a specific hand by right-clicking that hand and selecting [Add hand]. 
Next, set the display information, for example, by selecting [Hand Name] at "Properties".  
 

 
Figure 22-15 Add a Hand Item 

 
 

22.4.2.2. Add robot parts 
To add a robot part to the layout tree, right-click the robot to add the robot parts to, and select [Add Robot Parts] 
from the context menu. A robot part item will be newly added at the bottom of the list of robot parts. Or, a robot 
part can be added immediately under a specific robot parts by right-clicking that robot parts and selecting [Add 
robot parts]. 
Next, set the display information, for example, by selecting [Robot Parts Name] at "Properties". 
 

 
Figure 22-16 Add a Robot Parts Item 

 
 

22.4.2.3. Add user mechanism 
To add a user mech. to the layout tree,right-click the robot to add the user mech. ,and select [Add User Mech.] 
from the context menu.The user mech. item will be newly added at the bottom of the list of robot parts.Or, a user 
mech. can be added immediately under a specific user mech. by right-clicking that user mech. and selecting [Add 
User Mech.]. 
Next,set the display information ,for example,by selecting [User Mech. Name] at “Properties”. 
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Figure 22-17 Add a user mech. Item 

 
 

 
 
 

22.4.2.4. Add spline 
To add a spline to the layout tree, right-click the robot to add the spline to, and select [Add spline] from the 
context menu. A spline item will be newly added at the bottom of the list of splines. Or, a spline can be added 
immediately under a specific spline by right-clicking that spline and selecting [Add spline]. 
Next, set the display information, for example, by selecting [Display curve] at "Properties". 
 

 
Figure 22-18 Add a Spline Item 

 
 

Up to 3 user mechanisms can be displayed on 3D monitor 
You can add more than four user mech., but display up to three user mech. on the 3D monitor. 
When adding the fourth user mech. on the 3D monitor (checked in the layout tree), the first user 

mech. will be hidden. (the layout tree is not checked) . 

Caution 
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22.4.2.5. Copying a hand / robot parts / user mechanism 

Follow the procedure below to copy a hand / robot parts / user mech. in the layout tree. 
(1) Select the hand / robot parts / user mech. to copy, and select [Copy] from the context menu. 
(2) Right-click again on the copy destination robot, and select [Paste] from the context menu. 
(3) The selected hand / robot parts / user mech. is copied to the right-clicked robot. 

 
Or, a hand / robot parts / user mech. can be copied immediately under a specific hand by right-clicking that hand / 
robot parts / user mech. and selecting [Paste]. 

 

 
Figure 22-19 Operation of Copying Hands / Robot Parts / User Mechanism 

 
 
 
 
 

Select item to copy 
and click [Copy] 

Select copy 
destination robot 
and click [Paste] 

1 
2 

3 
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22.4.2.6. Deleting hands / robot parts / splines / user mechanism 

Follow the procedure below to delete hands / robot parts / user mech. / splines in the layout tree. 
(1) Select the hands / robot parts / user mech. / splines to delete, and select [Delete] from the context menu. 
(2) A confirmation message is displayed. Check the message and select [Yes]. 
(3) The selected hands / robot parts / user mech. / splines is deleted. 
 

 
Figure 22-20 Operation of Deleting Hands / Robot Parts / User Mech. / Splines 

 
 
   

Select item to delete 
and click [Delete] 

Check currently selected 
item and click [Yes] 

2 

3 

1 
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22.4.2.7. Adding layout objects 

To add a layout object to the layout tree, right-click the 3D monitor, layout object or a place where nothing is set 
on the layout tree, and select [Add object] from the context menu. The layout object is added. 
Right-click the layout object, and select [Add object] from the menu that is displayed. A layout object is added as 
a child object under the right-clicked layout object. 
 

 
Figure 22-21 Adding Layout Objects 

 
 
 
 
 



 

22-576  22-576 

 
Also, multiple hexahedrons arranged in a box type can be batch-added. Follow the procedure below to add 
multiple hexahedrons. 
(1) Right-click the 3D monitor, layout object or a place where nothing is set on the layout tree, and select [Add 

box] from the context menu. 
(2) In the Edit box screen that is displayed, set the sizes of the box and click the [OK] button. 
(3) Multiple hexahedrons arranged like a box are added in a single operation. 

 
The base hexahedron is displayed using the name set in the Edit box screen, and other box parts are child 
objects of the base hexahedron. For this reason, when moving the entire box, move the base hexahedron. 
 

 
Figure 22-22 Operation of Adding a Box 

 
 
When setting sizes, refer to the following. 
 

 
 

Figure 22-23 Explanation of Box Sizes 
 

Set box sizes and click [OK] 

1 

2 

3 

Z 

X 

Y 

X 

Y 

Z 
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Figure showing only 

-Y hexahedron 

Size Y Size X 

Size Z 

Thickness 

Reference 
position of -Y 
hexahedron 
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22.4.2.8. Copying layout objects 

Follow the procedure below to copy a layout object in the layout tree. 
(1) Select the layout object to copy, and select [Copy] from the context menu. 
(2) Right-click the copy destination layout object, 3D monitor or a place where nothing is set on the layout tree, 

and select [Paste] from the context menu. 
(3) The layout object is copied. Any child layout objects included with the layout object also are copied together. 
 

 
Figure 22-24 Operation of Copying Layout Objects 

 
 

When the parent object of a copied layout object is changed, its display position in the 3D monitor will not be 
changed, and it will be displayed overlaid on the copy source layout object. The [Position] value at "Properties" is 
changed to the relative position from the copy source layout object or origin. 

 

 
Figure 22-25 Changing the Position Value by Copy 

 

2 

3 1 

Copy and 
paste 
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22.4.2.9. Deleting layout objects 

Follow the procedure below to delete a layout object in the layout tree. 
(1) Select the layout object to delete, and select [Delete] from the context menu. 
(2) A confirmation message is displayed. Check the message and select [Yes]. 
(3) The selected layout object is deleted. Any child layout objects included with the layout object also are deleted 

together. 
 

 
Figure 22-26 Deleting Layout Objects 

 
 
 

Select item to 
delete and click 
[Delete] 

Check currently 
selected item and click 
[Yes] 

1 

2 

3 



 

22-579  22-579 

 
22.4.2.10. Bulk editing layout objects 

In some of the layout objects settings, you can edit some layout objects in bulk. When you edit in bulk, you follow 
the steps below. 
(1) You select some layout objects that you want to edit and [Bulk edit] on context menu. 
(2) When bulk edit screen appears, you change only the check boxes for the items you want to edit in bulk on, 

set your edits and select [OK] button. 
(3) The settings of the selected layout objects as (1) changes items ticked in the bulk edit screen. 
 

 
Figure 22-27 Bulk Editing Layout Objects 

 
 

 

"Display Type" and "Interference Check" can not be set if "String" is 
included in the selected object.  

Caution 

1 

2 
3 

On the state if only the color of the layout 
objects and interference check setting are 
edited in bulk. 
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22.4.2.11. Bulk edit of box 

You can set the color, display type, etc. of the box (child of hexahedron on the bottom) created by [Add Box] in 
the context menu. Please follow the procedure below. 
(1) Select the object (hexahedron) at the bottom of the box you want to edit, and select [Bulk edit] on the context 

menu. 
(2) [Edit Box] screen will be displayed, set the items you want to edit and select the [OK] button. 
(3) The setting contents of the child hexahedron are changed collectively. 
 

 
Figure 22-28 Bulk Edit of Box 

 
 

 
 

 

This function can only be used for boxes added with RT ToolBox 3 
Ver.1.10L or later. 

Caution 

After adding the box, if you do the following operation on the child 
(the child of hexahedron on the bottom), you can not edit the box at 
once.  

- Change Figure 
- Move to another object 
- Delete item 

Caution 

1 

2 
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22.4.2.12. Importing layout objects 

Follow the procedure below to import layout objects in other layout files. 
(1) Right-click the 3D monitor, layout object or a place where nothing is set on the layout tree, and select [Import 

object] from the context menu. 
(2) The select file screen is displayed. In this screen, select the file to import. 
(3) If the selected file is a normal layout file, the layout objects in the selected layout file are imported to the 

layout tree.  
 

 
Figure 22-29 Importing Layout Objects 

 
 
Also, layout objects can be imported from RT ToolBox2 layout files by similar operation. 
 
 
 

22.4.2.13. Importing 3D model files 
 
There are the following three ways to import a 3D model. 
 
(1) In the properties of the layout object, you change the [3D model] to [Figure]. When [File] is displayed on 

properties, you click the button displaying. When [3D model file select] is displayed, you choose 3D model file 
that you want to import. 
 

(2) In the layout tree, you right-click 3D monitor/layout objects/where does not show anything and select [Import 
3D model] on context menu. When [3D model file select] is displayed, you choose 3D model file that you 
want to import. 

 
(3) Please you drag the 3D model files from Windows Explorer onto the tree. If it is supporting 3D model, you 

can import it as an object. 
 

Select and open 
layout file to import 
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22.4.2.14. Export PLY format 
You can export the displayed layout objects (Hexahedron, Column, Sphere, Triangle Prism, Tube, Plane) in PLY 
format. 
Coordinates of child items are calculated with the object as the origin (0, 0, 0) and export. 
 
Export procedure of layout object 
(1) Check the objects you want to export in the layout tree.( It can also be output from the hand edit tree and the 

user mech. edit tree) 
(2) Select the object as the origin and right click. 
(3) Click “Export PLY format”on the context menu. 
(4) Click the “Save”button on the “Save As”screen. 
 

 
Figure 22-30 Export PLY fomart 

 
The export PLY file can be read as a 3D model.Please refer to 22.4.2.13Importing 3D model files. 
 

 
 
 

 
 
 
 

：Object to be the origin 

：Export object 

3D Model, String can not export 
If one of the 3D model, or character string is included, a confirmation message will be displayed 
stating that these can not be export. 
Objects that are not displayed (not checked in the layout tree) are not output. 

Caution 

PLY can not be export from the robot parts edit tree 
You can export PLY from layout tree, hand edit tree, user mech. edit tree, but PLY can not be done 

from robot part edit tree. 

Caution 
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22.4.2.15. Dragging and dropping 
 
Hands / robot parts / user mech. in the layout tree can be moved to other robots by dragging and dropping. 
Layout objects can be made into child objects of other layout objects by dragging and dropping. 
Even if multiple items are selected, only one item is targeted in drag and drop operations. 
Also, items can be copied by pressing the [Ctrl] key when releasing the mouse button in drag and drop 
operations. 
 
･ Hand / robot parts / user mech. drag and drop 

If the drop destination is a hand / robot parts / user mech., the dragged item is added immediately under the 
item at the drop destination. 
 

･ Layout object drag and drop 
If the drop destination is another layout object, the dragged item is added as a child of the layout object at 
the drop destination. 
Just like in copying layout objects, even if the parent object of the layout object is changed, its display 
position in the 3D monitor will not be changed. (Refer to 22.4.2.8 Copying layout objects.) 

 
22.4.2.16. Restore 

If you are editing a layout, press Ctrl + Z to return to the previous editing state. 
You can restore the setting contents of the layout object and the robot arrangement (position / rotation) to the 
previous editing state up to 10 times. 
You can also return to the previous edit state for the following operations. 
 
(1) Operations that can be restored 
Add objects in the layout (import / copy paste) 
Delete objects in the layout 
Drop and drag the layout object 
Object size / movement / rotation (including movement / rotation in 3D monitor) 
Movement / rotation of robot arrangement (including movement / rotation by 3D monitor) 
 
(2) Operations that cannot be undone 
When saving the layout 
When changing the operation mode (robot arrangement position (position / rotation)) 
 

 
 

Spin button operation is not recorded 

Caution 
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22.5. 3D Monitor Display Settings  
Display the 3D monitor and select 3D monitor in the layout tree. 
The 3D monitor display settings will be displayed at "Properties", and 3D monitor related display settings can be 
changed at respective items. 
 

 
Figure 22-31 3D Monitor Display Settings 

 
 
22.5.1. Light source position  

The position of the light source of the 3D monitor can be set. 
You can select from three light positions [Up], [Upper left], and [Upper right]. 
These positions are positions from the viewpoint. 

 

 
Figure 22-32 Light Source Position 

 
 
 
 

Up Right up Left up 
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22.5.2. Floor  

You can set the floor to be displayed in the 3D monitor. 
 
 

22.5.2.1. Floor display 
When [Display] is set to [True], the floor is displayed in the 3D monitor. 
The floor display can also be changed by clicking the [3D view] tab -> [3D View] group -> [Floor] button on the 
ribbon. 

 

 
Figure 22-33 Displaying and Hiding the Floor 
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22.5.2.2. Floor level 

When [Floor level] is changed, the height of the floor that is displayed on the 3D monitor can be changed. 
With "0" set as the origin, increasing the value changes the position of the floor in the + direction of the Z-axis, 
and decreasing the value changes the position of the floor in the - direction of the Z-axis. 
 

 
Figure 22-34 Changing the Floor Level 
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22.5.2.3. Size 

At [Size], you can set the length of one side of the floor. 
 

 
 

Figure 22-35 Change the size of the floor 
 
 

22.5.2.4. Color 
 
At [Color 1] and [Color 2], you can set the color of the floor. At "Floor", the [Color 1] and [Color 2] color panels are 
displayed alternately. 
 

 
Figure 22-36 Changing the Floor Color 
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22.5.2.5. Transparency 

The transparency of the floor can be changed by changing [Transparency]. 
The closer a value to 99 (maximum value) is set, the closer to transparent the floor is displayed. At the minimum 
value of 0, the floor is opaque. 
 

 
Figure 22-37 Setting the Floor Transparency 
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22.5.3. Displaying coordinate axes  

When [Display coordinate axes] is set to [False], the coordinate axes displayed at the origin in the 3D monitor 
and the small coordinate axes displayed at the reference position of the robot model are hidden. 
 

 
Figure 22-38 Displaying and Hiding the Coordinate Axes 

 
 
 
22.5.4. Background color  

When [Background color] is changed, the background color in the 3D monitor is changed to the new color. Click 
the [...] button at [Color]. The Set Color screen is displayed. Set the new color in this screen. 
The Set Color screen is also displayed just like clicking the [...] button at [Color] by clicking the [3D view] tab -> 
[3D View] group -> [Background color] button on the ribbon. 
 

 
Figure 22-39 Changing the Background Color 

 
 
 

Coordinate axes displayed Coordinate axes hidden 

Background color (0; 0; 0) Background color (0; 255; 255) 
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22.5.5. Projection type  

At [Projection type], the projection type of the 3D monitor can be changed to [Perspective] or [Orthographic]. 
The [Perspective] and [Orthographic] setting can also be switched in the [3D view] tab -> [Projection type] group 
on the ribbon. 

 
 

 
Figure 22-40 Projection Type 

 
 
 

Perspective Orthographic 

Changing the 
projection 

type 



 

22-591  22-591 

 
22.6. Robot Display Settings  
Display the 3D monitor and select the robot whose display settings are to be changed in the layout tree. 
The display settings of that robot will be displayed at "Properties", and robot related display settings can be 
changed at respective items. 
 

 
Figure 22-41 Robot Display Settings 

 
 
22.6.1. Robot information  

When [Display project name]/ [Display robot type] is set to "True", each of the project name and hardware name 
(model name of robot) are displayed near the mechanical interface position of the robot on the 3D monitor. 
When both the project name and robot type are displayed, the project name is displayed at the upper level and 
the robot type is displayed at the lower level. 
The text size of the robot information displayed on the 3D monitor can be changed by selecting from [Large]/ 
[Middle]/ [Small] at [Size]. 
 

 
 

Figure 22-42 Displaying Robot Information 
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22.6.2. Robot arrangement  

You can set the arrangement of the robot model displayed on the 3D monitor. 
 

 
Figure 22-43 Robot Arrangement Settings 

 
You can set the arrangement position of the robot model by editing [Position]. 

 
You can rotate the robot model by editing [Angle]. 

 
At [Rotation order], you can select from [Z-Y-X] or [X-Y-Z]. The rotation setting is reflected in the order around 
Z-axis -> around Y-axis -> around X-axis and around X-axis -> around Y-axis -> around Z-axis, respectively. 
Standard CAD programs rotate in the same order as [X-Y-Z], and robots rotate in the same order as [Z-Y-X]. 
 

 
Figure  22-44 Robot Arrangement 
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22.6.3. Robot model  

You can change display settings related to the robot model displayed on the 3D monitor. 
 

 
Figure 22-45 Robot Model Settings 

 
22.6.3.1. Displaying the robot model 

When [Display robot model] is set to [False], the robot model is hidden. 
 

 
Figure 22-46 Displaying and Hiding the Robot Model 
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22.6.3.2. View type 

You can select [View type] from [Solid]/ [Wire frame]. 
The respective display of the robot model is switched to the selected view type by changing this setting. 
 

 
Figure 22-47 Changing the View Type of the Robot Model 
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22.6.3.3. Displaying solenoid valves  

When [Display solenoid valve] is set to [True], the solenoid valves corresponding to the robot are displayed on 
the 3D Monitor screen. 
In the simulation mode, interference with peripheral devices can be checked. 
This function is available on robots mounted with the following solenoid valves, and solenoid valves with four 
valves are displayed. 

Solenoid valve 1F-VD0□(E)-02 
1F-VD0□(E)-03 

(□ shows the number of 
solenoid valves) 

Robots which can display 
solenoid valves 

RV-4FR series 
RV-7FR series 
RV-13FR series 
RV-20FR series 
RV-4F series 
RV-7F series 
RV-13F series 
RV-20F series 

This function is available when the robot model to display on the 3D monitor is a "Detailed model". 
 

 
Figure 22-48 Displaying and Hiding Solenoid Valves 
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22.6.3.4. Interference check  

When [Interference check] is set to [True] and an interference check is executed, the interference check is 
performed on that robot model. 
When the robot model is hidden, the interference check is not performed. For this reason, to execute this check, 
display the robot model. 
 
For details on the interference check, refer to "22.14 Interference Check". 
 
 

22.6.3.5. Displaying the tool coordinate system  
When [Display tool coordinate system] is set to [False], arrows that show the mechanical interface position or the 
tool coordinate system at the tool coordinates are hidden. 
 

 
Figure 22-49 Displaying and Hiding the Tool Coordinate System 
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22.6.3.6. Displaying the tool position  

When [Display tool position] is set to [True], the tool currently selected by the controller is displayed on the 3D 
monitor. 
 

 
Figure 22-50 Displaying and Hiding the Tool Position 
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22.6.3.7. Display of work coordinate  

Expand [Display work coodinate] and set the number of each work coordinate to [True], "(Robot ID): Work (work 
number)" will be displayed at the position set in the work coordinate of "14.3.5 Tool parameter". 
 

 
Figure 22-51 Displaying and Hiding the Work Coodinate 
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22.6.3.8. Robot path  

By [Robot path], display of the robot path can be set. 
 
When [Display] is set to [True], the path of robot movement is displayed on the 3D monitor. 
This function is available in modes other than offline. 
The robot path is displayed in green. Certain movements are displayed as the robot path, and are erased 
sequentially from the oldest data. 
 
The thickness of the path can be selected at [Thickness[point]] within the range 1 to 5 points. 
When the thickness is changed, the thickness of the line displayed to indicate the robot path is changed. 
 
When the [Delete] button is clicked, all currently displayed paths are deleted. 

 
The display of the robot path is restricted according to the robot model that is displayed. 
Models whose path is not displayed are as follows. 
 

 Robot model type 
Robot models whose path is not displayed RH-G, RC-G, RH-U 

 
When a robot model whose path is not displayed is selected, [Robot path] is not displayed. 

 

 
Figure 22-52 Displaying the Robot Path 

 
 

 
 
 

Under the following circumstances, the plot interval of the robot path might 
become longer. 

 When the operation speed of the robot is fast 
 When the performance of the PC used is low 
 When multiple simulators are started up 
 When complex CAD models are displayed on the 3D monitor 
 When another application is running, and others 

Caution 
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22.6.4. Hand  

You can change the display settings of hands provided with the robot. 
Note, however, that to display a hand, a hand file must first be created from the hand file manager. Then, the 
hand item must be added to the robot in the layout tree, and the hand file to display must be selected. 

 
When [Display] is set to [False], the hand is hidden regardless of the state in the layout tree or display conditions. 

 

 
Figure 22-53 Displaying and Hiding Hands 

 
 
When [Interference check] is set to [True] and an interference check is executed, the interference check is 
performed by the hand on that robot. 
When the hand is hidden, the interference check is not performed. For this reason, to execute this check, display 
the hand. 
 
For details on the interference check, refer to "22.14 Interference Check". 
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22.6.5. Robot Parts  

You can change the display settings of robot parts provided with the robot. 
Note, however, that to display robot parts, robot parts file must first be created from the robot parts file manager. 
Then, the robot parts item must be added to the robot in the layout tree, and the robot parts file to display must be 
selected. 

 
When [Display] is set to [False], the robot parts are hidden regardless of the state in the layout tree or display 
conditions. 

 

 
Figure 22-54 Displaying and Hiding Robot Parts 

 
 
When [Interference check] is set to [True] and an interference check is executed, the interference check is 
performed by the robot parts on that robot. 
When the robot parts are hidden, the interference check is not performed. For this reason, to execute this check, 
display the robot parts. 
 
For details on the interference check, refer to "22.14 Interference Check". 
 
 
22.6.6. User Mechanism 

You can change the display settings of the user mech. attached to the robot. 
Create a user mech. file from the [User Mech. File Manager] and add the user mech. item to the robot in the 
layout tree and select the user mech. file to be displayed. 
 
If [Display] is set to “False”, the user mech. will be hidden.  
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Figure 22-55 Hide display of user mechanism 
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22.6.7. Collision area  

You can check the collision area on the 3D monitor. 
[Collision area] is not displayed for robots that are in the offline mode or do not support the collision avoidance 
function. 
 
When [Display] is set to [True], the collision area of the robot and the collision area selected at [Hand] and [Work] 
are displayed on the 3D monitor. 
When [Color] is changed, the color of the collision area displayed on the 3D monitor is changed to the new color. 
Click the [Color] button. The Set Color screen is displayed. The color can be set visually in this screen. 

 

 
Figure 22-56 Displaying and Hiding the Collision Area and Changing the Color 
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22.6.8. Movement area  

You can check the movement area in the robot's current posture in the 3D monitor. 
In the offline mode, [Movement area] is not displayed. 
When the posture is changed, click the [3D view] tab -> [3D View] group -> [Update Movement Area] button on 
the ribbon to refresh the movement area display. Updating takes several seconds depending on the performance 
of the PC. 
 
When [Display] is set to [True], positions that the robot can move in the posture at the tool control point at that 
time are displayed on the 3D monitor as the movement area. 
When [Color] is changed, the color of the movement area displayed on the 3D monitor is changed to the new 
color. Click the [...] button at [Color]. The Set Color screen is displayed. The color can be set visually in this 
screen. 
 
The display of the movement area is restricted according to the robot model that is displayed. 
The following table shows the models that do not support display of movement area. 
 

 Robot model type 
Models that do not support display of movement area. RH-G, RC-G, RH-U 

 

 
Figure 22-57 Displaying and Hiding the Movement Area and Changing the Color 
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22.6.9. User-defined area  

You can check the user-defined area in the 3D monitor. 
Only numbers set with the user-defined area parameter are displayed at "Properties". 
In the offline mode, [User-defined area] is not displayed. 

 
When a number item is set to [True], the respective user-defined area is displayed. 
Also, multiple user-defined areas can be displayed together by entering only the numbers of specific user-defined 
areas to display in the format "[1; 2]" in [Display]. 

 

 
Figure 22-58 Displaying and Hiding User-defined Areas 
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22.6.10. Free plane limit  

You can check the free plane limit on the 3D monitor. 
Only numbers set with the free plane limit parameter are displayed at "Properties". 
In the offline mode, [Free plane limit] is not displayed. 

 
When a number item is set to [True], the respective free plane limit is displayed. 
Also, multiple free plane limits can be displayed together by entering only the numbers of specific free plane 
limits to display in the format "[1; 2]" in [Display]. 
 
The length of one side of a free plane limit can be changed at [Length]. Note, however, that locations that are not 
displayed cannot be moved simply by their display on the 3D monitor being changed. 
 

 
Figure 22-59 Displaying and Hiding Free Plane Limits and Changing Length 

 
 



 

22-607  22-607 

 
22.6.11. Safe monitoring 

You can check the monitoring plane and monitoring position set in the safety parameters in the 3D monitor. 
[Safe monitoring] is not displayed in the offline mode or on models that do not support safety parameters. 
The contents displayed are different between CR800 series and CR750 / CR700 series. 
 

22.6.11.1. Safe monitoring of CR 750 / CR 700 series 
At [Display monitoring plane], only item numbers of planes set with position monitoring (plane setting) in the 
safety parameters are displayed, and operation is not possible if no items are set. 
When a number item is set to [True], the respective plane is displayed on the 3D monitor. 

 
When a number item at [Display monitoring position] is set to [True], the respective position set at position 
monitoring (position setting) in the safety parameters is displayed in the 3D monitor. 

 
The plane in position monitoring (plane setting) is separate from the plane in the free plane limit. Also, the 
position in position monitoring (position setting) is separate from the collision area. 
This function is available in controller software Ver.R6, S6 (robot safety option is required) or later. 
For details on the robot safety option, refer to the "Robot Safety Option Instruction Manual" (BFP-A3371). 
 

 
Figure 22-60 Displaying and Hiding Position Monitoring and Changing Length 
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22.6.11.2. Safe monitoring of CR 800 series 

If you set the item of [Display monitoring planes] to [True], the plane set on the safety parameter SLP monitoring 
plane setting screen is displayed on the 3D monitor. If it is an invalid setting, the face is not displayed. 

 
If you set the item of [Display monitoring area] to [True], the area set on the safety parameter SLP monitoring 
area setting screen is displayed on the 3D monitor. If it is an invalid setting, the area is not displayed. 

 
If you set the item of [Display AREA Input to [True], the area set on the safety parameter AREA input area setting 
screen is displayed on the 3D monitor. If it is an invalid setting, the area is not displayed. 

 
If you set the [Display] item of [Arm model] to [True], the arm monitoring model will be displayed on the 3D 
monitor. When you change the item of [Color], the color of the robot arm monitoring position displayed on the 3D 
monitor is changed to that color. 

 
If you set the item of [Display tool model] to [True], the user specified monitoring position set on the safety 
parameter robot model screen is displayed on the 3D monitor. 

 
The plane in SLP position monitoring is separate from the plane in the free plane limit. Also, the robot arm 
monitoring position and the position of the user specified monitoring position are different from the interference 
area. The areas of SLP monitoring area and AREA input area are also different from those of user defined area. 
This function requires robot safety option. 
For details on the robot safety option, refer to the "Robot Safety Option Instruction Manual" (BFP-A3371). 
 

 
Figure 22-61 Displaying and Hiding Position Monitoring 
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22.7. Hand Display Settings  
Display the 3D monitor and select the hand whose display settings are to be changed in the layout tree. 
The display settings of that hand will be displayed at "Properties", and hand related display settings can be 
changed at respective items. 
For details on how to add hands in the layout tree, see "22.4.2.1 Add hand". 

 
Also, to display hands in the 3D monitor, hands must be registered separately to the workspace. For details on 
how to register hands, see "22.19 Hand Design". 
 

 
Figure 22-62 Hand Display Settings 

 
22.7.1. Hand display content 

At [Hand name], the hand file name is displayed as the name of the item. 
Also, the Select hand file screen is displayed by selecting [Hand name] and clicking the [Select] button or 
double-clicking a hand whose file is not set on the layout tree. 

 

 
Figure 22-63 Hand Name Select Button 

 
 

 
Figure 22-64 Undefined Hand 

 
 
In the Select hand file screen, the list of hand files currently registered to the workspace are displayed. Select the 
hand file to display in the list, check content in the 3D monitor and select the [OK] button. The selected hand file 
is set to the display content. 
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 Figure 22-65 Select Hand File Screen 
 
 
22.7.2. Display conditions 

By setting display conditions, the target hand file can be displayed only in specified I/O states or when a tool is 
selected. 
 
- Display in offline mode 

In the offline mode, hands for which [True] is selected are displayed. 
This setting is possible only on one hand per robot. When [Display while offline] is changed to [True], all other 
hands are changed to [False]. 
 

 
Figure 22-66 Display in Offline Mode 

 
- Tool # 

Specify the tool No. for displaying the target hand file. This condition is valid in both the simulation mode and 
when connected to an actual controller. 
Options are [-], [0], [1] and so forth. When [-] is selected, all tool Nos. are displayed regardless of the tool 
selection state. Note, however, that if there is a hand file that is specified with the same No. as the current tool 
No., that hand file will be displayed. 
 

Select hand file. 

Check file content. Set to display 
content 
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Figure 22-67 Specifying I/O Conditions for Display of Hand Files  

 
 

- Display conditions 
Specify the I/O conditions for displaying the target hand file. This condition is valid only in the simulation mode. 
To disable I/O conditions, select [Default], and to enable I/O conditions, select [I/O (valid only in simulation)]. 
When [I/O (valid only in simulation)] is selected, items [Condition1] to [Condition3] are displayed, and up to 
three I/O conditions can be specified. The hand file is displayed when all respective conditions are satisfied. 
 

 
(1) Enable: Set [True] for only the number of I/O conditions to set. 

When [True] is set, the following items are displayed. 
(2) I/O type: Specify the I/O type. 

You can select from [input signal], [output signal], [Register (CC-Link) input] and 
[Register (CC-Link) output]. 

(3) Start signal #: Specify the I/O start No. 
No. 0 onwards can be specified for I/O signals. 
No. 6000 onwards can be specified for register (CC-Link) I/O signals. 

(4) Bit size: Specify the number of bits (or number of registers) from the I/O start No. 
1 to 32 can be specified for I/O signals. 1 and 2 can be specified for register 
(CC-Link) I/O. 

(5) Signal value: Specify the numerical value for comparing with the I/O state. 
For I/O signals, specify a value expressed in binary for the bit size using an 
unsigned decimal. 
For register (CC-Link) I/O, specify a value expressed in binary for one I/O (16-bit 
width) or 2 I/O (32-bit width) using a signed decimal. 
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22.7.3. Write TCP (hand tip) 

If you select the hand setting and the tool number other than [-], the [TCP Write] button will be enabled. 
Click the [TCP Write] button to write the TCP coordinate value set by the hand to  
the tool parameter. (MEXTL/MEXTLn, n = tool #1-) 
 

 
Figure 22-68 TCP Write 

 
 
22.8. Robot Parts Display Settings  
Display the 3D monitor and select the robot parts whose display settings are to be changed in the layout tree. 
The display settings of that robot parts will be displayed at "Properties", and robot parts related display settings 
can be changed at respective items. 
For details on how to add robot parts in the layout tree, see "22.4.2.2 Add robot parts". 

 
Also, to display robot parts in the 3D monitor, robot parts must be registered separately to the workspace. For 
details on how to register robot parts, see "22.20 Robot Parts Design". 
 

 
Figure 22-69 Robot Parts Display Settings 

 
22.8.1. Robot parts display content 

At [Robot Parts Name], the robot parts file name is displayed as the name of the item. 
Also, the Select robot parts file screen is displayed by selecting [Robot Parts Name] and clicking the [Select] 
button or double-clicking a robot part whose file is not set on the layout tree.. 

 

 
Figure 22-70 Robot Parts Name Select Button 

 
 

The following robots cannot write TCP. 
CR500 series : RC-G  Liquid crystal 
CR500 series : RH-G  Liquid crystal 
CR500 series : RH-U  Wafer 

Caution 
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Figure 22-71 Undefined Robot Parts 

 
In the Select robot parts file screen, the list of robot parts files currently registered to the workspace are displayed. 
Select the robot parts file to display in the list, check content in the 3D monitor and select the [OK] button. The 
selected robot parts file is set to the display content. 
 

 Figure 22-72 Select Robot Parts File Screen 
 
 
22.8.2. Display conditions 

By setting display conditions, the target robot parts file can be displayed only in specified I/O states or when a 
tool is selected. 
 
- Display in offline mode 

In the offline mode, robot parts for which [True] is selected are displayed. 
This setting is possible only on one robot part per robot. When [Display while offline] is changed to [True], all 
other robot parts are changed to [False]. 
 

 
Figure 22-73 Display in Offline Mode 

 
- Display conditions 

Specify the I/O conditions for displaying the target hand file. This condition is valid only in the simulation mode. 
To disable I/O conditions, select [Default], and to enable I/O conditions, select [I/O (valid only in simulation)]. 
When [I/O (valid only in simulation)] is selected, items [Condition1] to [Condition3] are displayed, and up to 
three I/O conditions can be specified. The hand file is displayed when all respective conditions are satisfied. 

Select robot 
part file. 

Check file content. 
Set to display 
content 
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Figure 22-74 Specifying I/O Conditions for Display of Robot Parts Files 

 
 

(1) Enable: Set [True] for only the number of I/O conditions to set. 
 
When [True] is set, the following items are displayed. 

(2) I/O type: Specify the I/O type. 
 
You can select from [input signal], [output signal], [Register (CC-Link) input] and 
[Register (CC-Link) output]. 
 

(3) Start signal #: Specify the I/O start No. 
No. 0 onwards can be specified for I/O signals. 
No. 6000 onwards can be specified for register (CC-Link) I/O signals. 
 

(4) Bit size: Specify the number of bits (or number of registers) from the I/O start No. 
1 to 32 can be specified for I/O signals. 1 and 2 can be specified for register 
(CC-Link) I/O. 

 
(5) Signal value: Specify the numerical value for comparing with the I/O state. 

For I/O signals, specify a value expressed in binary for the bit size using an 
unsigned decimal. 
For register (CC-Link) I/O, specify a value expressed in binary for one I/O (16-bit 
width) or 2 I/O (32-bit width) using a signed decimal. 
 

 
22.9. User Mech. Display Settings 
Display the 3D monitor and select the user mech. whose display settings are to be changed in the layout tree. 
The display settings of that user mech. will be displayed at “Properties”, and user mech. related display settings 
can be changed at respective items. 
For details on how to add a user mech. , refer to “22.4.2.3 Add user mechanism”. 
 
Also, in order to display the user mech. on the 3D monitor, you need to register the user mech. in the workspace 
separately, refer to “22.21 Design of User Mechanism”. 
 

 
Figure 22-75 User Mech. Display Settings 
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22.9.1. Display contents of user mechanism 

Clicking the [Select] button, or double-clicking on the user mech. for which no file is set in the layout tree, the user 
mech. file selection screen will be displayed. 
 

 
Figure 22-76 User mech. name selection button 

 
 

 
Figure 22-77 Unconfigured user mechanism 

 
On the [select user mech. file]screen, a list of user mech. files registered in the current workspace is displayed. 
Select the user mech. file, check the contents in the 3D display, and select the [OK] button. 
The selected user mech. file is set to display contents. 
 

 
Figure 22-78 Select user mech. file 

 
Position 
It is displayed at the position specified by the user. 
If there is a parent item, it is relative to the position and angle of the parent item. The setting unit is [mm]. 
 

 
Figure 22-79 User mech. position 

 
Rotation order and Angle 
Display the rotation order and rotation angle by the user mechanism. 
If there is a parent item, it is the relative rotation angle from the position and angle of the parent item. The setting 

(2)Check the file. 

(1)Select the 
user mech. 
file. 

(3)Set the display 
contents. 
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unit is [deg]. 
 

 
Figure 22-80 User mech. position 

 
Displayed while offline 
When [True] is selected, user mech. can be displayed even while offline. 
 

 
Figure 22-81 When while offline 

 
Display the project name / mech. name 
When [True] is selected, the project name / mech. name is displayed at the specified position from the origin of 
the user mech. with the specified character size (Large / Medium / Small). 
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Figure 22-82 Show / hide project / mech. name 

 
22.9.2. User mech. type and relationship to robot 

User mech. type 
Set mech. to assign the joint axis value of the user mechanism. 

Additional axis ： Mech. with mech. number 1 (robot) 
User mech.-1 ： Mech. with mech. number 2  
User mech.-2） ： Mech. with mech. number 3  

 

 
Figure 22-83 User mech. type 

 
For details on setting of multi-mech. and additional axis, please refer to "14.3.9Robot additional axis 
parameter". 
 
Relationship to robot 
Set the relationship between the user mech. and the robot. 

Independence ： Make it a mechanism separate from the robot at a position distant from the 
robot 
(Coordinates are relative to the robot coordinates) 

Attach to the robot's 
mechanical interface 

： Attach to the mechanical interface of robot and make it part of robot 
(The coordinates are relative coordinates from the mechanical interface) 
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Figure 22-84 User mech. relationship to robot 

 
22.9.3. User mech. lnterference check 

When [True] is selected, By clicking the [3D view] -> [interference check] button, interference check between the 
user mech. and other objects etc. can be done. 
 

 
Figure 22-85 User mech. lnterference check 

 
Please refer to “22.14Interference Check”. 
 
22.10. Spline Display Settings  
Display the 3D monitor and select the spline whose display settings are to be changed in the layout tree. 
The display settings of that spline will be displayed at "Properties", and spline related display settings can be 
changed at respective items. 
For details on how to add a spline, refer to "Adding a spline". 
 

 
Figure 22-86 Spline Display Settings 

 
At [Display curve], you can select [Opened spline file], [Specified spline file] and [MXT file]. 
 
 
22.10.1. Opened spline file 

If the Spline screen for the target robot is opened, the data displayed in that screen can be displayed as the 
spline curve. 
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Figure 22-87 Display Settings for an Opened Spline File 

 
When there is an [Opened spline file], the position data of the curve (blue) of the spline file currently open in the 
3D Monitor screen and the currently selected path points are displayed. 

 

 
Figure 22-88 Display of Spline Curve (Opened File) 
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When a spline file corresponding to an EX-T spline is opened, the spline curve is displayed at the start position 
along the Ex-T coordinates. In addition to the position data of the currently selected path points, the position data 
(En, n: path point No.) corresponding to those points, and the gripping position (G) and Ex-T coordinate origin 
(EO) are displayed. 
 

 
Figure 22-89 Display of Curve Corresponding to Ex-T Spline (Opened File) 

 
 
22.10.2. Specified spline file 

The spline file on the PC or robot can be specified, and its spline curves can be displayed. 
To specify a spline file to display, select [Spline #] and click the [Select] button. The Select spline file screen is 
displayed. In this screen, select the spline file to display. 

 

 
Figure 22-90 Display of Spline Curve (Specified File) 

 

Position data of currently 
selected path point 

Position data on 
Ex-T spline curve 

Gripping 
position 

Ex-T coordinate 
origin 
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When a spline file corresponding to an Ex-T spline is selected, the spline curve is displayed at the position where 
the robot's tool is aligned with the gripping position. 
Also, the Ex-T coordinate original (EO) is displayed. 

 

 
Figure 22-91 Display of Curve Corresponding to Ex-T Spline (Specified File) 

 
 
 
22.10.3. MXT file  

You can display a specified MXT file approximated to the spline curve. 
To select an MXT file to display, select [File] and click the [...] button. The select read file screen is displayed. In 
this screen, select the MXT file to display. 
Then, set the tolerance for calculating the control points of the spline curve from the MXT file by changing the 
[Tolerance] setting. The smaller the set value, the more detailed points are calculated. 
 

 
Figure 22-92 MXT File Display Settings 

 
 
 
 



 

22-622  22-622 

 
22.11. Layout Object Display Settings  
Display the 3D monitor and select the layout object whose display settings are to be changed in the layout tree. 
The display settings of that layout object will be displayed at "Properties", and layout object related display 
settings can be changed at respective items. 

 
 

22.11.1. Layout object display content settings 

 

 
Figure 22-93 Layout Object Display Settings 

 
 

Table 22-5 Explanation of Layout Object Display Settings 
 Name Description 
(1) Name This item names layout objects. 

Names entered here are displayed in the layout tree. 
(2) Figure This specifies the shape of the layout objects. 

You can specify from hexahedron, column (cone), sphere, triangle prism, plane, 
tube, 3D model and string. 
When 3D model is specified, data created by CAD can be read. 

(3) Color This specifies the color of the layout objects. 
Select this item and click the [...] button. The Set Color screen is displayed. The 
color can be set visually in this screen. 

(4) Position This sets the position where layout objects are to be placed. 
When there is a parent layout object in the layout tree, the position is the relative 
position from the parent layout object. 

(5) Rotation 
order 

This sets the order in which the rotation angle of the layout object is reflected. 
You can select from "X->Y->Z" or "Z->Y->X". 

(6) Angle This sets the posture in which layout objects are to be placed. 
When there is a parent layout object in the layout tree, the angle is the relative 
angle from the parent layout object. 

(7) Size This specifies the size of the layout objects. 
(8) View type This sets the view type of the layout objects. 

You can select from [Solid] or [Wire frame]. 
(9) Condition This sets the conditions for displaying and hiding layout objects. 

For details, refer to "22.11.3 Layout condition edit". 
(10) Interference 

check 
This sets whether or not to perform an interference check on the selected layout 
object when the interference check is executed. 
By the interference check, the interference with the robot model, hand / robot parts 
/ user mech. is checked. 

 

(1) Name 

(2) Figure 

(3) Color 

(4) Position 

(7) Size 

(6) Angle 

(9) Condition 

(8) View type 

(5) Rotation order 

(10) Interference check 
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The following explains each of the layout objects. 
 

Table 22-6 Explanation of Layout Objects 
 Window Explanation 

Hexahe
dron 

(rectan
gular 

parallel
epiped) 

 

 

Column 
(Cone) 

 

 
* If a different value is set to an upper radius and a lower 
radius, it becomes a conic type. 
 

When [Unify the radius] is set to [True], the size of the 
upper radius and lower radius are always matched. 

X 

Z
 

Y

 Position 
（X, Y, Z） 

Size 
（Upper radius） 

Size
（Height） 

Size 
（Lower radius） 

Angle（X） 

Angle（Z） 

Angle 
(Y） 

Position 
（X, Y, Z） 

Size（Y） 
Size（X） 

Size（Z） 

Angle（X） 

Angle（Z） 

Angle 
(Y） 

X 

Z
 

Y
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 Window Explanation 
Sphere 

 

 
* With [Sphere], when there is a child layout object in the 
layout tree, the setting of this item affects the position 
posture of the child layout object. 

Triangle 
prism 

 

 

X 

Z
 

Y

 Position 
（X, Y, Z） 

Size 
（Radius） 

Angle（X） 

Angle（Z） 

Angle 
(Y） 

Position 
（X, Y, Z） 

Size（Y） Size（X） 

Size（Z） 

Angle
（X） 

Angle（Z） 

Angle
（Y） 

Y 

Z
 

X
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 Window Explanation 
Plane 

 

 

Tube 

 

 
* The minimum thickness ([Outer radius [mm]] - [Inner 
radius [mm]]) is 0.5 mm. 

X 

Z
 

Y

 Position 
（X, Y, Z） 

Size 
（Inner radius） 

Size
（Height） 

Size 
（Outer radius） 

Angle（X） 

Angle（Z） 

Angle 
(Y） 

Position 
（X, Y, Z） 

Size 
(width) 

Size 
(height) 

Angle
（X） 

Angle（Z） 

Angle
（Y） 

Y 

Z
 

X
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 Window Explanation 
3D 

model 

 

 
The position and a rotational reference position of 3D 

model are reference positions at the time of CAD data 
creation.  

When 3D model is selected, the CAD file to read can 
be specified. The CAD file which can be read is as 
follows.  

file extension 
STL (Stereolithography) file .stl 
OBJ (Wavefront format) file .obj 
3DS (3D Studio) file .3ds 
PLY (Stanford Triangle Format) file .ply 
VRML 2.0 (Virtual Reality Modeling 
Language) file 

.wrl 

When the file of OBJ form is read, the information on 
a texture is not reflected.  

 
3D 

model 
(Contin
uation) 

 

The unit of scale that display in 3D monitor can be 
specified. 

The millimeter is standard unit in 3D monitor. 
The unit of scale that can be specified is as follows. 
- Millimeter[mm] 
- Meter[m] 
- Inch[in] 
- Magnification specification (Magnification of 

1.0-10000.0 can be specified.) 
 

Position 
（X, Y, Z） 

Angle（X） 
 

Angle（Z） 
 

Angle 
(Y） 

X 

Z
 

Y
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 Window Explanation 
String 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* The maximum number of characters that can be 
displayed is 32 characters. 
* Multibyte characters are displayed only in the same 
language as the OS. (Different languages may display 
garbled characters.) 
* If you create many character strings, screen rendering 
processing becomes heavy. 

 

 
 
 

 
 
 
 
 
 

- If 3D model of big size is read, screen drawing processing will become 
heavy. 

- Abnormal operation may result due to size. Therefore make data size as 
small as possible during CAD tool conversion. 

- Because not all VRML formats are supported, these may not display 
normally. 

Caution 

Position 
（X, Y, Z） 

Size 

Y 

Z
 

X

 

Rotation Table 
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22.11.2. Moving and rotating layout objects 

To move or rotate layout objects that have been created, change the "Position" and "Angle" values in the 
respective "Properties". Layout objects can also be moved by mouse operation on the 3D monitor. For details, 
refer to "22.3.6.1 Moving objects by the ". 
Note, however, that the property values (position and posture) of child layout objects that are in a parent-child 
relationship on the layout tree become the relative position and posture from the reference position of the parent 
layout object. For this reason, take this into consideration when setting the position and posture. 

 

 
 

Figure 22-94 Position and Posture of Layout Objects in Parent-child Relationship 
 
 

Also, the position and posture of the child layout object are relative coordinates from the parent layout object. So, 
child layout objects can also be moved and rotated together with movement and rotation of the parent layout 
object. 

 

 
Figure 22-95 Moving and Rotating Parent Layout Objects 

 
 

To move and rotate a parent layout object only, either drag and drop or copy and paste the parent layout object 
on the layout tree, then cancel the parent-child relationship, edit the objects and then re-create the parent-child 
relationship. 
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Child 

Y 

Reference 
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Y 
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Layout tree 
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22.11.3. Layout condition edit 

Click the [Edit] button at [Condition] at "Properties". The "Layout object condition edit" screen is displayed. 
 

 
Figure 22-96 Layout condition editing 

 
 

 
You can display or hide layout objects by specifying I/O conditions for corresponding layout objects. This function 
can be used in simulation. 

 

 
Figure 22-97 Layout condition edit 

 
If you set no condition, select [Default]. If you set some conditions, select [I/O (Valid only in simulation)]. 
 

(1) ON->OFF : This sets the conditions for changing target layout objects from a displayed to a 
hidden state. Up to three conditions can be specified. When all conditions are 
satisfied, the layout object is hidden. 

(2) OFF->ON : This sets the conditions for changing target layout objects from a hidden to a 
displayed state. Up to three conditions can be specified. When all conditions are 
satisfied, the layout object is displayed. 

(3) Condition : If you checked [Enable], you can set the condition. 
Check same number to set conditions. 

(4) I/O type : Select [input signal], [output signal], [Register (CC-Link) Input], [Register (CC-Link) 
Output]. 

(5) Start signal # : Set 0 or larger when you select [input signal] or [output signal]. 
Set 6000 or larger when you select [Register (CC-Link) Input] or [Register (CC-Link) 
Output]. 

(6) Bit size : Set 1 - 32 when you select [input signal] or [output signal]. 
Set 1 - 2 when you select [Register (CC-Link) Input] or [Register (CC-Link) Output]. 

(7) Signal value : Set the value which is compared with I/O state. 
Set the unsigned decimal value which is expressed in binary value with bit size 
specified (6) when you select [input signal] or [output signal]. 
Set the signed decimal value which is expressed in binary value with 1 register (16 bit) 
or 2 register (32 bit) specified (6) when you select [Register (CC-Link) Input] or 
[Register (CC-Link) Output]. 

(8) Project : Specifies the target project (robot) to check I/O conditions. 
 

(1) 

(2) 

(3) (4) (5) (8) (7) (6) 
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22.12. Layout Files  
You can save the display settings of 3D monitor, robots, hands, robot parts, user mech.,  splines, and layout 
objects to layout files. Also, you can load the display settings of 3D monitor, robots, hands, robot parts, user 
mech., splines, and layout objects saved to layout files. 
The display settings of 3D monitor, robots, hands, robot parts, user mech., splines, and layout objects can be 
easily switched to and used in a separate workspace by saving these settings to a layout file. 

 
 

22.12.1. Saving layout information 

To save settings to a layout file, click the [3D view] tab -> [Layout file] group -> [Save]/ [Save as] button on the 
ribbon. 
The layout file is overwritten with the current layout information by clicking the [Save] button. 
When the [Save as] button is clicked, the "Input new name" screen is displayed. In this screen, enter the layout 
file name, and click the [OK] button. The current layout information is saved as a layout file using the name you 
entered, and is registered to the workspace. 

 

 
Figure 22-98 Operation of Saving Layout Files by "Save As" 

 
 

 
 
 

Cautions when saving layout information that uses a 3D model or an MXT file 
 

When a 3D model or MXT file is used in a layout, the file in use when the layout information is saved 
is copied to the same folder as the layout file, and from then on the copied file is referenced. To edit a 3D 
model or MXT file, either edit a copied file or select the file again after editing it. 
 

Caution 
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22.12.2. Loading layout information 

If layout information is changed even once after it is loaded from a layout file, the following confirmation screen 
will be displayed when the layout file is loaded. 

 

 
Figure 22-99 Layout File Load Confirmation Screen 

 
Note that if you select [Yes] in this screen to load the layout file, all currently displayed layout information will be 
deleted. 
 
There are two ways of loading layout information saved to layout file. 
 
Select the layout file to load by the [3D view] tab -> [Layout file] group -> [Select Layout File to be Load] combo 
box on the ribbon. 
The layout information of the layout file selected in the combo box will be loaded. 
This method is recommended when performing tasks while switching between multiple layout files, for example, 
when creating layout files for individual tasks, since layout information can be easily switched. 

 

 
Figure 22-100 Loading Layout Files on the Ribbon 

 
 

(1) Select the layout file name to load 
from the combo box. 
 

(2) The layout file selected in the combo 
box will be loaded. 
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Click the [3D view] tab -> [Layout file] group -> [Layout file manager] button on the ribbon. The "Layout file 
manager" screen is displayed. 
In the layout file list in this screen, select the layout file, and check the content of the layout information in the 3D 
display. When you have finished checking, click the [Load] button. 
The layout file selected in the layout file list will be loaded. 
This method is recommended when files cannot be distinguished purely by file name since both the file name 
and the content of the layout information can be checked in the 3D display. 
 

 
Figure 22-101 Loading Layout Files by the Layout File Manager 

 
 
 
 
 

(1) Click the [3D view] tab → [Layout file] group → 
[Layout file manager] button on the ribbon. 
 

(2) In the layout file list, select the layout file, and 
check the content in the 3D display. 
 

(3) If you check and find the layout file to load, click the 
[Load] button. 

 
(4) The layout file selected in the layout file list will be 

loaded. 
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22.12.3. Layout file manager 

The "Layout file manager" screen opens by clicking the [3D view] tab -> [Layout file] group -> [Layout file 
manager] button on the ribbon. 
In the "Layout file manager" screen, you can add, delete, rename and perform other operations on layout files. 
 

 
Figure 22-102 Layout File Manager Screen 

 
 

No. Item Description 
(1) Title name This displays all of the layout file names registered to the current workspace. 
(2) 3D display of layout 

files 
This displays the layout objects of the files currently selected in the layout file 
list so that you can check the file content. 

(3) Add This adds a new or existing layout file to the current workspace. 
Clicking the [Add] button displays the screen for selecting [New] or [Existing]. 
By [New], you can create a layout file with a new name. 
By [Existing], you can select an existing layout file, such as a layout file in 
another workspace, and add this to the current workspace. 

(4) Delete This deletes the layout file selected in the layout file list. 
Since the entire folder is deleted when a layout file is deleted, 3D models and 
MXT files also will be deleted if they are in the same folder. 

(5) Change name This renames the layout file selected in the layout file list. 
(6) Load This loads the layout file selected in the layout file list in the 3D monitor. 

Note that the current layout information will be deleted. 
 
 
 

(1) Title name 

(3) Add 

(4) Delete 

(5) Change 
name 

(6) Load 

(2) 3D display of 
layout files 
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･ Adding a layout file 

To add a new layout file, click the [Add] button. The following screen will be displayed. 
 

 
Figure 22-103 Selecting the Type of Additional Layout File 

 
When [New] is clicked, the name input screen is displayed. In this screen, enter the name of the new layout 
file to add, and click the [OK] button. The new layout file is added to the layout file list with the name you 
entered. 
 
When [Existing] is clicked, the select file screen is displayed. In this screen, select the layout file to add. After 
selecting the file, the name input screen is displayed. In this screen, enter the name of the new layout file to 
add, and click the [OK] button. The selected layout file is added to the layout file list with the name you 
entered. 
 
 

･ Deleting a layout file 
To delete an existing layout file, select the layout file to delete in the list, and click the [Delete] button. The 
following screen is displayed. In this screen, check that the file is the layout file to delete, and click the [Yes] 
button. The selected layout file is deleted from the layout file list. 
Since the entire target layout file folder is deleted when a layout file is deleted, 3D models and MXT files also 
will be deleted at the same time if they are in the same folder. 
 

 
 
 

･ Renaming a layout file 
To rename a layout file, select the layout file to rename in the list, and click the [Change name] button.The 
name input screen containing the current file name is displayed. In this screen, enter the new name, and 
click the [OK] button. 
 
 

･ Loading a layout file 
To load a layout file to the 3D monitor, select the layout file to load in the list, and click the [Load] button. The 
layout file list will be loaded to the 3D monitor. For details on cautions when loading layout files and other 
ways to load layout files, refer to "22.12.2 Loading layout information". 
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22.13. Types of Robot Model  
You can select the robot model to be displayed on the 3D monitor from "detailed model" and "simple model". 
Note, however, that the "detailed model" sometimes is not displayed depending on the model. 

 
As the default setting, "detailed model" is displayed. 
To change the type of robot model, select the type of robot model to displayed in the [3D view] tab -> [Robot 
model] group on the ribbon. 
Also, the type of robot model becomes "simple model" with the "The robot of 3D monitor is displayed in simple 
model." checkbox selected in the New Workspace screen. 
 

 
Figure 22-104 Types of Robot Model 

 
 
The recommended environment for displaying a "detailed model" is as follows. 
 

Item Recommended environment 
CPU Dual core including Core2 Duo or Core i3 3 GHz or faster processor 
Main memory 2GB or more 

 

 
 
 
 
 

Detailed model Simple model 

The 3D monitor sometimes cannot display detailed models normally and 
functions such as the operation panel are obstructed if they are displayed 
on a PC that does not satisfy this recommended environment. In this case, 
change the model type to simple model. 

Caution 
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22.14. Interference Check  
The interference check can be performed in the 3D monitor. 
The following table summarizes combinations in which the interference check can be performed. 

 
Table 22-7 Combinations in Which Interference Check Can Be Performed 

 Robot model 
(detailed 
model) 

Robot model 
(simple 
model) 

Hand Robot Parts 
 

User 
Mechanism 

Layout object 

Robot model 
(detailed 
model) 

○ × ○ ○ ○ ○ 

Robot model 
(simple model) 

× × ○ ○ ○ ○ 

Hand 
○ ○ ○ ○ ○ ○ 

Robot Parts 
○ ○ ○ ○ ○ ○ 

User 
Mechanism 

○ ○ ○ ○ ○ ○ 

Layout object 
○ ○ ○ ○ ○ × 

 
Note, however, that attention must be paid when setting both the robot model and the hand as targeted in the 
interference check since the hand also checks interference with the robot model other than the parts provided on 
the robot on which the hand is provided. 

 
Before starting the interference check, set the robot model and layout objects to be targeted by the interference 
check in their respective properties. 

 
Figure 22-105 Robot Model and Layout Object Interference Check Settings 

 
Set the interference check of the hand by the following items in the properties of the robot that is provided 
on.

 
Figure 22-106 Hand Interference Check Settings 

 
 
Set the interference check of the robot parts by the following items in the properties of the robot that is provided 
on.

 
Figure 22-107 Robot Parts Interference Check Settings 

 
 
After setting the parts to be targeted in the interference check, click the [3D view] tab -> [Interference check] 
group -> [Setting] button on the ribbon to start the interference check. Also, the interference check can be ended 
by clicking the [Setting] button again during the interference check. 
 
Please set the interference check of the user mech. with the following item of the user mech. property. 

Setting for not targeting in the interference check Setting for targeting in the interference check 
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Figure 22-108 Interference Check Setting 

 
 
 
 
 
 
 

 
Figure 22-109 Interference Check Start/End Buttons 

 
 

When you click [Setting] button and [Stop the Robot] button, you can stop the robot interfering. 

 
Figure 22-110 Stop the Robot Button 

 
 

Before interference check During interference check 

Effective [Stop the Robot] button 
The robot 

stops when 
interfered 
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During the interference check, end the interference check by either switching the mode by [Offline mode] or 
[Online mode] or by ending the 3D monitor. 
 
The interference check on the 3D model of the detailed models and simple models of the robot model is 
performed not on the currently displayed model but on its bounding box. The bounding box is displayed as a wire 
frame during the interference check, so refer to this. 
 

 
Figure 22-111 Bounding Box of Robot Model 

 

You stop the robot in the low-speed. You do not necessarily stop the 
robot in the high-speed. 

Caution 

Bounding box 
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When two parts targeted in the interference check interfere with each other during the interference check, the 3D 
monitor display is changed and the combinations of interfering parts are displayed at [Output]. 
 

 
Figure 22-112 Changes in Interference Times 

 
 

Interfering objects 

Interference times and 
combinations of interfering parts 
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･ Changes in 3D monitor 

When two parts targeted in the interference check interfere with each other during the interference check, the 
display of the interfering objects on the 3D monitor is changed. 
 

Table 22-8 Changes in Display at Interference 
No. Type Display at Interference 
1 Robot model (detailed model) 

Layout object (3D model) 
The currently displayed bounding box changes color from 
white to red. 

2 Robot model (simple model) 
Hand 
Robot parts 
User mechanism 

A red wire frame is displayed overlapping the robot. 

3 Layout object (other than 3D model) A wire frame of the opposite color is displayed overlapping the 
robot. 

 

 
Figure 22-113 Display of 3D Monitor at Interference 

 
 

･ Changes in [Output] 
When two parts targeted in the interference check interfere with each other during the interference check, the 
combinations of interfering parts are displayed at [Output] together with their times. 
 

 
Figure 22-114 Output Information at Interference 

 
 

(1) Interfering robot model 
(detailed model) 

(2) Interfering hand 

(3) Interfering layout object 
(other than 3D model) 

Project name of 
interfering robot 

If program is executing 
(program name) - 
(execution line) 

This is displayed when it is 
the hand that interfered 

Name of interfering 
layout object 
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By this function, only combinations of interfering parts that include objects that have not interfered even once 
since the interference check is started are checked. For this reason, with objects that have interfered even once, 
even in a combination that has never interfered with another object, when both objects have interfered with 
another object, that combination is not checked. To check those combinations, reset the interference history by 
clicking the [3D view] tab -> [Interference check] group -> [Reset] button on the ribbon. 
 

 
Figure 22-115 Resetting the Interference History 

 
 
 

Combination where 
interference of both 

objects has occurred 
and interference check 

is not performed 

Combination where 
interference of both 
objects has never 

occurred and 
interference check is 

performed 

Click [Reset] 
button 

The program execution line in the output information at interference 
sometimes shifts from the line that was actually executing. Use this as a 
rough guide that interference occurred somewhere neat that line. 

Caution 
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Also, models hose parts are displayed in 3D monitor as shown below, but does not check for hose part 
interference, please note. 
 

 
Figure 22-116 Models does not check for hose part interference 

 

Perform the interference check with the 3D monitor displayed. The 
interference check will not be executed if the 3D monitor display is 
minimized. 
During the interference check, robot movement on the 3D monitor 
sometimes slows down. If this happens, either reduce the number of 
objects set as targeted in the interference check or decrease the override. 
On low-performance PCs, the interference check sometimes is not 
performed normally. 

Caution 

Hose parts 
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22.15. Moving the Robot by Clicking  
With the simulation started up, click an object on the 3D monitor with the [Ctrl] key held down. The control point of 
the robot moves to the clicked position. 
 

This function is not available on the following models. 
 Robot model type 
Models that do not support the click move function RH-G, RC-G, RH-U 

 
The robot targeted for moving by clicking can be selected in the [3D view] tab -> [Click move] group -> [Robot] 
combo box on the ribbon. 
When the [3D view] tab -> [Click move] group -> [Change posture of the robot] checkbox on the ribbon is not 
selected, the robot will not move depending on its posture because it moves with its posture held intact. 
 

 
Figure 22-117 Setting the Robot Targeted for Moving by Clicking 

 
 

 
Figure 22-100 Click Move Operation 

 

 
 

Click with [Ctrl] key 
held down 

If there is no object at the clicked position or it is outside the robot operation 
range, the robot will not move. 
Since the robot moves with the multi-rotation state of the joints held intact, the 
robot will not move depending on the multi-rotation state of the joints. 
This operation is invalid while the robot is running. 

Caution 
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Also, if you click an object on the 3D monitor with the [Ctrl] key held down with the [3D view] tab -> [Click move] 
group -> [Change posture of the robot] on the ribbon selected, the control point of the robot will move to the 
clicked position, and the posture will be changed to one where the normal direction of the click surface matches 
the Z-axis direction of the tool coordinate system. 
 

 
Figure 22-118 Setting to Match the Posture with the Normal Direction of the Click Surface 

 

 
Figure 22-119 Click Move Operation for Matching the Posture with the Normal Direction of the Click Surface 

 
 

 
 
 
 
 
 

Click with [Ctrl] key 
held down 

･ This function is available only on vertical 6-axis robots. 
On other models, the robot moves to the clicked position with its current 
posture held intact. 

･ The target posture is sometimes not attained depending on the current 
posture before click move operation. 
In this case, bring the current posture close to the target posture, and then 
perform click move. 

Caution 



 

22-645  22-645 

 
 
22.16. Move the robot by grasping the tool 
When displaying the robot tool coordinate system, while pressing [Ctrl] + [Shift], click and slide in the XYZ 
direction, and the robot's control point will move in the direction of the grasped axis. 
 

  
Figure 22-120 Move the robot by grasping the tool 

 
 Hold down [Ctrl] + [Shift] and slide one of the spheres on X, Y, Z coordinates in the tool  with left clicking, the 
control point of the robot will be rotate along the rotation axis. 
 

  
Figure 22-121 Operation to grab the tool and rotate the robot 

 
 

Press [Ctrl] + [Shift] 
click and slide the Z 
coordinate of tool 

Hold down [Ctrl] + 
[Shift] key, click on the 

tool's Y coordinate 
sphere and slide in X 

direction 
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When the robot is selected, the tool coordinate is expanded as shown below and a ball for rotation is displayed. 

  
Figure 22-122 Display change of tool coordinate system 

 
 

 Robot 
Tool mobile robot Vertical 6 axis, Horizontal 4 axis, Ceiling horizontal 4 axis, Micro, 

Palletizing Caser, RH-L Series 
 

 
 

. The robot cannot move when the moving position exceeds the operating range 
of the robot. 
. This operation is invalid when the robot is running. 

Caution 

Select Robot 
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22.17. Distance measurement 
You can measure the distance between any two points on objects (robots, layouts etc.) displayed in 3D monitor. 
To use this function, click the [3D view] tab -> [Tool] group -> [Distance measurement] button on the ribbon. The 
"Distance measurement" screen is displayed. Then when you click while entering the space key two points on 
objects to be measured, the line and distance (mm) as follows are displayed. 

 
This function can also be used with hand / robot parts / user mech. . 

 
Figure 22-123 Distance measurement between two points 

 
The distance measurement screen displays the history of positions and distances of each measurement. If you 
turn ON / OFF a checkbox of each line, you can show / hide the line and the distance of the measurement. 
The history keeps during the 3D monitor is opened. 

 
In addition, the measurement result is also displayed in the [Output] window as shown above. 
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[XYZ] / [X] / [Y] / [Z] can be selected in the mode field of each measurement result. By changing to the mode of 
[X] / [Y] / [Z], the line that extracted only the distance on the designated axis between the two points is displayed 
on the 3D monitor. The distance column is changed to the distance on that coordinate axis. 

 
 

 
 
 

Figure 22-124 Distance measurement on the coordinate axis between two points 
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22.18. XYZ position variables 
It is possible to display the XYZ position variable on 3D monitor. 
Correspondence of color and coordinate axis are as follows. 

 
Table 22-9 Correspondence table of colors and coordinate axes 

Color Coordinate axes 
Red X axes 

Yellow Y axes 
Light Blue Z axes 

 
When some XYZ position variables in a robot program are selected, these all of positions are displayed on 3D 
monitor. 
It is possible to display the XYZ position variables on some 3D monitors. When selection of the XYZ position 
variables is released, the positions on 3D monitor are vanished. 

 
When two or more XYZ position variables in some programs in a project are selected, all selected position 
variable is displayed. When the XYZ position variables of the same name in some programs are selected, all 
selected position data is displayed. 

 
It is possible to display only XYZ position variables. Joint position variables cannot be displayed on 3D monitor. 

 

 
 
 
 

 
Figure 22-125 XYZ position 

 

A maximum of 50 XYZ position variables can be displayed in 3D 
monitor. 

Caution 
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The position data which can be displayed is as follows. 

 
Table 22-10 The position data which can be displayed 

Preservation place Kinds of program Remarks 
Robot program in 
the robot controller 

Movemaster 
command 

A simulation cannot be used when Movemaster 
command is selected. 

MELFA-BASIC IV  
MELFA-BASIC V  
MELFA-BASIC VI  
SQ Direct Only a CRnQ type can be displayed. 

Robot program in 
the project 

Movemaster 
command 

A simulation cannot be used when Movemaster 
command is selected. 

MELFA-BASIC IV  
MELFA-BASIC V  
MELFA-BASIC VI  
SQ Direct  
Backup programs  
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22.19. Hand Design  
Hands can be displayed at the mechanical interface position of the robot on the 3D monitor, and the hand to 
display can be switched according to signal state, for example. 
Hands that you design are registered to the workspace. For this reason, hands must be designed before hand 
display settings are made on the layout tree. Create the hand file to be used and then make the display settings 
on the layout tree. 
 
22.19.1. Hand file manager 

Click the [3D view] tab -> [Hand file] group -> [Hand file manager] button on the ribbon. The "Hand file manager" 
screen is displayed. 

 

 
Figure 22-126 Display of the "Hand file manager" Screen 

 
 
Except for the [Edit file] button, the layout files are changed to hand files. However, operations are the same as in 
"22.12.3 Layout file manager". So, refer to this section for details on operation in the hand file manager. 
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- Editing hand files 

Double-click the selected edit file in the hand  list, or click the [Edit] button to open the hand editing dialog and 
display the edit tree. You can also open the hand editing screen by double-clicking the already set hand in the 
layout tree. 
 

 
Figure 22-127 Editing Hands 
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22.19.2. Hand editing operations 

Operation methods are basically the same as in the 3D monitor. So, refer to "22.3 3D Monitor Operations" for 
details. 
Note, however, that view center rotation differs from operation in the 3D monitor in that this can be operated by 
the mouse only. 
To save hand files, click the [3D view] tab -> [Hand file] group -> [Save]/ [Save as] button on the ribbon. 

 
Figure 22-128 Saving Hand Files 

 
22.19.3. Hand edit tree 

The display content and operation methods on the hand edit tree are basically the same as in the layout tree. So, 
refer to "22.4 Layout Tree" for details. 
Note, however, that display and operations related to the robot, hands, robot parts, user mech. and splines 
cannot be executed. Display conditions cannot be set to objects for hand parts. 
Also, [3D Monitor] in the layout tree is changed to [Mechanical interface] on the hand edit tree. The properties of 
this item will not be displayed even if this item is selected. However, the mechanical interface in the "Hand editor" 
screen can be switched between displayed and hidden by selecting the [Mechanical interface] checkbox. 
 
A TCP item is added to the child item of the mechanical interface. TCP is displayed as a gray ball and a rotated 
coordinate system in the hand deitor screen. Select the TCP item and press [Ctrl], click on a part from hand editor 
screen, the TCP will move to the clicked position. In addition, the coordinates of the TCP (hand tip) can be written 
to the TOOL parameter (MEXTL/MEXLn). Please refer to "22.7.3Write TCP (hand tip)" for details. 
 

 
Figure 22-129 Hand edit tree mechanical interface 
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Figure 22-130 Click movement of TCP (hand selection) 

 
22.19.4. Distance Measurement 

Please refer to "22.17Distance measurement". 

 
Figure 22-131 Distance measurement during hand editing 

 

Press the [Ctrl] and 
click 
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22.20. Robot Parts Design  
Robot parts are displayed on each axis of the robot on the 3D monitor and the robot parts to display can be 
switched according to signal state, for example. 
Robot parts that you design are registered to the workspace. For this reason, robot parts must be designed 
before robot parts display settings are made on the layout tree. Create the robot parts file to be used and then 
make the display settings on the layout tree. 
 
22.20.1. Robot parts file manager 

Click the [3D view] tab -> [Robot Parts File] group -> [Robot Parts File Manager] button on the ribbon. The "Robot 
Parts File Manager" screen is displayed. 

 

 
Figure 22-132 Display of the "Robot Parts File Manager" Screen 

 
Except for the [Edit file] button, the layout files are changed to robot parts files. However, operations are the same 
as in "22.12.3 Layout file manager". So, refer to this section for details on operation in the robot parts file 
manager. 
 
- Editing robot parts files 

Double-click the selected edit file in the parts list, or click the [Edit] button to open the parts editing dialog and 
display the edit tree. You can also open the parts editing screen by double-clicking the already set parts in the 
layout tree. 

 
Figure 22-133 Editing Robot Parts 
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22.20.2. Robot parts editing operations 

Operation methods are basically the same as in the 3D monitor. So, refer to "22.3 3D Monitor Operations" for 
details. 
Note, however, that view center rotation differs from operation in the 3D monitor in that this can be operated by 
the mouse only. 
To save robot parts files, click the [3D view] tab -> [Robot Parts File] group -> [Save]/ [Save As] button on the 
ribbon. 

 
Figure 22-134 Saving Robot Parts Files 

 
22.20.3. Robot parts edit tree 

[3D Monitor] in the layout tree is changed to [Robot] on the robot parts edit tree and the axis are displayed in the 
child item. The number of axes displayed is the same axis number as the displayed robot. 
When you select an axis to which you want to attach a robot part and add an object, the object is displayed on the 
corresponding axis of the robot. When you select [Robot] and add an object, the object is displayed on the base 
part of the robot. 
When you select [Robot], properties are displayed, you can select the display robot and change the display type. 
The display content and operation methods on the robot parts edit tree are basically the same as in the layout 
tree. So, refer to "22.4 Layout Tree" for details. 
Robots, hand, robot parts, user mech., spline and related display and operations can not be executed. Objects of 
robot parts an not set display conditions. 
 

 
Figure 22-135 Add Objects in Robot Parts Editing Tree 
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Figure 22-136 Properties in Robot Parts Editing Tree 

 
22.20.4. Distance Measurement 

Please refer to "22.17Distance measurement". 

 
Figure 22-137 Distance measurement during parts editing 
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22.21. Design of User Mechanism 
Displays the user mech. at a position away from the mechanical interface on the 3D monitor or the robot. 
The designed user mech. is registered in the workspace. Before setting the display of the user mech. in the 
layout tree, it is necessary to design the user mechanism. 
Please create the user mech. file to be used beforehand and make the display setting in the layout tree. 
 
22.21.1. User mech. file manager 

Click the [3D Display] tab of the ribbon -> [User Mech. File] group -> [User Mech. File Manager] button to display 
the user mech. file manager screen.  
 

 
Figure 22-138 Display User Mech. File Manager 
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Except for the [File Edit] button, the rest of the operation is the same as the layout file,Please refet to 
“22.12.3Layout file manager”. 
 
Edit user mech. file 
Double-click the selected edit file in the user mech. list, or click the [Edit] button to open the user mech. editing 
dialog and display the edit tree. You can also open the user mech. editing screen by double-clicking the already 
set user mech. in the layout tree. 
 

 
Figure 22-139 Display Edit user mechanism 

 
22.21.2. Operation of editing user mechanism 

The operation method is basically the same as the 3D monitor, refer to “22 3D Monitor”. 
However, rotation of the viewpoint is possible only with the mouse operation unlike the 3D monitor. 
Use the [3D view] tab of the ribbon -> [User Mech. File] group -> [Save] / [Save As] button to save the user mech. 
name file. 

 
Figure 22-140 Save user mech. file 

 
 
22.21.3. User mech. edit tree 

[3D monitor] in the layout tree is changed to the user mech. name that you set in the user mech. edit tree. 
Add objects and create user mechanism. 
Joint is used for the part to be used as the axis of the mech. set in the [Type] of the property. 
You can add joint by clicking [Add Joint] in the context menu. 
When you add a joint, a red ball appears on the user mech. edit screen with the mark [ ] in the user mech. edit 
tree. 
For other display contents and operation method, refer to “22.4Layout Tree” 
However, display and operation related to robot, hand, robot parts, user mech., spline can not be executed. 
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Figure 22-141 Add joint in user mech. edit tree 

 
22.21.3.1. Object properties 

The property item of the user mech. object is the same as the layout object (except for the interference check 
item). 
Objects added to the user mech. have display conditions individually, and you can display or hide certain objects 
by specifying I / O conditions. Please refer to “22.11.3 Layout condition edit”. 
 

 
Figure 22-142 Add joint in user mech. edit tree 

 
22.21.3.2. Joint properties 

Joint name 
 Set the joint name. 
 
Position 
 The joint is displayed at the specified position. The position is relative to the position of the parent item. The 
setting unit is [mm]. 
 

It is possible to set display conditions individually 
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Figure 22-143 Display position of joint 

 
Rotation order and Angle 
The rotation order and angle specified by the joint are displayed. It becomes relative rotation angle from the 

position and angle of the parent item. The setting unit is [deg]. 
 

 
Figure 22-144 Rotation order and Angle of the joint 

 
Axis type 
 Set up the movement method of the joint. 

Axis rotation : Rotation about the Z axis 
Axis linear : Move in X axis direction 

 

 
Figure 22-145 Joint type of joint(Axis rotation) 
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Figure 22-146 Joint type of joint(Axis linear) 

 
Reversed 
 Sets whether or not to reverse the movement of child items. When set to [Reversed], the direction of rotation or 
the direction of movement is reversed.  
By creating joints of [Not Reversed] and [Reversed] and assigning them to the same axis, it becomes possible 

to make symmetrical movement.  

 
Figure 22-147 Reversed of Joint 
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Axis of symmetry 
Assign the joint to the axis of the mechanism specified by the [Type] of the property of the user 

mechanism.Please refer to “22.9.2User mech. type and relationship to robot”. 
J1 or J7 :  Assign to J7 of Mech. # 1 (Robot) 

   Assign to J1 of Mech. number 2 or Mech. number 3 
J2 or J8 : Assign to J8 of Mech. # 1 (Robot) 

  Assign to J2 of Mech. number 2 or Mech. number 3 
J3 : Assign to J3 of Mech. number 2 or Mech. number 3 

 

 
Figure 22-148 Target Axis of Joint 

 

 
 
Axis value 
When entering a value or moving the knob of the slider bar, you can check the movement of the user 

mechanism. 
 

Axis rotation : It can be set within the range of -180 to 180. The unit is [deg]. 
Axis linear : It can be set in the range of -1000 to 1000. The unit is [mm]. 

 

J3 can not be assigned to the mech. number 1 (robot). 
Caution 
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Figure 22-149 Axis Value of Joint 

 

 
 

Please confirm with jog operation of simulator on 3D monitor 
The movement can be confirmed by entering the axis value only on the user mech. edit screen. 
To move the user mech. on the 3D monitor, specify the mechanism on the simulation operation 

panel and operate the jog. 

Caution 
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22.21.4. Distance Measurement 

Please refer to "22.17Distance measurement". 

 
Figure 22-150 Distance measurement during user mech. editing 
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22.22. Recording  
Content displayed on the 3D monitor screen can be recorded and saved to an AVI file. 

 
Click the [3D view] tab -> [Rec.] group -> [Start] button on the ribbon. The recording is started. 

 

 
Figure 22-151 3D Monitor: Recording in Progress 

 
 

To pause recording, click the [3D view] tab -> [Rec.] group -> [Pause] button on the ribbon. 
 

  
Figure 22-152 3D Monitor: When Recording Is Paused 
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If the [3D view] tab -> [Rec.] group -> [Stop] button on the ribbon is clicked during recording or when recording is 
paused, recording is stopped and the "Save As" dialog for saving the AVI file opens. 

 

 
Figure 22-153 "Save As" Dialog 

 
Also, recording functions can be set before recording by the [3D view] tab -> [Rec.] group -> [FPS] combo 
box/[Auto save] checkbox on the ribbon. These items cannot be operated during recording. So, set them 
beforehand. 

 

 
Figure 22-154 3D Monitor: Recording Options 

 
 Frame rate (FPS) 

You can change the frame rate of the video data to save the avi file. 
Setting range: 30/20/10[FPS] 
* By raising the frame rate the video will be smoothed, but on the other hand, the file size will be 
large(recording time is short). 
 

 Auto save 
When the [Auto save] checkbox is selected, the AVI file is automatically saved to the "Videos" folder in the 
workspace folder when recording is stopped. 
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About the recording time 
The recording time is affected by the screen size of the 3D monitor and the frame rate. 
To extend the recording time, reduce the screen size or the frame rate. If the initial screen size 

and frame rate is 30, it can be recorded for about 2GB. (30 minutes). 
 
 About codec 
The recorded video is saved and compressed with codec [Microsoft Video 1]. If you can not 

see the recorded video, please play on a computer environment that corresponds to the codec 
[Microsoft Video 1]. 

 
 About 3D monitor display position 
Please be sure to record with 3D monitor display (you can use some). If the 3D monitor is 

completely hidden behind other windows (project tree or property window), correct video data can 
not be recorded. 

Caution 
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23. MELFA-3D Vision  
 

This sets the control unit of MELFA-3D Vision. 
 

To add a control unit for use in the workspace, double-click the [MELFA-3D Vision] – [Setup/Add] in the project 
tree.  

 

 
Figure 23-1 “Setting and Add Control Unit” window 

 
When the control unit is double-clicked, the MELFA-3D Vision window is displayed.  

 

 
Figure 23-2 MELFA-3D Vision window 

 
For details, refer to the user’s manual containing a complete description of the MELFA-3D Vision.  
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24. I/O Simulator 
24.1. Summary 
The I/O simulator simulates the signal communication between robots. This function can also interact with GX 
Simulator2, 3 devices. (For details of GX Simulator2, 3, refer to GX WORKS2, 3’s manual.) 
 

 
 
24.2. Simulator settings 
Before starting the I/O simulator, create an I/O simulator definition file. 
Double-click [I/O Simulator] -> [Simulator Setting] on the project tree to display the [Simulator Setting] screen. 
Checking [Enable] checkbox applies the signal connection to the I/O simulator.  
 

Figure 24-1 Simulator setting screen 
 
Right-click on the list of signal connection to display the right button menu. 
 

 
Figure 24-2 Right button menu. 

 
(1) Add 

Add a new signal connection. 
Select a row and click the [Add] button to add a new signal connection.  

 
(2) Edit 

Edits the selected signal connection row. 
For editing signal connections, refer to “24.3 Signal connection edit screen”. 
 

(2) 

(4) 

(1) 

Check to apply the signal connection to I/O simulator. 

(3) 

This Software supports only GX Simulator2, 3. 
Caution 

(1) 

(2) 

(3) 
(7) 

(8) 

(6) (5) 
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Figure 24-3 Add/Edit signal connection. 

 
(3) Delete 

Deletes the selected signal connection row. 
You can also delete multiple rows at the same time. 

 
(4) Up / Down 

Moves the selected signal connection row up/down. 
You can also move multiple rows at the same time. 
Signal connections are applied in descending order. 

 
(5) Load 

Loads signal definitions saved in an I/O simulator definition file. 
Be aware that the signal selection settings shown in the signal connections list will be cleared. 

 
(6) Save 

Saves the current signal connection settings into an I/O simulator definition file. 
During the I/O simulator operating, you can choose whether to apply the save setting to the I/O 
simulator.   

 
(7) Copy / Paste 

Copies / Pastes signal connections. 
You can copy / paste multiple rows at the same time. 

 
(8) Paste in reverse 

When both the source and destination are robots, you can swap source for destination by pasting. 
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24.3. Signal connection edit screen 
On the simulator setting screen, Click the [Add] button or [Edit] button to display the signal connection edit 
screen.   

 

 
Figure 24-4 Signal connection edit screen 

 
(1) Simulation operation 

Select a desired signal simulation behavior. 
Select from [Signal value copy] (default), [Only first], [Unconditional], [Specifying condition1], [Specifying 
condition 1 and 2]. 

 
    Each behavior is as follows. 
 
- Signal value copy 

Copies the signal value to another device. 
 

 
Figure 24-5 Signal value copy 

 

(1) 
(2) 

(3) 
(4) 
(5) 
(6) 
(7) 
(8) 
(9) 
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- Only first 
Specify an initial signal value condition. 

 

 
Figure 24-6 Only first 

 
 
- Unconditional 

Specifies the signal state during simulation. 
 

 
Figure 24-7 Unconditional 

 
 



 

24-674  24-674 

- Specifying condition1 / Specifying condition 1 and 2 
Specifies 1 or 2 conditions and a signal value. The set value is applied when the set conditions are satisfied. 

 

 
Figure 24-8 Specifying condition 

 
 
(2) Signal type 

Specify a Signal type. 
Select from [PIO] (default), [CC-Link (Link Relay)] and [CC-Link (Link Register)]. 

 
The following items differ according to [Simulation operation] and [Signal type]. 
 
(3) Source / Destination / Reference side / Setting side 

Select the signal copy source from robot, GX Simulator2 and GX Simulator3 devices. 
You can select from [Project ID: name of project] (Only the number of projects is displayed), [GX Simulator2 
A to D], and [GX Simulator3 #1 to 8]. 
GX Simulator2 is assigned to A to D in the order that it is started up. Startup GX Simulator2 so that the order 
is matched. 
GX Simulator3 is assigned to 1 to 8 in the order that it is started up. Startup GX Simulator3 so that the order 
is matched. 
 

 
Figure 24-9 Items of Source / Destination / Reference side / Setting side 

 
(4) Device 

When [Source] / [Destination] / [Reference side] / [Setting side] is GX Simulator2, 3, select the device used in 
the simulation. When it is robot, the device setting is fixed. 

 
Table 24-1 Selectable Devices 

[Signal Type] [Source]/[Destination]/[Reference side]/[Setting side] 
Robot GX Simulator2, 3 

[PIO] 
[CC-Link(Link relay)] [Bit device] B (bit device) 

SB (bit device) 
L (bit device) 
M (bit device) [CC-Link(Link register)] [Word device] 
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SM (bit device) 
X (bit device) 
Y (bit device) 
D (word device) 
SD (word device) 
R (word device) 
ZR (word device) 
W (word device) 
SW (word device) 
U3En(0 to 3)\G (word device) (*1) 
U3En(0 to 3)\HG (word device) (*2) 

(*1) This can be selected only when GX Simulator2 is selected. 
(*2) This can be selected only when GX Simulator3 is selected. (GX Works3 version can be used after 
1.040S) 
 

 
(5) IN / OUT 

Select input / output of signal. 
When [Source] / [Reference side] is a robot, select [IN] or [OUT]. When [Source] / [Setting side] is a robot, 
fixed by the [IN]. 
When it is GX Simulator2, 3, this item is not visible. 

 
(6) Start # 

Specifies the start numbers of the signals / devices. 
For input range of this item, refer to Table 24-2 Input range of [Start #]/ [End #]. 
 

(7) End # 
Specifies the end number of the signal / devices. Please set the start and ending numbers to within 32 points. 
When [Simulation operation] is [Signal value copy], the destination [End #] is filled in automatically according 
to [Start #] and [End #] of source. 
For input range of this item, refer to Table 24-2 Input range of [Start #]/ [End #].  

 
Table 24-2 Input range of [Start #]/ [End #] 

[Signal type] [Source]/[Destination]/[Reference side]/[Setting side] 
Robot GX Simulator2, 3 

[PIO] 0～40960 
0～65535（0xFFFF） [CC-Link(Link relay)] 6000～8047 

[CC-Link(Link register)] 6000～6255 
 

(8) Data type 
Specifies the Data type of [Signal value]. 
Select from [Bin], [Dec] and [Hex]. 

 
(9) Signal value 

Specify the output signal value. The set value is treated in the specified [Data type]. 
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24.4. Starting I/O Simulator 
Before starting the I/O simulator, create an I/O simulator definition file.  
For an explanation of creating an I/O simulator definition file, refer to “24.2 Simulator settings”. 

 
To start up the I/O simulator, click the [Online] tab -> [I/O Simulator] group [Start] button on the ribbon in the 
simulation mode. 

 
Figure 24-10 Starting I/O simulator 

 
 
Click the [Start I/O simulator] button to display the following [I/O simulator start] screen. 
 

 
Figure 24-11 I/O simulator start screen 

 
 
Click the [Browse] button to select an I/O simulator definition file. The file used in the simulation can be checked 
on the [Simulator setting] screen. 
I/O simulator start, and the character “I/O Simulator” is displayed on the status bar. The letters [GX Simulator] 
also are displayed when the controller is connected to either GX Simulator2 or GX Simulator3. 

 
Figure 24-12 Status bar during I/O simulator operating 

 

Start I/O simulator 

When connected to GX Simulator2/3 
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While the I/O simulator is operating, the I/O simulator icon is displayed in the task tray. 

 
Figure 24-13 Icon of I/O simulator 

 
When a previously-used I/O simulator definition file exists, it is possible to start the robot simulator and I/O 
simulator simultaneously. Check the checkbox [Start I/O Simulator with the definition file used last] on the [Select 
the project] screen which is displayed before starting the simulation. 
 

 
Figure 24-14 Start robot simulator and I/O simulator simultaneously 

 
 
During the simulation, the signal values of the robots can be checked on the signal monitors. For details, refer to 
“15.3.1 General signal” and “15.3.4 Register (CC-Link/EtherCAT)”. To check the signal value of GX 
Simulator2, 3 devices, use GX Works2, 3.  
 

Click the icon to open 
menu. 
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24.5. I/O Simulator Connection Status 
When the "Simulator setting" screen is opened when the I/O simulator is started up, the connection status to the 
robot simulator and GX Simulator2/3 that are to be connected to the I/O simulator can be checked. 

 
When each of the [Setting side], [Condition1/Source] and [Condition2] cells in the signal connection list are 
displayed in red, this means that the simulator displayed in those cells is not yet connected. 
When there are simulators that are not yet connected, check the following: 
 Is the simulator to be connected started up? 
 In the case of GX Simulator2/3, is the startup order correct? 
 

 
Figure 24-15 I/O Simulator Connection Status 

 
 
24.6. Stopping I/O simulator 
To exit the I/O simulator, click the [Online] tab -> [I/O Simulator] group [Exit] button on the ribbon. Or, click the I/O 
simulator icon on the task tray, and select [Exit] in the menu that is displayed. 

 
Figure 24-16 Stopping I/O simulator 

 
 
When the simulation stops and the connection status is offline, I/O simulator stops simultaneously.  

 
 

Stopping I/O simulator 

Simulators that are not yet connected 
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25. Document out 
You can create and save to the HTML document of information of the connected robot controller and the offline 
settings. 
 
 
25.1. Start-up of the document creation screen 
There are two methods of starting document out screen. 
 
[Method (1)] Starting from the project tree 

Select the Offline, Online or Simulation of the targeted project in the project tree and click the right mouse 
button. The context menu will open, so click [Document Out]. Document Out dialog is displayed. 

 
Figure 25-1 Starting Document Out Screen from the project tree 

 
 

 
[Method (2)] Starting from the ribbon  

Select the item in the Offline, Online or Simulation of the targeted project from the project tree. Click the 
[Document Out] button in [Home] tab -> [Document] group from the ribbon, then Document Out dialog is 
displayed. 

 
Figure 25-2 Starting Document Out Screen from the ribbon 

 

 

During editing the parameter or the robot program 
During displaying the parameter list screen or the program edit screen in the project, you can 

not use this function. 

After closing the parameter list screen and the program edit screen, please use this function. 

About the displayed position of 3D monitor 
When you output the image of the 3D monitor to the document, please move the 3D monitor to 

the position to see (Even the part is possible). If the 3D monitor is completely hidden by other 
windows (project tree, properties window or others), correct image can not be output. 

Caution 
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25.2. Selection of content to be output to document 
By checking each checkboxes in the document out screen, you can select contents to be output to the document. 
 

 
Figure 25-3 Select contents to be output to the documen 

 
Table 25-1 Content of output to document 

Item Content of output to document 
Reference 
of output 
content 

Header Output the entered title, subtitle, company name etc. as header page 
on the document. 

 

Contents Output links to each page of "Controller information" to "3D Monitor" 
as contents page on the document. 

 

Controller 
information 

･ Output the model information (model name, robot controller software 
version and etc.) of connected robot controller and robots on the 
document. 

･ When offline, Output information of the project inside the PC to the 
document. 

3.2 

System status ･ Output the each status of connected robot controller and robots to the 
document. 

･ When offline, cannot output. 

15 

Robot program ･ Output all programs in the connected robot controller to the document. 
･ When offline, Output all programs in the project inside the PC to the 

document. 

11.2 
11.13.1 

 
Parameters setting Output the list of changed parameters to the document. 14.1.3 
Error information ･ Output the currently occurring errors or the histories/records of error 

that have occurred so far to the document. 
･ When offline, cannot output. 

15.2.6 

Event history ･ Output the list of events that have occurred so far in the connected 
robot controller to the document. 

･ When offline, cannot output. 

15.2.5 

3D Monitor Output the images in which the viewpoint of the 3D monitor is 
switched to X-Y plane, X-Z plane and others to the document. 

22.3.3 
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Figure 25-4 Document output example 
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25.3. Save document 
By click the [Save] button in the document out screen, “Folder of the document to create” dialog. In this dialog, 
enter or select the folder name for create the document, and click the [Save] button, then the document creation 
will start to the selected folder. 
When the creation of the document is completed, the created HTML document is displayed in Windows default 
web browser. 
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26. MELFA-Works 
You can be used the function of 3D robot simulator “MELFA-Works”. 
This function can only be used with the Pro edition. 

 
When "RT ToolBox 3" Pro version is started and set to simulation mode, the item of "MELFA - Works" is displayed 
in the project tree. Clicking [MELFA - Works] -> [Start] in the project tree starts the MELFA - Works function as an 
add - in for Solid Works. 

 

 
Figure 26-1 Start of MELFA-Works function 

 
 

For details, refer to the “MELFA-Works Instruction Manual". 
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27. iQ Care MELFA Support 
You can be used the function “iQ Care MELFA Support”. 
This function requires an online connection to a robot controller with iQ Care MELFA Support enabled. 
 
For details, refer to the “ Industrial Robot Support Service iQ Care MELFA Support User's Manual (BFP-A3804)”. 
 
Each screen can be opened from the project tree under [Online] – [iQ Care MELFA Support]. 
 
 
 
 
 
 

Figure 27-1 Start of iQ Care MELFA Support 
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28. MelfaRXM.ocx Communications Middleware Setup  
28.1. Summary 
MelfaRXM.ocx is an ActiveX controller that communicates with CR800/750/700/500 series robot controllers. 
MELFARXM.ocx can only be used if you have purchased the standard edition of RT ToolBox3. (Customers who 
have purchased the mini edition cannot install MELFARXM.ocx.) 
When using only the RT ToolBox3 functions, there is no need to set up "MELFARXM.ocx". 

 
Using MELFARXM.ocx enables you to simply produce Windows applications connected to a robot controller on 
the customer's device. 
 

 
 
 
28.2. DVD-ROM Contents 
The contents of the "RT ToolBox3" (standard edition) DVD-ROM are as follows. 

 
Figure 28-1 DVD-ROM Contents 

 
For details on MelfaRXM.ocx usage methods, refer to the user's manual on the DVD-ROM. 
 

/: 

: 
: 

: 
: 

RT ToolBox3 installation files 

Communications 
middleware 
MelfaRXM.ocx 
related file 

These are cautions for using MELFARXM.ocx. 

MelfaRXM.ocx installation files 

This is the MELFARXM.ocx user's manual. 

The user's manual for using MelfaRXM.ocx and the cautions are on the RT ToolBox3 standard edition 
DVD-ROM. 

The means for communicating with CR800/750/700 series robot controllers are RS-232(CRnD-700), 
Ethernet and USB(CR800-D/CR750-D/CRnD-700). 

To communicate with CRnQ_R and GOT, the RT ToolBox3 must be installed.  
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28.3. User's Manual Reading Guide 
The manual is in the DVD-ROM as an Adobe PDF file. 

D:/Utility/MELFARXM/Doc/MelfaRXME.pdf 
* Example for when the DVD-ROM drive is "D:” 

 
(1) Preparation for viewing 

1) Prepare computer  
Prepare a computer that has a DVD-ROM drive. 

2) Preparation of viewing software 
Adobe Reader is required to read the User's Manual. 
If neither Acrobat Reader (nor Adobe Reader) is installed, download it from the Adobe 
Systems web site. (As of November 2019) 

URL: http://www.adobe.com 
 

(2) Viewing methods 
1) Starting from Windows Explorer 

Start Windows Explorer, then select the file. Acrobat Reader (or Adobe Reader) will start and 
the user's manual displayed. 

2) Starting directly from Acrobat Reader (or Adobe Reader)  
Start Acrobat Reader (or Adobe Reader), then select the file to display the user's manual. 

 
 
28.4. Installation 

Perform installation according to the following procedure 
 

(1) Insert the program DVD-ROM into the DVD-ROM drive of your personal computer. Setup of “RT ToolBox3” 
will start automatically. Click “cancel”. 
 

(2) Select [Run] from the [Start] button. 
  

Press  on the keyboard. 
 
 

(3) Check the drive name of the DVD-ROM drive. Enter the following and click the [OK] button. 
"Drive name":/Utility/MelfaRXM/Setup.exe 
 (If the DVD-ROM drive is "D", enter "D:/Utility/MelfaRXM/Setup.exe") 

 
Figure 28-2 [Run] Screen 
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(4) Installer starts and the Setup screen appears. Install according to the instructions that appear on the screen. 

The Product ID is needed when this "MelfaRXM.ocx" is installed. Input the Product ID same as the Product ID 
of "RT ToolBox3". "MelfaRXM.ocx" can be installed with the Product ID of the standard version, but cannot be 
installed with the Mini version. 

 
Figure 28-3 Input Product ID 

 
The product is installed as in "Table 28-1 Files to be Installed". 
 
 

Table 28-1 Files to be Installed 
No. Description Install destination 
1 MelfaRXM.ocx 

 
These files are installed under the system folder. 
For example: 

32bitOS : \Windows\System32 
64bitOS : \Windows\SysWOW64 

 
2 communication DLLs 

3 RoboCom.exe  
(communication server2 ) A folder specified during install operation (Normally, C:/ is used.) 

[MelfaRXM_Dev] 
ReadMe.txt ······ text file which indicates notes 
[RoboCom] ······ folder of communication server 
[Doc] ·············· folder of Instruction Manual 
[Sample] ········· folder of sample programs 

[BCB] ··········· Borland C++ Builder (5.0) 
[CS] .................... Visual C# (Visual Studio 2010) 
[VB] ············· Visual Basic (6.0) 
[VC++]·········· Visual C++ (6.0) 
[VB.NET] ······ Visual Basic .NET 2003 

(Operation confirmed only in the Japanese version.) 
[Redist]  

[Installer] ······· folder of system files Installer (for redistribution)  
 

 

4 Instruction Manual 
(this document) 

5 Sample programs 
 
 
 

6 Redistribution files 
 

7 Information files for 
 USB driver 
(for 
CR800-D/CR750-D/CRn
D-700) 
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29.  Appendix 
29.1. Q&A 
This explains frequently asked questions in a Q&A format. 
 
1. Version 

(1) Where is the software version information? 

It is printed on the surface of your DVD-ROM for this software. 
You can also check the version information on the screen displayed by clicking the [Help] tab -> [Version 
Information] button on the ribbon of this software. 

 

 
 
 

(2) Where is the robot controller software version information displayed? 

When this software is connected, you can check in the [Online] properties in the project tree. 
The version information is also displayed on the title screen for the optional teaching box. 
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2. Product ID 

(1) Where can I check the product ID? 

This software requires the product ID for installation. 
The package containing your software contains a sheet of paper on which is written the product ID. 
After installing this software, you can check the product ID on the screen displayed by clicking the [Help] tab 
-> [Version Information] button on the ribbon. 

 

 
 

(2) I checked the version information but the product ID is not displayed. 

Is "No Product ID!" displayed? 
If "No Product ID!" is displayed in the version information, the software installation may have failed. 
Unfortunately, you need to install the software again. 

 



 

29-690  29-690 

 
3. Communications (general) 

(1) What are the means for communication with the robot controller? 

With a CR800/750/700 series robot controller, you can communicate via USB, Ethernet, and RS-232.  
With a CRn-500 series robot controller, you can communicate via Ethernet and RS-232. However, when 
using Ethernet with a CRn-500 series robot controller, the robot controller must have the optional Ethernet 
card. 
For details, see "9.1 Robots Connected and Types of Communication". 

 

(2) Where are the communications settings made? 

They are made on the project edit screen. For details, see "9.2 Connection Settings". 
For the robot controller side, change the communications parameters with the optional teaching box. For 
details, see "Detailed explanations of functions and operations" in the robot controller's user's manual. 
[Caution] The communication settings must be made on both this software and the robot controller. 
If you change the robot controller settings, you must change the settings in this software too. 

 

(3) I cannot communicate with the robot controller. 

If you cannot communicate with the robot controller, check the following. 
Also see "4 Communications (RS-232)", "5 Communication (Ethernet)", and "6 Communication 
(USB)". 

 
Check item or cause Solution 

Is the connected robot controller selected 
correctly? 

Check if the correct project is selected with this software. 
For details, see "8.18 Offline/Online/Simulation". 

Is the robot controller power supply On? Switch On the robot controller's power supply and check 
that the robot controller starts up normally. 

Is Communication Server 2 running? 
Communication Server 2 is started 
automatically when this software is started. 
Communication Server 2 is started as an 
icon. 

If you closed Communication Server 2 by mistake, close 
this software, then restart it. 

Are you connected to a robot controller 
other than the CR800/750/700/500 series? 

Check the robot controller model name in its user's 
manual (or standard specifications or the like). 

Are the robot controller's network settings 
correct? 

The robot controller's network settings are made by the 
parameters. Check the robot controller's network 
settings with the optional teaching box. 

Are the communications settings on this 
software correct? 

Set the correct communications settings. 
For details, see "9.2 Connection Settings". 

Is some other MELFA product running? 
For example is E/EN series computer 
support software or P/P or P/P-2 running? 

Close any MELFA product other than this software. 
For details, see "1.6 When Starting at the Same Time 
as Another Product". 
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Check item or cause Solution 

Is there a error occurred in the PLC CPU? Extend the time of [(4)Check at Communication Time] on 
the [Detail setting] screen of [CRnQ_R communication 
setting]. 

 
What color is Communication Server 2? 
Return Communication Server 2 to icon 
status and check the color displays for the 
line state. 

 

Red 

The problem may be that the robot 
controller is not connected correctly.  
Check the items in "(4) When 
Communication Server 2 is red 
(overall)". 

Green 

The problem may be that the robot 
controller and the computer have different 
communications settings. Check the items 
in "(5) When Communication Server 2 is 
green (overall)". 

Yellow 
Check the items in "(6) When 
Communication Server 2 is yellow 
(overall)". 

Light blue Check the items in "(7) When 
Communication Server 2 is in light blue 
or blue (overall)". Blue 

 
 

(4) When Communication Server 2 is red (overall) 

When Communication Server 2 is displayed in red, check the following. 
 

Check item or cause Solution 
Is the communications cable connected 
correctly? 

Connect the cable correctly. 

Are you using the correct communication 
cable? 

Check the communication cable specifications. 
Be careful. RS-232 cables and Ethernet cables can be 
either cross cables or straight cables. 
For the cable specifications, check your robot's 
"Standard Specifications". 

When connected by CRnQ_R 
communication, is the target CPU set 
correctly? 

Set the target CPU correctly. 
For details, see "9.2.5 CRnQ_R Communication 
Settings". 

 
 

(5) When Communication Server 2 is green (overall) 

When Communication Server 2 is displayed in green, check the following. 
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Check item or cause Solution 

Do the communications settings in this 
software and on the robot controller match? 

The communications settings in this software and on the 
robot controller must match. 
The communications settings for this software are made 
on the project edit screen. For details, see "9.2 
Connection Settings". 
For the robot controller side, change the 
communications parameters with the optional teaching 
box. For details, see "Detailed explanations of 
functions and operations" in the robot controller user's 
manual. 

 

(6) When Communication Server 2 is yellow (overall) 

When Communication Server 2 is displayed in yellow, check the following. 
 

Check item or cause Solution 
Is this software in the "Online" status? This software initially starts in the "Offline" status. When 

you put it into "Online" status, it communicates with the 
robot controller. 
For details, see "8.18 Offline/Online/Simulation". 

 
 

(7) When Communication Server 2 is in light blue or blue (overall) 

If Communications Server 2 is displayed light blue or blue, but communications are still not possible, check 
the following. 

 
Check item or cause Solution 

Is there a communications error in this 
software? 

Check the contents of the communications error and 
close the communications error window. 

Is a simulation underway? 
(Note) Only the standard edition has the 
simulation function. 

End the simulation. 

Is the screensaver running on the 
computer? 

Close the computer's screensaver. 

Is the computer's hard disk is power save 
mode? 

Close computer hard disk power save mode setting. 

 
 

(8) Communication with the robot controller is cut off mid-way through. 

If you cannot communicate with the robot controller, check the following. 
 

Check item or cause Solution 
Is the screen saver set, hard disk power off 
set, system standby set, or system 
shut-down set? 

If any of these functions are running, they may cause a 
communications time-out, so do not use any of these 
functions. 

Is some other product running that uses 
communication? 
Or is any permanent resident software 
running that uses communication? 

A computer communication port cannot be opened for 
two applications, so either close the other application or 
change the port that this software uses. 
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4. Communications (RS-232) 
If you cannot communicate with the robot controller using RS-232, check the following. 
Also, see "Communication (general)". 
 

Check item or cause Solution 
What color is Communication Server 2? 
Return Communication Server 2 to icon 
status and check the color displayed for the 
line state. 

 

Red 

The problem may be that the robot controller 
is not connected correctly. Check the items 
in "(1) When Communication Server 2 is 
red (RS-232)". 

Green 

The problem may be that the robot controller 
and the computer have different 
communications settings. Check the items in 
"(2) When Communication Server 2 is 
green (RS-232)". 

Yellow See "3Communications (general)". 

Light blue Check the items in "(3) When 
Communication Server 2 is light blue or 
blue. (RS-232)". Blue 

 

(1) When Communication Server 2 is red (RS-232) 

If Communication Server 2 is displayed in red with communication with the robot controller set to RS-232, 
check the following. 
 

Check item or cause Solution 
Is Communication Server 2 set for the 
correct communication port 
(COM1-COM10)? 
 

The default value for this software is COM1. On some 
computers, COM1 is not allocated to RS-232, but to an 
infrared port, modem, or the like. Also, when using 
RS-232 over USB, the port used for RS-232 may be 
other than COM1. 
Use the Windows device manager or the like to check 
the COM number allocated to RS-232 and change the 
"Port" setting in the communication settings to that port. 

Is some other product running that uses the 
communication port? 
Or is any permanent resident software 
running that uses the communication port? 

A computer communication port cannot be opened for 
two applications, so either close the other application or 
change the port that this software uses. 

In the communications settings for this 
software, is the communication method set 
to TCP/IP or USB? 

Change the communication method to RS-232. 

 
(2) When Communication Server 2 is green (RS-232) 

If Communications Server 2 is displayed green with communications with the robot controller set to RS-232, 
check the following. 

 
Check item or cause Solution 

Do the communication settings in this 
software and on the robot controller match? 
In particular, check that the protocol settings 
match. 

The communication settings in this software and on the 
robot controller must match. 
The default protocol for this software is "Procedural", but 
for CRn-500 series robot controllers, the default protocol 
is "Non-Procedural" 
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(3) When Communication Server 2 is light blue or blue. (RS-232) 

If Communication Server 2 is displayed in light blue with communication with the robot controller set to 
RS-232, check the following. 

 
Check item or cause Solution 

Is anti-virus software running virus checks 
on RS-232 communication? 

Switch off virus checking for RS-232. 

When a computer starts up, sometimes this 
generates noise. 
This noise can cause a communication error 
in the robot controller. 

Either start the computer before connecting the cable or 
start the computer before starting the robot controller. 
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5. Communication (Ethernet) 
[Note]  When using Ethernet with a CRn-500 series robot controller, the robot controller must have the optional 

Ethernet card. 
 
If you cannot communicate with the robot controller using Ethernet, check the following. 
Also, see "3. Communications (general)". 
 

Check item or cause Solution 
What color is Communication Server 2? 
Return Communication Server 2 to icon status 
and check the color displayed for the line 
state. 

 

Red 

The problem may be that the robot 
controller is not connected correctly. 
See the items in "(1) When 
Communication Server 2 is red 
(Ethernet)". 

Green 

The problem may be that the robot 
controller and the computer have different 
communication settings. 
See the items in "(2) When 
Communication Server 2 is green 
(Ethernet)". 

Yellow See "3 Communications (general)". 
Light blue See "3 Communications (general)". Blue 

 

(1) When Communication Server 2 is red (Ethernet) 

If Communication Server 2 is displayed red with communication with the robot controller set to Ethernet, 
check the following. 

 
Check item or cause Solution 

In the communication settings for this 
software, is the communication method set to 
USB or RS-232? 

Change the communication method to TCP/IP. 

 

(2) When Communication Server 2 is green (Ethernet) 

If Communication Server 2 is displayed green with communication with the robot controller set to Ethernet, 
check the following. 

 
Check item or cause Solution 

Are the robot controller's network settings 
correct? 

Make the computer's network settings. 
Check that the IP address, gateway, subnet mask, and 
other network settings are correct. 
Check on the computer [Control Panel] – [Network 
Settings]. 
* For details on the network settings, please consult 

with your network administrator. 
Is the robot controller's IP address set 
correctly in the communication settings? 

Correctly set the IP address of the robot controller 
connected to. 
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(3) The communication time is long when using a backup etc. 

In the Windows Firewall settings, if inbound communication of Communication Server 2 (RoboCom.exe) is 
blocked, change to allow the connection. 

 
Check item or cause Solution 

If there are one or more “RoboCom” lines in 
the [Inbound Rules] of the [Windows Firewall] - 
[Advanced settings] screen, is [Allow the 
connection] selected for all these lines? 

If there are “RoboCom” lines with [Block the 
connection] selected, change them to [Allow the 
connection]. 

 
 
 

(4) Spline files cannot be saved.  

See "(3) The communication time is long when using a backup etc.“.  
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(5) The Oscillograph cannot be used when the communication method is set to High speed. 

If you see the message "It can not communicate with the controller." after clicking the [Start Record] button, 
please change so that that RT ToolBox3 (MELFA_RT.exe) is allowed to receive in the Windows Firewall 
settings. 

Check item or cause Solution 
Show the following screen by selecting 
[Control panel] -> [System and Security] -> 
[Windows Firewall] -> [Allow a program or 
feature through Windows Firewall] (for 
Windows7).  

 
 
Is [RT ToolBox3] in the [Allowed programs and 
features] list is the communication range of the 
use environment allowed? 
 

If [RT ToolBox3] is not in the [Allowed programs and 
features] list, click the [Allow another program] button. 
If the [Allow another program] button is disabled, click 
the [Change settings] button first. 

  
 
Select and add [RT ToolBox3] on the [Add a program] 
screen. 

 
 
Set the check boxes ON according to the use 
environment of [Home/Work (Private)] and [Public]. 
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6. Communication (USB) 
If you cannot communicate with the robot controller using USB, check the following. 
Also, see "Communications (general)". 

 
Check item or cause Solution 

What color is Communication Server 2? 
Return Communication Server 2 to icon 
status and check the color displayed for the 
line state. 

 

Red 

The problem may be that the robot 
controller is not connected correctly. 
Check the items in "(1) When 
Communication Server 2 is red 
(RS-232)". 

Green 

The problem may be that the robot 
controller and the computer have different 
communications settings. 
See "3 Communications (general)". 

Yellow See "3 Communications (general)". 

Light blue Check the items in "(2) When 
Communication Server 2 is light blue or 
blue (USB)". Blue 

 
(1) When Communication Server 2 is red (USB) 

If Communication Server 2 is displayed in red with communication with the robot controller set to USB, check 
the following. 

 
Check item or cause Solution 

In the communication settings for this 
software, is the communications method set to 
TCP/IP or RS-232 

Change the communication method to USB. 

Is the USB driver installed? Communicating with USB requires that the USB driver 
be installed. 
For details, see "1.5.3 USB driver 
(CR800-D/CR750-D/CRnD-700 series robot 
controller) installation", "1.5.4 CRnQ_R 
communication USB driver installation" and "1.5.5 
CRnQ_R Communication USB driver for GOT 
transparent function / GOT communication 
installation". 

 

(2) When Communication Server 2 is light blue or blue (USB) 

With communications with the robot set to USB, if Communication Server 2 is displayed in light blue or blue, 
but communication is still not possible, check the following. 

 
Check item or cause Solution 

Is the robot controller power supply Off? When connected by USB in CRnQ communication, if 
the robot controller power goes Off after a normal 
connection was established, the display remains light 
blue. 
Switch to Offline in this software, switch the robot 
controller power On, and then go back online. 

Is the communications cable connected 
correctly? 

When connected by USB in CRnQ communications, if 
the communications cable is disconnected after a 
normal connection was established, the display 
remains light blue. 
Switch to Offline in this software, connect the 
communications cable, and then go back online. 
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7. Robot program 

(1) Did you write the program with Movemaster commands? 

The robots that can use Movemaster commands are restricted. Check your robot's standard specifications to 
see whether it supports Movemaster commands. If your robot supports Movemaster commands, change the 
language used with "10 Robot Programming Language Setting" in this document 

 

(2) Is it possible to use programs as is that have been used with an E/EN series robot controller? 

Position data prepared with MELFA-BASIC III (for E/EN series) cannot be used as is. Convert the position 
data with the "Program conversion" function. For details, see "11.14 Program Conversion". 
Also, some commands have changed. For details, see "Detailed explanations of functions and 
operations" in the robot controller user's manual. 
 

(3) Is it possible to use R-250R series and R-300R series programs? 

R-250R series and R-300R series robot programs written in the MELFA II language cannot be used as is. 
Write new programs. 
 

 
8. Program edit 

(1) When we check syntax, "Error in input command statement syntax" occurs frequently. 

 
Check item or cause Solution 

Is the command statement syntax correct? Program in correct syntax. 
Are double-byte spaces used? Use only single-byte spaces. 
Is the language to use set correctly? 
This software supports MELFA-BASIC IV/V/VI 
and Movemaster commands, but there are 
terms that must be switched and set for 
whichever one of these you use. 

Set the robot program language you are using. 
For details, see "10 Robot Programming Language 
Setting". 
 

Does the version of this software support your 
robot controller? 
For some robot functions, new commands 
have been added. 

Purchase a version that supports your robot controller. 
(Contact the store you purchased from or one of our 
branches.) 
* A program can be written to the robot controller even 

if the syntax check finds many "syntax errors". 
 

(2) How should we change the robot program language setting? 

This is done on the project editing screen. For details, see "10 Robot Programming Language Setting". 
The robot program language set here is enabled when you edit a program offline. Online programs are 
displayed in the robot program language set by the connected robot controller. 

 

(3) When you open a program, the robot program language is different from the one set for this 
project. 

Is there any online program open? 
Online programs are displayed in the robot program language set by the connected robot controller. The 
robot program language set in the project is enabled when you edit a program offline. 

 

(4) Is it possible to edit or copy a program while it is running? 

You can neither edit nor copy a program while it is running. Stop the program, then edit or copy it. 
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(5) How should we edit a program for which the start condition is "Always"? 

A program for which the start condition is "Always" is executed immediately after the robot controller power 
comes On. To edit such a program, use the following procedure. 

(1) Change the starting condition in the "Slot table (SLT * * 1-32)" parameter to "Start (normal)".  
(Write this parameter to the robot controller.) 

(2) Reset the power supply for the robot controller. 
(3) Edit the target program and save it to the robot controller. 
(4) Return the starting condition in the "Slot table (SLT * * 1-32)" parameter to "Always".  (Write this 

parameter to the robot controller.) 
(5) Reset the power supply for the robot controller. 

 

(6) Is it possible to change the font for a robot program displayed with the program edit tool? 

Yes. 
Change the font used with "11.6.10Changing the font" in this document.  

 

(7) Is it possible to edit backed up program data with the program editor? 

Program data backed up by this software can be opened in editing of programs. Please refer to "11.2.4 
Editing a program in the backup data" in this manual for details.  

 

(8) "User-defined external variable cannot be used (481000000)" is displayed and the program 
cannot be edited. 

This error is displayed if a user-defined external variable is used even though the user base program is not 
defined. (Normally, a user base program is defined with the "PRGUSR" parameter, but if nothing is set in the 
"PRGUSR" parameter, this error occurs.) 
To use a user-defined external variable, define the user base program. 
Also, for details on user base programs, see "Detailed explanations of functions and operations" in the 
robot controller user's manual. 

 

(9) Is it possible to copy position data to another program? 

Yes. 
For details, see "11.7.4.4 Copying position variables" and "11.7.4.5 Pasting Position Variables" in this 
document. 

 

(10) Does it cause an error to not discriminate uppercase and lowercase letters when inputting 
commands? 

No. 
You can input either uppercase letters or lowercase letters with the program editor, but when the program is 
saved to a robot controller, the commands are converted correctly. 

 
9. Variable monitor 

(1) How are external variables (system status variables, program external variables, and user 
defined external variables) monitored? 

Use the program monitor. 
For details, see "15.2.2 Program monitoring" in this document. 
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10. Option card 

(1) How should one check what option cards are mounted in a robot controller? 

Check from the project tree. 
For details, see "17 Option Card" in this document. 

 
11. Parameter editing 

(1) No parameter list is displayed in the parameter editing tool. 

Download the parameter list from the robot controller. 
For details, see "14.1.4 Parameter list reading". 

 

(2) We changed a parameter, but the new value does not take effect. 

After you changed the parameter, did you switch the power for the robot controller Off, then On again? 
The new parameter value does not take effect until you switch the robot controller power Off, then On again. 
Switch the robot controller power Off, then On again. 

 
12. Backup/restore 

(1) Is it possible to edit backed up program data with the program editor? 

Program data backed up by this software can be opened in editing of programs. Please refer to "11.2.4 
Editing a program in the backup data" in this manual for details.  

 
13. 3D Monitor 

(1) It takes time to update the screen display. 

It might take time to update the screen display when a lot of data is displayed in the 3D monitor. The time to 
update the screen display shortens when the displayed data is reduced. 
Moreover, depending on the performance of the computer, it may not be possible to display other screens 
during 3D monitor display. 
If you selected the "Detailed model" of the robot, change to "Simple model". The robot model can be changed 
to detailed model or simple model in the [3D view] tab -> [Robot model] group on the ribbon. 

 
14. Other 

(1) Characters are displayed on the screen on top of each other or with some characters missing. 

Is the font size in the computer screen settings something other than "Standard"? 
Use this software with the font size set to "Standard".  

 

(2) A program does not print correctly. 

In some printer types, tab characters in a program may not print correctly. 
Replace them with a space character in program editing, or change the printer settings to use a TrueType 
font. 

 

(3) RT ToolBox 3 is forcibly terminated when opening the graphic screen of the robot such as 
project edit / 3D monitor. 

Is the Aero function of Windows 7 enabled? 
If the Aero function is disabled in Windows 7, please enable the Aero function by the following procedure. 
1) Right-click on the desktop and open "Personalize". 
2) Select an arbitrary theme from the list of Aero themes.
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29.2. Copyright, Disclaimer 

29.2.1. Open Source Computer Vision Library 

Copyright, Disclaime 
 
IMPORTANT: READ BEFORE DOWNLOADING, COPYING, INSTALLING OR USING. 
 
 By downloading, copying, installing or using the software you agree to this license. 
 If you do not agree to this license, do not download, install, 
 copy or use the software. 
 
 
                          License Agreement 
               For Open Source Computer Vision Library 
 
Copyright (C) 2000-2008, Intel Corporation, all rights reserved. 
Copyright (C) 2008-2011, Willow Garage Inc., all rights reserved. 
Third party copyrights are property of their respective owners. 
 
Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met: 
 
  * Redistributions of source code must retain the above copyright notice, 
    this list of conditions and the following disclaimer. 
 
  * Redistributions in binary form must reproduce the above copyright notice, 
    this list of conditions and the following disclaimer in the documentation 
    and/or other materials provided with the distribution. 
 
  * The name of the copyright holders may not be used to endorse or promote products 
    derived from this software without specific prior written permission. 
 
This software is provided by the copyright holders and contributors "as is" and 
any express or implied warranties, including, but not limited to, the implied 
warranties of merchantability and fitness for a particular purpose are disclaimed. 
In no event shall the Intel Corporation or contributors be liable for any direct, 
indirect, incidental, special, exemplary, or consequential damages 
(including, but not limited to, procurement of substitute goods or services; 
loss of use, data, or profits; or business interruption) however caused 
and on any theory of liability, whether in contract, strict liability, 
or tort (including negligence or otherwise) arising in any way out of 
the use of this software, even if advised of the possibility of such damage. 
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29.2.2. Diff Template Library 

Copyright, Disclaime 
 
In short, Diff Template Library is distributed under so called "BSD license", 
 
Copyright (c) 2013 Tatsuhiko Kubo <cubicdaiya@gmail.com> 
All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification,  
are permitted provided that the following conditions are met: 
 
 * Redistributions of source code must retain the above copyright notice,  
   this list of conditions and the following disclaimer. 
 
 * Redistributions in binary form must reproduce the above copyright notice,  
   this list of conditions and the following disclaimer in the documentation  
   and/or other materials provided with the distribution. 
 
 * Neither the name of the authors nor the names of its contributors  
   may be used to endorse or promote products derived from this software  
   without specific prior written permission. 
 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS  
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT  
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR  
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT  
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,  
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED  
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR  
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF  
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING  
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS  
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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